
ABOUT Frank’s VS Info. 
 
This is my manual and a quick start guide for Newbies written in the Dummies style, on 
the VS2480. A lot of this info works as well with the VS2400 and VS2000. Roland Tech 
Support taught me how to use my VS2480CD in 2002 and beyond and I have typed up 
step by step info, pretty much on all the features I have learned. I have had people who 
were fed up with the Roland manuals and selling their VSs, tell me that this info “saved 
the day.” So... I send it out FREE to VSPlanet members. 
 
The second doc, a CONTENTS doc, tells what’s covered in each .doc. The third is the 
QUICK START guide titled "Easy VS Info" that takes you from start of project to 
finished CD, step by step in 11 easy pages. Start with this document. Roland’s manuals 
do not really give you step by step instructions on how to use the VS with a mouse and 
the external VGA monitor connected; so I wrote this manual to help other Newbies learn 
to use their VSs like they do a computer with a monitor, mouse and keyboard. A lot of 
the language is in “plain English” and laid out very simple so just about anybody can 
follow it. You will need to have a PC style Monitor, mouse and keyboard connected to 
your VS to get the most out of these word docs. 
 
If you have any questions or need another copy sent, just email me at Fcgjabq@aol.com 
I am always updating this info as I learn more so you can also come back for updated 
copies. You will find that I have covered just about everything I have needed to know 
using mine since 2002. I cover the basics then have extra docs that take steps more in 
depth as well as links to info on line and added info from post that I have found helpful 
on VSPlanet. 
Start with the “Easy VS Info” and good luck, Frank. 
 
Last updated Oct 24, 2012 
 

mailto:Fcgjabq@aol.com
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CONTENTS OF VS DOCS 
Easy VS Info…Is a 10 page start to finished CD Quick Start doc to get you up and 
recording as quickly as possible and covers tons of good things to know. If you read 
nothing else at least read this one to teach you all of the basics about the VS. The most 
helpful word docs for Newbies are: Easy VS Info, VSCpyMveExchExprt, VS EFFECTS, 
VS INSERT EFX, VS LEVELsRecMSTclkTrk, VS Mastering CDs for Newbies, VS 
MST & BURN, VS SUB MIXESbounceLoop & VS V-TrkOptUndoAPnchRgnCpyEtc. 
This info was written using a Monitor, keyboard and mouse and will you need them too. 
 
“Easy VS Info” starts with the 5 Goals using the VS, then New Project & Initializing 
routing page settings, Setup Audio, Input & Track Fader Setup,  Input Levels, Recording 
Levels, Check Track, V-Tracks, Track naming, Recording Guitar w/ Hi-Z, Linking 
channels for stereo, Loop Effects, Insert Effects, Add Effects to Inputs, Edit Effetcs, 
Mixing Recorded Tracks,  Phrase Normalize, Analyzer, Mastering Tracks, Burning to 
CD, Backups, Bouncing Tracks w/ Effects, Bounce without Effects, EZRouting Clear 
Tools, CR-R Mode, Important to remember, No “Save As” only Copy project, Never do, 
Always do, Conclusion, Frank’s email address and Links to Videos, the Plancton DVDs 
and a post on VSP comparing the VS audio quality to Pro Tools. 
 
VS2480 SHORT CUTS….Shows you the VS shortcuts as well as shortcuts you can use 
on a PS/2 keyboard with the VS. IDHold for different views on LCD and VGA. 
 
VS 16bit w MTP...How to get 16bit .wav format files out of the VS2480 while in MTP 
24bit mode, from Brett’s site on line.  
 
VS & PC Progs…Shows you how to use PC programs like Acid and Wavelab to export 
.wav files from each other to disc or into the VS. 
 
VS & RPC-1Setup…Is just that, how to setup the VS to work with an RPC-1 card & PC. 
 
VS BitsSamplesWavsCDA... explains what windows burn what files in what bit rate, 
sample rate and file format. CD-R WRITE window, TRACK EXPORT window, 
Mastering Room and Project modes and settings that affect bit and sample rates. 
Post about Jerry Tubbs and VS wav files as good as Pro Tools. 
 
VS BkUPFmtRcvy…Covers Backups, Formatting your hard drive and recovering 
projects. Installing hard drives and models to use. Also formatting an external SCSI and 
links to VS2480CD to DVD Conversion and models used. 
 
VS BPMwTmpMp…Finding the BPM of a song using the TEMPO MAP. 
How to use the Metronome with recording and recording a click track. 
 
VS CompEQ PRM EDIT…How to assign the PAN knobs to become the parameters for 
the compressor and EQ for that track. 
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VS CompressExpGate…How to use the VS compress with Expander to create a GATE. 
A brief example of how to use the Compressor and Kick, Snare and Bass Guitar settings. 
 
VS CpyMveExchExprt…How to edit with the VS, copy, move, erase, cut audio, make a 
song shorter or longer, A-Punch, copy a song to another drive/partition, track exchange 
one track with another and how to copy parameters, Dyn, EQ & Level settings from one 
track’s or input’s Ch-Edit page to another. Also how to export .wav files to burn to CD 
and import them as well as IMPORT tracks and master tracks from other projects. Also, 
converting 48k tracks to 44.1k tracks using VS to PC to CD to VS. Also, CD Capture and 
TRACK IMPORT, importing tracks from other projects into an open one & Phrase 
Export phrases of tracks to CD-R/RW. 
 
VS Danielo Data Recover....So you powered down without saving the project or 
somebody unplugged your VS, or lightening struck, do what’s in this doc. 
 
VS DAO LIVE Rcdng…How to burn a live recording to disc using Disc at once. Also, 
how to separate songs into their own one song projects, in brief. 
 
VS De-esser EFX…How to use P022 Vocal Multi as a De-esser. 
 
VS EFFECTS... How to patch in effects and route them as INSERT or LOOPED effects, 
on INPUTS or TRACKS also some on EQ & Compression. Also how to edit effects 
patches and save them as USER patches. 
 
VS EQing Bas&Kic…Some tips on how to use the EQ Graph to mix the bass guitar and 
kick drum so they both come out in the mix. Also, how to use the ANALYZER to 
identify what frequency range an instrument or vocal is made up of. Plus a quicky list of 
freqs for all instruments, drums, vocals etc. Also a couple of tips on using compression 
and VS patches on bass guitar. Also, “Side Chaining” compression. & VSP post link. 
 
VS ERASE Silnt pts…How to get rid of the data between the vocal parts and solos, save 
on disc space by erasing un-wanted data, silent parts between takes etc. 
 
VS External EFX…How to setup the VS to work with external effects units. From VSP 
post by members. 
 
VS Faders Clean & Replace…Links to info on how to clean faders, parts to order for 
replacing faders and how to turn them On or Off. 
 
VS INSERT EFX…INSERT effects explained in more detail and the 4 positions of the 
EFX button. 
 
VS Install HD in VS2480CD... Describes how to install a new hard drive in the CD 
model VS2480,  provides a link to a PDF with pics to help with the install, a brief how to 
do and tools needed and what brands and specs to look for in hard drives. 
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VS LEVELsRecMSTclkTrk…Setting the recording levels at -12db to -4db to leave 
headroom for mixing, setting mastering levels, using 3card MTKs and how to use a click 
track. From VSP members post and setting levels for sending mixes to mastering houses. 
 
VS Mastering CDs for Newbees... Several tips on finishing off your CD, song order, 
keys, levels, tempo and setting the right mood. Adding the final touch to your CD. 
 
VS MasteringKarl…A VS-Planet post on mastering by Karl Lakestone. 
 
VS MST & BURN…Mastering and burning master disc in more detail. Protecting your 
master CDs with “Digital Copy Protect.”Also, how to master 24bit, 96k projects in the 
VS. 
 
VS MST DAO… Mastering the MTP, 44.1k 24bit Master Tracks using DAO (Disc At 
Once) by Importing them into a new project and adding track markers. 
 
VS MST Fade AutoMx…VSP setting up a master fade-out using Auto-Mix. How to use 
auto-mix to set a track or tracks volume and/or pan levels, EQ,Mute, Aux Sends, record 
movements, etc... 
 
VS MST TRKS Normalized…How to Normalize master tracks or any track. 
 
VS MTK USE…Different VSP Members give pointers on how to use the 
MTKs/Mastering Tool Kits in the VS8F-2 cards and 3cards. 
 
VS Pitch Correction... How to use the AUTO-TUNE plug-in to correct pitch and how to 
use the VS2480’s EFFECT P022 Vocal Multi to correct vocals and guitars. 
 
VS PRE POST Mix…How to use the PRE and POST fader settings when reading the 
meters durning recording and especially mixing. Also how to use the ATT knob to 
control some recorded levels. 
 
VS Preamp Test…How to test your VS’s preamps to see if they need the “FIX” to get 
rid of harmonic distortion. 
 
VS REC & MIX TRKs…How to use EQ, Compression and mix your tracks better. How 
to use the PRE and POST settings right. 
 
VS RegionArrange…How to use Region Arrange by VSP member Karl Lakestone. 
 
VS RPC1 PC Setup…More on how to setup the VS & RPC-1 card from Brett’s site. 
 
VS ScanDsk & DATA Recvy…VSP post on how to setup the PC to scan a VS hard 
drive for problems, I have never done this, do at your own risk. Also, Brett’s info on VS 
Data Recovery. 
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VS SOLO Trk with EFX… Explains 3 different ways to SOLO a TRACK with looped 
EFFECTS like reverb so you can set levels of the effects and mix the track alone. 
 
VS Split prjt COMBINE…Project Split & Combine by Karl Lakestone on VSP. 
 
VS SUB MIXESbounceLoop…How to bounce tracks with effects, bounce multiple 
tracks with or without effects and how to create SUB MIXES for drum tracks or backup 
vocals. Bouncing Effects with tracks and bouncing using the Mastering Room How to 
initialize and clear EZ Routing settings. 
 
VS Time Delay DBL Trk…Time delay and how we perceive what we hear from VSP. 
 
VS Updating & Upgrading…How to update the VS2480HD, CD & DVD model VSs 
properly, info from Roland’s site and post on VSPlanet. Checking the OS, updating from 
1.XXX via MIDI. Also, info on converting VS2480CD to DVD, force initialze/format 
button sequence and diagnostics check sequence. Performing a drive check and fixing 
corrupt data problems & turning off the IDE: Drive. VS2480 specs, hard drive and fan 
specs. How to replace CD and HD in a VS2400 and HD & CD model numbers. Link to a 
PDF on how to run the Roland VS2480 TEST MODE. 
 
VS Vocoder Effect… How to setup the vocoder effect in the VS8F-2 card properly. 
 
VS VS8F3 InsFmt&Plgn…How to install a VS8F-3 card and plug-ins and use plug-ins, 
formatting for installing.  
 
VS V-TrkOptiUndoPnchRgnEtc…Covers V-Tracks and V-Track maps, Optimizing 
projects, using UNDO and Auto-punch recording. Also Region Copy and some editing. 
LOCATORS and SCENES. 
 
VS WAVE DISP Incr…How to use the Wave Form and the Wave Display to edit the 
wave form and the jog wheel to move in small increments. 
 
XP PC SETUP AUDIO… Shows you some of the tweaks for XP to setup a PC for use 
with Audio programs so less CPU power is used and the aps run faster. 
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THE GOAL WITH THE VS2480 IS THIS:                                         by Frank Griffith 
1) Start by LEARNING how to record songs with the VS. I record one song per project 
to keep things simple. 
2) Once you have learned how the RECORDING stage works with one song, move on 
to the next, and the next till you have enough songs for a CD to present to listeners. 
3) Next is the MIXING stage, adding EQ, Dynamics, effects and panning. Once you 
have the songs mixed and ready for CD move on to the next item. 
4) Learn how to MASTER your songs in the MASTERING ROOM using the MTKs, 
(mastering tool kits) to have them ready for burning to CD. 
5) Now open each project with a completed song and learn the BURNING stage of the 
process, burning one song/project at a time to CD using the TAO (Track At Once) 
method or you can import the master tracks into a new project for burning DAO 
Now let’s begin. 
*First off, you need powered monitors or monitors you run thru an external power amp! I 
use Dynaudio BM5A monitors, Roland makes digital monitors for this unit, the DS50As 
and DS90As.  
To power up the VS, find the toggle switch on the right hand, back side of the unit. It 
takes a couple minutes to run thru the “Load Project” progress bar so be patient. Never 
power down the unit by just flipping the toggle switch off! Use the proper shutdown 
sequence discussed near the end of this document. 
 
NEW PROJECT: (Create a “Practice” song/project) by Frank Griffith                                                        
Click on PROJECT> select New> then in the PROJECT NEW Window Enter a name in 
the Name field for the project with your PS/2 keyboard, then you can click on the music 
note Icon and select one of six Icons to make it easier to identify your project., then if 
MTP and 44.1 is what you want just click on “OK” and YES to save these settings. Also, 
if you want to copy Utility settings or Mixer Parameters from the current project to this 
new one then check mark those as well, if this is your first project then don’t bother with 
it.  You can also left click and drag up and down on the music staff ICON to select from 
6 different project icons. *If you plan on presenting your music to listeners on Audio CDs 
then it is smarter to record at 44.1k in the first place rather than at a higher sample rate 
like 48k and convert it back to 44.1k on CD. Converting sample rates will result in a loss 
of audio quality. (VS manual pg 96.) 
 
SETUP AUDIO 
Once your new project is open and on the HOME page click on EZ-Routing> Routing 
View> for that screen to open. This screen is sectioned off into 4 quadrants. In the upper 
right hand quad you’ll see the OUTPUT ASSIGN. Let’s setup the headphones, master 
and monitors so they all work independently. *If you have already been messing around 
with this screen INITIALIZE the routings by clicking on [F1(IniPB)] and [F3(IniTra)] to 
set all the virtual cables to their default settings so later when we are routing tracks and 
inputs it’s less confusing.. 
 
If you have digital monitors then find the white lettered COAXOPT/LR/LR black virtual 
cables with tiny black squares on the ends. They come linked in pairs on the top right of 
this quad. With your mouse grab (L-Clk & Hold) the tiny squares and drag the black lines 
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down to connect them to the MON white lines. They will turn blue when selected. If you 
have regular analog monitors the black lines from MON/7&8/L&R should be connected 
to the MON white lines as default and the MST/LR/1&2 black to MST white lines as 
default. *Some of this maybe set by default but it’s good to know. 
 
Now find the white lettered PHONE/1&2/LR/LR black squares and click and drag those 
up to the MST white lines to connect them. Now all of your audio can be controlled 
independently with the 3 knobs and RED Master Fader on top of the VS unit. The White 
one with RED top is for the Monitors, the White ones with the blue tops are for the 
Headphones 1 & 2. You will find these to the left of the 3“x 5” VS LCD screen. Now 
click on HOME in the top upper right of the screen.  
 
INPUT & TRACK FADERS SETUP     CH-EDIT=Channel edit 
Let’s find these very important buttons. They are the 4 buttons above the MASTER fader 
in a white background labeled FADER. Press the one labeled IN1-16/SOLO, it will turn 
yellow. Let’s set all the faders to 0db. To the right of the RED/MASTER fader is a button 
labeled CLEAR, Press and hold down CLEAR while running a finger across all of the 
CH-EDIT buttons for each FADER  [There are 2 buttons above each FADER, one is the 
TRACK STATUS button and the one above that is the CH-EDIT button]. This will cause 
all of the FADERs to jump up to UNITY/0db GAIN. Now your inputs are ready and the 
input levels can be controlled by using the TRIM/SEN knobs and the blue PAD buttons. 
 
Now Press the FADER button labeled IN17-24/AUX MST. The FADERs change to 
INPUTS & AUX Busses. Let’s set these to 0db. Now press & hold CLEAR and run your 
fingers across the CH-EDIT buttons for these faders, 17-24. They should jump to 
UNITY/0db GAIN. Notice, your AUX Busses Faders are already up for routing. *As I 
said before, some of this is set by default. 
 
Now press the FADER button labeled TR17-24/FX RTN. The Faders change again. 
These Faders should all be at 0db UNITY GAIN as default, if not bring these up too. This 
sets up the effects returns with the aux busses so routing LOOP EFFECTS later is easy. 
Sometimes people move this and that and press this and that before they know what 
they’re doing so we’re just making sure things are set right.  Note: Bring all INPUT 
FADERS down before mixing after all recording is done! Also, Yellow Fader buttons for 
INPUTS and GREEN for TRACKS. 
 
Now press the FADER button labeled TR1-16/Master Edit. Now we’re back to your track 
Faders. Press and hold the CLEAR button and run your finger across the CH-EDIT 
buttons again. Now all tracks are up and ready. Set Master RED Fader at the 0db mark.  
 
INPUT LEVELS 
To check an INPUT and get a level lets plug a mic, guitar, bass or keys in to the INPUT # 
1 on top of the unit. It’s the first of the 16 TRS in jacks. Now with your mouse click on 
the virtual buttons at the bottom of the screen marked [F1 INPUT]. This will change the 
METERS to read the INPUT levels. As you do this, watch the meters in the middle of the 
HOME screen change. Make sure the meters are on PRE for now. Now play something 
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or sing something and slowly turn up the TRIM/SENS knob until you get a good level. 
You can also use the [F1 INPUT] and [F2 IN MIX] on PRE to set levels. [F2 IN MIX] on 
POST is what’s being recorded. *Be sure no Comp, EQs or Efx are on in the CH-Edit 
pages of the INPUTs when recording unless you intend to record these changes. 
 
 If the signal is too Hi turn the SEN down and press the blue PAD button above it and 
raise the SENS knob and set the level again. I shoot for -12db to -4db to leave 
HEADROOM for Dynamics & EQing later on. Try to get the best level you can with the 
PAD OFF. NOT 0db! In analog gear you want 0db but with the VS you need -12db with 
peaks around -4db. 0db and over can cause distortion and leaves no room for mixing. 
 
RECORD LEVELS 
Now click on the [F3 TR MIX] button at the bottom of the HOME page. The METERS 
change to read the TRACK levels. Press the TRAK STATUS buttons for each track until 
they are all GREEN for PLAY. Now press TRACK1’s TRACK STATUS button until it 
is flashing RED for record, or hold down the RECORD button and press the tracks 
STATUS button to arm it. Play the instrument you have plugged into input 1.*Note: You 
can also hold STOP and press the track status button to put it back to GREEN/Play mode.  
 
The TRACK METERS, on POST, should read the same as the INPUT METERs did. 
You can click back and forth between [F2 IN MIX] & [F3 TR MIX] to check it. Once the 
level is set you can press the big RED, with white dot, Record button to arm it and when 
you’re ready to record Track 1 press PLAY. Record some and press STOP and then 
ZERO. Note: Track Status button, RED=Recording, Flashing RED=Armed, Not lit=OFF 
and GREEN=Ready to play. CH-Edit Button GREEN=Displays CH-Edit page, not lit= 
back to Home screen. 
 
CHECK TRACK 
Now press TRACK1’s STATUS button till it turns GREEN for PLAY and press PLAY. 
You should hear your track playing back what you just recorded. If you don’t like what 
you recorded or it’s a test take you want to get rid of, press UNDO> in the window that 
opens it shows your recording and time, press ENTER and it erases it from the list. Now 
you’re ready to try again or try something else.  
 
Once you have recorded a good keeper track, move on to repeating this process to record 
the rest of your tracks in this song/project. Note: To check to make sure you have no 
distortion on the recorded track you can click on the PRE setting and PLAY the track/s 
and see if the level coming into the fader is in the -12db to -4db range, the TRACK Fader 
will not affect this reading. If you have too hot of a recorded signal then start over and 
record the track watching the INPUT meters to be sure you have a proper level.. *See 
“VS LEVELsRecMSTclkTrkdoc” for more on this subject. 
 
V-TRACKS 
The VS2480 has 24 tracks and each TRACK has 16 V-TRACKS. The number [ 1] next 
to each track number in the HOME screen represents the first V-Track for that track. L-
Click on that [ 1 ] and it opens up the V-track MAP for that track. Larger black dots 
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indicate data that’s been recorded to a V-Track, a dash is an empty V-Track. Click again 
to close the map. Also, the large BLACK arrow at the far right end of the ruler on the 
track window opens up full V-track MAP of all 24 tracks. Click on a V-track’s square 
(colored ones have data) to change V-Tracks, a small window opens and shuts. To open a 
TRACK’s CH-Edit page double click on the track number. Where the mouse rest on the 
CH-Edit page you’ll see V.TRACK, you can also open up the V-Track Map there.   
 
TRACK NAME 
To name your tracks click on TRACK> TRACK NAME> a window opens and the first 
track is highlighed, click on [F1 NAME] and in the next window type out the name of 
your track or click on the letters in the alphabet list below to spell it out one letter at a 
time.. Click [F5 OK] now you can high light another tracks to name or click [F6 EXIT]. 
You can name mastered tracks this way as well. 
 
RECORDING A GUITAR W/ Hi-Z INPUT 
Usually you plug guitars into the Hi-Z Input # 16 and turn it on by pressing in the blue 
pad-like button next to it. If you want to do this then the INPUT is number 16 and to send 
the guitar to TRACK 1, click EZ-Routing and select Routing View, when the View opens 
look in the lower left QUAD and find INPUT MIXER with 1----24 in white numbers and 
the RECORDING TRACK numbers 1----24.  
 
Find INPUT 16 in the INPUT MIXER and click on it with your mouse, it turns blue, now 
click and drag on the number 16 in the INPUT MIXER block and drag the blue line the 
number 1 on the RECORDING TRACK block leaving a blue square around 
RECORDING TRACK 1. Now INPUT 16 is connected to TRACK 1’s Recording Track 
to record it on Track 1. Now click HOME. Return to the section above, “Recording 
Levels” to record the guitar if need be. Record a bit of guitar for this next section. (Or  
bass.) 
If you use Auto punch to punch in and out, to hear audio before and after A-Punch edit 
points, go to UTILITY> Play/Rec Parameter> under “Record Monitor” on page [F1 
Param1] place a check mark by “Source” or “Auto”, which ever one is not checked, to 
hear the audio. 
*Another way to route the INPUT to the TRACK would be to HOLD down track 1’s 
TRACK STATUS button , a window opens, keep holding the status button down and 
now press the CH-Select button above Fader #16 to patch it to INPUT 16. 
*If you have a stereo signal ie piano, keyboard synths, you need to link the INPUTS and 
the TRACKS to keep the signal stereo. Left is the odd number and right is the even. You 
will find “CH.LINK” on the left-hand side of the CH-Edit pages of inputs and tracks. 
 
LOOP EFFECTS or Send & Return Effects/ Patching an effect 
Let’s add a Reverb to the recorded TRACK 1. Click on EFFECT> EFFECT1> the 
EFFECT1 window opens, click [F1 PATCH] Find [P001 :Reverb2 ] click on it to 
highlight it and click on [F5 SELECT]. Now Effect1 is PATCHED with REVERB P002. 
Click [F6 EXIT] twice to back out of the EFFECT window. Since all of the AUX Faders 
and FX RTN Faders have been brought up to UNITY/0db we can skip that step. Looped 
reverb fills out the sound of tracks, IMO. [See “VS EFFECTS.doc” for more on this.] 
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Now, play the recorded guitar track 1 so we can hear it and press the CH-EDIT button for 
TRACK 1. The page changes to Dynamics/Compression and EQ Parameters with graphs. 
At the bottom of this screen in the “AUX SEND” area turn up the AUX1 knob until you 
hear the reverb. About -15db on the AUX1 knob and above will add REVERB you can 
hear. It should already be ON/yellow and PST/blue. Each TRACK and INPUT has a CH-
EDIT button and page and each CH-EDIT page has AUX1 thru AUX8 for your 
EFFECTS1 thru EFFECTS8.  
 
If you had PATCHED in your REVERB P002 on EFFECT3 then we would be turning up 
the AUX3 knob to add reverb to the TRACKS or INPUTS. With the REVERB 
LOOPED, you can add as much of this reverb to each track 1-24 that you want by 
pressing its CH-EDIT button of the TRACK and turning up the AUX knobs and you can 
do the same with INPUTS but you have to connect the FX RTN from the effect to the 
destination track in EZ-Routing. *In theory, you are NOT adding the reverb to the 
tracks or inputs, you are routing their signal thru the master bus where the reverb 
is applied thru FX RTNS & AUXS. Do not press HOME yet, stay here. 
 
INSERT EFFECTS 
INSERT EFFECTS are different. Instead of the AUX knobs you click on FX1 thru FX8 
under the EFFECT INSERT to the left of the AUXs. You can only INSERT an EFFECT 
to ONE track at a time on the first position or 2 using the Left & Right positions of the 
FX1 thru 8 buttons. [See the “VS INSERT FX.doc” for more on this.] You do not turn up 
the AUX knobs, just click on FX1 to INSERT the EFFECT to this Track1. Each Track 
has this on its CH-EDIT page too. 
 
ADDING EFFECTS TO INPUTS 
You can Press Fader button IN 1-16 then the INPUTs CH-Edit button or Under MIXER 
at the top of the screen. Click on MIXER> “CH VIEW <INPUT>” and select “IN 16” to 
bring up the CH-EDIT screen for INPUT 16, that’s your HI-Z INPUT 16. Now you can 
INSERT or LOOP to INPUT 16 and INPUTs 1 thru 24 depending on which you want. 
This is how you can get to the CH-EDIT screen for all of the INPUTs 1 thru 24.  
 
Once you loop the effect, go to EZ-Routing> Routing View> and in the bottom left hand 
quad find the FX RTN 1 thru 8 block and connect the FX RTN number that corresponds 
to your Effect number and connect it to the destination TRACK on the Recording Track 
block that your INPUT is routed to. This completes the LOOP. You only connect the FX 
RTN virtual cables to the INPUTS or to a destination TRACK when bouncing with 
EFFECTS. You do not connect the FX RTN cables to TRACKS that are already recorded 
or being recorded. Now you click HOME.  
 
*VS8F-2 cards fill up 2 Effects under EFFECT. Effect1 thru 8 equals four of the VS8F-2 
Cards 1 thru 4, or Slots “A” thru “D” inside the unit under a back panel. EFFECT1 thru 8 
equals AUX1 thru 8 and FX RTN1 thru 8. Some EFFECTS use up the whole card but 
most are mono. You can select them as left & right and split up the effects into a total of 
16 effects.  
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TO EDIT EFFECTS 
Click EFFECT at the top of the screen, the select the EFFECT1 thru 8, in out case 
EFFECT1, here is where you can click on “EDIT” in the EFFECT window. Usually there 
are several boxed areas for effects in a chain but not on all. You can turn them on and off 
by clicking the small square in the box next to OFF. To get to the parameters just click, or 
double click on the name of the box in the chain and the parameter knobs will show up 
for that box in the chain. Click EXIT as few times to get out of the EFFECTs area. 
 
After adding Dynamics/Compression, EQ and EFFECTs to your tracks the PRE levels 
may rise above 0db. While playing back your tracks in the mix, set the METERS to PRE 
instead of POST. If any are pegging, slamming 0db, go to the CH-EDIT screen for that 
track and turn the ATT knob counter-clockwise into the MINUS area to bring the PRE 
METTERS Level down to and below 0db or readjust the Dynamics and/or EQ. The 
METERs are in Pairs of odd and even on the CH-Edit pages. Do this for each track that is 
OVER 0db on the PRE Meter/Fader setting.  
 
Once they are all below 0db then set the METER/Faders to POST and re-mix your song 
to record to Master Tracks. Note: Bring all INPUT FADERS  & SENS down and turn off 
the PADs to prevent adding noise to your mix before Mastering! Also, be sure you have 
all of your tracks recorded and the song complete before moving on to the mastering 
room and the mastering stage. You can master one song and burn to CD but most record 
several songs, one per project, then open each project one at a time and burn the mastered 
stereo tracks to disc, one at a time  
 
EDIT EFFECTS REVERB 
Click on EFFECT> EFFECT1, or which ever you want to edit. Let’s say P001:[Reverb 2] 
is patched in. In EFFECT1’s window you will see Reverb 2 and 2 Boxes; one is REV/on, 
the other EQ/on. To turn them on or off just click the tiny half round squares on & off. To 
edit “Rev”, click “Rev” twice and there are the 8 or so parameters you can adjust. Under 
“Type” you have 5 to choose from, Hall 1&2, Room 1&2 & Plate for example. Click 
EXIT and now you can do the same with EQ or click EXIT again to close the screen. 
Note. Again the section on “ADDING EFFECTS TO INPUTS” works for adding 
Dynamics/Compression & EQ too, it’s all on the CH-Edit page. 
 
REMEMBER 
Remember, in the EZ-Routing> Routing View> when we connected INPUT 16 to 
TRACK1, this means you turn up the SENS for 16 to set the track level/meters for 
TRACK1 to record. After tracks are recorded you can set their mix level with their 
faders. You can also add Dynamics/Compression & EQ to each track by pressing their 
CH-EDIT buttons to get to that screen. Just turn the EQ on or Compression and adjust 
away. Keep in mind, less is more. 
 
MIXING RECORDED TRACKS 
I always start with my drums, if they’re stereo loops then it doesn’t take much to get them 
sounding right. I add a little EQ on the top to brighten them up and a little on the bottom 
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to add thump to the kick. Once the drums sound good soloed, then bring in the Bass and 
get it sounding good soloed and then with the drums, then the rhythm guitar soloed and 
then with the rest the drums bass etc and repeat for the rest of the tracks, vocals, leads etc.  
 
To hear looped effects with a track you have to mute all other tracks, a track soled will 
not play the looped effect unless you solo the FX RTN. You can find FX RTNs on the 
MIXER menu> CH VIEW<FX RTN> or all FX RTNs on MIXER> TRACK MIXER/FX 
RTN MIXER>. (See “VS Solo Trks with EFX.doc” for more.) Try to PAN all your 
tracks so that each occupies its own space in the stereo field. Do not overlap tracks, this 
can make the mix muddy. Try to place the instruments left to right as they would be on a 
stage playing live and use reverb to place them front to back. Once you have your tracks 
sounding good, if there’s a track that needs to stand out more, try just turning on the 
Compressor with its default settings. *See “VS EQing Bas&Kic.doc”for more on EQing. 
 
Mix your tracks as hot as you can get them with out turning on the OVER light on the 
TRACK meters. If an OVER light comes on you are adding distortion and that can cause 
you problems.  Be sure to leave the MASTER Red fader at Unity/0db while mixing.  
Also, remember to bring down the INPUT faders on IN1-16 and IN17-24 and turn 
down the SENs and turn off all PADS before mixing so no stray signals or mics that 
may still be hot. get into the mix! 
 
PHRASE NORMALIZE 
If some of your tracks have high peaks and low lows, where there is too much meter 
movement to control them when setting levels for mixing. You can “Normalize” the track 
or tracks and it will act as a sort of limiter to smooth out the levels of the track or tracks. 
To do this click on TRACK> PHRASE NORMALIZE> a small window will open and 
you can place a check mark the track or tracks to NORMALIZE and click [F5 OK] and it 
will begin the process. It’ll take several minutes. I seldom use this feature. When done 
click EXIT, now check your tracks. 
 
ANALYZER 
The ANALYZER is a useful tool for checking out the frequencies of your INPUTS, 
TRACKS, Master bus etc. Click on UTILITY> ANALYZER> and it opens up in the 
HOME screen where the meters were. It uses up on whole processor/effects card to run it 
so you’ll need to decide which card to use. Under “Use Effect Board” select A, B, C or 
D. Under Source, you can click and hold and scroll thru all INPUTs, TRACKs, FX# 
RTNs, Gen/Osc, MST L & R,  Mon L & R, Auxs and Dirs (or use the jog wheel). The 
“Average Times” is speed at which the display is refreshed, 50 is a good number to use. 
Set “Average Type” to NRM for now, EXP is good for drum tracks. Solo a track and play 
it to see the frequencies displayed. (Lower freqs displayed left, higher ones to the right.). 
You don’t have to solo the track but it helps, IMO. I use Source - MST L to show the 
whole mix while mixing. You can set up the VS’s small LCD screen to display the 
ANALYZER giving you an independent display for this feature once setup and still have 
the meters on the HOME screen on the VGA. Click on Home, then select Page 3/3, then 
select [F4 IDAnlr] to show the Analyzer in the small LCD, click [F6 IDHold]. To turn off 
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the Analyzer, select OFF under “Use Effect Board.” *Remember, a processor/ effects 
card is tied up while using the analyzer. 
 
MASTERING TRACKS 
Go to CD-RW/Mastering> Mastering ROOM> now the METERS area becomes the 
Mastering room. Click Mastering Room “ON”/yellow. Click the STATUS button from 
GREEN/PLAY to RED/Record. In the V.TRACK window you should see 23/24-16. 
That’s the track you are recording to. (Click on 23/24-16, If you want to select other V-
Tracks to record too, you have 15 sets of 23/24 V-tracks you can use.) If you have an 
MTK (Mastering Tool Kit) patched into an EFFECT like EFFECT1 then click on FX1 to 
turn it yellow and add that MTK. Click nothing else! Why? See the note at the end of this 
document “CD-R Mode.” 
 
Now press the PLAY button and set you Master Levels to Unity/0db or slightly under. 
(you can also edit your MTK here as well.) Press STOP and cue up your tracks where 
you want the recording to begin. I usually press the LOCATOR button till its lit 
YELLOW then the #1 button to mark/locate this beginning point later. Press RECORD & 
PLAY and MIX your song live. Fade out at the end and press STOP. 
 
Now press the ZERO/Back button, bring up the Master RED Fader to Unity/0db, click on 
the mastering room’s STATUS button to GREEN/PLAY and press the PLAY button to 
hear what you recorded. The tracks should be GRAYED out and music playing. If you do 
not like this recording of your master tracks you can select a different set of V-Tracks to 
record to or press UNDO> ENTER> to erase it. *Note: Once again, master your songs in 
each project, one song per project and then burn the mastered pairs to disc one at a time 
from each songs project. Once you have several projects/songs completed and mastered 
burn them to disc. Before burning songs to CD SHIFT+STORE your project!! 
NOTE: If you need another copy of the project then you have to use Project Copy, 
there is no “Save As” function with the VS as there is with computers. 
 
NOTE* If you don’t have an effect’s processor open for using the MTK because you 
have used all the effects up in your project you can do one of 2 things. Either bounce 
tracks that are using up one of the effects cards to other tracks recording the effects with 
the tracks to new tracks OR you can master the project in the mastering room WITHOUT 
an MTK so all effects are recorded with the project to a stereo pair and then master the 
stereo pair in the mastering room using an effects MTK. 
 
BURN TO CD (Save project first!) 
To burn these to CD, be at this stage in the Mastering Room, Mastering Room ON and 
STATUS Play. Click CD-RW Mastering> select CD-WRITE, store current? Click 
“YES” and the INSERT a blank CD-RW or CD-R. The CD-R WRITE window will open. 
Make sure your V-Tracks 23/24-16 are shown in the L-Ch & R-Ch windows, (Just 
because you have them set right in the Mastering Room does not mean they will be the 
same here.)  
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Select “FINALIZE” to “OFF”, “WRITE METHOD” to (TAO)Track at Once, “SPEED” 
to MAX and click “OK” to burn. NOTE! If you do not have other Master Tracks in other 
projects to add to this CD then click “FINALIZE” to “ON”. If you do have more leave it 
“OFF” until the last song’s Master Tracks are ready to burn. This will close the CD so 
you can play it in a CD Player. If you forget to turn “FINALIZE” “ON” on the last song’s 
Master Tracks to the CD, then stick it back in and select “FINALIZE” to “OnlyFin.” for 
finalizing ONLY. Now it’s ready for playing and copying with PCs. Click “OK” then 
“YES”, “ENTER” and “YES” to burn 16bit, 44.1k in .cda format. 
*You can master and burn only one song to disc using this method, just select “Finalize” 
to “ON” and it will place the track marker for the song and close/finalize the CD. To 
protect the CD, go to UTILITY> Project Parameter> and set “Digital Copy Protect” ON. 
 
BACKUPS 
To backup songs click on Project> Project List> check mark the projects to backup, click 
to page ¾ and select “F1 BACKUP”& insert a CD-RW. In that window select Verify to 
“ON” and SPEED to MAX and click “OK”. To  RECOVER go to Project> Project List> 
and in that window scroll down to [SCSI—CR-RW--] click it and select LIST in the 
window that pops up, check mark projects to recover, on ¾ page and click on “F2 
RECOVER” and in that window click “OK”.  This will save all of the effects settings, 
undo history, track parameters, locators etc along with your audio to disk. 
 
BOUNCING TRACKS W/ EFFECTS                                                  
Let’s say we have a vocal on TRACK 5 that we want to bounce to TRACK 10 and use 
EFFECT1 to add and effect to the vocal. Let’s also say, we want to use P001:[Reverb 2] 
on that vocal. First off, click on EFFECT at the top of the screen and select EFFECT1. 
When the EFFECT1 window opens click “F1 PATCH”, now using the scroll arrows to 
the right of the patch list scroll down to P002 and click on it to highlight it, now click “F5 
SELECT” to select it, it will be listed under “Current” and click “F6 EXIT” twice to back 
out of the windows. *See VS manual for list of which are Insert vs. Looped effects. 
 
Now let’s click on EZ Routing> then Routing View> and in the lower left hand quad find 
TRACK MIXER underlined green, tracks 1 thru 24. L-Click and hold the track number 5 
and drag the blue line up to RECORDING TRACK number 10 and let go. You have now 
selected TRACK 5 to bounce to TRACK 10 without a Reverb EFFECT!  
 
Now let’s complete the LOOP of the Reverb on EFFECT 1 to the vocal by finding the 
FX RTN underlined in green, and click on the EFFECT/FX RTN number 1 and dragging 
its blue line over to the RECORDING TRACK number 10. Now you should see a black 
or blue “Virtual cable” from TRACK MIXER number 5 to RECORDING TRACK 
number 10 and a blue one from FX RTN 1 to RECORDING TRACK number 10. This 
will add the effect. Since we have all AUX & FX RTN Faders set to 0db, we don’t have 
to do that step. Click HOME. 
 
RECORD THE BOUNCE 
Press the TRACK STATUS button on TRACK 10 till its flashing red, cue up the vocal 
track to the verse to bounce with the reverb effect, and press RECORD and Play when 
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ready. After the vocal part records press STOP and cue the Recorded vocal track up and 
press the TRACK STATUS button of TRACK#10 till it’s green for PLAY and press 
PLAY to hear it. You can MUTE the other tracks to be sure and compare TRACK 5 with 
TRACK 10 to be sure. 
 
You can pretty much bounce any track to any track with effects added that you want. If 
you want to bounce TRACKs 5, 7 & 9 to TRACK 10 then in EZ ROUTING grab the 
TRACK MIXER number 7 and drag it up to the RECORDING TRACK number 10 and 
repeat for TACK MIXER number 9. It’s that easy. To bounce with an INSERT EFFECT, 
you would just go to TRACK#5’s CH-EDIT page and click on the FX1 thru 8 button that 
matches the EFFECT processor number you have the insert effect patched into. No EZ-
Routing for INSERT EFFECTS. *See “VS SUB MIXES.doc” for more. Also, to clear all 
the track routings to hard disk recorder tracks in the EZ Routing View click [F4(ClrTra)] 
at the bottom of the window. 
 
BOUNCE WITOUT EFFECT 
Do all the above but forget about patching an effect and grabbing the FX RTN cable. In 
other words, don’t add the effect. You can do SUB MIXES (See VS SUB MIXES) as 
well where you add more than one track to the destination track. Say you want to bounce 
all 6 drum tracks to a PAIR, or all background vocal tracks to a pair of tracks that’s how 
you would do it. Bouncing to a pair of tracks requires you to go to the CH-Edit page of 
the ODD numbered tracks and linking it with it’s even numbered track by clicking on the 
CH LINK button down below the ATT knob on the left hand side of the screen. 
 
EZ ROUTING TOOLS 
To INITIALIZE, or reset all input-to-input channel routings click on [F1(IniPB)] at the 
bottom of the screen. To CLEAR all input-to-input channel routings click on “F2(ClrPB). 
 
To INITIALIZE all routings to the hard disk recorder tracks click on [F3(IniTra)] and to 
CLEAR all routings to the hard disk recorder tracks click on [F4(ClrTra)]. 
 
SHUT-DOWN PROCEDURE 
To shutdown the VS2480, Click on PROJECT> select the last item on the list “SHUT 
DOWN/EJECT> A small “SHUTDOWN!” window opens, click YES then it ask if you 
want to STORE the project, I would select YES, then is goes thru the save procedure and 
puts up a small window with “POWER OFF/ RESTART” then you can flip the power’s 
toggle switch  to OFF. 
 
Note: “CD-R Mode”  
I master using the non-CD-R Mode in the mastering room. Why? Because the master 
tracks stay in 24bit and can be played back within the project they are mastered in. I also 
like to send my mastered pair of tracks thru my R-Bus outs to an RPC-1 card inside a PC 
for mastering them there with Wave Lab and/or T-Racks, PC version.  
 
If you use CD-R Mode  in an MTP 44.1k project then you have to import the mastered 
pairs into a new Empty CDR project for mastering just to listen to them. Then line up all 
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of the mastered pairs from all of the projects, one after another on their tracks, add CD-R 
markers and burn DAO(Disc At Once) to CD-R. I use TAO(Track At Once) and keep 
them at 24bit within the project so I can hear them, review them etc. Then I burn them 
TAO to CD-R from each project one mastered pair at a time. If you want to use the CD-R 
Mode that’s fine, I have a “VS MST DAO” doc that explains the process step by step. 
You can also use it to do the same with non-CD-R Mode mastered pairs, import them to 
an empty MTP project and import the tracks into it using the steps given in the “VS MST 
DAO” doc. That’s up to you. Also Mastering TAO had caused problems with Duplicators 
in the past,  but recently the newer duplicating gear claims it can work with both TAO & 
DAO. 
 
Important to remember: These documents are written to be used with your VS on and 
connected to a PS/2 mouse, PS/2 keyboard and VGA [external] PC Monitor. When using 
any of the VS info docs keep in mind, most of the things you do within a project can be 
un-done. You can practice anything you want with recording, bouncing, editing, adding 
effects, routings etc. anything with mixer settings and if you don’t want to keep the 
practice settings, just shutdown the VS and answer “NO” to saving the current project 
and it will revert back to the original state it was in when you first opened it. Also, most 
actions you take can be un-done by pressing UNDO> a small window opens with a list of 
actions, your last action will be at the top already highlighted so press the ENTER> 
button and it performs an UNDO on that action. So practice, practice & practice some 
more without worry! 
 
NEVER… 
OPTIMIZE> UNDO> and SAVE in a row. Your track data will disappear! If you do 
Optimize and UNDO go to Project> List> and reload the project! Also, Never, shutdown 
the VS power without going thru the proper shutdown procedure, you could cause the VS 
to lock up on next power up! Shutdown= Project> Shutdown/Eject> YES & YES. 
 
ALWAYS… 
Have a UPS (Battery Backup device) between the VS and wall socket to run you VS and 
condition the power. If the power ever goes off when your VS is up and running, you can 
loose your data or worse, cause the VS to lock up on power up! 
  
CONCLUSION 
The most helpful word docs for Newbies are: Easy VS Info, VSCpyMveExchExprt, VS 
EFFECTS, VS INSERT EFX, VS LEVELsRecMSTclkTrk, VS Mastering CDs for 
Newbies, VS MST & BURN, VS SUB MIXESbounceLoop & VS V-
TrkOptUndoAPnchRgnCpyEtc. 
 
If you go thru the “Easy VS Info.doc” instructions several times you should get the hang 
of using the VS2480 and actually get some good recording done. For more on recording 
go to www.studiobuddy.com and download their Studio Buddy program full of free info 
on how to record and with what etc. Seriously, it’s good info, it’s just that they have a 
stupid puppy dog logo, ignore the dog. Don’t let it influence your opinion of the 
information given. Also, if you have questions about this info email me at 

http://www.studiobuddy.com/
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Fcgjabq@aol.com and if you need even more help with the VS2480 call Roland’s Tech 
Support at 1-323-890-3741 on week days and for help all the time, go to VS-Planet.com. 
Now get some good music recorded and on CDs.  
Good Luck, Frank. 
 
LINKS TO VS PLANCTON & Videos on Youtube                                                                     
Here's the Youtube videos, parts 1 thru 12. 
I've been watching them today and this guy uses mainly the machine and it's buttons, not much 
VGA & Mouse. I found it confusing just to try and keep up with him and I'm no newbie. 
http://www.youtube.com/watch?v=dyHolMawEqk&playnext=1&list=PL8FCCE59C30CADE1E 
  
Here's the VS Plancton Videos that are on the Plancton DVDs done on a VS2400CD. 
http://www.youtube.com/watch?v=PXs9jz72SuI 
  
To buy the VS Plancton DVDs in English. 
http://www.plancton.de/english1.html 
 
Link to a post on VSP comparing the audio quality of the VS to Pro Tools. 
http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Board=16&Number=922073
&Searchpage=1&Main=89576&Words=Jerry+Tubbs&topic=0&Search=true#Post922073 
 

mailto:Fcgjabq@aol.com
http://www.youtube.com/watch?v=dyHolMawEqk&playnext=1&list=PL8FCCE59C30CADE1E
http://www.youtube.com/watch?v=PXs9jz72SuI
http://www.plancton.de/english1.html
http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Board=16&Number=922073&Searchpage=1&Main=89576&Words=Jerry+Tubbs&topic=0&Search=true#Post922073
http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Board=16&Number=922073&Searchpage=1&Main=89576&Words=Jerry+Tubbs&topic=0&Search=true#Post922073


 1 

To use Acid, 
 Click on the (if you have my “ProgsPlugs” CD if not skip to Acid Pro) 
“ProgsPlugs”folder> acid pro> then Acid Pro file with ".exe" as an ending file 
name is the execute file for installing the program. Click on it and follow the 
recommended instructions to install Acid. Acid is a pretty simple program to use. 
When you install it, sooner or later it will ask you for a key. Acid Pro 4.0 
keygenerator.exe is what you click on then and copy and paste the number in the 
SERIAL window into Acid's window. If that doesn't work, try it again by clicking on 
GENERATE to generate a new key to use. You can make up a number for the 
computer ID window too, if need be.  
  
ACID PRO 
Now insert a Loop CD. Once Acid is installed you click on the Desktop Icon to 
open it. Don't fill out the name form and comments, just click OK.  Once it is 
open, find the EXPLORER window, bottom left. Next to it, right bottom, is the File 
Audition window. In then EXPLORER window click on My Computer> then the D: 
Drive the Loop CD is in and then click on one of the loop folders. Audio Wave 
files should appear in the Audition window. This window has a play and stop 
button you can use. Click on a file and use the play and stop buttons to listen to 
different loops. Once you find a loop you want to use Double Click on it and it will 
appear as a track in Acid's Track window above the Audition window. Find 
several loops to use for a test run and double click on them too. 
  
USING LOOPS 
Now with the mouse cursor, it will be a pencil instead of an arrow, left click and 
hold, on track one on, a grid line and draw, left to right, a LOOP out. Small 
indentions will appear on the top and bottom of the loop as it repeats. you can 
make them as long as you want. Any loop can be 1/4, 1/2 3/4 or full loops. It's up 
to you to decide how much of each loop to use and how many times to use it. 
Draw out a couple of repeats on track 1. Then on track 2, draw another one out 
where the last one ended and so on with the next track's loop and the next 
track's loop. Now at the bottom of this track window on the left are the play, stop, 
back, etc buttons. Play your drum loops you drew out to get an idea of how this 
works and sounds. Click stop. 
  
Now let's check out the grid spacing and snap to options. Click on OPTIONS> at 
the top of the program window, then Snapping> and make sure it's Enabled. 
Indented is ENABLE. This snaps the loops to lines on the grid. 
Now OPTIONS> GRID SPACING> and select "16th or 32nd  Note" for now. 
  
Now let's find the zoom buttons for the tracks window. On the Horizontal and 
Vertical scroll bars there are little + and - signs. On the Horizontal one click the + 
plus sign about 5 times quickly each click. This spreads out the loops so you can 
see if they are lined up on the grid lines evenly so the beat is steady from loop to 
loop and track to track. If any are off, left click and hold in the middle of a loop 
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and drag the loop left or right until they SNAP to a line. Once all are on the lines, 
one after another they should play seamlessly.  
  
SAVING A PROJECT 
Once you have all the loops from this CD in the project, you have to save them 
before using another loop CD. Click on FILE> SAVE AS...> In the SAVE window 
it should show a folder and 4.0, in FILE NAME enter a name, like "Practice 
Project", in SAVE AS TYPE click the down arrow and select "ACID Project With 
Embedded Media (*.acd-zip)" and click the SAVE button. Now, when you click on 
the Acid desktop window, this most current project will open. Close Acid and put 
another LOOP CD in then Open Acid again and you can add more LOOPs to this 
Project. If you don’t save them as “Embedded” then every time you want to play 
the loops in this project you’ll have to have the loop CD in the drive. 
  
BPM SLIDER 
Notice in Acid you have a BPM slider under the TRACK NAMES area midway 
down the left side. Also, a tuning fork displaying 4/4 time and the BPM of the 
song. The slider handle is what you use to drag it left to slow the song down or 
drag it right to speed it up. If you will notice, as you left click and hold the mouse 
on that handle, up next to the track names there is a divide/center point where 
color lines are on the right or left of this point. This shows how much a loop has 
been slowed down or sped up to match the BPM the slider has selected. Loops 
sped up too fast or slowed down too much can start to sound a bit funny and fast 
ones sound, impossible for a real drummer to play. Be careful with too big of a 
difference in the BPM of the loops you use. They may sound strange. 
  
Volume & Pan 
Each track/loop has its own VOLUME (Vol.) slider knob and normally it is set to -
6db. The more tracks/loops you add the more the total, over all volume is raised, 
so -6db is a good starting point. To PAN tracks/loops left or right, next to the Vol. 
is a drop down arrow, click on it and select PAN, now all Volume knobs are PAN 
sliders.  
  
ENVELOPES/Automation 
Another feature I like to use is the ENVELOPE feature. Click on a TRACK'S 
number to highlight/select that track then click INSERT> at top of window, Select 
ENVELOPE> and there are VOLUME and PAN selections. When you select PAN 
an ORANGE line will appear across the track and it's loops, select VOLUME and 
a BLUE line will appear. To use these have the tracks zoomed out some and on 
the line just double click and that places a square on the line. Add several of 
these on the line and then you can left click and drag them to where you want 
them. For PAN Up is LEFT and DOWN is RIGHT. The line will follow these 
squares as you drag them. Rest on them and a window opens to show in 
percentages how far left and right the PAN line is. With the Volume, UP is UP 
and DOWN is DOWN and it displays this in dbs. These come in handy for 
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panning cymbals and toms in a fill and for raising and lowering the volumes to 
add emphasis to the drums.  
  
SAVING CHANGES  
While you work on drum tracks, once you have saved it as embedded media, as 
you make changes to the tracks you can click the SAVE button to save it just 
incase something happens, your PC freezes, a power outage or whatever.  
  
SAVE AS .WAV & BURN TO CD 
Now let's say you are done with a songs drum tracks and you want to save them 
to disc and load them into the VS. After a song has been saved, I usually click 
the save button again to be sure, Click on FILE> RENDER AS..> in the SAVE IN: 
window, select a folder you can find on your hard drive, I created a "AAudio Wav" 
folder on my C: Drive, so have a folder selected you can get too. In FILE NAME: 
"Practice Project" as an example, in SAVE AS TYPE: select "Wave 
[Microsoft][*.wav]" and click the SAVE button.  
  
XP BURN WIZARD 
Now close Acid and INSERT a blank CD-RW into you PC burner drive, open it as 
a folder in it's own window and after it's open click on START> MY COMPUTER> 
Local Disk:C> and find your audio folder and open it up in it's own window. Find 
you audio file and Right Click on it and select COPY, now in the blank CD-RW 
window R-Click and select PASTE. If you have XP Home or XP Pro a Wizard 
should open, Name the disk to burn the wav file too, and select "Make Copies for 
Some computers and Players" or some thing like that, not the regular "Audio CD 
for CD Players" and follow thru the wizard and it'll burn a DATA copy of this WAV 
FILE to the CD-RW.  
  
IMPORT .WAV INTO VS 
Now in the VS2480 and INSERT the CD-RW with the wav file on it, click on CD-
RW Mastering> select WAV IMPORT> the VS scans the drive and a window 
opens, click on the CD-RW's folder and a smaller window opens, in that window 
select the WAVE FILE "Practice Project" and select the TRACKs or V-Tracks to 
send it too, Click OK and it'll say Done when finished. Click EXIT and eject your 
disk. These instructions are rather general but you'll be able to figure it out. 
That's how it's done. 
  
In Acid on some loop CDs you'll find single shots of kicks snares cymbals etc and 
intros and endings that you can use to create the opening intro to the songs drum 
tracks and their ending crashes. Single Shots are just that, a single hit of a snare, 
kick or crash or ting of a cymbal that can be place one at a time, a track at a time, 
anywhere on the time line of the drum tracks in Acid. Now play around with it 
once you get it and if you have more questions email me at Fcgjabq@aol.com for 
more help. 
 
 

mailto:Fcgjabq@aol.com
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Acid and Bussing 8 tracks of Audio to VS for use with 8 track loops thru an 
RPC-1 card. 
In Acid, Under Options> Preferences> Audio tab and under “Audio Devices 
Type” select “Roland RPC-1 ASIO” from the drop down menu, click APPLY & 
OK. Go to INSERT and on the drop down menu select Bus. This will insert “A” 
bus ½ with a Left & Right channel onto the bottom right hand side of Acid’s 
window next to the Master Bus. Go back to INSERT and select Bus 3 more times 
for Busses “B”, “C” & “D” for a total of 4 Busses. “B” will be 3/4 L&R, “C” 5/6 L&R 
and “D” 7/8 L&R.  
 
Now click on the Double square bus icon on A Bus and select “R-Bus Out ½ 
Roland RPC-1” now Bus B and select “R-Bus Out 3/4…” and Bus C and select 
“R-Bus Out 5/6 RPC-1” and Bus D and select “R-Bus Out 7/8..RPC-1” now you 
have 8 channels out to RPC-1 Card. Now click on the Bus Icon on each track 
and select Roland ½ for tracks 1 & 2, the tracks 3 & 4 select Roland 3/4 and so 
on for a total of 8 tracks. Now PAN track 1 left, track 2 right, track 3 left, track 4 
right, track 5 left, track 6 right, track 7 left and track 8 right. This will send Acids 
tracks 1 thru 8 to the VS thru RPC-1 card via R-Bus to INPUTS 17 thru 24 in the 
VS. You have to bring up the VS 17 – 24 input faders to hear them. If you are not 
using 8 tracks loops then pan all bus pairs left & right. Some loops have 5 
parts/tracks and some have 6 parts/tracks, depending on which Discrete Drums 
series loops you have or Drums On Demand (DOD). This means that with the 5 
and 6 track loops you only need to insert 3 Busses in Acid to send the tracks to 
your VS. 
 
Envelope in Acid  
More on using the ENVELOPE feature. Click on a TRACK'S number to 
highlight/select that track then click INSERT> at top of window, Select 
ENVELOPE> and there are VOLUME and PAN selections. When you select PAN 
an ORANGE  line will appear across the track and it's loops, select VOLUME and 
a BLUE line will appear. To use these have the tracks zoomed out some and on 
the line just double click and that places a square on the line. Add several of 
these on the line and then you can left click and drag them to where you want 
them. For PAN Up is LEFT and DOWN is RIGHT. The line will follow these 
squares as you drag them. Rest on them and a window opens to show in 
percentages how far left and right the PAN line is. With the Volume, UP is UP 
and DOWN is DOWN and it displays this in dbs. These come in handy for 
panning cymbals and toms in a fill and for raising and lowering the volumes to 
add emphasis to the drums.  
 
  
[*acd.] PROJECTS 
You can also save Acid projects as "Acid Project File[*.acd]" but it does not save 
the audio data with it, only the location this data can be found in. If another 
application like Cakewalk Home Studio has this data in a folder then Acid can 
find it and use this Acid project as a TEMPLATE on how to use this file. If you 
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saved loops from a disc this way then the next time you tried to play this Acid 
Project it would ask you for the disk that the loops came off of. That's why I save 
LOOPS as "Acid Project with Embedded Media [*.acd-zip]"so the data stays with 
the Acid Project and i don't have to search for the disk the loops were on. I often 
use loops from many loop disk. 
  
ACID PLUG-IN EFFECTS 
You can also add effects to tracks in Acid. Each track has a funny looking green 
FX Icon with a tiny drop down arrow on it's right side. Left click on this FX Icon 
and an "Audio Plug-In" window opens the Equalizer, EQ. It has 3 more of the 
green FX Icons in the upper right hand corner of this small window, the one on 
the left is the "EDIT CHAIN", rest the mouse pointer on it and you'll see it identify 
itself.  
  
Left click on this one and a larger "Plug-In Chooser" window opens with a list of 
effects in it. Here, you simply click on an effect name to select it, then click the 
"ADD" button and then click "OK." Now it has added the REVERB to the "Track 
EQ" with check marks beside them in a chain. The REVERB is now indented and 
ready for use.  
  
Play your Acid track and now you can select a "Reverberation Mode" from 
the modes drop down menu and see what it sounds like on your track. When you 
find one you like simply click the "X" to close the window or click on the "Track 
EQ" and make adjustments there and then close the window. The EQ is not on 
and working until you make adjustments to it. To delete either one of these plug-
in effects from the chain, have it's window open and left click on the second 
green FX Icon from the left, at the top right of it's window.  
  
Any time you want to come back to a track's FX chain just left click on the FX 
Icon on the track. This is fairly basic instructions for how to use Acid's effects but 
it will get you started. For more, see the Acid manual on in the Acid folder on the 
"ProgsPlugs" All In One disc or click on HELP in Acid and select "Contents and 
Index" from the menu. 
 
 
To Use Wave Lab 
Once Wave Lab is installed you can go to File> Open> Wave > and pull in a .wav 
file from a CD or folder on your PC to work with. 
 Play/Stop/back etc transports are at the top right of the screen, if not click on 
View> Tool Bars> Transport> and it will open. 
  
ADD EFFECTS/Plug-ins 
Under Effects at the right of the screen, click on #1 and the list has DirectX & 
VST there, select one from the pop up menu, or none to clear one. The plug-in 
opens, select some PRESETS till you find a sound you like. The plug-in window 
will open on top of the .wav file. You can move it around by grabbing it’s top blue 
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bar or minimize, fold etc. There will be parameters you can adjust and PRESETS 
where you see “PRESET” or “LOAD” if it has any. You can make your own by 
adjusting the parameters and then clicking EDIT, type in a name for it, click ADD 
and then OK or SAVE. You can add up to 8 plug-in effects that’s why there are 8 
effect’s blocks. To get rid of an effect click to open the list and select NONE. 
  
RENDERING A .WAV FILE 
Bottom right of the screen is a "Render" button, to add an effect or up to 8 effects 
plug-ins processed to a file, click on "Render"........... 
 
Then on the File tab tick "Create new file" and place a Check Mark in the box 
next to "Create Specific File".....Now click on the small yellow folder to the right of 
the little window and explore to an audio file you can find on your PC and select it 
and click OK. 
  
Now you can go to your audio folder like "My Music", if you selected it and saved 
the file there before, and send that file to a CD-RW to burn so you can use WAV 
IMPORT in the VS to place it on a track. See the XP BURN WIZARD in Acid 
above. 
  
Use Track Export in the VS to burn a .wav file of a track to a CD-RW to load into, 
Wave Lab, Acid or Sonar. 
 
Roxio 7 
Basically just click on the desktop icon with the disc in your PC that you want to 
copy music or data to and it’ll take a minute to load then it’ll ask you to agree to 
something, click OK and the main Roxio window opens. For DVDs and CDs, 
data, audio or video, that you want to copy click on “Disc Copier” and a window 
open and you can select Copy if it doesn’t.. In the “Roxio Disc Copier” window 
you have a “Source Drive” section and a “Destination Drive Section” with drop 
down menus that allow you to select the source and destination drives and disc. 
Usually it’ll show you where the blank disc is under the Drives selected. You can 
select write speed and number of copies and then click COPY. It’ll copy a CD in 
a couple of minutes and a DVD in several minutes depending on how much data 
or video is on it. Full DVD of data, appx 20 mins. using one drive, half that with 2 
drives. I like to make copies from one drive because Roxio stores the data on 
your hard drive and checks it for errors before burning it to disc. When burning is 
done click the CLOSE button to eject disc. It’ll show you how many minutes the 
burn took. 
 
To copy audio, video or data off of your hard drive select “Creator Classic”, you’ll 
see the loading wait window then “Creator Classic” window opens. You’ll have a 
“Select Source” window at the top and “Data Disc Project” window at the bottom. 
I click on the numbers next to the disc icon below “Disc Name” and enter a title 
for the disc, then at the top on the left side I use the explorer window to find my 
data clicking on the [+] sign by Local Disk (C:) and when I find the folder or 
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folders I’m looking for I click and drag the folder down to the Data Disc Project 
window’s right hand side and drop the folder under Name, Size etc…… Then I 
click the on the “BURN” icon and another window opens with Destination drive 
only and a Details page on the right of the burn window. If it’s not there, click on 
“Details”. Here you select how you want to burn and it’ll show you how much data 
you are burning and number of disc needed. When ready, click Burn. When the 
burn process is done, click the CLOSE button, that use to be CANCEL, and the 
disc will eject. Roxio ask if you want to save the project, I say NO. and close 
Roxio. 
 
T-Racks24 Brief how to.. 
T-Racks is pretty easy to install and use. There's and Open button to open an 
explorer window to bring in a .wav file. Then regular transport buttons to Play, 
Stop, Back etc.. To get to the presets click on the word Default in a little window, 
you can check out different presets while the file is playing. You also make 
adjustment to the different sections of the rack. When it sounds the way you like 
you click on the Process button and process and save the file. 
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VS & RPC-1 Card Setup                         By Frank Griffith 
Hardware/tab on the RPC-1 card Master Clock = External 
Multi/Track Driver Devices = Single and in sync 
DMA Buffer size = 384 
Tick Disable Control of... and the 
Reset when Idle...   both boxes should be ticked. 
Adjust nothing else in the other tabs.    Save these settings. 
Sample Rate should equal the VS projects sample rate, 24bit/44.1K 
Whatever sample rate & bit rate you need. 
*The dip switch's on the card,  the switch closest to the R-Bus 
connection(the one on the left) should be UP and the one furthest 
away from the R-Bus connection (On the right) should be DOWN. To 
SLAVE the RPC-1 card to the VS flip them the opposite way. 
 
  
VS UTILITY> Project Parameter page F3, 
Set master Clock to INT. 
Dither and Digital Copy Protect to OFF. 
Leave R-Bus Coaxial Sel & R-Bus Optical alone. 
  
UTILITY> SYNC Parameter> 
Make sure Sync Mode is set to INT. 
If you want to sync to MIDI Time code from the VS choose MTC in 
the R-BUS1 SYNC GEN. 
Set your software to MTC as well.  And from where(Midi RPC-1). PC 
& VS will sync. 
 
Now EZ-Routing>Set up RPC-1 Inputs & Outputs on the VS2480, R-
Bus1 Inputs are attached to IN 17-24. 
Under OUTPUT in EZ-Routing. R-Bus1 Outputs are paired in stereo 
Aux outputs 1-8. (You can connect the first 2 to MST if you want to 
send the stereo master bus to PC.) 
 
Press IN 17-24 and press the CH-Edit button of IN 17 and select the 
CH-Link to link IN17 & 18 so they will pan automatically and set their 
faders to 0db 
That's about it. 
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For setting up windows PC audio to be heard in the VS go to Start> 
Control Panel> Sounds & Audio Devices> select the Audio tab and 
use the drop down menus to select the RPC-1 card for playback. 
 
 
 
 
SONAR 4 
In Sonar Options> Audio...> General> I have my RPC-1 selected as 
Playback & Record Timing Master, bit depth 16 or you can use 24 
with VS? 
My buffer @ 4 and the slider set to “Fast.” 
 
Advanced Tab> I/O Buffer at 64, Driver Mode=WDM/KS. Dithering= 
Pow-r3 & Full Chased Clock ticked. 
 
Drivers Tab> 
All Input and Output Drivers are highlighted. 
 
Driver Profiles Tab> Roland RPC-1(10in, 8 out) 
Stream 16bit Data As= 32Bit PCM left-justified. 
 
*Some say you need the Sonar to be Master and the VS to be Slave 
to sync them both or the audio will glitch when recording. 
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> Getting 16bit .wav Files Out of the 2480 
                           While in MTP (24bit) Mode < 

Let's say that you want to get 16bit .WAV (wave) files out of the VS2480 in MTP (24 
bit) mode but you don’t have PC conversion software. And, you don’t want to go to the 
trouble of burning the 24bit files to CD-R and then importing back into M16 mode, and 
then have to burn them all over again at 16bit. 
  
It can be done using Mastering Room. As Mastering Room offers CD-R mode allowing 
conversion from 24bit to16bit. [*See below] 
  
Go to Mastering Room. In the V.Track section, the VS2480 default tracks are 23/24-16, 
being Tracks 23 and 24 (stereo) Virtual Track 16. However, you can choose the other 
V.Tracks by left clicking in the V.Track section.  23/24 V.Tracks 1, 2, 3, 4, 5 up to16. 
  
You can record two or more tracks as 16bit files using the SOLO buttons on any of 
your tracks. 
  
Simply SOLO two or more tracks that you want to convert to 16bit, two or more at a 
time. Then in Mastering Room select the V.Track 23/24 1-16 that you want the 16bit file 
to be recorded to i.e. if you plan to convert all 24 tracks to 16bit SOLO'ed two at a time 
you will need to record 12 times to 12 V.Tracks (23/24 – V.Tracks 1 through 12) as 
Stereo. [*See below] 
  
Set a LOCATOR point so that you can return to that exact point prior to each new 
recording. 
  
SOLO two or more of your recorded tracks (Blue SOLO buttons). 
  
Now just follow the Mastering Room procedure.  Hit the LOCATE point, very important, 
select V.Track 23/24 1-16, then Mastering Room [ON], CD-R Mode [ON] Status [Rec].  
Hit the transport REC (now blinking) and press play. Your SOLO'ed tracks are now 
recording, press stop when finished. Repeat this process again by SOLO’ing new tracks 
and choosing different V.Tracks in the Mastering Room. 
  
Mastering Room in CD-R Mode converts 24bit to16Bit, so now you might have up to 16 
Stereo V.Tracks on Tracks 23/24 (V.Track 1-16) and if CD-R Mode was on each time, all 
your recorded files will be 16bit. 
  
Now just TRACK EXPORT the Tracks to CD-R under CD-RW Mastering. Under CD-
RW Mastering go to TRACK EXPORT then press MAP [F2] under the 23/24 all your 
recorded CD-R Mode .WAV files will be there and they will all be 16bit.  Select them 
and burn to CD-R! That’s it. 
  
*All 16bit .WAV files EXPORTED like this are Stereo not Mono, I know of no way 
around this. 
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- Set a LOCATE Point prior to recording, return to it each time. 
- SOLO two or more tracks to be recorded as 16bit. 
- Use Mastering Room Procedure, CD-R MODE must be ON for 16bit. 
- Two tracks to 23/24 V.Tracks 1-16 Newly SOLO'ed tracks to NEW V-Tracks (don't 
record over the previous ones). 
- EXPORT TRACKS under 23/24 to CD-R they are all 16bit. 
 
From Brett’s Site…   http://www.rolandvs2480.net/ 
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VS BitsSamplesWavs 
PROJECT>>NEW>> 
When you CREATE a NEW project, you select bit rate, sample rate and project mode 
there. If you are in an MTP mode project which is the default, normally it'll have 24bit 
and 44.1k sample rate check marked for the projects sample and bit rate. IF SO... Then 
when you use TRACK EXPORT or PHRASE EXPORT thru the TRACK EXPORT 
window(or PHRASE), the files will be 24bit, 44.1k, .wav format files. 
................................................ 
CD-RW Mastering>>Mastering Room>> 
MASTERING. 
If you use the mastering room and DO NOT use CD-R Mode in the mastering room, then 
your master tracks will stay 24bit 44.1k and EXPORT as 24bit, 44.1k .wav files. 
 
If you use CD-R mode in the mastering room then your masters will be 16bit, 44.1k and 
TRACK EXPORT as 16bit 44.1k .wav files to CD-R... hence the CD-R mode. 
.................................................. 
 
CD-R MODE at 16bit and 44.1k is the standard that the market uses to BURN .cda 
format Music CDs. You buy a CD at the store, Pink Floyd, it most likely will be .cda 
audio format in 16bit, 44.1k. 
...............................................  
CD-RW Mastering>> CD-R WRITE>> 
BURNING Mastered Tracks to CD-R in VS. 
When you use the CD-R WRITE window to BURN your mastered songs in TAO(Track 
At Once) or DAO(Disc At Once) to CD-R making your own music audio CDs, the VS 
BURNS them (not considered exporting) in the standard 16bit, 44.1k .cda audio format. 
............................................... 
PROJECT  MODE. 
If you select CD-R Mode in the PROJECT>>NEW>> window and have CD-R Mode be 
your project mode then when you EXPORT tracks or phrases they will be in 16bit, 44.1k 
sample rate, .wav format files. Your Master Tracks BURN to CD as 16bit, 44.1k, in .cda 
format. 
What ever the project mode, bit rate and sample rate, the tracks will export in the same 
bit rate and sample rate and always be .wav format files. 
........................................................ 
CD-RW Mastering>>WAV IMPORT>> 
When you import .wav files into the VS, the VS will CONVERT them to match the 
project’s mode, bit rate and sample rate. It uses the WAV IMPORT window. Pg269 
You can IMPORT .wav format files that are 16bit and 24bit. 
................................................. 
CD-RW Mastering>> CD CAPRURE>> 
When you want to IMPORT .16bit, 44.1k, .cda format audio tracks off a market CD, you 
have to use the CD CAPTURE window. Thw VS will CONVERT them to match the 
Project Mode, bit rate and sample rate. 
................................................................ 
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*The VS can run projects in different sample rates and bit rates. The second most popular 
project mode is M24, 24bit, 48k sample rate.  
*Any time you use the CD-R WRITE window in the VS, the tracks will be BURNED in 
16bit, 44.1k sample rate, .cda format audio files. 
 
Here’s post where a Pro claims he can’t tell the difference between wav files out of a VS 
MTP project and wav files out of Pro Tools DAW. 
http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Board=16&N
umber=922073&Searchpage=2&Main=89576&Words=Frank+to+Jerry+tubbs&top
ic=0&Search=true#Post922073 
 

http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Board=16&Number=922073&Searchpage=2&Main=89576&Words=Frank+to+Jerry+tubbs&topic=0&Search=true#Post922073
http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Board=16&Number=922073&Searchpage=2&Main=89576&Words=Frank+to+Jerry+tubbs&topic=0&Search=true#Post922073
http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Board=16&Number=922073&Searchpage=2&Main=89576&Words=Frank+to+Jerry+tubbs&topic=0&Search=true#Post922073
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VS BkUPFmtRcvy 
*If you have an OS above 2.009 then it is not necessary to Format/Initialize 
the hard drive in your VS after updating to a higher version! 
 
BACKUPS (Formatting & Recovering Projects)          By Frank Griffith 
It’s best to click on PROJECT> Project List> and add up the mega bites of 
each Project on the list. To the right of each project title are the mega bites 
(MB) size of the project and a date below that. Group them into numbers 
that add up to less than 700MB, closer to 600MBs to be safe. So you can fit 
them on the 700MB CD-R or RWs. Usually 4 or 5 songs per CD-RW or 
CD-R are enough. Once you have done this you know which ones to check 
mark for each backup to the CDs. Insert a blank CD-R or RW. It’s important 
to note here that VS backups will only be able to be recovered on a VS 
machine. Most older model VS machines, 880, 1680 etc. backups can be 
recovered in VS2480s. My point is, VS backups are not an audio format or 
data file that can be used in a PC. DVD models use only DVD-R disc. 
 
Check Mark the first group of PROJECTS to BACKUP to CD. There are 
little empty boxes to the left of each project, click in them with your left 
mouse button to place a check mark. Do this for each one you want to 
backup to the CD. Then select PAGE ¾, bottom left of window, and click on 
“F1 BACKUP”. Click on it. Answer YES to the prompts and another 
window opens. In this window, select MAX Speed, check mark VERIFY  
and click “OK” to burn the Backup disk.  
 
5 songs will take about 20 minutes then it EJECTS the disk. Then you can 
repeat the process for each group of songs to backup to each disk. It’s 
always a good idea to perform a test RECOVER of a project to be sure the 
data is there. You do have to recover at least one project to do this, you can’t 
cancel a RECOVER but you can select another drive using the “F” buttons 
in the Recover window.  
 
Also, each time a project is recovered it is date/time stamped just like saving 
a project. This means that the projects you do test recover will have a current 
date/time stamp in the project list so you can tell them a part from the 
original song on the list. Just as long as you see the VS recover a 
project/song from the backup disk without giving you the “Operation 
Failed” message, you project/song recovered and the backup disk is good. 
See “Recovering Projects” below for step by step info on how to do this. 
Note: If you have an UPDATE, do it at this time. 
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FORMATTING THE HARD DRIVE 
Usually when backups are done you can FORMAT the hard drive. Go to 
PROJECT> PROJECT LIST> click on the scroll bar’s arrows to get to the  
IDE:0 Drive to place the rectangular box around it and at the bottom of the 
window select PAGE 4/4 and click on “F2 FmtDrv” to open the Format 
window. 
 
In this window select 10GB for Partition size then select PHYSICAL 
FORMAT ON, (Quick Scan For new HDs) and SURFACE SCAN ON to 
reformat. Next click OK to begin the formatting process. This will take 
about 6 ½ hours for an 80GB Hard Drive and 13 hours for a 120BG Hard 
drive. Most do this at night so it’ll be done during down time. You can tell 
it’s finished when it loads a “IntProject 001” when it is done. You can 
RENAME this one and use it or ERASE it. All of your old projects will be 
erased and this will be the only project showing in Project> Project List> 
until you recover them from the backup disk. 
 
RENAME PROJECT. To RENAME it just click on PROJECT> NAME> 
and type in a new name in the NEW PROJECT’s window.   
 
ERASE a PROJECT just select PROJECT> PROJECT LIST> and 
CHECK MARK the PROJECT to ERASE. Then select PAGE 2/4 and click 
on”F2 ERASE” and answer YES to the prompts. The project will be erased. 
 
RECOVERING PROJECTS 
Click on PROJECT> PROJECT LIST>in this window click on the scroll 
bar’s down arrow (right side of list) to move the rectangular box around 
“SCSI:  CD-RW  [---.-MB/---.-MB]” this will select the built in CD-RW 
drive, now INSERT the BACKUP disk of PROJECTS and click “F5 LIST” 
at the bottom of this window.  Answer YES to the prompts. A new window 
opens listing the PROJECTS on the disk. Check Mark the ones to 
RECOVER from the list by click on the empty box to the right of the song’s 
titles, when all of the projects you want to RECOVER have been check 
marked, click PAGE until you see “PAGE ¾” and then click “F2 
RECOVER.” A Recover window opens and click “F5 OK” to begin 
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recovery. This takes about ¼ the time it did to back them up. Once you LIST 
the projects on a disk, recover at least one to test recovering projects. You 
can back out of this operation without recovering a project by scrolling the 
rectangular box up to and around another drive, I select IDE:0 where my 
projects are and click “F6 LIST”, it’ll ask you if you’re sure you want to 
change to that drive, click YES and it’ll scan the IDE:0 drive for a bit and 
then LIST your projects. Then you can check mark a project and click on 
“F1 Select” and it’ll scan and load that project. Once the project is loaded 
you can PRESS the Eject button and eject your backup disk. OR If you want 
you can recover a song and then go to project list and ERASE it as explained 
above RECOVERING PROJECTS. 
*These instructions are a bit brief but they are easy enough to figure out. Just 
think logically about what you need to do with the VS and usually you can 
get the job done. 
 
 
 
FORMATTING EXTERNAL SCSI DRIVE  
Go to Project> Project List> select Page 4/4> Find “F2 FmtDrv” and select 
Partition Size: 10GB,  
Physical Format: On, 
Surface scan: On and OK.  
It’ll take about 6 ½ hours for 80GB and double that for 120GB. 
 
FORMAT A NEW HARD DRIVE 
Once it’s physically installed, turn the VS on and watch the small 3” x 4” 
LCD on the VS and answer the prompts using the ENTER/EXIT buttons, 
“F” buttons under the screen, the cursors to change box selections and the 
jog wheel to highlight the selections. You can do a “Quick” format with a 
new hard drive but it’s recommended to do the following:  
 
First you’ll see “Formatted Drive Not Found, Force Initialize? 
Press ENTER for YES then you select 10GB partitions, cursor down to Jog 
to highlight “Physical: ON”, then cursor over to select “Surface Scan: ON” 
then “F5” for [OK]. Next you have to “F button” for [SelDrv] to get to the 
next screen and Select Drive IDE 0. It becomes logical as you do it and 
finally you select “OK” and it’ll ask you twice if you want to do Format, 
answer “YES.” These instructions are brief but I added them from memory. 
It’ll take about 6 ½ hours for 80GB and appx double that for 120GB. 
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Brands: Seagate, Western Digital, Maxtor & IBM 
Specs: 40, 80 0r 120GB, 7200RPM, 8MB Cache/Buffer, ATA/100 or 133 
interface (NO SATA). I had to remove the master/slave jumper off of the 
hard drive before the VS would format mine and work. Important: Find a 
hard drive with average seek times less than 10ms! 
 
Formatting Hard drive in HD Model VS 
The hard drive comes in a caddy that the hard drive is mounted into with 4 
screws. After updating, if needed and backups, power down the VS 
1. Unplug the VS and touch a metal grounded piece of gear in the room to 
remove static electricity. 
2. Remove the face plate by removing the 2 Phillips head screws, from front 
right side of the machine. 
3. You can use a coin to unlock the caddy, straight up should be unlocked. 
4. Slide the caddy out and carefully pop the top metal cover off and then 
remove the 4 screws on the sides of the hard drive with a #2 screw driver. 
*Note: The metal cover may be on tight and may require a flathead screw 
driver to help pry it off, do not bend the cover. 
5. Lift the drive out and remove the power and data cables. They can be in 
pretty tight so you may have to pull on them hard. 
6. Check your new hard drive and make sure the jumper is set to MASTER 
before installing. Just follow these steps backwards to complete. 
 
When done plug in the VS2480HD and power up. Check the small LCD for 
prompts, “Force Initialize” answer YES with the enter button the select drive 
IDE0, Physical Format ON, Surface Scan ON and use the “F” buttons under 
the VSs LCD to select 10GB Partitions and Format the new hard drive. 
 
List of hard drives in a thread at VSlanet... 
http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Number=677261&fpart=1 
AND 
http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Board=16&Number=976890&Search
page=7&Main=47033&Words=Hard+drive&topic=0&Search=true#Post976890 
AND 
http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Board=16&Number=102931
5&Searchpage=2&Main=97783&Words=Hard+Disk&topic=0&Search=true#Post1029315 
 
*If you ever need to turn the hard drive off, say you are using the VS only as 
a control surface for a PC then click on Utility> System Parameter> Param 
2> IDE  Drive> Select OFF. If you have a hard drive that refuses to spin up 
and on, check this parameter and make sure it’s ON. 
 

http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Number=677261&fpart=1
http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Board=16&Number=976890&Searchpage=7&Main=47033&Words=Hard+drive&topic=0&Search=true#Post976890
http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Board=16&Number=976890&Searchpage=7&Main=47033&Words=Hard+drive&topic=0&Search=true#Post976890
http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Board=16&Number=1029315&Searchpage=2&Main=97783&Words=Hard+Disk&topic=0&Search=true#Post1029315
http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Board=16&Number=1029315&Searchpage=2&Main=97783&Words=Hard+Disk&topic=0&Search=true#Post1029315
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NOTE: If you have a VS2480CD model VS, you can install a laptop DVD 
burner in place of the CD burner in your VS. The VS defaults the CD write 
speed at CD4x and DVD1x but here’s the catch. DVD2x is as fast as CD18x 
so DVD1x is equal to CD8x when it comes to burning backups. Also, DVDs 
hold 4.7GB of data, that’s 4700MBs and CDs only hold 700MBs so 5 or 6 
CD backups will fit on one DVD in far less than half the time it takes to 
backup to CD. I recommend you do this your self and save hundreds of 
dollars compared to buying the VS2480DVD model or an external DVD 
burner. It takes about 30 minutes to change them out plus you will also know 
where the hard drive is and can change it on your own as well. Hard Drive 
specs: 7200RPM, 8MB Cache, ata/100 or 133 Interface. No SATAs! 
Download the “Converting the VS2480CD to VS2480DVD” PDF from this 
direct link and buy a Panasonic UJ-845-B Slot Loading DVD/CD Laptop 
Burner….  
http://www.rolandvs2480.net/VS2480CD%20to%20vs2480DVD%20Conve
rsion/Convert%20your%202480CD%20to%20a%202480DVD.htm 
 
The UJ-85J REPLACES: UJ-811, UJ-811-B, UJ815, UJ-815, UJ-815-B; 
UJ825, UJ-825, UJ-825-B; UJ835, UJ-835, UJ-835-B, UJ845, UJ-845, UJ-
845-B model DVD Burners that have worked and even the UJ-845-S or UJ-
845S model has worked. I have not heard of the UJ-85J being tried out in a 
VS2480CD as of yet. Also, the Panasocic/Matshita UJ-845-B, UJ-850 and 
UJ-870 was used which shows up as UJ870QJ in the CD-R Write window! 
Arjan  van gog on VSP, used a UJ-875 BXM Master DVD Burner and it 
worked. 
 
Link above is from Brett’s web site at this link… 
http://www.rolandvs2480.net/ 
You’ll be glad you installed a DVD Burner in your VS2480CD. If you need 
more help with it contact me at Fcgjabq@aol.com  
Also, the new VS2480DVD comes with the Matshita/Panasonic DVD-RAM 
UJ-840-S model burner. 
 
 
 
 
 
 
 
 
 

http://www.rolandvs2480.net/VS2480CD%20to%20vs2480DVD%20Conversion/Convert%20your%202480CD%20to%20a%202480DVD.htm
http://www.rolandvs2480.net/VS2480CD%20to%20vs2480DVD%20Conversion/Convert%20your%202480CD%20to%20a%202480DVD.htm
http://www.rolandvs2480.net/
mailto:Fcgjabq@aool.com
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Tempo Mapping/Find BPM    By Frank Griffith 
1) Load the project...find the TAP button and SHIFT. 
 
2) Play the song and tap the TAP button in time with the beat of the 
song. Tap out about four measures of beats. This will place yellow 
markers above the track window. 
 
3) Stop the project from playing and zoom in on the waves and adjust 
the yellow marker to line up on the waves beats as close as you can, 
using the mouse's grabby hand, L-click and drag them into place. 
 
4) Press SHIFT+TAP to bring up the Tempo Map window 
 
5) In that window select "F1 TM Cnv" for the Tempo Map Converter 
window. 
 
6) In this window select 
----a) Under CONVERT TYPE left click and scroll to the option              
"Tap -->       Tempo Map" 
----b) Under BEAT select 4/4 for a time signature 
----c) Under TAP BEAT select 4 for how many beats to calculate...       
(I tried 16 on a song I knew was 100BMP and it gave me 25BPM so I 
tried it at 4 and it gave me 100BMP) 
----d) Now click ENTER and answer YES to the prompt. It'll say 
"Done." 
 
7) Now click EXIT in the Tempo Map window. 
 
8) Press SHIFT+TAP to open the window again and see what the beats 
per minutes are if the window is not already there.  
 
9) You can add the notes sign BPM numbers all up and divide by the 
number of numbers to get the average. That's about as close as you 
can get. 
 
10) If you want to clear the yellow markers, hold the CLEAR button 
down and L-click on each marker. 
 
Metronome 
Click on the UTILITY menu then Click on METRONOME and a window 
opens up. There you will find all of the parameters for setting it up. 
To send the metronome to the MONITOR bus you check mark INT 
under METRONOME OUT at 0db by default. Under INT LEVEL you can 
set the level from –infinity to +6db. I use -10db. 



 2 

METRONOME MODE lets you select whether you want it to be heard 
only when recording “Rec Only” or heard during both record and 
playback “Rec&Play”. You can check mark the one you want. 
 
TONE TYPE let’s you play a pair of clicks CLICK1, play a clave like 
sound CLICK2, or a drum like kick sound using with MIDI 
CLICK2<Note> or to use the metronomes programmable beat box 
DRUM. When you select DRUM the “F1” below becomes active and 
displays “F1 PtnEdt” (Pattern Edit). This brings up the Beat Box and 
parameters. For more on this and using the metronome with MIDI see 
the VS manual starting page 369. 
 
I would just check mark INT under METRONOME OUT, at what ever 
INT LEVEL sounds loud enough with your project playing, use -8db at 
first, check mark “Rec& Play”, check mark the CLICK2 Clave sound and 
“F6 EXIT” for easiest use. You can always come back and adjust the 
volume as needed. 
 
Use these settings for setting different BPMs, METRONOME OUT 
check INT, -8db INT LEVEL and DRUM for TONE TYPE then click on “F1 
PtnEdt” to get to the Current Tempo (92.1 to 120.0 default to 
140.0BPM) and Beat parameters (1/1 to 4/4 as default to 16/16) and 
change them to match what ever beat and tempo you need. Again, for 
more on this see pg369 in the VS Manual. 
 
Bobkat on VSP wrote: 
I read an interesting way of recording a click track using the internal 
metronome and the tempo map feature on the 2480 that might be 
useful. 
First make your metronome and tempo map settings.  
Then click Utility Menu;click Gen/Osc,click SW to ON,click Source to 
Metro and click F6 exit.Click Routing View in the Track Assign section 
to make the connection from Gen to the track you want to record to 
and then simply arm the track for recording. 
 
How to route the click to a track 
On the Utility Menu go to the GEN/OSC, Set the SOURCE to METRONOME. 
 
Then, go to EZROUTING, find the Gen/OSC and drag a line from GEN/OSC to 
the RECORDING TRACK of your choice. 
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VS “PRM EDIT” Button                     By Frank Griffith 
Any time you are working with Dynamics & EQ Parameters, there is a little 
feature that can come in handy if you do not like using the mouse to adjust 
the Dynamics & EQ settings. Any time you select a CH-Edit button for a 
TRACK or INPUT then return to the home page, to the left of the virtual 
PAN knobs on the screen is displayed what fader button has been selected, 
such as FADER and “TR 1-16” with a green line below it. PRESS TR 1-16 
fader button above the red master fader to see this, just below that should be 
the last CH-Edit button selected, press TRACK # 1’s CH-Edit button and 
below the TR 1-16 should be CH and “TR 1” for Track # 1’s CH-Edit 
selection. PRESS Track # 1’s CH-Edit button again. CH and TR 1 stays 
there. What is significant about this is this…  
 
Too the right end of the PAN knobs on top of the VS2480 is a button labeled 
“PRM EDIT.” PRESS “PRM EDIT,” it’ll light up RED and watch what 
happens to the virtual PAN knob display. It changes to show you all of the 
Compression Dynamics and EQ Parameter settings for that TRACK # 1.  
 
The PAN knobs on the VS are now knobs to adjust all of the parameters for 
the Dynamics and EQ of that track. To change it to another TRACK’s 
parameters, press any TRACK’s CH-Edit button once for the CH-Edit 
screen or twice just to use the knobs without the CH-Edit screen.  
 
To show an INPUTS Dynamics and EQ parameters while tracking, PRESS 
the fader button IN 1-16, then the CH-Edit button of the INPUT you want 
and then PRESS the fader button “TR 1-16.” Notice that the display to the 
right of the virtual PAN knobs on your VGA is displaying the “IN #” you 
selected and the Dynamics and EQ parameters for that INPUT are still there.  
 
To get back to the PAN knobs just press the “PRM EDIT” button again and 
the red light goes off. When working with mixing tracks you can PRESS the 
PRM EDIT button then double press any tracks CH-Edit button twice to see 
its Dynamics and EQ parameters for fast and easy adjustments. 
 
You can also assign the PAN knobs to be AUX Send 1-8 knobs and other 
functions but you’ll have to see your manual for more on that. I find it a bit 
more confusing to do more than use it for Dynamics and EQ parameters. 
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From VS-Planet 
Comp/Expander/Gate 
Basically we’ve got 48 of them, but what are they? A guide to dynamic 
processing. 
 
Most modern digital workstations have like the “big consoles” of the past build 
in dynamic processing. Every track- and input channel on a Roland 2480CD/HD 
has one such processor. 
 
In the last years several budget outboard preamps equipped with, or just stand 
alone, compressor/limiter/expander/gates have seen birth and launch on the 
market. They seem to be a miracle in itself to give the recordings that extra to 
become “outstanding”. 
 
As they are two means of using dynamics basically, ie.: reducing 
dynamics/noise-spill and as sort of effect. 
 
For starters: most digital dynamic processors lack the ability to perform as sort 
of effect, where they can excel as doing their job as dynamic processors. Sound 
strange? 
 
For this we need a little history. The first dynamic processors where as you 
guessed analogue. What they basically did was to reduce level, with a certain 
ratio above a certain input level. Hence the nomenclature on most units! This 
was mainly done by clever amplifier circuitry and more then once helped by 
light sensitive resistors. Especially the last option gave a smooth, laid back 
compressor with lots of side effects, which nowadays are called warm, vintage 
etc. Well at least you can call it character. Later on there came VCA controlled 
gear, which worked with less side effects, and had faster working times, making 
them more tight. 
 
So far, a few new things are introduced, such as laid back, warm and tight. The 
faster a compressor or any dynamic processor can work, the tighter it will sound. 
This is due to the fact on how long it will take the processor the reduced the 
signal level. In other words: as it takes longer, the first transients and signals get 
thru un-processed. Will it work very fast (like the digital and newer analogue 
ones) the initial transients/hits will be processed to. This makes a huge different 
on the processed sound. Lucky enough this time it will take and can be set with 
the attack-time control. Sometimes basically with fast/slow or with a rotary 
control. The same goes for the time it takes the processor to return to it’s 
original state of amplifying after the signal level is under the threshold level, 
which is called release time.  
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Ok, threshold is introduced..........basically this is what it says to be. Once the 
signal level exceeds the threshold, taking attack time in count, the processor 
starts doing it’s job. At least for compressors/limiters – which are basically the 
same in some accounts, whereby gates/expanders work the other way around. 
 
Let’s introduce another important thing: ratio. In case of compressors, ratio 
determinates how much compression there will be above the threshold.  For 
instance if we set a ratio of 1:3, and the level rises 12dB above the threshold, the 
compressor will apply 12–(12/3)=8 dB of gain reduction and only 4 dB above 
the threshold level is outputted. So if the threshold was set in this case at –6 dB, 
the output level shall be –2 dB on the meters. So as a theoretical rule you can 
apply the following: 
 
Output level = input - ([input-threshold] – [{input-threshold} /ratio]) 
 
VS ExpanGate 
Airproof, start with the KICK DRUM track. 
 
Invoke the EXPANDER on the TRACK CHANNEL. 
 
Set the Ratio pretty high, 4.00:1. 
 
Set the THRESHOLD to about 12dB. 
 
Set the ATTACK to 0.0, and the DECAY to about 250. 
 
Now, WATCH THE LED "GR" (Gain Reduction) meter, while you 
play the KICK track and mess about with the settings. 
 
That should get ya started. 
 
Gates work well with Kick and Toms, but not so great on OH or 
ROOM mics. Some interesting effects can be had by gating a 
strong SNARE, but not a soft (or brushed) snare. 
By Karl 
 
AND another post... 
In the "DYN Screen" of the recorded track 
switch to EXPANDER 
choose an extreme ratio (the lower line is steep) 
choose a short attack time 
then experiment with treshold level and release time 
 
on the meters you can see (what you hear ) if the gate is opened 
or closed 
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if you also want to add compression you can switch to 
"EXP+COMP" 
 
I would say, play with, there is nothing you can damage with your 
experiments. Listen to this track alone while adjusting and be 
aware that later with all tracks something will be covered - OK 
depends on the material. 
 
 
Compression In General  
Use the IN and OUT of each different section to see what effect 
that particular section has on the signal..... 
 
For example, take a kinda hot channel, and turn the compressor 
on, but turn the A.GAIN switch OFF. Now, the IN meter is the 
signal BEFORE compression, and the OUT is the signal AFTER. The 
GR meter shows how much reduction is being applied to the 
signal.  
 
Vary the THRESHOLD until you see the GR kick in ONLY on the "hot 
spots". Now, when the IN goes past that threshold, the OUT gets 
reduced. You can SEE the difference. 
 
Same deal with the EXPANDER and the EQ. Use the IN and OUT 
meters of each stage to ensure there is a clean signal all the way 
thru. 
 
 
Point is, any signal that goes OVER at ANY point in the chain will 
add distortion of some sort, and reducing the FADER simply passes 
a smaller picture of the signal, distortion and all, to the Mix. 
 Lakestone Karl. 
 
LDT2 
“The expander on each channel can be used as a noise gate. Just 
crank the ratio to infinity and adjust the threshold to where ever 
you need it and it'll gate to silence. You can fine tune with the 
release setting also.” 
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Well why do we need them, and how do we use them? 
 
First of all, it may be time to know the difference between the basic four of 
dynamic processors. 
 
The first group consist of two, ie.: compressors and limiters. Their names 
explain them a bit already: compressors do indeed compress the sound, so that 
the signal level will stay between the noise floor and “the red zone” of your 
metering. This is achieved by correct settings of the device (more on this later!). 
A limiter is slightly easier: one chooses the maximum level, and the limiter takes 
care that the signal level will not rise above the set level by cutting in on the 
volume/level once it rises above the threshold set. 
 
The second group consists of the noise gate or gate and the expander. These 
units work the other way around and are mainly used to restore dynamics and 
keep noise/spill out. Simply said the noise gate is the opposite of the limiter: 
once the signal goes below the threshold, the gate shuts, and silence is heard... 
Useful on multi miked drums etc. The expander on the other hand reacts more 
like a compressor, with a ratio of working below the threshold. It works more 
slight and can be good on use on instruments/vocals which have longer decays 
and/or release times. 
 
The time for some secrets.........not really! 
 
When, which and how much is the main question here for many of us. When is 
the first one. As a matter of fact, during recording, I try to avoid using any at all. 
This might seem a bit weird, but once recorded with the dynamics processed in 
any way or form is not a thing of undo or so; it’s recorded that way and 
irreversible!!! What could have been a good take without or with different 
settings is probably ruined by the wrong settings. (The same story goes for 
EQing and FX’s before the recording as far as I’m concerned). On very 
percussive and/or dynamic instruments/voices, I sometimes use limiting set at –
0.5 dB to avoid overshoots, and the uninvited digital distortion.  
 
So that was the first use for a limiter! It is also useful to pump up a track in the 
mix, but can be rude sounding, but he, maybe this is what you want for a 
track....... Compressors can do also a great job on getting the overall level of a 
track, or mix, a bit higher by pushing the lower levels up, and keeping the peak 
level within the save range. It’s hard to say use this or that setting for such a 
signal. Instead of looking at tables, numbers or so, it is better to understand and 
learn how a signal behaves. Is it percussive/dynamic or has it got a slow attack 
and long release, or something in the middle? By understanding the parameters 
we can adjust, and what kind of signal we have on a track will help us better. 
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Spend some time with (raw)tracks of snare drum with some spill and hear what 
a gate can do, or an expander if you like. Pump up a kick drum with gentle 
compression, or freak out on it with extreme parameter values. It’s also nice to 
play around with a clean guitar track and some expanding for the sheer fun of it. 
Try spending time on mix, and get vocals more upfront with compression 
settings, and try to get the feeling of what parameter values make sense for 
certain tasks. Playing around like this seems to be waste of precious studio time, 
but it will pay off one day when you are encountering a difficult mix and/or 
tracks during your sessions. It will also pay of in your overall sound quality in 
the future, and playing around also learns you to move faster on the machine. 
Common sense and experience will take you to a higher level of “wise” use of 
dynamic processing. 
 
Some words to end a summary of things........ 
 
First of all: do you really need any form of dynamic processing on a track? This 
is always good to ask. If things are proper recorded, and a good source, mics etc. 
are used, you don’t have to do much to get a good mix. Especially to much 
limiting and compressing can make your tracks and mix sound “un lively”, dull 
and less dynamic. This is something to be aware of. In general: unless used as 
effect, a good track/mix doesn’t need to much EQ, FX’s or dynamic processing. 
What was wrong during recording can’t always be fixed with the three groups of 
processing. If you need them (to) much, maybe it’s time to consider what went 
wrong with mic-setup, or choice of instruments, amps etc. 
 
Some terms short explained again: 
 
Threshold: 
 
The level at which a dynamic processor starts to work, depending on being 
limiting/compression above the threshold, and gates/expanders below it. 
 
Ratio: 
 
Amount of compression/expanding applied below/above the threshold. Limiters 
as well as gates have a ratio of 1:infinity. 
 
Attack time:  
 
The time it takes before the dynamic processor starts to kick in. Mostly in mili 
seconds, sometimes in slow/fast. 
 
Release time: 
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The time the processing works on, after the level is below/above the threshold 
again. (Compressor: below and expanders: above) 
 
Make up gain: 
 
The give a rise in overall level, gain can be applied to the compressed signal and 
the average level will be higher than the unprocessed signal. 
 
AIRPROOFING on VSP uses these Compressor settings... 
You'll need to work with it to suit what your signal is, but these can 
maybe get you started... 
 
Kick 
Threshold: -6dB 
Ratio: Between 4:1 and 6:1 
Attack: Between 40ms and 50 ms 
Release: Between 200 ms and 300 ms 
Gain: Adjust so that the output level matches the input level. You don't 
need much added gain. 
 
Snare 
Threshold: -4dB 
Ratio: Between 4:1 and 6:1 
Attack: Between 5 ms and 10 ms 
Release: Between 125 ms and 175 ms 
Gain: Adjust so that the output level matches the input level. You don't 
need much added gain. 
 
Bass Guitar 
Threshold: -4dB 
Ratio: Between 2.5:1 and 3:1 
Attack: Between 40 ms and 50 ms 
Release: About 180 ms 
Gain: Adjust so that the output level matches the input level. You don't 
need much added gain. 
 
Bruce 
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INCREMENTS of DATA 
*For making really precise edits and for placing the edit points more 
exact, use the WAVE DISP button above the cursor buttons to bring 
up the wave form display. 
 
1) Check out the time in the upper left hand corner of the HOME 
screen. There is a yellow line under one of the double zero digits. 
There's 00h00m00s00f00 for hours(h), minutes(m), seconds(s), 
frames(f) and something smaller, "Ticks" I guess. 
 
2) Press the Left or Right of the 4 cursors buttons above the JOG 
wheel to move the yellow line to seconds or frames and then turn the 
JOG wheel. The TIME LINE moves in the smaller increments across 
the tracks. This is good for use when editing tracks with them zoomed 
in on the wave files. You can easily line up the TIME LINE, (The RED 
LINE that crosses all tracks vertically) in very small increments for 
placing edit points. 
 
*Note: You can also use the zoom buttons on the scroll bars to zoom 
tracks in to show only 2 or 4 tracks and still get the wav form on 
screen for placing more precise edit points. I also PLAY the audio, 
keep the beat with my hand and count 1 and 2 and 3 and 4 and etc. 
Right after 4 on the “And” I press STOP and place my edit points or 
flags. This is usually a silent spot between beats. Practicing this will 
help you to get pretty precise at placing these flags. 
 
 REGION COPY or MOVE 
1) I like having the tracks zoomed in and showing only 4 tracks so I 
can use the wave form visual for better placement of the edit points. 
For copying or moving sections of music you can place the time line 
at the beginning of a section of audio, PRESS the IN button. I also 
PLAY the audio, keep the beat with my hand and count 1 and 2 and 3 
and 4 and etc. Right after 4 on the “And” I press STOP and place my 
edit points or flags. This is usually a silent spot between beats. 
Practicing this will help you to get pretty precise at placing these 
flags. 
  
2) Then move the time line to the end and PRESS the OUT button, 
this will select that chunk of audio to me copied or moved.  
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3) Then move the time line to the point where you want the audio to 
go and PRESS the TO button. The IN of the audio selected will be 
copied or moved to the TO point. Once IN, OUT & TO are set, the 
FROM is set automatically. If you are compiling tracks (making one 
good vocal track out of several takes) and the IN points and the TO 
point are in the same place on the time line then press the IN button 
then the TO and then the OUT. (* Also, you can select as many 
tracks as you want to copy, move, erase in the select track window.) 
  
4) Now click on TRACK> and select REGION COPY or MOVE to 
actually MOVE the audio> and in the next window click on "F1 Sel 
Trk" button to select the track or tracks with the IN & OUT edit 
points and the track or tracks to send it or them TO. 
  
5) Here you will see 3 rows of numbers and boxes to check mark. 
Check Mark the box of the track with your IN & OUT audio edits, then 
to the right of the arrow, with your mouse, or JOG wheel, dial in the 
track to send that selected audio too (the one with the TO point). If it’s 
the same track then you don’t have to change it, the same track is 
listed by default. To move from track to track (16 V-Tracks at a time) 
hold down SHIFT+JOG, to select V-Tracks then JOG only. 
  
6) Now click the "F5 OK" button and answer YES to the prompt. It'll 
say Done! Now click "F6 EXIT" to close the Region Copy or 
Move window. 
*Region Copy will "COPY" the data, Region Move "MOVES" the data. 
  
7) If you are not satisfied with the edit, PRESS the UNDO button and 
then ENTER to erase the current edit you just made. Clear your edit 
flags by left clicking on them while holding down the CLEAR button 
and start over, OR... 
You can leave the flags there and grab your TO flag and move it to a 
new position then click on TRACK> REGION MOVE> Sel Trk> etc... 
 
To CUT a section of audio, you just place an IN, then the OUT then 
select TRACK> REGION CUT> and in the window that open click on 
“F? Sel Trk” and in the next window check mark the tracks to cut the 
audio from and click OK. This removes that section of the time line as 
well so that space will be gone and the two pieces of audio on either 
side of the highlighted section of audio will jump together. 
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You can also left click at the IN point and drag to the OUT point, 
highlighting the audio and right-click and on the menu that pops up 
then select CUT. You could also select ERASE if you just want a 
silent spot of the time line left. 
Again... I PLAY the audio, keep the beat with my hand and count 1 
and 2 and 3 and 4 and etc. Right after 4 on the “And” I press STOP 
and place my edit points or flags. This is usually a silent spot between 
beats. Practicing this will help you to get pretty precise at placing 
these flags. 
 
COPY SONG/PROJECT 
If you want to copy a song to this same partition/drive so you can 
keep the original before region cutting a song to make it shorter or 
region copying a song to make it longer do this.  
 
Click on PROJECT> Project List> and in the Project List window click 
on the page button till you see 2/4 and “F1 COPY”.  Now check mark 
the project/song or songs to copy. Now turn the JOG wheel to place 
the box around the drive/partition number to copy the song or songs 
too. *To copy to the same partition jog the box all the way up to 
IDE:0. To copy to another partition jog the box down to IDE:1 or etc. 
 
Now click on “”F1 COPY” and the Project Copy window opens. On 
the left it shows the project/song to copy, below that what drive it’s 
on, then on the upper right, the drive to copy the song too and below 
that “Erase All Projects.” Make sure it is check marked “OFF.” 
*Unless you want to erase the destination drive clean.  
 
Now press “F5 OK” and it asks “Copy to (your drive you selected?” 
click on “YES” and “Store Current?” answer “YES” or “NO” if you 
don’t need to store the current project that’s open. Now the progress 
bar comes up “Loading… and Copy Project.”  
 
It’ll take a couple of minutes. When it’s done the windows disappear 
and the current project is still open.  If you copied the song/project to 
the same partition you can go to Project> Project List> and scroll to 
the end of the list of songs and find it there. You can go to Project> 
Name> and rename the current project so you don’t get them mixed 
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up. *To check a song on another drive you have to select that drive 
from the project list window. 
 
USING REGION MOVE TO SHORTEN A SONG 
HERE'S A VISUAL OF WHAT TO DO..... 
  
Song Intro      TO     Part to cut        IN                      Song End    OUT 
>>>wav>>>>>//>>>>>wav>>>>>>>//>>>>>>>>>>>>>>wav>>>>>>> 
Section # 1             Section # 2                                   Section # 3 
  
EDIT Points    TO                             IN                                        OUT> 
 
Jog the TIME LINE to the EDIT points and PRESS the appropriate 
button to place the EDIT points as shown above. 
 
You want to cover up section # 2 with section # 3 removing section # 
2 from the song. Placing the IN point and OUT point will highlight 
section # 3 to be moved over section # 2. The IN point will meet with 
the TO point once the edit is made covering up section # 2 leaving 
only sections # 1 & 3 to be heard when played. 
  
NOW click on TRACK>> REGION MOVE>> and a small window 
opens, click on the “F”1 Sel Trk">> another window opens. Select 
ALL tracks to REGION MOVE >>> then click “F5 OK” and “YES” 
you’re sure then “EXIT.”  
 
Now check your edit and see if you like it. If not press UNDO and 
ENTER to start over or if you like it, hold CLEAR down and click on 
the flags with your mouse and they’re gone. If you want to try again, 
you can just left click and drag the EDIT FLAGS to new positions and 
go to TRACK>> REGION MOVE>> and repeat the edit. If not then 
hold down the CLEAR button and press each edit button, IN, TO, 
OUT one at a time to clear out your edit points/flags and start over or 
left click on the edit flags with the mouse. 
 
Again” I PLAY the audio, keep the beat with my hand and count 1 
and 2 and 3 and 4 and etc. Right after 4 on the “And” I press STOP 
and place my edit points or flags. This is usually a silent spot between 
beats. Practicing this will help you to get pretty precise at placing 
these flags. 
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USE REGION COPY TO MAKE A SONG LONGER 
Let’s say you want to make a song longer. I like having the tracks 
zoomed into show just 4 tracks that will give me a good visual of the 
wave form for more accurate placement of my edit points. You’ll have 
to decide what sections to copy to where. 
 
For this example, let’s say you want to repeat the last chorus and 
solo. What you can do is jog the time line to place an IN point at the 
beginning of the chorus to repeat and then jog and place an OUT 
point after the song fades out. This has now selected that chunk of 
audio to Region Copy to a later point in the song. 
 
Jog the time line to the later point in the song, like at the end of the 
chorus and solo that’s to be repeated and place a TO point. The 
FROM is placed automatically. I like to PLAY the audio, keep the beat 
with my hand and count 1 and 2 and 3 and 4 etc. Right after 4 on the 
“And” I press STOP and place my edit points or flags. This is usually 
a silent spot between beats. Practicing this will help you to get pretty 
precise at placing these flags. 
  
Now to Region Copy click on TRACK> Region Copy> and in the 
window that opens select “F1 Sel Trk” and in the next window, check 
mark all of the tracks to be copied to their same track and click “OK.” 
Click “EXIT” to close the window and check your edit to see if you like 
it. If not press UNDO and ENTER to start over and try again or if you 
like it hold CLEAR down and left click on the edit flags with your 
mouse to remove them. 
 
USE REGION CUT TO SHORTEN A SONG 
Zoom the tracks in so only 4 tracks are showing, this will allow you to 
see the wave form better for placing your edit points. *We use Region 
Cut because if you copy the end of a song to the front part, you will 
have a tail of the original song at the end of the new shorter song that 
you will then have to perform a Region Erase on.  
 
Region Cut will cut out a solo or a chorus and bring together the two 
pieces on either side of the cut. You place an IN point at the 
beginning of a solo or chorus and an OUT point. *Notice the TO and 
FROM is automatically placed, you don’t have to worry with it.  
 



 6 

Now click on Track> Region Cut> and in the window that opens 
select ”F1 Sel Trk” and check mark every track in the song to cut to 
their same track, then click “F5 OK” and “YES” you’re sure then 
“EXIT.” Now check your edit and see if you like it. If not press UNDO 
and ENTER to start over or if you like it, hold CLEAR down and click 
on the flags with your mouse and they’re gone. If you want to try 
again, you can just left click and drag the EDIT FLAGS to new 
positions and go to TRACK>> REGION CUT>> and repeat the edit. 
 
*NOTE: I also PLAY the audio, keep the beat with my hand and count 
1 and 2 and 3 and 4 etc. Right after 4 on the “And” I press STOP and 
place my edit points or flags. This is usually a silent spot between 
beats. Practicing this will help you to get pretty precise at placing 
these flags. 
 
TRACK EXCHANGE 
Sometimes we need to change the position on the tracks line up so 
we use the TRACK EXCHANGE feature in the VS. If you want to 
exchange, let’s say TRACK #1 with TRACK #10, then you… 

1) Click on TRACK at the top of the HOME screen and 
 
2) Select TRACK EXCHANGE from the drop down menu and a 

TRACK EXCHANGE window will open. In this window there are 
3 rows of 8 TRACKS and their V-Tracks. 

 
3) In the first row place a check mark in the empty box to the left 

of “1-1    -“, it will change to “1-1  1-1” and become 
highlighted. 

 
4) Now with your JOG wheel dial in  the right numbers “10-1” and 

the set should look like “1-1 10-1”, meaning TRACK #1’s V-
Track 1 will be exchanged with TRACK #10’s V-Track 1.  
Basically, TRACK #1 and TRACK #10 will exchange positions.   
You can also dial in V-Tracks here. 
 

5) Now click “F5 OK” and answer YES to the 2 prompts and the 
process will take place. If any track title has been type in then 
the title will move with the track too. You can also EXCHANGE 
pairs or several tracks at once. 
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6) Now click “F6 EXIT” to close the TRACK EXCHANGE window.  
 
*When using the TRACK EXCHANGE feature, make sure, when you 
are in the TRACK EXCHANGE window, that other tracks do not have 
check marks in their boxes because those tracks will be exchanged 
also. This can happen once you have done a previous TRACK 
EXCHANGE they can still be check marked the next time you go in to 
do another EXCHANGE, so be careful, tracks can get lost this way 
and create a lot of confusion. When this happens, I go in and tell it to 
do the EXCHANGE again to bring the lost tracks back to where they 
were in the first place. 
 
TRACK IMPORT (Between Projects) 
To move tracks from project to project use the TRACK Menu and 
select TRACK IMPORT. Open the project you want the tracks to end 
up in then TRACK> TRACK IMPORT> in this window find the 
project/song with the tracks you need and select it, then click “F5 
Select” and in this window you select the SOURCE TRACK by 
scrolling up or down to the tracks or V-tracks needed, and then select 
the DESTINATION TRACK you want the source tracks to end up on 
in the project. Click “F5 OK”, YES and sure yes etc. See MST DAO 
for better step by step on this process. 
 
COPY PARAMETERS 
To copy the Dynamics, EQ and Level settings from one Track’s or 
Input’s to another you have to Press the CH-Edit button of the Track 
or Input that you want these settings copied to. Let’s say you 
Exchanged Track#10 with Track#3 and you want Track#10’s Dyn,EQ 
& Level settings from it’s channel edit page to be moved to Track#3 
after the Track Exchange of Track#10 to Track#3, you would do this. 
 

1) Press the CH-Edit button on Track#3 and at the bottom of the 
page 1/5, you’ll see “F5 CpyPRM”. 

2) Click on “F5 CpyPRM” and a small “Copy Mixer Parameter” 
window opens with SOURCE Ch on the left and COPY 
TARGET on the right. 

3) Simply use the mouse to drag the SOURCE display to show 
TRACK 10 in the window (or highlight and jog) then in the 
COPY TARGET side select ALL. There are 4 selections here, 
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ALL, DYNAMICS,EQ and LEVEL so you can do all or one of 
them at a time. 

4) Once your selections are made click on ENTER and the copy 
will be made. You can not use UNDO to undo this step. 

*NOTE: Also, as you dial through the selections under SOURCE, 
linked tracks will show up as linked ie. Track 1/2. 
 
TRACK EXPORT (.wav format) 
To export a track or tracks to a CD-R or RW from a 24bit, 44.1k MTP 
project, just click on CD-RW Mastering> select TRACK EXPORT> 
and INSERT a blank disk. Now the EXPORT window opens. 
 
In the TRACK EXPORT window all tracks and V-Tracks are listed 16 
at a time in the window on the left. You will see an empty box and “1 
– 1: Your Track Name” for Track 1 V-Track 1. (It runs thru each 
track’s 16 v-tracks but boxes only appear next to tracks that have 
data). Place a check mark in the empty box to the left of the track 
name and use the down arrow to scroll to the next track “2 – 1: 
Another Name” and place a check mark there too and so on for all 
the tracks to be exported. (You can also export your master tracks 
using this method, just find the V-Tracks on tracks 23 and 24.) Once 
you have selected all tracks to export Click “F5 NEXT”. 
 
The VS scans your blank disc and puts up a list of all selected tracks. 
In this window select VERIFY to “ON” with a check mark and for CD 
Speed select “MAX” and then click “F5 OK” and the VS will start 
burning the selected tracks to disk unless there’s data on the CD-RW 
disc, it will say “Finalized Disc”, click ENTER, then in the next window 
click YES to ERASE the CD-RW disc. This can take several minutes 
just for a couple of tracks. You will see the blue progress bar and 
“Now working” in the middle of the screen. The disc will eject when 
done. CDs will not hold more than 700MB, I shoot for 650MB. 
 
The exported tracks will be mono data files in 24bit  @ 44.1k in .wav 
format from an MTP project for loading into other PC audio programs 
like Pro Tools & Sonar. They are not audio files to be played in a 
market/home CD player. *NOTE: The track export window will keep 
these files checked until you uncheck them so don’t go in and export 
other tracks without un-checking these or they will export again.  
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NOTE: Very early VS2480 HD models did not have the ability to 
import and export files. If you have this problem then you need to 
update the VS’s OS to get these functions to appear on the CD-R 
Mastering  and TRACK Menus. 
 
Also, if you put the CD-RW with the track on it into your PC, you can 
process it with Auto-tune or whatever audio application you have. 
Save it to a folder you can find, or name it differently so you can find 
the processed file instead of the original like naming it #2 or 
something.  
 
Then open that folder in its own window and then you can open a 
window to a blank CD in a CD Burner. Now you can drag and drop 
the processed file into the blank CD-RW window click File> Write 
these files to CD> and the XP Wizard will open, you can name the 
disc in the first window where there is a highlighted date then click 
NEXT, in this window be sure to select Data Audio not CD Audio for 
players, then after it burns it to disc stick it into the VS.  
 
Note: When you track export tracks using “Track Export” through the 
EXPORT WINDOW out of a 24bit 44.1k MTP project, they stay at 
24bit 44.1k. .wav files. If you master your tracks in the mastering 
room as non-CD-R Mode, those master tracks can also be 
EXPORTED out of the VS using this method and will be 24bit, 44.1k, 
.wav stereo files, same as the project’s mode, I suggest channel 
linking the master tracks before exporting.  
 
EXPORTING MASTER TRACKS 
When you get to the V-Track map in the TRACK EXPORT window, 
you’ll have to scroll thru all the tracks and their V-tracks to get to track 
23, check mark its V-track you mastered to then scroll to track 24 and 
check mark its same V-track you mastered to.  
 
Even though you have to check mark both the left and right mono 
tracks in the track export window, the VS will still combine them into 
one STEREO PAIR in to a single stereo file as long as you have them 
LINKED. Bring them forward in the HOME screen, selecting the V-
Tracks on the V-track map and then link them on track 23’s CH-Edit 
page. If you do not LINK them before exporting master tracks they 
will wind up being MONO left and right files.   
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Also, if you export mastered tracks, the CD-R Mode 16bit pairs will be 
exported as stereo .wav files but with the non-CD-R mode mastered 
tracks in 24bit, if you do not have them linked and check mark the L & 
R tracks to be exported, they will turn out to be MONO .wav files. If 
you want STEREO .wav files, be sure to link them and check both left 
& right to be exported at the same time.  
 
It can be tricky but you can export STEREO .wav format mastered 
tracks in 24bit. They will come out with a file name similar to this: 
2316V_T23_16.WAV. Notice, track 24 is not in the title, weird but OK. 
Once done linking the tracks and exporting them, don’t forget to go 
back and select empty V-tracks or the original V-tracks that were in 
the HOME screen. The stereo .wav files are 24bit so some apps that 
only play 16bit audio will not open them ie Window’s Media Player! 
 
WAV IMPORT Insert CD of .wav files, Now go to the CD-RW 
MASTERING menu and select WAV IMPORT, a window opens after 
the VS scans for the CD-RW, the WAV IMPORT screen opens with a 
list of files on the CD. (You may have to open a folder on the CD-
R/RW disc first by clicking “F5 ChgDir”). 
 
Highlight the file to IMPORT and click “F5 Select” and a destination 
screen opens.  Here you select which tracks to send the file to on the 
VS. Select the destination track and use NORMAL under “CONVERT 
TYPE”.  “TO” sets the time position to send the .wav to in the VS 
project. The Track Status lights on the VS light up when you send a 
wav file to them. Once all is set correctly click “F5 OK” to IMPORT the 
file. When the VS shows “DONE” click “F1 Back” to return to the 
IMPORT screen to import more files or click “F6 EXIT” to exit the wav 
import screen. This is a bit brief but you'll figure it out. See pages 354 
to 358 in the Roland manual. 
Note: You can only WAV IMPORT one file at a time. 
 
Now, if you use track export to export to CD and bring that into a PC 
audio program, you need to match the bit rate of 24bit in the audio 
application or have an audio program that will convert 24bit to 16bit if 
needed. Otherwise you can end up with noise in the .wav file when 
listening to it at the wrong bit rate. Anytime you use “Track Export” 
out of the VS, the file will match the projects bits rate and sample 
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rates i.e. a 48k project exports 24bit 48k .wav files. A CDR project 
exports 16bit 44.1k .wav files.  
 
When you use “Wav Import” in the VS the files will be converted to 
match the project. The VS accepts only ISO 9660 format data CDs, a 
standard for most. Just select “Wav Import” from the CD-RW 
Mastering Menu and insert the disc. Say you want to master 48k 
24bit masters you would use “Track Export” to export them to CD out 
of the 24bit 48k project and use “Wav Import” in the 24bit 44.1k 
project to convert them into 24bit 44.1k project .wav files. 
 
TRACK IMPORT(Importing tracks or master tracks from other 
projects) 

1) Open a new project and click on TRACK> select TRACK IMPORT, a 
window opens with a list of all of your songs on your hard drive on 
that partition. 

2) Now Select the track or master tracks to IMPORT, a rectangular box 
will surround it, 

3) Click “F5 Select” to get to that projects mastered V-Tracks or tracks, 
a new TRACK IMPORT window will open. Notice the track’s title is 
there and two areas, SOURCE   and Destination. 

4) In the SOURCE window click on the scroll bar’s UP and DOWN 
arrows to find the track or mastered pair of V-Tracks.  For master 
tracks, Make sure the first song’s LEFT V-Track is selected and 
appears in the small rectangular window under SOURCE. We can 
only Import one side at a time. The RIGHT V-Track will have to be 
done by it self next. So…select “23-16:V. T23-16” first! “24-
16:V.T24-16 next time around. 

5) Next, we have to select the DESTINATION track to send the 
SOURCE V-Track or track too. In the DESTINATION window, 
make sure that the master track “1L-1:V.T 1-1” or your track is 
selected and appears in the Destination window. It should be there this 
first step. If not, use the UP and DOWN scroll arrows to select it. 
Clicking on them moves it 1 track’s full 16 V-Tracks at once. 

6) Now click the “F5 OK” button and answer “Yes” to Are you Sure and 
“YES” to Store Current Project. A progress window will appear. 
When done, move on. 

7) For master tracks: Now Track# 1 has the Left track of the song 
IMPORTED to it. Click TRACK> TRACK NAME> and select “F1 
NAME” and name it the title of the Song. Click “F5 OK” and then 
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click “F5 EXIT” NOW……REPEAT STEPS 1 thru 7. This time 
IMPORT the R side V-Tracks to TRACK 2 in this project, then LEFT 
then RIGHT etc.   

*From what I understand, you can only TRACK IMPORT tracks from 
projects that are in the same sample rate and project mode. To IMPORT 
48k tracks into a 44.1k project, you have to transfer them to PC, burn 
them to a CD then IMPORT the 48k tracks from the CD into the 44.1k 
project. The VS will convert the 48k track to 44.1k using the WAV 
IMPORT feature on the CD-R Mastering menu in the 44.1k project. 
 
PHRASE EXPORT 
Place the time line across the phrase/s to EXPORT. 
1) Click on CD-RW MASTERING menu> select  PHRASE EXPORT> 

in the small PHRASE EXPORT window check mark the 
Phrases/tracks to export. (Only the phrases that the time line is 
touching will show up in this window)  

2) Once they are check marked, they will become highlighted on the 
HOME screen. Insert a CD-R/RW in the CD/DVD Drive and click 
NEXT. It will scan the drive then list the phrases in a new larger 
PHRASE EXPORT window. 

3) In the PHRASE EXPORT window the phrases are listed on the left, 
on the right check mark VERIFY to ON and then the SPEED, I select 
MAX. (If you have problems you can try slower speeds but my DVD 
burner only lets me select MAX.) Click  F5 OK  

4)  Now Working... pops up then a small Phrase Export with [EXIT] and 
a rolling “Now Working...” with blue progress bar. You’ll hear the 
drive speed up and down from time to time. 

5)  When done the smaller Eject Disc window opens and ejects the disc 
then Done... Click the close button on the PHRASE EXPORT 
window and that’s it. 

 
CD-CAPTURE 
Pretty basic, Open a new project, insert the CD in drive. Click on CD-
RW Mastering Menu> Select CD Capture> it’ll scan the CD, then in the 
window that opens you will see a list of the tracks/songs in the bottom 
right quad, highlight to select the track to capture,on the left where it says 
“Destination track” Left click and scroll the Track and V-track number to 
send the left side of the stereo tracks to and the right side just below it 
will follow, select Capture to Zero, Start of track, Capture whole track, 
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then click OK and it should send the track to the new project on the 
destination tracks you selected. 
 
USING A-Punch  
1. Jog the time line to where you want the A-Punch to come in, hold 

down the A-Punch button and press the IN edit button. 
2. Jog to the point where you want the A-Punch to end, hold down the 

A-Punch button and press the OUT edit button. 
3. Jog a ways before the IN point so you have time to get in rhythm with 

the song. 
4. Press Record/Play and then play along with the song. The A-Punch 

will automatically come in on the IN and go out on the OUT. You can 
also get out of it by just pressing the STOP button. 

5. Then hold down the CLEAR button and left click on the A-Punch edit 
flags to remove them. They will interfere with recording a regular 
track later. 

*NOTE: I also PLAY the audio, keep the beat with my hand and 
count 1 and 2 and 3 and 4 etc. Right after 4 on the “And” I press 
STOP and place my edit points or flags. This is usually a silent spot 
between beats. Practicing this will help you to get pretty precise at 
placing these flags. 

 
Manual A-Punch 

1. Jog the time line ahead of the point where you want to punch in and 
press PLAY. 

2. When the time line plays to the point you want to come in, press the 
RECORD button. 

3. Once you have played the part you want just press PLAY or STOP. 
 
*You may want to use the WAV DISP screen to clean up the edit points 
later, just highlight it, right click and select DELETE. I like using the Auto 
A-Punch, the edits in and out are usually cleaner and more precise. 
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So you powered off your 2480 without saving that great live gig you recorded last night? 
 
This document should guide you how to get at least some of the recording back by using 
VSWaveExport Software. 
 
First some clarifications to dampen the optimism: 

• The more fragmented your hard drive is, the lower the chance to get back a long 
continuous recording. This means if you recorded to a freshly formated partition you 
may get back 100%; if you heavily recorded and edited on that partition and the last 
format was 5 years ago, that percentage will be (much) lower 

• Everytime you hit stop and rec during the recording presumably also lowers this 
percentage. This means if you recorded 2 hours nonstop you have good chances to 
find a long continuous bunch of data you can recover 

• Every write operation to the partition in question after the unintentional power down 
will lower the percentage of recoverable data. If you, for example recorded another 
session or used a PC disk repair or recover program you may have overwritten the 
audio data you want to recover. 

 
So, lets get practical now. You have connected the VS internal IDE drive to your PC and the 
PC has recogized the drive? Fine! If you have not connected the drive by now and you are 
unsure of what to do then look out for descriptions on the web on how to connect an IDE 
harddrive to a PC. 
 
Start VS Wave Export. You should get a window like this: 

 
This shows all partitions of the drive. 
Now highlight the partition where your lost data is. 
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Then select ‘Partition Analysis’ from the Extras Menu 

 
 
 

Click onto PartitionX 
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Another window appears: 

 
The partition is now read, note the filecount increasing. This can take a while. When 
everything is finished it will look like that: 

 
The green/black/yellow area is a graphical interpretation of the FAT (File allocation table) 
and indicates used sections (clusters) on your drive. The green and yellow dots mean that a 
known file is allocating these clusters. Note that you can scroll the FAT graphic with the 
scrollbar. The data you are looking for is in the black areas. 
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Now activate ‘Play cluster’ in the ‘upon click in the FAT graphic’ area and select the Mode 
and Samplerate of the project you are looking for: 

 
 
 
OK, now turn your speakers down! If you click a wrong cluster you might get a terrible noise. 
Now move your mouse over the black area of the FAT grafic and click somewhere. VS Wave 
Export will play the content of the clicked cluster, no matter what is in there. 
One cluster equals more or less one second of audio. You should be able to determine what is 
recorded in that cluster. Look out for your gig. You can also set the app to play more than one 
cluster, which may make it easier to identify the material. 
But before doing this you must understand how multitrack recordings are saved by the VS: 
If you record 8 Tracks at the time, the VS will place the audio data  of this 8 Tracks in 
consecutive single clusters. This means that cluster 1 will hold one second of audio data for 
track 1, cluster 2 will hold one second for Track 2, …, cluster 8 holds one second of Track 8. 
After that the next recorded second follows: cluster 9 holds the 2nd second of Track 1, a.s.o. 
Therefore if we just play clusters 1,2,3 we would mixup Tracks. Instead we must play cluster 
1,9,17,25,33, aso to hear Track 1. 
You can do this by setting the ‘offset’ to the number of tracks you recorded at once: 2 for 2 
tracks, 8 for 8 tracks, 16 for 16. 

 

Activate ‚Play cluster’ 

Select Project Parameters 

Enter the number of tracks you recorded 
into the offset field. 
Enter the number of clusters you want to 
play in the count field 
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Every time you click into the FAT graphic the ‘from cluster’ value will be changed to the 
clicked cluster. 
Your task is now to find the right values for ‘from cluster’ and ‘count’ so that a long 
contiuous recording is played. Instead of clicking into the FAT, you can also edit the ‘from 
cluster’ field and hit the ‘Play’ Button to playback the selected clusters. 
You do not need to playback and listen to all selected clusters.  For example, if you recorded 
8 Tracks and found Track 1 starting at cluster 12345 and playing fine through the next 5 
clusters (12345, 12353,12361,12369,12377 and 12385) you could directly go to cluster 16345 
(=12345+500*8) and verify if Track 1 is still playing. If yes, the chance is very good that you 
found 500 consecutive clusters of Track 1. 
But be aware that every green spot (used cluster) in between will break up continuation, as the 
VS cannot use this cluster when recording, it will stop here and continue placing recorded 
data somewhere else. 
 
Once you found a passage that you want to recover, setup all cluster parameters (in the above 
example this would be ‘from cluster’=12345, ‘offset’=8, ‘count’=500) and press the ‘Save as’ 
button, you will be prompted to define where you want to save the recovered data, and to 
choose if it shall be saved as Wave or RDAC Format after that hit save and the file should be 
created. 
You can then continue to search for other contiuous blocks. 
 
After you extracted all data you could find, you can align the recovered data in your audio 
software. As a rule of thumb, consecutive recorded clusters should align perfectly at cluster 
boundaries. This means in the above example Track 1 recovered from clusters 12345, 
12353,12361,… to 16345 should line up with Track 2 recovered from 12346, 12354,12362,… 
to 16346 and Track 3 (12347-16347) a.s.o. 
 
 
Good Luck! 
 
 
Technical Stuff: 
1 cluster on a 10Gig Part formated with the 2480 equals  

• 32768 Bytes equals 32768 24bit samples at MTP or 
• 32768 16bit samples at MT1 or 
• 43680 16bit samples at MT2 
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VS DAO (Disc At Once) Live Recording     By Frank Griffith 
If you have a live recording of a performance with several songs in a roll 
that you want to burn to CD and have track markers for each track on the 
CD do this. 

1) Run the whole recording of the performance thru the Mastering Room 
using CD-R Mode. 

2) When done bring those mastered V-Tracks forward in the home 
screen by selecting them from the tracks 23 and 24’s V-Track map. 

3) Now place CDR Markers where you need them by holding down the 
“CD-RW Mastering” button and pressing “TAP.” This will place 
BLUE MARKERS that will make players recognize it as a Track 
Marker. Place no marker on the first song, it’s placed automatically 
during CD-R Write. 

4) Now you’re ready to burn the whole list of songs to CD-R. Just go to 
CD-RW Mastering Menu and select CD-R Write as you insert a blank 
CD and be sure to select “Disc At Once” MODE in the CD-R Write 
window, MAX speed and OK. That’s it. 

 
To separate each song into its own project, say you have 4 total: 
 
1) PROJECT> COPY the existing project 4 times. Now giving you (4) 
copies of the same project. 
 
2) Open each project, and use REGION CUT to cut out everything that you 
do not want in that project making it a one song project.  
 
3) Also, OPTIMIZE each of the projects to make it smaller, only holding 
one song instead of all four. Rename the projects for each song. 
 
4) DELETE the 3 unused projects you created leaving you with the original 
recording and the single song projects. 
 
If you take the time to NAME THE TRACKS in the original Project, each 
single-song project will also have the names in place.  
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 Settng up a De-esser Effect  
Although there is no specific effect patch for de-essing, Preset 022 (Vocal Multi) may be 
modified for that purpose. Use the following procedure to modify an effects preset to 
serve as a De-esser (in this example, Effect 1 is already set up as Preset 022): 
 
1. Press DISPLAY(HOME) to start from the main screen. 
 
2. Press EFFECT. Press F1(FX1) to choose the first effects processor. 
 
3. Press F3(EDIT) to edit the chosen effects patch. Press F2(Next->) to get to the next 
section of the effect. 
 
4. ''[Vocal Multi] lmt'' is displayed. CURSOR to the ''Mode'' option and choose ''De-
esser'' with the TIME/VALUE dial. 
 
5. Further adjstments for the De-esser effect (Sens and Freq) are now displayed. use 
CURSOR and the TIME/VALUE dial to change the values.  

From Brett’s site…  http://www.rolandvs2480.net/ 

*Basically you can choose one of the VOCAL MULTI presets (P139 thru P148), enter 
the LIMITER module, and you can select LIMITER or DE-ESSER mode. By Karl. 

LDT says…I usually use the analyzer to see which freq the ssss is most prominent to 
choose a freq point. 
 
Try turning the sens up to 50 to make it more audible, but be careful or you'll add a 
lisp to the vocal.  
 
Also bring the DES down to hit it harder (think of it as the threshold on a 
compressor). 

*You can find this info and much more on the VS at Brett’s site... 

http://www.rolandvs2480.net/ 

 

 

http://www.rolandvs2480.net/
http://www.rolandvs2480.net/
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LOOP EFFECTS (known as Send & Return EFX)            By Frank Griffith 
Loop effects work a bit differently, you have to SEND the effect thru the aux 
bus and RETURN it thru the FX RTNs (Effects Returns).   
PRESS TR 1-16. If you want to LOOP an EFFECT to a vocal TRACK 
that’s recorded on TRACK #5 here’s what you do. First, go to EZ-Routing> 
Routing View> and under “TRACK ASSIGN” you see the FX RTN Block 
with 1 thru 8 they match EFFECTS 1 thru 8, make sure nothing is connected 
from the FX RTN to the track you are recording too, the RECORDING 
TRACK number, which in this case is TRACK#5, we only use this when 
bouncing TRACKs with effects or adding effects to INPUTs for 
recording/printing effects and will cause feedback if connected at this time. 
Before you will hear an effect you have to PRESS IN 17-24/AUX MST 
Fader Button and make sure the AUX1 thru AUX8 Faders are set to 0db, 
then PRESS TR 17-24/FX RTN Fader Button and make sure FX RTN1 thru 
FX 8 Faders are set to 0db. Now PRESS TR 1-16 from the TRACK MIXER 
and then click HOME. *In theory, you are NOT adding the reverb to the 
tracks or inputs, you are routing their signal thru the master bus where the 
reverb is applied thru FX RTNS & AUXS. 
 
Now, PRESS the CH-Edit button above TRACK #5 and on the 
Dynamics/Compression and EQ Parameter graph screen at the bottom, find 
the AUX knobs. AUX 1 thru AUX 8 are routed to EFFECTS 1 thru 
EFFECT 8. These AUX knobs will control the amount of an effect to be 
used on a TRACK. Let’s say you have a REVERB you want on this vocal 
TRACK #5. Click on EFFECTS -> Select EFFECT 1-> a window opens, 
click on the “F1 PATCH”, in this window highlight P001 Reverb 2 and click 
“F5 SELECT”, now it is listed above SELECT as the “CURRENT” one 
patched in. (You can use the scroll bar arrows to find other effects patches 
when needed) Now click on “F6 EXIT” twice to back out of the EFFECTS 
window.  
 
Now you can turn up the AUX1 knob to 0db to add this EFFECT to the 
TRACK MIXER and TRACK#5. Now PRESS Play to hear the vocal track 
with reverb. Make sure TRACK #5’s TRACK STATUS Button is lit 
GREEN for PLAYBACK. 
 
Now, to adjust the amount of REVERB from EFFECT 1 that you want 
added to the Vocal TRACK #5 just PRESS the CH-Edit Button above 
TRACK 5’s Fader and use the AUX1 knob to turn it up or down with your 
mouse by Left Clicking and holding and moving your mouse up or down, or 
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you can click on the AUX parameter to select it and use your JOG wheel as 
a knob.  
 
Remember, Fader button IN 1-16/Solo takes you to the INPUT MIXER and 
FADERS and Fader Button TR-1-16/Master Edit takes you back to the 
TRACKS MIXER and FADERS. You can use the Fader Buttons IN 17-24 
and TR 17-24 in this same way. All INPUTS and TRACKS have their own 
CH-Edit page with Dynamics, EQ, Auxs and EFFECTS.  
 
LOOPED EFFECTS ON INPUTS (To print/record effects) 
To LOOP an EFFECT to an INPUT you would do the same as above. Have 
your EFFECT already PATCHED in, like P001 Reverb 2, and PRESS IN1-
16, find your INPUT, PRESS its CH-Edit button, and turn up the proper 
AUX knob. 
 
Now here’s what’s different. Go to EZ-Routing> Routing View> and in the 
left hand bottom side of the screen under “TRACK ASSIGN” there is a FX 
RTN1 thru 8. To complete the LOOP to the INPUT, you must connect that 
FX RTN number to the TRACK (on the RECORDING TRACK block) that 
the INPUT is sending it’s signal too. Let’s say you have a mic on INPUT1 
recording a vocal to TRACK #5, and you are adding the reverb of EFFECT1 
to it, then FX RTN1 must be connected to TRACK #5 to complete the 
LOOP for recording the reverb to that TRACK. This same connection has to 
be made when bouncing tracks with effects too. That’s the only way the 
effect will get recorded/printed with the track. 
 
Now, what's odd or can be a bit confusing is this, when you have a track 
recorded dry and you want to add a reverb to that dry track to be heard 
during playback or recorded  during mastering, you do not have to connect 
the FX RTN virtual cable to the destination tracks, that routing is done 
automatically on the track mixer for recording it in the mastering room to 
master stereo V-Tracks.  
 
INSERT EFFECTS 
First off, you need to know, each fader has two buttons above it. The first 
one is the TRACK STATUS Button. GREEN for PLAY, Blinking RED for 
ready to RECORD or ARMED, steady for recording and no color for OFF. 
The second button just above the TRACK STATUS Button is the CH-Edit 
Button, (channel edit). This button brings up a screen for each TRACK & 
INPUT and has your Dynamics/Compression and EQ Parameter graphs, 
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your INSERT EFFECTS and all of your AUX Busses on it. (Plus many 
other things we won’t worry about now.) 
 
On the CH-Edit page you can add INSERT or (Send & Return) LOOP 
Effects to the INPUTS and/or the TRACKS. All of them. When you PRESS 
TR 1-16 Fader Button (above the master red fader), the CH-Edit Button on 
each TRACK will open for use. When you PRESS IN 1-16, the CH-Edit 
Button will now open for use with the INPUT you are on. Each TRACK and 
INPUT has it’s own CH-Edit Button and page of EQ, Compression and 
EFFECTS abilities. Now let’s add an INSERT EFFECT to an INPUT to 
PRINT it when we record. 
 
PRESS IN 1-16/Solo button above the master red fader. Now your faders are 
set for INPUTS. If you are adding an EFFECT on INPUT #1 then PRESS 
the CH-Edit button above fader #1. The page with EQ and Compression 
graphs on it will fill the screen. Below the Compression graph is where you 
will find the EFFECT INSERT and under it, FX1 thru FX8. If you are using 
the EFFECTS Processor #1, then click on FX1 once. (It has 4 positions) You 
want the first position for now. See “VS INSERT EFX.doc” for more about 
these positions. 
 
Now Patch in your EFFECT by clicking on EFFECT> then EFFECT#1> a 
window opens, select the "F1 PATCH”, now in this window, highlight the 
effects patch you want to use, by default P000 is usually highlighted black, 
select P001 Reverb 2 for this exercise and click the "F5 SELECT”> then “F6 
EXIT”> twice. 
 
Now click HOME and above the Red Master fader, PRESS IN 17-24/AUX 
MST and make sure all AUX FADERS are set to 0db, then PRESS TR 17-
24/FX RTN button and make sure all of the FX RTN faders are set to 
0db(especially the one you are using, fader AUX1 &  FX1 for EFFECT1). 
Down the road you will need these up for LOOPED effects so it’s good to 
have them setup all the time anyway. 
 
Now, when you record INPUT #1 to any TRACK, the EFFECT Patch you 
selected to use, P002 Reverb 2 or any you may have chosen, will be printed 
to the TRACK as long as you connect the FX RTN of that EFFECT number 
to the DESTINATION Track in the RECORDING TRACK block.  
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How do you route and input? Click on EZ Routing> Routing View> and on 
the left hand side of the screen find INPUT MIXER with 1-24. INPUT #1 
can be clicked on, it'll turn blue and the other end of it can be dragged to any 
of the RECORDING TRACKS 1-24 below the INPUT MIXER. By default 
INPUT 1 is connected to RECORDING TRACK 1, 2 to 2, 3 to 3 etc. (You 
can connect any INPUT to any TRACK or several if you want.) Once you 
connect you input where you want it, click HOME. Now arm your track to 
record and record the INSERT EFFECT with your track.  
 
For this next part, keep in mind all AUX busses and FX RTNs numbers 
match the EFFECTS Processors numbers. EFFECT 1 routes thru AUX 1 and 
FX RTN 1, EFFECT 2 thru AUX 2 and FX RTN 2 and so on. 
 
EFFECTS, COMPRESSION & EQ IN BRIEF 
When you press the IN 1-16 fader button above the red master fader, all of 
the CH-Edit button on that bank take you to the INPUT side and you can add 
Compression, EQ, Insert & Loop Effects to the INPUT signal that gets 
recorded to the TRACK. For more on Dynamics & EQ Parameters see “VS 
EQ Bass&Kick.doc.”  
 
When you press the TR 1-16 fader button, all of the CH-Edit buttons now 
take you to the TRACK side and you can add Compression, EQ & Effects to 
already recorded tracks or to tracks while they are being recorded. That way 
you can hear the effect while recording but not actually record the Effect, 
Compression or EQ. Effects, EQ and Compression added to the track side 
only gets recorded when you are mastering your song or if you bounce a 
track with effects. See “VS SUB MIXES.doc” for more on bouncing tracks 
with effects and for more on Dynamics & EQ Parameters see “VS EQ 
Bass&Kick.doc.”  
 
*See VS Manual for a list of which effects are used as Insert and which you 
should use as a Looped effect.  
 
SOLOing EFFECTS on a SOLOed Track 
Go to your FX RTN Screen by pressing  

1) TR17-24/FX RTN then press 
2)  Channel Edit button of the FX to solo. 
3) Solo button over fader on VGA (next to MIX & MUTE). 

 
USER PATCHES (Edit and Save)  
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Page 224 in my 2001 Roland manual explains how to save regular patches as 
user patches. 
 
Basically, on any effect you just do this... 
Click Effect> Select an Effect1 thru 8>>  
 
Click [F1 PATCH] If a “P” is before the effect number it’s on the PRESET 
list, if “U” is before the numbers it’s on the USER list. Start with a PRESET. 
Then highlight a patch/effect and click [F5 SELECT], now this effect is 
selected. 
 
Click [F6 EXIT] to get to the edit button. 
  
Click [F3 EDIT] then make your adjustments then  
 
Click [F5 Save] to view the EFFECT PATCH SAVE screen. 
In this window, a USER memory location patch will be highlight, the one 
you created will replace the one you have selected.   
 
Next click [F1 NAME] then name the patch what you want or leave it 
named as is and then you Click [F5 OK].  It asks if you’re sure, click YES 
and you're done. The effect window is still open so click [F6 EXIT]. 
 
When you select an effects processor and click [F1 PATCH] you’ll see [F1 
PRESET] and [F2 USER]. You can get to the PRESET list or USER list. 
What’s cool is you can get to this new USER patch you saved, from any 
Effects VS8F-2 card in the VS machine. 
*You do not have to save the project to save this effects edit, weird but true. 
Good luck, Frank.  
 
*NOTE: VS8F-2 cards fill up 2 Effects under EFFECT. Effect1 thru 8 equals 
four of the VS8F-2 Cards 1 thru 4, or Slots “A” thru “D” inside the unit 
under a back panel. EFFECT1 thru 8 equals AUX1 thru 8 and FX RTN1 
thru 8. Some EFFECTS use up the whole card but most are mono. You can 
select them as left & right and split up the effects into a total of 16 effects.  
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EQing Bass & Kick 
The “Q” is default at 2.00, it’s the bottom row of knobs under the EQ graph. 
These can be turned up to 5.00 or more and that’ll make the middle red 
arrows on the graph have a sharp point when you drag them upward or a 
sharp dip when you drag them downward. Once you do that you can sweep 
them left & right to find certain frequencies in the signal that may sound bad 
or good. The good ones you want to drag up, the bad ones you want to drag 
down. That’s how you first, find the frequencies in question then carve a hole 
in them to either get rid of a signal or carve a hole to let another signal come 
through. 
 
Now, Press the CH-Edit button of the bass track to get to the Parametric EQ 
graph. Take your bass guitar track and bring it up about 1-3kh in the 
parametric EQ by grabbing the second red arrow from the right and dragging 
it up. Now turn the “Q” knob, the one on the left and turn it up to around 
5.00.  This is the bass "burp" area of the frequency. This is called a notch. 
 
 
Now, while the bass is playing...solo out the bass and kick...left click and 
grab the second red arrow from the left side of the EQ graph notch and 
sweep that kick frequency back and fourth (left & right), you will notice at 
one point that... 
 
Your kick drum will "disappear" some what, when sweeping (moving the red 
arrow notched back and fourth)...this is where your bass and kick are sharing 
the same frequency. Take that frequency and drag it all the way down to 
carve out a hole in your bass track so the kick can come through. Adding 
anything below 200Hz can add muddiness to the bass track so keep that in 
mind. 
 
 
Now take between 40 and 60hz on the kick channel and slowly turn it up 
until the low end on both the kick and the bass is clearly heard at around the 
same increase in decibels. Now take and grab the red arrow around 4-6k on 
the kick and turn that up by dragging the red arrow up until your kick gets 
the desired amount of "crack". 
 
By notching and sweeping both tracks you can find the frequencies that you 
want add too and cut away. Experiment with this on both the bass and kick 
tracks till both sound right to you. Only you can hear this and decide what 
sounds best. The bass and kick are so close that in some cases they over lap 
the same frequencies so carving out holes in one or both can help to hear 
each better in the mix.  
 
Using Filters, LP, HPF, BPF & BEF 
Lo-Pass, Band Pass, Band Eliminate and Hi-Pass filters in the VS EQ section are 
very important things to work with in any mix. Usually, by default they are set to 
OFF, the "F" (Freq) @ 1.00k Hertz and the Q @ 0.71. If not then you can check it 
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out by clicking on the "OFF" and a small menu pops ups with Off, LPF, HPF, BPF 
& BEF options for setting the EQ graph to one of these choices. These are 
important for general purpose use, the HPF, BPF BEF & LPF. Low pass means 
just that. The graph will cut off the high frequencies so only the low frequencies 
pass through, hence Low Pass Filter.  Band Pass cuts off the Hi and Low 
frequencies, Band Eliminate cuts only the middle and Hi Pass cuts off the low 
frequencies so only the Hi frequencies pass through. 
  
These are used in conjunction with the "F" and "Q" knobs to set where the 
frequency cut off begins and how sharp or flat the curve of the cut off is. That 
way you can set the graph to cut off higher or lower than the default setting to 
match it better with what you are hearing on a track.  
  
Using the LPF on your bass and kick will help to keep the bass and kick from 
bleeding over into the mids and mudding them up. You have to listen to the track 
by its self when setting these to really hear what's happening then with the mix to 
see how it sits in the mix. 
  
Using the HPF on you cymbals, lead guitars, higher vocals etc can also help to 
keep the mids from sounding muddy.  
  
The BPF can be used on instruments that are in the mids like rhythm guitars and 
other instruments but I would adjust it a bit more open than the default. 
  
Using the BEF for finding bad frequencies such as hums and noises will help to 
clean up any problems in a signal and eliminate it. Also you can use it on a Bass 
or kick to carve out an area for one or the other to come out in a mix. The Bass 
and kick sit in the same are of frequencies and if the kick is being hidden behind 
the bass guitar then use this on the bass and see if you can place that dip in the 
area where the kick sits, allowing it to come though the mix. 
  
These are brief descriptions of what these filters are and how to use them so 
research more about EQ in your VS manual and on line, read up on frequencies 
and where each instrument sits in the frequency range, and how others are using 
these filters.  
 
Analyzer and Freqs 
Using the ANALYZER on the UTILITY menu is another good tool for find out 
what frequency range an instrument or vocal is made up of. Click on UTILITY> 
Select Analyzer and it appears where the meters were on your HOME screen. 
The A, B, C, D stands for effects processor slots so pick an effects processor 
that’s not in used by checking the letter that corresponds then select the Track or 
Input for SOURCE ie TR1 or IN1. You should be able to figure it out easy 
enough. Play the track or if it’s an input play the instrument that’s connected to 
that input.  
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Stuff you can do to de-muddy a mix: 
#1) HPF: Use it on EVERY TRACK! Let your ears be your guide, but 
here's a rough guide to get ya started: 

 BAS - 40Hz  
 GTR - 80Hz  
 VOX - 120Hz  
 OTHER - 100Hz                           Karl Lakestone VSP 

Here’s a good link to start with about using EQ. 
http://www.trinitysoundcompany.com/eq.html  
 
Here is the bulk of the material from that web site… 
Understanding EQ and its Effects on Signals  
There are two areas of equalization that I want to cover. Those two areas are vocals and 
music. I'd like to discuss the different effects of frequencies within audio signals. What 
do certain frequencies do for sound and how we understand those sounds. Why are some 
sound harsh? Why do things sound muddy? Why can't I understand the vocals? I'll try 
and answer all of these question and hopefully bring some light to the voodoo world of 
EQ.  

   

Vocals  
Roughly speaking, the speech spectrum may be divided into three main frequency bands 
corresponding to the speech components known as fundamentals, vowels, and 
consonants.  
Speech fundamentals occur over a fairly limited range between about 125Hz and 250Hz. 
The fundamental region is important in that it allows us to tell who is speaking, and its 
clear transmission is therefore essential as far as voice quality is concerned.  
Vowels essentially contain the maximum energy and power of the voice, occurring over 
the range of 350Hz to 2000Hz. Consonants occurring over the range of 1500Hz to 
4000Hz contain little energy but are essential to intelligibility.  
For example, the frequency range from 63 to 500Hz carries 60% of the power of the 
voice and yet contributes only 5% to the intelligibility. The 500Hz to 1KHz region 
produces 35% of the intelligibility, while the range from 1 to 8KHz produces just 5% of 
the power but 60% of the intelligibility.  
By rolling off the low frequencies and accentuating the range from 1 to 5KHz, the 
intelligibility and clarity can be improved.  
Here are some of the effect EQ can have in regards to intelligibility. Boosting the low 
frequencies from 100 to 250Hz makes a vocal boomy or chesty. A cut in the 150 to 
500Hz area will make it boxy, hollow, or tube like. Dips around 500 to 1Khz produce 
hardness, while peaks about 1 and 3Khz produce a hard metallic nasal quality. Dips 
around 2 to 5KHz reduce intelligibility and make vocals woolly and lifeless. Peaks in the 
4 to 10KHz produce sibilance and a gritty quality.  

http://www.trinitysoundcompany.com/eq.html
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Effects of Equalization on Vocals  
For the best control over any audio signal, fully parametric EQ's are the best way to go.  

   

80 to 125  

160 to 250 

315 to 500 

Sense of power in some outstanding bass singers.  

Voice fundamentals 

Important to voice quality 

630 to 1K 
Important for a natural sound. Too much boost in the  

315 to 1K range produces a honky, telephone-like quality. 

1.25 to 4K  

5 to 8K 
Accentuation of vocals  

   
Important to vocal intelligibility. Too much boost between 2 and 4KHz  
can mask certain vocal sounds such as 'm', 'b', 'v'. Too much boost between  
1 and 4KHz can produce 'listening fatigue'. Vocals can be highlighted at the 3KHz  
area and at the same time dipping the instruments at the same frequency.  
Accentuation of vocals:  
The range from 1.25 to 8K governs the clarity of vocals. Too much in the area of 5 to 
16K can cause sibilance.  

   

Instruments  
Mic'ing instruments is an art ... and equalizers can often times be used to help an engineer 
get the sound he is looking for. Many instruments have complex sounds with radiating 
patterns that make it almost impossible to capture when close mic'ing. An equalizer can 
compensate for these imbalances by accenting some frequencies and rolling off others. 
The goal is to capture the sounds as natural as possible and use equalizers to straighten 
out any non-linear qualities to the tones.  
Clarity of many instruments can be improved by boosting their harmonics. In fact, the ear 
in many cases actually fills in hard-to-hear fundamental notes of sounds, provided the 
harmonics are clear. Drums are one instrument that can be effectively lifted and cleaned 
up simply by rolling off the bass giving way to more harmonic tones.  
Here are a few ideas on what different frequencies do to sounds and their effects on our 
ears.  
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31Hz to 
50Hz 

These frequencies give music a sense of power. If over emphasized 
they can make things muddy and dull. Will also cloudy up some 
harmonic content. 

80Hz to 
125Hz Too much in this area produces excessive 'boom'. 

160Hz 
to 
250Hz 

This is the problem area of a lot of mixes. To much of this area can take 
away from the power of a mix but is still needed for warmth. 160Hz is 
a pet-peeve frequency of mine. Also, the fundamental of bass guitar 
and other bass instruments sit here. 

300Hz 
to 
500Hz 

Fundamentals of string and percussion instruments. 

400Hz 
to 1K 

Fundamentals and harmonics of strings, keyboards and percussion. This 
is probably the most important area when trying to control or shape to a 
natural sound. The 'voice' of an instrument is in the mids.  

To much in this area can make instruments sound horn-like. 

800Hz 
to 4K 

This is a good range to accentuate instruments or warm them up. Too 
much in this area can produce 'listening fatigue'. Boosts in the 1K to 2K 
range can make instruments sound tinny. 

4K to 
10K 

Accentuation of percussion, cymbals, and snare drum.  

Playing with 5K makes the overall sound more distant or transparent. 

8K to 
20K 

This area is often what defines the quality of a recording or mix. This 
area can also help define depth and 'air' to mix. Too much can take 
away from the natural sense of a mix by becoming shrill and brittle. 

   
Here are a few other pin point frequencies to start with for different instruments. In a live 
sound situation, I might event pre set the console's eq to these frequencies to help save 
time once the sound check is under way. These aren't the answers to everything... just a 
place to start at.  
Kick Drum:  
Besides the usual cuts in the 200Hz to 400 area, some tighter Q cuts at 160Hz, 800Hz and 
1.3k may help. The point of these cuts makes for space for the fundamental tones of a 
bass guitar or stand up. I have also found a high pass filter at 50Hz will help tighten up 
the kick along with giving your compressor a signal it can deal with musically. 5K to 7K 
for snap.  
Snare Drum:  
The snare drum is an instrument that can really be clouded by having too much low end. 
Frequencies under about 150Hz are really un-usable for modern mixing styles. I would 
suggest a high pass filter in this case. Most snares are out front enough so a few cuts 
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might be all that is needed. I like to start with 400Hz, 800Hz, and some 1.3K. This are 
just frequencies to play with. Doesn't mean you will use all. If the snare is too transparent 
in the mix but I like the level it is at, a cut at 5K can give it a little more distance and that 
might mean a little boost at 10K to brighten it up.  
High Hats:  
High hats have very little low end information. I high pass at 200Hz can clean up a lot of 
un-usable mud in regards to mic bleed. The mid tones are the most important to a high 
hat. This will mean the 400Hz to 1K area but I've found the 600Hz to 800Hz area to be 
the most effective. To brighten up high hats, a shelving filter at 12.5K does nicely.  
Toms and Floor Toms:  
Again, the focus here is control. Most toms could use a cut in the 300Hz to 800Hz area. 
And there is nothing real usable under 100Hz for a tom... unless you are going for a 
special effect. Too much low end cloud up harmonics and the natural tones of the 
instrument. Think color not big low end.  
Over Heads:  
In my opinion, drum over heads are the most important mics on a drum kit. They are the 
ones that really define the sound of the drums. That also give the kit some ambience and 
space. These mics usually need a cut in the 400Hz area and can use a good rolling off at 
about 150Hz. Again, they are not used for power.... these mics 'are' the color of your 
drum sound. Roll off anything that will mask harmonic content or make your drums 
sound dull. Cuts at 800Hz can bring more focus to these mics and a little boost of a 
shelving filter at 12.5K can bring some air to the tones as well.  
Bass Guitar:  
Bass guitar puts out all the frequencies that you really don't want on every other 
instrument. The clarity of bass is defined a lot at 800Hz. Too much low end can mask the 
clarity of a bass line. I've heard other say that the best way to shape the bass tone is to roll 
off everything below 150Hz, mold the mids into the tone you are looking for, then slowly 
roll the low end back in until the power and body is there you are looking for. If the bass 
isn't defined enough, there is probably too much low end and not enough mid range 
clarity. Think of sounds in a linear fashion, like on a graph. If there is too much bass and 
no clarity, you would see a bump in the low end masking the top end. The use of EQ can 
fix those abnormalities.  
Guitar/piano/ etc.:  
These instruments all have fundamentals in the mid range. Rolling off low end that is not 
needed or usable is a good idea. Even if you feel you can't really hear the low end, it still 
is doing something to the mix. Low end on these instruments give what I call support. 
The tone is in the mids. 400Hz and 800Hz are usually a point of interest as are the upper 
mids or 1K to 5K. Anything above that just adds brightness. Remember to look at 
perspective though. Is a kick brighter than a vocal? Is a piano bright than a vocal? Is a 
cymbal brighter than a vocal?  

   

In Closing  
Equalizers are one of the most over looked and misused pieces of gear in the audio 
industry. By understanding equalizers better, an engineer can control and get the results 
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he or she is looking for. The key to EQ'ing is knowing how to get the results you are 
looking for. Also, knowing if it’s a mic character or mic placement problem. EQ can't fix 
everything. It can only change what signal it’s working with. Equalizers are also a lot 
more effective taking away things in the signal than replacing what was never there.  
Another link to good info on EQing… 
http://www.recordingwebsite.com/articles/eqprimer.php 
 
Here's the FREQS for each instrument, drums, vocal etc... 
Listen to a track you have recorded and if it needs more of something ie fullness or less of it then 
this list will help you to know where to find these freqs to add or cut freqs according to your own 
taste. 
  
Bass Guitar == Bottom @ 50 - 80Hz;   Attack @ 700Hz;  snap @ 2.3kHz 
Kick Drum == Bottom @ 80 - 100Hz;  Hollowness @ 400Hz;  Point @ 3-5kHz 
Snare == Fatness @ 120 - 240Hz;  Boing @ 900Hz;  Crisp @ 5kHz;  Snap @ 10kHz 
Floor Toms == Fullness @ 80 - 120Hz;  Attack @ 5kHz 
Toms == Fullness @ 240 - 500Hz; Attack 5 - 7kHz 
HiHat & Cymbals == Clang @ 200Hz;  Sparkle @ 8 - 10kHz 
Congas == Ring @ 200Hz;  Slap @ 5kHz 
Elec. Guitar == Fullness @ 240 - 500Hz;  Presence @ 1.5 - 2.5kHz 
Acoustic Guitar == Fullness @ 80+Hz;   Body @ 240Hz;  Presence 2 - 5kHz 
Organ == Fullness @ 80+Hz;  Body @ 240Hz; Presence @ 2 - 5kHz 
Piano == Fullness @ 80=Hz;  Presence @ 2.5 - 5kHz, Honk @ 2.5kHz 
Horns == Fullness @ 120Hz; Piercing @ 5kHz 
Voice == Full @ 120Hz;  Boomy @ 240Hz; Presence @ 5kHz; Sibilance 5kHz;  Air @ 5 - 10kHz 
Strings == Fullness @ 240Hz;  Scratchiness @ 7 - 10kHz 
 
Compression on Bass Guitar 
Threshold: -4dB 
Ratio: Between 2.5:1 and 3:1 
Attack: Between 40 ms and 50 ms 
Release: About 180 ms 
Gain: Adjust to taste, don't need too much but even out the in and out meters if you can. 
The Higher the ratio, the louder it may sound as well. 
 
Nothing is set in stone here, every bass and player is different. 
 
By Lakestone Karl on VSP 
Here's my latest bass EQ scheme: 
 
RECORDING (INPUT MIXER): 
I use the DI'd BASS PATCH on the -2 card. 
I also use a "USER PATCH", a PEQ set up for My Bass.  
HPF @ 40Hz (for 4-string bass, 32 Hz for 5-string bass) 
 
PLAYBACK: 
I use the COMPRESSED BASS PATCH on the -2 card. 
HPF @ 40Hz (for 4-string bass, 32 Hz for 5-string bass) 
LoShelf -3dB @ ~250-300 
LoMid -2dB @ 120Hz 
HiShelf (if needed) 
 
After you set this much up, raise the Q of the HPF to restore the very low end of the bass. 
 

http://www.recordingwebsite.com/articles/eqprimer.php
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By Waterman on VSP 
I always HPF the bass starting 40Hz, lately I've been going as high as 60hz (but that's because 
I've been doing an acoustic 3 piece with no drums). 
 
Most bass mud is in the 250-500hz range I'll notch that out a few db.  
Attack or pluck is increased at 700 to 1k 
Bottom added at 60 to 80 Hz 
String noise at 2.5k 
boost added around 1 to 2k 
 
compression: 
2.5 gain 
threshold 17db 
attack 7ms 
release 233ms 
I never use autogain, I set that by ear and also watch the meter to see much I'm compressing the 
signal. 
 
 
SIDE CHAINING                                                    by headwerkn2 on VSPlanet 
Within the Channel or Track View screen you can select the side  chain input to 
the compressor - on the Roland VS is this called Key In. Obviously Roland 
couldn't call it "Side chain In" because that would have been too logical ;-) 
 
This from the VS2480 manual (VS2400 is similar except it doesn't have the 
EXP+COMP option). 
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This is the VGA view (from the VS2400 manual) 
 

 
 
By default it's set to the actual input you're editing eg. track 1 for track 1, etc. 
etc. so that the compressor is operating off its source signal - usual compressor 
operation. You can adjust the Key In input to another track, which will give you 
a side chain type setup. 
 
For example, if you wanted to use the Kick Drum on Track 1 to compress the 
Bass on Track 7 so the kick 'punches through' the bass - a pretty typical 
dance/techno effect that also works well with rock drums - you'd set KeyIn on 
Track 7's compressor to TR 1. The kick's attack will then trigger the bass's 
compressor. 
 
The track being used to control a compressor doesn't need to be audible and 
can exist solely to control another track's compressor. If you don't want to 'lose' 
a playback track solely for side chaining another track's compressor, you can 
set Key In to an Input channel and sequence or play in real time the 'keying' 
track from another source, like a keyboard or even an oscillator/sound 
generator to create tremolo effects. 
 
Another use is 'look ahead gating', where a gate effect (EXP) is triggered by a 
copy of the track being gated that is moved ahead a few milliseconds... this 

http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Number=1106171&gonew=1##
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way the gate itself opens just before the attack of the source material, 
allowing strong/effective gating without affecting the transients adversely. 
Most newer compressor plug-ins actually have this option inbuilt now. 
 
http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Number
=1106171&gonew=1#UNREAD 
 
 
 
 
 
 
 
 
  
 
 

http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Number=1106171&gonew=1#UNREAD
http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Number=1106171&gonew=1#UNREAD
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ERASE SILENT PARTS          By Frank Griffith 
Once you are through recording all of your tracks you might have places in 
between vocals and lead guitar solos that you want to get rid of, erase them 
from the background to eliminate the extra room noise. A simple way to do 
this is to…. 

1) Left Click and hold the cursor at the beginning of the piece of track to 
erase… 

2) Drag the mouse to the left, to the end of the piece to ERASE and then 
let go… 

3) Place the mouse cursor in the highlighted area of the piece to erase… 
4) Right Click and select ERASE from the drop-down menu. 

 
To get a more precise edit point for placing the IN and OUT  points, select 
the TRACK so it is highlighted then…. 

1) Place the time line on your IN point and PRESS the WAVE DISP 
button, check that your IN point is in between beats and not on a 
signal, a quiet spot, Press WAVE DISP to zoom back out… 

2) Now we’re on full screen, JOG the time line to the OUT point and 
PRESS the OUT button, the check it on the WAVE DISP again and 
back as above… 

3) Click on TRACK> and select REGION ERASE and a window opens 
4) Click on “F1 Sel Trk” and in the next window… 
5) Place a check mark in the box next to the Track number you are 

ERASING from… 
6) Now click “F5 OK” and answer YES to “REGION ERASE Sure?” it 

will display “Done.” 
7) To shut the REGION ERASE window click on “F6 EXIT” and you’re 

done. 
8) Click HOME to get out of the WAVE DISP display. To CLEAR out 

the edit flags HOLD the CLEAR button and PRESS the IN, OUT and 
TO buttons and the flags are gone. 

 
If you had trouble jogging in small enough increments you can go to the 
TRACK TIME DISPLAY area of the HOME screen and with your mouse 
click on one of the 2 digits to move the yellow under-line from “h” to “m” to 
“s” to “f” to jog in hours, minutes, seconds or frames. Frames are good for 
the smallest increment. You can also PRESS on the left & right CURSOR 
buttons above the jog wheel to do the same. Another reason to erase the 
silent spots is to get rig of any noises the singer made or guitarist in between 
parts. If this leaves a void in the mix then record a whole track of the mic at 
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the same level the singer sang at and edit that in later to add space to the mix 
without the noise of the singer grunting, coughing or breathing. You would 
be surprised at what does get recorded between segments like this. 
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VS with External Effects Units from VSP By Karl & Others 
All I want to do is record vocal tracks 3-4 thru my external effects and 
back into the 2480 on trks 7-8 using a wet and dry signal input. I want 
to use trks 23-24 for the effects and trks 3-4 (orig dry signal). Then 
rec them both to trks 7-8. So therefore I have the dry signal recorded 
with the wet signal on 7-8 trks.OK, try this.... 
 
Reply 
You have dry tracks on 3/4, and your FX coming in on 23/24. You 
want to mix them to 7/8. 
 
OK, first select Fader Bank TR1-16. Press and hold the Track Status 
button over Fader7 until the EZRouting screen is displayed, and all the 
buttons begin to blink. 7/8 don't blink, cause that's your chosen 
destination track pair. 
 
Now, press the CH EDIT button over Track3. This connects Track3/4 to 
Track7/8. 
 
Now, while the buttons still flash, select FaderBank IN17-24, and press 
the CH EDIT button over Fader23. Now, both Track3/4 AND 
Input23/24 are routed to Track 7/8. Exit the EZRouting screen. 
 
That's it, you're there! No AUX busses required! Simply record on 7/8, 
dry volume on 3/4, wet volume on Input23/24. 
 
Notice you are NOT actually recording the Wet signal by itself, and are 
NOT using any Track Mixer channels for the Wet signal. 
 
 
 
 
More on External Effects 
I want to route recorded tracks 1-8 (drums)out to a pair of dbx 160x 
comp/limiter. Via a pair of stereo buss's hit them fairly hard and then 
route back into a pair of tracks and tuck them underneath the original 
tracks. However getting a little confused here in terms of how to get 
the original tracks to a pair of buss's. Thanks 
 
 
Reply By Karl 
First step is to LINK a pair of AUX busses. Go to the MIXER->MASTER 
EDIT menu, and LINK AUX3&4, for example. 
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Now go to each of the 8 drum tracks, and create a mix that will feed 
the outboard gear, using the AUX3/4 SEND and PAN controls. 
 
In the OUTPUT ROUTING area, drag the AUXA_LR_OUTPUT to the 
AUX3&4 buss. Connect the AUXA_LR outputs to your outboard gear. 
Remember that the AUX3/4 MASTER FADER will also control the mix 
going to the outboard gear. 
 
Explained Again by Karl 
You treat the OUTPUT OF THE EFFECT the same as any other input. 
Bring it in thru an input channel, either thru an analog or digital input. 
If all you want to do is have the XFX appear on the MIX bus, all you 
need is the MIX button turned on for whatever input channel(s) you 
have used. If you wish to print the FX to a track(s) for further 
processing, then you must record it, just like any other input (synth, 
etc.) 
 
Now, getting the signal from the 2480 to the XFX kind of depends on 
what you are sending. If it's only a single track, you can use the 
DIRECT outs in the CH.EDIT screen. But if it's a group of tracks, you 
will need to use an AUX buss to sum the tracks and send them to the 
XFX. Either way, you connect one of the ANALOG OUTS to either the 
selected DIR or AUX buss. 
 
By Karl one more time… 
By default, AUXA and AUXB outputs (Output jacks 3, 4, 5, and 6) are 
routed to AUXBUSS1, 2, 3, and 4. Confusing. 
 
So I go in to the EZ ROUTING screen, in the OUTPUT ASSIGN section, 
and connect AUXA to AUX3/4 and AUXB to AUX5/6. Much easier to 
understand. 
 
OK, so now, on the kick drum channel, when you raise the AUX4 
SEND, the kick goes out JACK4 in the back of the 2480. You can send 
as many thing as you wish out JACK4 at the same time by adding 
other tracks via their AUX4 SEND levels. 
 
Bring the FX back into an input channel, just like you would a mic or 
synth. You can choose to print the FX return, or simply allow it to 
enter the mix via the INPUT channel. 
 
External Effects by Calypso on Virtual Planet. 
It is just like using an internal effect, but you need to route the AUX 
bus to one of the analog outputs, run a cable to your effect, run a 
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cable from the effect output to one of the analog inputs (1-16), and 
route that input to an empty recording track. Now you can "SEND" 
signal to the AUX bus and it will return to a new recording track. 
 
To avoid feedback, turn off the "MIX" button on the INPUT channel 
where the effect comes back into the 2480. (The input channels send 
signal to the master bus mix when the machine drops out of RECORD 
mode.) 
 
To use the effect purely as an insert, turn off the "MIX" button on the 
dry track you are using as the source - then you will only hear the 
return track with the effect already applied in the mix. (In this case 
you will probably be sending all of the signal to the AUX bus.) This is 
preferred over using the "solo" button. 
 
The internal effects have their own "busses" inside the machine which 
makes it simple. An external effect has to come back through an 
INPUT channel before it can go to a new recording track. Once you get 
that INPUT leveled, removed from the mix and routed to an empty 
recording track then everything is golden. 



To turn the faders On or off…  
Go to UTILITY menu>  MIDI PARAMETER> LOCAL CONTROL> SW [On/Off]. 
VS2480 Faderboard Part # 71561767 
         
<<<<<<<<<<< Threads & Info on cleaning, repairing and replacing faders 
>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>> 
Searched VS2480 Forum, Past 5 years, “Faderboard” in Subject and Body. 
 
Seunity on VSP… 
http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Number
=831954#Post831954 
 
I've done the manual cleaning like suggested in earlier threads here.  
 
Remove the slider knobs (!), turn the VS around and open the bottom plate. 
Unscrew and remove the faderboard carefully, paying attention to the three 
connections on the edge of the board; the wires are short so don't yank the 
board out too hard. This all is easy enough to do. 
 
For the actual cleaning I used cotton swabs, Q-tips, anything small enough to 
get to the the tracks inside the fader housing. I used PRF 6-68 "dry" cleaning 
solvent for the first round and applied just a tiny dab of PRF 7-78 lubricant 
after that. You have to be careful to not leave any pieces of cotton etc. inside 
the housing while cleaning, this could just make things worse. 
 
From about 10 sticky faders that I had, I was able to cure 8 like this. Not totally 
smooth movements, but not sticking that bad either. 
 
Later on I went in the second time, trying to fix the two faders which were still 
acting up, but couldn't make any difference with further cleaning. There was 
not even any kind of dirt coming up this time around. 
 
 
Worth to notice; the driver belts which actually move the faders will wear out 
eventually. I noticed several which were loose or had worn gearing, quaranteed 
to slip at some point. Unfortunately there seemed to be no way to tighten the 
belts to fix this. 
 
When I finally got compressed air in spray can, I went in the 3rd time. This is 
what messed up the whole faderboard! All of a sudden I got several more 
faders which were all over the place, not moving much anymore or not getting 
into exact spot, slippin past or lagging behind etc. Based on these experiences, 
I would certainly warn against some procedures, like Frank already said. 
 
In the end I contacted the Roland service here and found out that they won't 
sell you the whole faderboard. For that you'd have to have a broken board, not 

http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Number=831954#Post831954
http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Number=831954#Post831954


just the faders. What they will sell are the individual faders, of which there are 
two types; with longer and shorter housings. That means some soldering but I'm 
ready, as soon as they'll get the faders in. 
 
 
<<<<<<<<<<<<<<<<<<<<<<<<<<<<<UPDATE On FADER 
REPLACEMENT>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>> 
Update on fader replacement. 
 
I finally got the faders from the Roland service and did the job. Two types of 
faders, 8 and 9 pieces. There are total of 204 connections to be desoldered, 12 
on each fader. 
 
Desoldering went fast until I ran out of rosin braid and had to use no clean wick 
for the rest. All in all it took about 6 hours to take out the old faders and 
solder the new ones in. 
 
When done I noticed something which is worth mentioning, since this might 
trouble others as well. While most of the new faders really snapped into their 
positions fast and easy, there were two which were still sticky, pretty much 
like they were before the replacement. Taking out the fader knobs I noticed 
that the shafts of those two were leaning pretty close to the edge of the panel. 
So when the knobs were in place, they would rub against the panel, thus 
making them sticky! All the other shafts were more or less in the middle of 
their panel cutouts, all fine there. 
 
I went back in to check my work, but all the faders were set pretty much level. 
So what I did is, I desoldered those sticky faders and tilted them a little bit so 
that I got the shafts to line up more in the middle. Reassembled, everything 
worked fine. 
 
I don't know if the front panel is offset a little from the fader board or what it 
is, but since there are so many parts and boards piled up in the box, there 
certainly is a chance of having some of them misaligned. Even a little bit can 
make a difference, at least with faders, it seems. 
 
<<<<<<<<<<<<<<<<<<<<<<<<<<<<<<<Replacing the faderboard 
>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>> 
http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Board=1
6&Number=436070&Searchpage=1&Main=46858&Words=faderboard&topic=0&Se
arch=true#Post436070 
 
 
<<<<<<<<<<<<<<How much did you pay for thr faderboard its 
self?>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>> 
V Jo Go “Crystal Studios”.... 

http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Board=16&Number=436070&Searchpage=1&Main=46858&Words=faderboard&topic=0&Search=true#Post436070
http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Board=16&Number=436070&Searchpage=1&Main=46858&Words=faderboard&topic=0&Search=true#Post436070
http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Board=16&Number=436070&Searchpage=1&Main=46858&Words=faderboard&topic=0&Search=true#Post436070


It took me an hour >> just to study the diagram, of all the screws to remove 
(thanks to FRANK) I figured I could complete the job in 6 hours, and then not 
sure it would be operational...I paid nearly $500 with shipping ... 
>>>>>>> 
Jim Sharp...... 
Frank, I paid $289 from bmp music.com There was no shipping charge. The new 
faders work fine. Now I'm cleaning up the hard drives on both of my 2480s and 
tomorrow I'll switch over the 3 card and put the one with the new faders as my 
primary unit. It's the one with the DVD burner. The one I've had to use over the 
summer has only an external CD burner. 
>>>>>>> 
C Jo Go... 
I think I may try the next time ---there are maybe 30 screws ~~ with 12 varities 
....but there is just one ribbon and an "easy to align into place" fader ? Should 
be able to attempt that fete >> will give it a try ~~ hope to obtain another 2 
years, on this board. 
 
<<<<<Thread on Sticky Faders and Cleaning 
them>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>
>>>> 
http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Board=16&Number
=408966&Searchpage=1&Main=44111&Words=faderboard&topic=0&Search=true#Post
408966 
AND another... 
 
<<<<<< FADER MAINTENANCE 
>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>
>>>>>>>>>>> 
http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Number=1099564
&gonew=1#UNREAD 
 
 
 
<<<<<<<<<<<<<<<<<<<<<<<<<<<<<Where to get the fader board for $300? 
>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>> 
http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Board=16&Number
=386405&Searchpage=1&Main=41912&Words=faderboard&topic=0&Search=true#Post
386405 
>>>>>>> 
Slobbermonster.... 
CRAP DUDE just order the fader board for $300 from Roland and swap the 
whole board, faders and all. 
 
The only thing attached to the board is a ribbon cable. It's so simple an 
operation that anyone who can run a screw driver can do it. No soldering and 
no sweat. And it only takes about an hour. 

http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Board=16&Number=408966&Searchpage=1&Main=44111&Words=faderboard&topic=0&Search=true#Post408966
http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Board=16&Number=408966&Searchpage=1&Main=44111&Words=faderboard&topic=0&Search=true#Post408966
http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Board=16&Number=408966&Searchpage=1&Main=44111&Words=faderboard&topic=0&Search=true#Post408966
http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Number=1099564&gonew=1#UNREAD
http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Number=1099564&gonew=1#UNREAD
http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Board=16&Number=386405&Searchpage=1&Main=41912&Words=faderboard&topic=0&Search=true#Post386405
http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Board=16&Number=386405&Searchpage=1&Main=41912&Words=faderboard&topic=0&Search=true#Post386405
http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Board=16&Number=386405&Searchpage=1&Main=41912&Words=faderboard&topic=0&Search=true#Post386405


 
Do the guys "fixing" yours provide any vaseline? 
 
 
<<<<<<<<<<<<<<<<<<<<<<<<<<<<<<<<<<<<<Fader 
Calibration>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>> 
>>>>>> 
Poplikecrazy.... 
Had this same problem Larry, luckily doing a fader calibration at startup solved 
the problem in my case " One thing to try...calibration. When you boot it up 
hold down PAGE + F1. Then select Fader Test. You'll see all the faders center, 
then go up and down one at a time. "...heres a link to previous post 
http://www.vsplanet.com/cgi-
bin/ubb/ultimatebb.cgi?ubb=get_topic;f=16;t=014078 (link does not work) 
 
This should be enough info to help. 
Frank. 
<<<<<<<<<<<<<<<<<<<<<<<<<<<<<<<<<<<<<<<<<<<>>>>TURN OFF 
FADERS>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>> 
 
UTILITY Menu> MIDI PARAMETER >> LOCAL CONTROLL SW>>> (OFF/ON) 
 
<<<<<<<<<<<<<<<<<<<<<<<<<<<<<<<<<<<<<<<<<<<<< VS FADERS ARE 
60MM>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>> 
 
They are regular 60mm motorized faders. 
IC704-720 are BA6208F-E2 motor drivers which will move the faders as 
commanded from the various screens. 
IC701-703 are TC74HC4052AF CMOS circuits routing the fader values (resistive 
load affecting the voltages) back to the system. This is the information system 
will use to decipher (show in the screens) what is or should be the current 
fader position (dB value). 
VS2480 Faderboard Part # 71561767 
 
 
 

http://www.vsplanet.com/cgi-bin/ubb/ultimatebb.cgi?ubb=get_topic;f=16;t=014078
http://www.vsplanet.com/cgi-bin/ubb/ultimatebb.cgi?ubb=get_topic;f=16;t=014078
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INSERT EFFECTS     By Frank Griffith 
PRESS IN 1-16/Solo button, above the master red fader. Now your faders 
are set for INPUTS. If you are adding an EFFECT on INPUT #1 then 
PRESS the CH-Edit button above fader #1. The page with EQ and 
Compression graphs on it will fill the screen. Below the Compression graph 
is where you will find the INSERT EFFECT FX1 thru FX8. If you are using 
the EFFECTS Processor #1, then click on FX1 once. (It has 4 positions) You 
want the first. See NOTE below for more on these buttons & positions.  
 
Now Patch in your EFFECT by clicking on EFFECT> then EFFECT1> a 
window opens, select the "F" button for PATCH, now in this window, 
highlight the effects patch you want to use and click the "F" button for 
SELECT> then EXIT> twice. 
 
Now click HOME and above the red master fader, PRESS IN 17-24/AUX 
MST and make sure all AUX FADERS are set to 0db, then PRESS TR 17-
24/FX RTN button and make sure all of the FX RTN faders are set to 
0db(especially the one you are using, fader FX1 for EFFECT1).  
 
Now, when you record INPUT number one to any TRACK, the EFFECT 
Patch you select to use, like reverb or a vocal multi, will be printed to the 
TRACK. How do you route and input? Click on EZ Routing> Routing 
View> and on the left hand side of the screen find INPUT MIXER with 1-
24. INPUT one can be clicked on, it'll turn blue and the other end of it can 
be dragged to and of the RECORDING TRACKs 1-24 below the INPUT 
MIXER. By default INPUT 1 is connect to RECORDING TRACK 1, 2 to 2, 
3 to 3 etc. Once you connect you input where you ant it click HOME and 
arm your track to record and record the INSERT EFFECT with your tracks 
now. 
 
Make sure the effect you are inserting has not been LOOPED in the EZ-
Routing screen. Go to EZ-Routing> Routing View> and under “TRACK 
ASSIGN” you see the FX RTN Block with 1 thru 8 they match EFFECTS 1 
thru 8, disconnect the FX RTN that matches that effect’s number you are 
inserting if it’s connected to the destination track. For more on this and 
LOOPED EFFECTS see “VS EFFECTS.doc.” 
 
NOTE: The two BLUE BARS to the right of the YELLOW effects button, 
you click on to turn the effect on, can be clicked on and held, then you can 
push the mouse up and down to adjust the SEND or the RETURN LEVELS 
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of the effect. Also, below the YELLOW buttons where the patch number of 
the effect is displayed, you can click on that to open the effect’s window for 
patching and editing effects. Clicking on the YELLOW FX buttons runs it 
thru 4 positions Ins., InsL., InsR. and InsS then to OFF. 
 
Ins. The channel’s signal is processed by both sides of the stereo effect. 
InsL. The channel’s signal is processed by the Left side only. 
InsR. The channel’s signal is processed by the Right side only. 
InsS. The channel’s signal is processed by the Left side and then the Right 
side. I use the first setting for a full stereo effect sound. Splitting the effect 
up into Left and then Right allows you to use the same insert effect on a left 
track and then on a second Right track. 
 
*See VS manual for list of which are Insert vs. Looped effects and when and 
why to use them. Mainly, reverbs, choruses and delays work best LOOPED. 
To use one INSERT Effect on 2 different tracks you have to select the InsL 
position on the effect for one track and InsR on the effect for the other track. 
This way you can setup all 8 Effects to use 2 Mono INSERT Effects in each 
instance for a total of 16 INSERT Effects. 
 
NOTE: VS8F-2 cards fill up 2 Effects under EFFECT. Effect1 thru 8 equals 
four of the VS8F-2 Cards 1 thru 4, or Slots “A” thru “D” inside the unit 
under a back panel. EFFECT1 thru 8 equals AUX1 thru 8 and FX RTN1 
thru 8. Some EFFECTS use up the whole card but most are mono. You can 
select them as left & right and split up the effects into a total of 16 effects.  
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VS Install HD in VS2480CD 
First, you need to download the “Converting VS2480CD to DVD” PDF 
from this link... 
http://www.rolandvs2480.net/VS2480CD%20to%20vs2480DVD%20Conve
rsion/Convert%20your%202480CD%20to%20a%202480DVD.htm 
The hard drive and the CD burner are in the same caddy inside the 
VS2480CD model VS. This PDF will guide you step by step thru the 
process of removing the VS CD models back cover and caddy all with detail 
pictures and info. 
 
Briefly: 
1) Flip the VS over onto a pillow on top of a table and remove all of the 
screws from the back cover and use an egg carton to keep the different size 
and threaded screws in, you will need a medium and very small phillips head 
screw driver. 
2) Once inside the VS locate the caddy that has the hard drive and burner 
mounted in it and remove the screws holding the caddy in the VS. 
3) Unplug the data and power ribbons from the caddy and work on the caddy 
separately so you do not risk dropping any screws inside the VS. 
4) Remove the old hard drive from the caddy and replace it with the new 
hard drive. Make sure to set the pin to master just like the old drive. Some 
times it can be hard to get the new hard drive in place in the caddy. Also, do 
not strip the small screws and only tighten them hand tight.  
5) Now plug in the ribbons and mount the caddy back in the VS, put on the 
back cover and screws and flip the VS over to format the hard drive. 
 
FORMAT A NEW HARD DRIVE 
Once it’s installed, turn the VS on and watch the small 3” x 4” LCD on the 
VS and answer the prompts using the ENTER/EXIT buttons, “F” buttons 
under the screen and the jog wheel. You can do a “Quick” format with a new 
hard drive but it’s recommended to do the following:  
 
First you’ll see “Formatted Drive Not Found, Force Initialize? 
Press ENTER for YES then you have to Select Drive, IDE 0 and then 
Partition size 10GB, Check “Physical Format” and surface scan “ON”. I 
think you use the jog wheel to highlight items and the ENTER to select and 
the “F” buttons to page through the menus. It becomes logical as you do it 
and finally you select “OK” and it’ll ask you twice if you want to do this, 
answer “YES.” These instructions are brief but I added them from memory. 
It’ll take about 6 ½ hours for 80GB and double that for 120GB. 

http://www.rolandvs2480.net/VS2480CD%20to%20vs2480DVD%20Conversion/Convert%20your%202480CD%20to%20a%202480DVD.htm
http://www.rolandvs2480.net/VS2480CD%20to%20vs2480DVD%20Conversion/Convert%20your%202480CD%20to%20a%202480DVD.htm
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Brand hard drives and Specs. 
Just about any brand name should work with the right specs. 
Seagate Barracuda is one of the best, Maxtor, Western Digital, Hitachi 
Deskstar, IBMs etc. 
Specs:  40, 80, 120GB hard drive, 7200RPM, 8MB Cache ( 2MB & 16MB 
has worked), ATA/100 or 133 interface and this is important, less than 10ms 
average seek times. So in a nut shell use a hard drive with these specs. 
*7200RPM, 8MB Cache, ATA/100 or 133 with less than 10ms average seek 
times. 
VSPlanet Thread with a list of hard drives that have worked for others... 
http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Number=677261&fpart=1 
AND 
http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Board=16&Number=976890&Search
page=7&Main=47033&Words=Hard+drive&topic=0&Search=true#Post976890 
Good luck, Frank. 
 
 

http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Number=677261&fpart=1
http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Board=16&Number=976890&Searchpage=7&Main=47033&Words=Hard+drive&topic=0&Search=true#Post976890
http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Board=16&Number=976890&Searchpage=7&Main=47033&Words=Hard+drive&topic=0&Search=true#Post976890
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VS LEVEL SETTINGS From Post On VS-Planet 
…………………………………………………………………………….. 
Question: What meters do I watch during recording??? 
…………………………………………………………………………… 
Reply: I set the INPUT and TRACK faders to 0db then I use the SENS 
knob and PAD to set my levels and start with the INPUT meters by 
clicking on the "F" INPUT then "F" IN MIX" then once that's set I click 
on the "F" TR MIX" and then record. Try to shoot for -12db on the 
meters.  
 
The Track has to be armed to get a meter reading. I read some where 
that you should use the PAD and keep the SENS as low as possible 
when setting the levels. Then you can use the PRE and POST buttons 
to switch back and forth from INPUT and TRACK Meters to make sure 
you’re no going over any where. Leave it on POST for recording and 
mixing. 
………………………………………………………………………………………………………………… 
Reply: look at your eq/dyn screen under the compressor, is the auto 
gain button on? If so that is what’s pushing your levels up on the track 
mixer. Most folks turn the auto gain off and use the manual gain 
"knob" right under the button. 
Always watch your input meters when your tracking, you don't want 
those clipping. 
As far as your guitar re-amping goes, look at the eq/dyn screen again 
for that channel and there is a "mix" button on the right side of the 
screen, I think its above the "virtual" fader. That button will take that 
track out of the playback mix. 
…………………………………………………………………………………………………………………. 
Reply: yes but 
your compressor is after the input peak light and before the recorder 
so yes you have to watch both meters. 
………………………………………………………………………………………………………………….. 
Reply: Also remember that if you use compression on the input you're 
stuck with it because it will be printed to your track. 
And Mike's warning about the dynamics can really get you in a mess if 
you don't watch it (check meters post and pre often). 
I always adjust comp for bass on the track channel while I'm tracking 
(if I use it) to hear what it would sound like, but it doesn't get 
recorded with the track so you can change it later if you choose. 
 
Frank's got the right idea here, keep the input faders at 0db and 
adjust the pre (sens) levels. 
Set the meters to ANALOG INPUT so you'll know what's actually 
coming in (use INPUT MIXER if altering input channels). Use the pads 
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as needed. 
The track levels are basically for monitoring purposes while you're 
tracking. Think of the 2480 in separate sections; 
Use the pre's across the top with the input mixer at unity gain (0db) 
when tracking. 
 
INPUT MIXER to apply effects, EQ and dynamics while tracking (if you 
want to, but remember you're stuck with whatever you do here). 
 
TRACK MIXER to apply effects, EQ, dynamics and level adjustments for  
monitoring while tracking and final mixing. 
………………………………………………………………………………………………………………….. 
quote:  

 
Originally posted by What does this button do?: 
When I'm recording, which level do I need to pay the most 
attention to?  

 
Reply: There's a lot of info in these replies, but it's spread across 
three or four of them. 
 
Assuming you're using ONLY the 2480, things to remember are in the 
order of the 2480's internal signal chain. Each stage and process must 
stay below the clipping point, and the addition of every change to the 
original signal should slightly change those levels at the next tier. 
 
Each stage is critical, starting with the INPUT. 
If analog, you must adjust the INPUT using the SENS knob while 
viewing the INPUT meters. Keep the signal well below clipping and 
make sure you know if the clip indicator is set at -6dB, -3dB, or 0dB. 
 
Next, you'll need to set the INPUT MIXER levels using the fader sliders. 
This is also the level adjustment when using a digital source. View this 
level/adjustment by selecting the INPUT MIXER and the POST level 
position. This will ensure the actual levels being recorded are not 
clipping. The INPUT MIXER in POST is what's being recorded.  
 
You can flip back and forth between PRE and POST (without touching 
the INPUT MIXER faders) to see if you have any changes in levels. 
However, this can be difficult to do with constantly changing source 
levels. But, it can also help to identify if you have dynamics, EQ, or 
effects accidentally (or intentionally) turned on. Once they're printed 
to the track, you'll have to live with them. 
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Don't be fooled by the audio output of the TRACK MIXER and faders in 
TRACK mode. These sliders change NOTHING in regards to what's 
being recorded. They only modify the audio output that your hear. 
 
Lastly, just remember that it's easy to overlook unwanted items in the 
signal chain, and double check your settings with use of the PRE and 
POST meters, as well as your ears. 
…………………………………………………………………………………………………………………. 
 
What you have is an INPUT MIXER and a TRACK MIXER and the signal 
path is pretty much the same for both. 
 
INPUT to SEN+Pad to IN Meter> 
TRACK to Phrase parameter >  BOTH FOLLOW THE PATH OF……. 
DYN Meter IN> Dynamics Block> Level> DYN Meter OUT> EFX Send 
Inserts 1 thru 8> EFX RTN> ATT knob> EQ Meter IN> EQ Block>EQ 
Meter OUT> Aux Sends Pres 1 thru 8> Pre Fader> Post Fader> Aux 
Send Post 1 thru 8. 
 
Setting Levels for Mastering 
With the 2 card, in the MTK MixDown patch, P231, I never use the soft 
clip. I use the EQ, compression, and the limiter on that patch if 
needed.  
Here's what I do to get the levels hot at the end. 
First of all make sure none of your track levels are going over 0db, 
bring your track levels down so that hottest track is below 0db and you 
have some headroom, it's best that your not slamming the master 
buss, and never have your master fader below 0db. You will see where 
the master levels are at, I try to get the master level peaks as close to 
0db even if that means raising the master fader, (this is of course with 
the MTK inserted), I use the limiter set at -1db to get the occasional 
spike. 
So far no problems getting my CD's to sound pretty close to 
commercial, but you have to realize they really slam these new CD's 
with compression to get them loud, I'd rather have a great sounding 
CD than one that's loud. 
Pete on VSPlanet 
 
VS8F-3 card & Plug-ins for Mastering. 
I have the VS8F-3 card and use the same settings in it. It seems to 
work much better than the VS8F-2 card’s MixDown patch. All of the 
MTKs on the 3card sound better and do a better job of mastering, 
IMO. Also, T-Racks for the PC has many Presets that sound good and 
really add that market CD compression some like. I hear that the VS 
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version of T-Racks can do the same for you. Buying the VS8F-3 card 
and plug-ins like T-Racks and the UA Bundle can really add a lot of 
options for mastering as well as better recordings of individual tracks. 
The MTKs on the 3 card also fill up your screen with all of the 
parameters so that it is much easier to understand and use. Frank.  
 
Mastering to send to a Mastering House 
If you’re recording tracks and mastering your stereo pairs without 
MTKs to be sent out to be mastered by a professional then you need to 
record your tracks at lower levels and mix at lower levels. Record 
between -12 to -6db and mix every thing at those levels then run the 
master red fader a couple db below zero as well. Also, the less 
compression you use, the better. This will leave HEADROOM for the 
mastering houses to work with. Maybe send a test mix first to see if 
they can work with the mixes you are doing before mastering them all. 
 
Recording a click track 
Go to UTILITY menu> Select the Gen/OSC screen and turn it on, then 
go to EZ Routing> Routing View> and route the output of the 
GEN/OSC to a free tracks and record enable, arm, that track. 
Page 288 in the VS POWER book. Frank. 
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VS  MASTERING CDs FOR THE NEWBEE 
Mastering should be the process of just adding the icing on the cake, polishing up the 
mastered mixes. Making them sound better and putting them in the best listening order on 
the CD. You could take your mixes to a mastering house but in today’s world with this 
technology at you finger tips, you can do a decent job as well. You just need some simple 
guidance, IMO. Also see my “VS MTK USE .doc” using the VS’s Mastering Tool Kits to 
get the most out of your mixes. 
 
*Before getting to the mastering stage, it’s very important that you record all of your 
tracks at consistent levels so songs are at consistent levels in the mastering stage. I always 
setup my VS with all faders at 0db and use only the SENS/TRIM knobs and PADs to set 
my recording levels so that none are below -12db and the peaks go no higher than -4db. 
When I get to the mastering stage in the VS I like to use the “Mixdown” patch in the 
MTK to master my stereo pair of tracks. Learn how to use the MTKs and you can get a 
good and loud enough CD out of the VS.  
 
*You need to make sure you have a treated room to mix your songs in and good set of 
flat frequency response monitors. Check these sites for info on treating your room. 
www.auralexuniversity.com and www.acoustics101.com . For monitors in the $1,000 
range check out Dynaudio BM5A’s and Adams A7’s. Now onto mastering the whole CD 
project. 
 
*Trim al1 of your mastered tracks. Make sure the fade outs are good and don’t have dead 
air space at the beginning or end of your songs. Don’t have a second of silence before the 
track begins or at the end. The VS can add that silence between each track automatically 
using TAO or if you use DAO and have to set the track markers yourself, set those 2 
seconds apart and have the track start playing in a split second, 10 or so frames of a 
second before the song begins! 
 
*Pacing the CD’s track order. You need to organize the tracks in a good order to set a 
good flow from track to track. Make a rough CD and listen to the songs in random order, 
see what songs sound best together. Arrange the keys of the songs in ascending or 
descending order and see what they sound like. Try not to have 2 songs in the same key 
together. Some songs may sound good in pairs so consider putting them together or even 
cross-fading from one to the next. 
 
*Decide if you want the song order to build or taper off. Do you want the CD to start off 
slow and build or to build excitement at the start with fast tempo songs and get faster 
with each song after? You could then back off with slower tempos to end on a calmer 
tempo. It’s all up to you and what sounds best with your songs.  
 
*Always lead off with your best songs, especially if this is to be used as a demo CD to 
shop around. If you don’t get their attention with the first song and hook, you have lost 
them, IMO. Also, keep your songs short, 2:30 to 4:00 is a good length. My motto is 
always leave them wanting more! 
 

http://www.auralexuniversity.com/
http://www.acoustics101.com/
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* You can normalize all of your songs if you want using NORMALIZE in the VS or in 
some PC programs but it’s important to make sure all of your songs on your CD can be 
listened to with out having to adjust the volume knob of the player. Master them all at a 
consistent level. If a softer song doesn’t sound loud enough and you can’t get the volume 
up, then use dynamics to help it to sound louder. Add some compression to the Mastered 
V-Tracks if needed and re-master. 
 
*Check your CD’s volume levels by comparing them with market CDs. Pick a market 
CD in the same style of music your style is and see if your CD is in the same volume 
range. If yours is louder that’s OK but if your CD’s over all volume is lower then you 
will want to go back and re-master them with the MTKs. Some times it’s best to burn the 
first mastered song to CD and check it with a market CD before mastering them all. 
 
*If some of these tips don’t work for you, no problem, just use them as guidelines and do 
the best you can. Remember, less is more. Get your tracks right in the mix so you don’t 
have to try and fix it in the mastering stage. 
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"OK, here's how to get you Mix to CD...I'll assume you have a VGA monitor.... 
 
Go to CD-RW MASTERING->MASTERING ROOM menu item. The "Mastering Room" is 
displayed. 
 
Click the Mastering Room OFF button to ON. 
 
Change the STATUS to RECORD. 
 
Set CDR REC MODE to ON. 
 
Select the VTRACK PAIR on which you wish to record. 
 
Set AUTO MARKER to ON (if desired). 
 
Set the AFTER REC to "to Last Phrs:4s". 
 
If desired, and an FX engine is available, you may insert an MTK patch in the Mastering Room. 
 
That's the setup. Now run your mix while RECORDING in the Mastering Room. Place the 
Mastering Room in PLAY mode after recording. 
 
This method produces 16-bit CDR-ready tracks. There are variations of this method for other 
purposes." 
  
then he came back later and answered; 
 

    "OK, one error on kirk's part....the MasterPair is the same VTrack# on both 23 and 24. Initially it 
is set to VTrack23/24.16. You can change the VTrack number to 15, but it will effect both Tracks 
23 & 24. It's like linking stereo tracks, the VTrack# is the same for both. OK? Good. 
 
Now, the way I detailed produces 16-bit audio. BUT, if you leave the CDR MODE button OFF, the 
Master Tracks are created in the native format of the project (24 bit!). Just like any other stereo 
pair. In fact, you can exit the Mastering Room, select VTracks23/24.16 (or whatever), and play 
the mastered mix as a regular stereo pair. 
 
Now, hopefully, you have saved that mix as a SCENE. Cause now that it is mixed, you no longer 
NEED those FX to be what they were. You can un-assign all the FX, and invoke an MTK patch 
for the Mastering tracks/24.16 through the MTK, with CDR MODE ON, recording them to 
VTracks23/24.15!!!! 
 
I hope you followed all this. It's a 2-step process. MASTER your MIX in 24-bit mode with full FX. 
Then, "MASTER" that stereo mix thru the MTK to create a "MASTERED" 16-bit CDR version." 
  
.........the mtk patches on the vs3 really give it a different overall sound. i unassigned the effects 
and saved 3 scenes using different mtk patches but some of them seem to add distortion. i'm 
going to be a better writer than engineer until i get better recording techniques.  
...........same thing everyday here about this time. bad storm and lightning. gotta unplug the puter 
till it passes. later....... kib 

By Karl Lakestone on VSP 
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MASTERING TRACKS & BURNING TO CD USING TAO 
At this stage of the process we want to create a stereo mix of our 
Project/Song so we can later, burn them to a Master CD-R or RW. Some like 
to use CD-R Mode but that turns your stereo pairs into 16bit masters that 
you cannot listen to until you burn them to a disk or import them to a CDR 
Mode project. I was taught not to use CD-R Mode so the mastered pairs stay 
in 24bit so that I can then listen to my final mixed pairs before burning them 
TAO (Track At Once) to disk. Now for mastering, if you want to use an 
MTK (Mastering Tool Kit) then patch that into an effects processor now, it 
will use up both sides of the effects process, one full card. Then we begin 
with mastering your mix. Leave your meters on “F3 TR MIX” for now at the 
bottom of the HOME screen, if you do not see this click on the page button 
on the right hand side of the task bar. 
 
Go to CD-RW/Mastering> Mastering ROOM> now the METERS area on 
the HOME screen becomes the Mastering room. Click Mastering Room to  
“ON”, it’ll turn yellow. Your tracks will be grayed out. Click the STATUS 
button from GREEN/PLAY to RED/Record and the color comes back to 
your tracks.  
 
Now, in the V.TRACK window you should see V-Tracks 23/24-16. That’s 
the pair of V-Tracks you are recording this song’s mix too in stereo. (You 
can Click on 23/24-16 if you want to select another pair of V-Tracks to 
record too if these have a previous mastered pair on them. If this is your first 
time then leave it as is, 23/24-16 is the default.) It’s important to make sure 
you know what V-Tracks you are using here, there are 16 pairs of 23/24. 
 
If you have an MTK (Mastering Tool Kit) patched into an EFFECT like 
EFFECT1 then click on FX1 to turn it yellow and add that MTK to the mix. 
Click nothing else! No Auto Marker or CD-R Mode. After Rec. should read, 
“to ZERO” as default. 
 
Now press the PLAY button and set your Master Levels to 0db or slightly 
under, watch you master meters so they do not go over to 0db. Once your 
levels are set press STOP and cue up your tracks where you want the 
recording to begin. (You can also edit you MTK here as well. Bring up the 
EFFECT that has the MTK patched into it and click on EDIT and adjust the 
parameters while your master tracks play). I usually have a LOCATOR 
button setup to this point and press that locator number to go back to. (To 
use a LOCATOR just place the TIME LINE where you want it and press 
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one of the 0 thru 9 buttons. It will light up and any time you need to jump to 
this point just press it again. To clear it, hold CLEAR and press it again.)  
 
Now press RECORD & PLAY and MIX your song live, watch your master 
meters.  (*If you need to see your TRACK METERS then click “F6 EXIT” 
at the bottom of the screen to EXIT the mastering room and watch your 
track mix meters. Remember, we left them on “F3 TR MIX” at the 
beginning. Before the end of the song you can click on CD-RW Mastering> 
Mastering Room to bring the Mastering Room back up at any time while 
recording your mix.) Now fade out at the end of the mix using the RED 
MASTER FADER and press STOP. 
 
Now press the ZERO/Back button, bring up the Master RED Fader to 
Unity/0db, click on the mastering room’s STATUS button to GREEN/PLAY 
and press the PLAY button to hear what you recorded. The tracks should be 
GRAYED out again and music playing. If you don’t like the mix PRESS 
UNDO and you’ll see “Master Rec” in the small window, PRESS ENTER. 
Now do the MIX over.  
 
You can also open the effects and select a different MTK patch if you want 
while in the Mastering Room.  If you have the mastering Room “ON” and 
STATUS green to PLAY with the tracks GRAYED out, you won’t hear 
them if you press PLAY on the VS. You can either turn the Mastering Room 
“OFF” or click STATUS red to REC to PLAY the mastered tracks.  
 
* If you have problems with the volume levels you can use the two blue 
lines on the inserted MTK in the mastering to boost the signal. To the right 
of the yellow FX block are two lines, the top blue line is for boosting/cutting 
the level of the mix coming into the MTK and the bottom blue line is for 
boosting/cutting the level coming out of the of the MTK. Click on one of the 
blue lines and use your value dial on the jog wheel to set levels. 
 
If you’re done, then you can leave the Mastering Room as is and move on to 
the next Project/Song or begin the burning process. I usually leave the 
Mastering Room as is so I can jot down the Master V-Tracks numbers 
during the burning process and keep track of which pairs I used on each 
Master CD-R or RW. I always hear something wrong with one of my songs 
and have to re-master. Sometimes you can do this 3 or 4 times before you’re 
satisfied with your final mixes. Press SHIT+STORE and SAVE project! 
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NOTE* If you don’t have an effect’s processor open for using the MTK 
because you have used all the effects up in your project you can do one of 2 
things. Either bounce tracks that are using up one of the effects cards to 
other tracks recording the effects with the tracks to new tracks OR you can 
master the project in the mastering room WITHOUT an MTK so all effects 
are recorded with the project to a stereo pair and then master the stereo pair 
in the mastering room using an effects MTK. 
 
BURN TO CD (Save the project before burning!) 
To burn these Projects/Songs to CD, be at this stage in the Mastering Room, 
Mastering Room ON and STATUS Play. That’s why I left mine that way in 
the last stage of mastering my Projects/Songs. The Mastering Room defaults 
to 23/24-16 after every burn so make sure you select the right 23/24-V-
tracks to burn to disk, in the next window. 
 
Selecting the V-Tracks in the CD-R Write window, you have the LEFT side 
of the pair on top with the RIGHT side of the pair underneath the LEFT. I 
always click L-Click on the LEFT side pair to adjust the V-Tracks because 
the RIGT side will follow suit with the left. If you adjust the RIGHT side, 
the LEFT will not move and you could wind up with a song on the left 
speaker and a different one on the right! It’s happened to me so make sure 
you have the right, LEFT & RIGHT V-Tracks! 
 
Click CD-RW Mastering> select CD-WRITE, store current? Click “YES” 
and the INSERT a blank CD-RW or CD-R. The CD-R WRITE window will 
open. Make sure your V-Tracks 23/24-16 are shown in the L-Ch & R-Ch 
windows, (Check the window to be sure the right, Left and Right 23/24-V-
Tracks are selected here.)  
 
Select “FINALIZE” to “OFF”, “WRITE METHOD” to (TAO)Track At 
Once, “SPEED” to MAX and click “OK” to burn. NOTE! If you do not have 
other Master Tracks in other projects to add to this CD then click 
“FINALIZE” to “ON”. If you do have more leave it “OFF” until the last 
song’s Master Tracks are ready to burn. This will close the CD so you can 
play it in a CD Player. Then click “YES”, “ENTER” and “YES” to burn. 
 
If you forget to turn “FINALIZE” “ON”, on the last song’s Master Tracks to 
the CD, then stick it back in and select “FINALIZE” to “OnlyFin.” For 
finalizing ONLY. Now it’s ready for playing and copying with PCs to be 
played in stereos. Also, a message comes up asking you if you want to 
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“Write Another CD” and you answer “NO.” This happens after burning a 
TAO song to disc. What it’s asking is if you have another CD you want to 
write this same song to besides the one you are working on. If you are 
burning only one song to disc then follow these steps and “Finalize” the CD. 
 
DIGITAL COPY PROTECT 
To lock and protect the Master Song CDs you burn go to  UTILITY> Project 
Parameter> and Turn “Digital Copy Protect” ON. This will protect your CD 
so that others can not RIP songs off of your CD using Nero, Roxio, 
Windows Media Player etc. 
 
NOTE: If you want to record your Master Tracks using CD-R Mode and at 
16bit you can use the VS manual to find out more about it. It makes your 
mastered pairs 16bit, 44.1k so you have to create a new empty CD-R Mode 
project and IMPORT the mastered pairs into that CD-R mode project from 
the other project to burn them to disc in .cda format. The IMPORTING 
process is explained in detail in “VS MST DAO.doc.” Your 16bit CD-R 
Mode mastered pairs will not playback in a MTP, 44.1k , 24bit project, 
that’s why I keep them 24bit.You can also use the mastering room to create 
sub-mixes and use Track Exchange to move the sub mix to new tracks in the 
project. See my “VS SUB MIX.doc” for more on this. 
 
Mastering 24bit 96k Projects 
It's a work around just using the 2480 for sample rate conversion. 
Let's say you have a beautiful 12 track 24 bit 96K mix and want to burn it to 
CD. Simply mix down to the mastering room with CD-R Mode=off. Then 
perform a Track Export of those two tracks. This will create a stereo 24 bit 
96K .wav File on CD-R or CD-RW. 
 
Then create a new project in CDR mode, 16 bit 44.1k, and use .wav import 
to grab the mix. The 2480 automatically converts the sample rate to match 
the new project! 
 
This is also a great way to get from one recording mode to another, MTP to 
MT1 etc. 
By Laura Tyson 
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MASTER DAO               By Frank Griffith 
Master CD “Disc At Once”, 24bit When songs are mastered without CD-R 
Mode, one song per project do this! 
First create a new EMPTY or MTP 24bit Project with the Name being the 
name of the CD. Once this is done it’s time to use the TRACK IMPORT 
feature to IMPORT all of the Mastered V-Tracks from all of the 
SONGS/PROJECTS that are to be on this CD.   
NOTE: If your mastered pairs are CDR Mode with Auto-marker then the 
New Master Project must be CDR Mode 16bit.  
 
With the NEW Master Project Open 

1) Click on TRACK> select TRACK IMPORT, a window opens with a 
list of all of your songs on your hard drive on that partition. 

2) Now Select the first song to go on the CD, a rectangular box will 
surround it, 

3) Click “F5 Select” to get to that song’s mastered V-Tracks, a new 
TRACK IMPORT window will open. Notice the track’s title is there 
and two areas, SOURCE   and Destination. 

4) In the SOURCE window click on the scroll bar’s UP and DOWN 
arrows to find the Mastered pair of V-Tracks. Make sure the first 
song’s LEFT V-Track is selected and appears in the small rectangular 
window under SOURCE. We can only Import one side at a time. The 
RIGHT V-Track will have to be done by it self next. So…select “23-
16:V. T23-16” first! “24-16:V.T24-16 next time around. 

5) Next, we have to select the DESTINATION track to send the 
SOURCE V-Track too. In the DESTINATION window, make sure 
that “1L-1:V.T 1-1” is selected and appears in the Destination 
window. It should be there this first step. If not, use the UP and 
DOWN scroll arrows to select it. Clicking on them moves it 1 track’s 
full 16 V-Tracks at once. 

6) Now click the “F5 OK” button and answer “Yes” to Are you Sure and 
“YES” to Store Current Project. A progress window will appear. 
When done, move on. 

7) Now Track# 1 has the Left track of the song IMPORTED to it. Click 
TRACK> TRACK NAME> and select “F1 NAME” and name it the 
title of the Song. Click “F5 OK” and then click “F5 EXIT” 
NOW……REPEAT STEPS 1 thru 7. This time IMPORT the R side 
V-Tracks to TRACK 2 in this project, then LEFT then RIGHT etc.   
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Once you have IMPORTED all of the SONGS LEFT & RIGHT V-Tracks, 
one at a time, into this project we need to line them all up on the same pair 
of tracks. We will use Tracks 1 & 2. To make it easier to move them we will 
do it in pairs so let’s go to the CH-Edit page of each odd number pair of each 
song.  

1) PRESS the CH-Edit button of TRACK #1 and click on “CH 
LINK”, it should turn yellow. It’s below the ATT knob on the 
left-hand side of the screen.  Now PRESS the CH-Edit button 
of TRACK #3 and click it’s “CH LINK” button on, then repeat 
for TRACKS #5’s & #7’s etc.  Once they are all linked, we 
need to move the LINKED PAIRS of all SONGS to TRACKS 
1 & 2. 

2) Click HOME and now PRESS the ZERO button.  To perform a 
REGION MOVE, 

3) PRESS the IN button, now JOG to the END of the second song 
on tracks 3 & 4, position the RED time line at the END and 
PRESS the OUT button 

4) Now lets position the RED time line 3 to 4 seconds PAST the 
first song on TRACKS 1 & 2 and PRESS the TO button plus, 
press LOCATOR # 1. This will send the BEGINNING of the 
SONG on 3 & 4,  2 seconds AFTER the END of the second 
song on TRACKS 3 & 4. Once all edit points and the first 
locator button is set. 
* Note* Some place tracks as close as 2 seconds apart but some 
CD players can’t find tracks that fast so I suggest you use 3 or 4 
seconds between songs. 

5) Click TRACK>, at the top of the screen, and select REGION 
MOVE> , the REGION MOVE window opens… 

6) Click “F1 Sel Trk” to select the TRACKS to move, in this 
window select TRACKS 3 & 4, since they are linked, placing a 
check mark in the odd number, automatically check marks the 
even one. We are moving TRACKS 3 & 4 to TRACKS 1 & 2. 

7) Now, with the JOG wheel dial in TRACKS 1 & 2, just turn in 
counter-clock-wise till it no longer changes. That will be 
TRACKS 1 & 2’s first V-Tracks where the FIRST song is.  
When ready click on “F5 OK” and answer “YES” to the 
prompts. 

8) This will MOVE the SECOND song on TRACKS 3 & 4 to 3 or 
4 seconds after the END of TRACKS 1 & 2. Now you need to 
repeat steps 1 thru 7 for the rest of the songs. Send the THIRD 
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song on Tracks 5 & 6 to 2 seconds PAST the MOVED second 
song that was on TRACKS 3 & 4 but now on TRACKS 1 & 2. 
And so on and so on.  *You will be pressing IN, OUT, TO & 
the next LOCATOR not lit up, on each song’s pair of tracks. 

 
Once all of your SONG’S LINKED TRACKS are REGION MOVED to 
TRACKS 1 & 2 we need to use the LOCATORS you placed, with each 
SONG’S press of the TO button, to place our CD track markers so players 
can find each individual track on the disk. The first song on TRACKS 1 & 2 
does not need one, it will be automatically placed by the CD-R Write 
process. Now….. 

1) PRESS LOCATOR #1 (for the beginning of song #2) , Now set TIME 
on seconds, just click on the “s” for seconds and turn the jog wheel 3 
or 4 clicks back to lay a track marker 3 or 4 seconds before the song 
begins.  
NOTE* If you used 4 seconds between the songs in the last procedure 
then that should leave you one second after the first track/song ended 
and 3 seconds before the second track/song begins. If you used 3 
seconds of space between the songs then click it back just 2 seconds, 
leaving 1 second after the first song and 2 seconds before the next 
song begins.  

2) Now, HOLD down the CD-RW button and PRESS the TAP button, a 
BLUE down arrow TRACK MARKER will appear above the tracks. 

3) PRESS LOCATOR #2 (for the beginning of song #3), JOG 2 or 3 
click back and HOLD the CD-RW button down and PRESS the TAP 
button, repeat this process until all of the songs have a BLUE CD-RW 
marker at their beginnings. Once they are all done we can MASTER 
the CD. 

 
MASTER THESE SONGS TO CD 

1) Click on CD-RW MASTERING> and select CD-R WRITE, answer 
YES to Store current Project, you will see NOW WORKING………..,  

2) INSERT a BLANK CD-R in to the CD bay,  the CD –R Write 
window will open 

3) Select TRACKS 1 & 2 in the L-Ch SOURCE TRACK &  the R-Ch 
SOURCE TRACK area, 

4) Under FINALIZE, I select ON with a check mark, I’m told it’s not 
necessary but to be safe I do anyway, 

5) Under METHOD Of WRITE, select “Disc At Once” 
6) Under SPEED, select MAX and click 
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7) OK….Audio CD Write? Answer “YES”,  License agreement? Answer 
“YES” etc.. and you will see a progress window “MAKE IMAGE.” It 
took about 15 minutes for my 8 songs to go thru this step then it 
changes to “CD Write DAO” for a couple more and EJECTS the CD. 
Done!  

Doing my non-CD-R Mode Mastered V-Tracks with DAO (Disc At Once) 
seemed to take just as long, if not longer, than doing them TAO (Track At 
Once). CD-R Mode knocks them down to 16 bit also. Mastering them this 
way keeps them at 24 bit until they hit CD-R Write window, then the CD-
Write method turns them into 16bit CD Audio. If you were to transfer them 
to PC thru an RPC-1 card or other audio cards, they can be kept at 24bit in 
PC aps like Sonar, Cubase and Wave Lab. Total process took about 50 
minutes. 
 
Karl’s Project Split and Combine process basics. 
You want to create 24bit Stereo Mixes of each song. This mix should be on 
it's own VTrack (naturally). 
 
In each project, perform a PROJECT SPLIT of the 24bit Stereo Mix only. 
This yields one project with only the stereo mix per song. 
 
In each of these projects, move the Stereo Mix to the same virtual Track 
Pair, at ZERO. All these files must be on the same partition. 
 
Open the project that is the song you want to be first on the CD. Select 
PROJECT->LIST from the Menu. MARK both the current project, and the 
project that is the second song, and choose COMBINE (F4 on page2). This 
adds the second song to the first. 
 
Repeat this until all the songs are in one project. You can then master the 
project as a CD. 
 
*You can also do this another way. If you have most of your songs in one 
project you can master them to V-Tracks on 23/24, then Region Move them 
all to one set of 23/24 V-tracks, add the CD-R+TAP track markers and then 
select those V-tracks to be burned DAO, “Disc At Once” in the CD-R Write 
window. If you have other songs mastered tracks in other projects you can 
use TRACK> Track Import> to import them to the V-tracks in this project 
and they will import after what ever song is on the V-tracks. This means you 
can import them in the order you want them to appear. Them move them to 
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leave 2 seconds (or however long you want) in between them and add the 
CD-R+TAP track markers and burn DAO. If you record your master tracks 
with CD-R Mode, then they are linked automatically and I am told they will 
burn to CD faster. Thing is, they all have to be in CD-R Mode to burn them 
DOA or all not! The bit rates and sample rates must match. 
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Master Fade-Out Auto-mixing Step-by-Step:                       By Karl Lakestone on VSP 

 Hold SHIFT and press AUTOMIX. In the AUTOMIX setup dialog, unclick PAN, and set 
the MASTER to RECORD. All other items should be at IGNORE status. Close this dialog.  

 Go to the start of your song, or a second before the start. Hold SHIFT and press the 
Tr17-24 FX RET/MASTER EDIT button. Make sure the Master Fader is set to Unity. 
Close the Master Edit dialog.  

 Hold REC and press AUTOMIX to enable Auto-mix Recording. Hold AUTOMIX and press 
TAP to take a SNAPSHOT of the Master fader at Unity to start the song.  

 Move to where you want the Fade-Out to begin. Press IN and take another SNAPSHOT 
(both needed for the Gradation process)  

 Move to where you want the Fade-Out to end, move the Master Fader to Infinity 
(OFF). Press OUT, and take another SNAPSHOT (again both for the Gradation 
process).  

 Choose the UTILITY->AUTOMIX EDIT menu item. Notice how the Playlist Area changes 
to darker colors, indicating AUTOMIX EDIT mode.  

 Above the list of track names, choose MASTER from the first drop-down list, and 
LEVEL from the second. A single track should become visible in the playlist area, this is 
your Master Automation track. You should be able to see both your IN and OUT points 
on the screen.  

 Press F3 to SELECT the area between IN and OUT. The area becomes highlighted.  
 Press the yellow GRADATION button, located very close to the WAV DISP button. You 

should see the fade out represented on the screen. 

 
Make sure to set the Master back to Auto-mix PLAY mode to test your work. 
By: Lakestone Karl on VSPlanet.com 
 
 
 
AUTOMIX Volume and Pan on a Track or Tracks 
 

1) At the top of the HOME screen under the date there is a [A] button. Click on it to turn 
on AUTOMIX. It will turn YELLOW and so will all the track’s smaller [A]’s next to the 
mute and solo buttons on screen. The CH-Edit buttons will turn YELLOW as well. 

 
2) Now click on the track or track’s YELLOW [A]’s to turn them RED to ARM them to 

record auto-mix data. *(Red for record, Yellow for ignore & green to play). 
 

 
3) Now back at the top of the screen click on the black dot record button next to the [A] 

auto-mix button and turn the black dot RED for RECORD. 
 
4) Now you’re ready to record auto-mix on the tracks you have the smaller [A]’s set to 

RED. PRESS the PLAY button on the VS and record your VOLUME/Fader  or PAN/knob 
movements and when you are done PRESS the STOP button on the VS. Then 
ZERO/Store button to return to the front of the project. 

 
 
5) Now click on the track’s smaller [A] or [A]’s to turn them GREEN for PLAY and you can 

now PRESS the PLAY button on the VS and see the Volume and/or Pan knobs move. 
 
• Notes: There is an UNDO arrow to the right of the auto-mix record button so if you 

don’t like what you recorded you click it and start over. 
 
• Also, under UTILITY> AUTOMIX SETUP>> you will see that the Volume and Pan are 

checked by default, you also have several other items you can check mark for 
recording auto-mix with ie EQ, Mute, Aux Sends etc... 
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• Even though all tracks you did not record data to have their [A]’s yellow, don’t worry, 

this means that track is to ignore auto-mix data. 
 
• To turn off all auto-mix yellow button you click on the top [A] button that is YELLOW 

and it will go gray and all the smaller track [A]’s will go off. 
 

By Frank Griffith 
 

VS AUTO-MIX 
Auto-mix automation is a pretty easy feature to use on the VS. You can use 
different actions to perform on all tracks or just one or a few at a time. You 
can use auto-mix to record all of your fader movements and other changes 
you make with your tracks to have a hands free mixing when recording your 
masters. 
 
Auto-Mix Panning 
OK, let's Auto-mix Track1 from L63 to R63, starting at 10seconds and 
ending at 15seconds (short song)..... 
 
Place locators or markers on or at 10 and 15 seconds, so we can get 
there quickly and accurately. 
 
First, let's limit our work to the PAN settings. Hold SHIFT and press 
AUTOMIX, then make sure only PAN/Bal is selected in the WRITING 
PARAMETER. Set the AFTERPUNCHOUT to "KEEP". Close this screen. 
 
Now turn Auto-mix ON by pressing the AUTOMIX button. Place Track1 
into AUTOMIXRECORD by holding AUTOMIX and pressing Track1's 
CH.EDIT button, turning it red. 
 
Now let's switch to AUTOMIX EDIT mode, under the UTILITY menu.  
 
Just above the Track Names, there are two drop-down menus, SECT 
and PRM. Set SECT to TRACK MIXER, and PRM to PAN. 
 
OK, so Track1 is going to start on the left, so go to the start of the 
song (ZERO), set Track1's PAN to L63. Hold AUTOMIX and press 
RECORD, or simply click on the AUTOMIX RECORD ICON on the VGA 
monitor, to put the 2480 in “Auto-mix Record Mode”. Now take a 
SNAPSHOT of Track1's PAN setting by either clicking on the icon or 
holding AUTOMIX and pressing TAP. 
 
Now, let's locate to 10seconds, where the pan will start. Once again 
we need to take a snapshot at the beginning of the PAN activity. We 
should still be in “Auto-mix-Record-Mode”, so take another snapshot. 
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While we are here, press IN to denote the start of the PAN activity to 
be automated. 
 
Now locate to 15seconds, the end of the PAN. Set Track1's PAN setting 
to R63, and take another snapshot. Also press OUT to mark the e nd 
of the PAN activity. 
 
OK, now to invoke the magic..... 
 
Make sure that Track1's play list area is highlighted. Press F3 to 
SELECT the area between IN and OUT on Track1's Auto-mix Edit 
display. Now press the GRADATION button (above the WAVE DISP), 
and select linear..., Now you have automatic panning! 
 
Remember to set Track1 back to Auto-mix PLAY mode to audition the 
edit. 
By Karl on VSP 
 
VS Gradual Fade Out Automix 
Like Mark sats, the "missing info" is that there MUST be a Automix Event at the 
*exact* START and END points of the area to which the gradation is to be 
applied. 
 
I use IN and OUT instead of Markers. The IN and OUT both NEED to be there for 
the gradation to work, anyway. 
 
Set IN to the start of the fade. Set OUT to the end of the fade. Hold SHIFT, 
press IN to return to the IN Point. Take a snapshot of the Master at Unity. Hold-
SHIFT, press OUT to return to the OUT point. Take a snapshot of the Master at 
Infinity. Press F3 to select the area between IN and OUT. Apply the gradation. 
 
Takes longer to type it than to do it! 
 
LakeStone Karl on VSP 

With a GROUP, you only need to automate ONE member of the grup, and 
they will all follow. 
 
Gigpig, GROUPS work proportionally, no worries about starting at different 
levels, they will all reach "infinity" at the same time. 
 
To use the GRADATION feature,  
 
1) Set the IN Point where you want the fade to start, and the OUT point 
where you want the fade to end.  
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2) Hold SHIFT, press IN, to return to the IN point. Take an AUTOMIX 
SNAPSHOT of the track(s) you wish to fade. 
 
3) Hold SHIFT, press OUT, to return to the OUT point. Move the desired 
Faders to Infinity. Take an AUTOMIX SNAPSHOT of the track(s) you wish to 
fade. 
 
4) Invoke the AUTOMIX EDIT screen, use you cursor to move to the desired 
track(s) and press F3 to select each track you wish to automate. The area 
between IN and OUT should become highlighted as each track is selected. 
 
5) Press the GRADATION button, select your slope (Exponention at the 
beginning, Linear, or Exponential at the End), press OK, and the 2480 draws 
nice smooth transitions for you. 
 
And another way to perform a gradation from Karl.... 
 
1)Invoke AUTOMIX EDIT. Set the TARGET if required. 
 
2) Go to where you want the fadeout to start. Press IN. 
 
3) Go to where you want the fadeout to end, Press OUT. 
 
4) Hold SHIFT and press IN to return to the Start Point. TAKE A SNAPSHOT!! 
 
5) Hold SHIFT and press OUT to return to the End Point. TAKE A SNAPSHOT!! 
 
6) Press F3 to SELECT the REGION. The GRADATION button should now be illuminated. 
 
7) Press the GRADATION button.  

 
For me, taking the snapshots AFTER setting the IN and OUT points is the Magic Ingredient 
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Normalizing Mastered Tracks without VS MTK Inserts. 
If you are sending your master mix out to other gear or PCs for mastering the 
mastered tracks and having trouble with the Left & Right levels being un-equal 
and not loud enough you can do this. Master them without any VS MTKs then 
PHRASE NORMALIZE the master pair. Normalizing acts like a limiter and brings 
the levels up to a more even stage and can tame some peaks. 
A) Mastering room> 
Turn it on, then the PLAY button RED for RECORD and select your 23/24-16 V-
Tracks or what ever ones you want to record too. 

1) Play the auto mix tracks and set the levels on the meters, not the 
master fader, to 0db or -1db. Never light up the “OVER” RED light! 
 
2) Cue the song up to where you want it to begin recording to the master 
and press the RECORD BUTTON, on the VS and PLAY when ready to 
record the master. When the master mix is done, FADE OUT. 
 
3) Press STOP and the back to ZERO button on the VS. Now click on the 
RECORD in the mastering room to change it to GREEN to PLAY the 
master tracks. They should show up grayed out on the screen. If they 
sound good then STOP and ZERO and let's move on to the next step. 

 
B) Normalize 

1) Click HOME and go to tracks 23 & 24 and click on the "1" to open the 
V-Track map and select V-Track#16 on both tracks, 23 & 24 to bring them 
forward in the home screen like regular tracks.  
 
2) Now click on TRACK> and select PHRASE NORMALIZE> and in this 
window place check marks by 23 & 24 and click "OK". It'll take several 
minutes to NORMALIZE the pair of tracks. When done go to the CH-Edit 
page of Track 23 and click CH-Link to link them. Now, send them out. 

 
C) Norm/Masters to Outboard gear or PC 

1) Click Mastering Room to "ON" and GREEN for PLAY and the tracks 
should be grayed out. Press the PLAY button on the VS and set the 
meters to 0db or -1db but never "OVER". When the levels are set, STOP.  
 
2) Now press the back to ZERO button on the VS to cue up the mastered 
pair of normalized tracks and when you're ready to send them to the 
Avalon press the PLAY button on the VS. When the mastered mix gets to 
the end of the song…  
 
3) Watch the meters and when they go all the way down where the song 
fades out press the STOP button on the VS. Now, Zero and you’re DONE! 
*This may not be for every body but if you like the results then do it! 
Also, you can UNDO/ENTER and try again if you like. 
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PHRASE NORMALIZE 
From time to time, when I have tracks that are having LEVEL problems, I 
will NORMALIZE them. What this does is something similar to what 
compression does to a signal. It will take the track and level out the lows and 
highs in a signal. Bring the lows up and the highs a touch down on the 
peaks. When I look at the wave form visually, they look the same but 
listening to them, they sound louder and tighter. You can even do this with 
your mastered pair of master tracks if you like.  
 
To NORMALIZR a track… 
 

1.) Have the TIME LINE touching the tracks data in the home screen, 
then Click on TRACK> select PHRASE NORMALIZE> in this 
window, all track PHRASES that the TIME LINE is touching will 
show up here. 

2.) Select the track to NORMALIZE  by placing a check mark in the 
empty box to the left of it and then click “F5 OK”. 

3.) It’ll take several minutes for the VS to NORMALIZE the whole track 
and if the track has breaks in the data, you’ll have to reposition the 
time line so that it touches them as well and repeat the process on each 
one. 

 
This can be a time consuming process. Stereo tracks about 4 minutes long 
will take about 10 minutes or longer to do. Almost 3 times as long as the file 
in time. The more tracks you have, the longer it’ll take. Some like 
normalizing the master tracks instead, I can’t tell m too much difference my 
self. Always experiment with new processes and make up your own mind 
about what you like best. 
 
Sound on Sound Definition: (they spelled it with an “S”?) 
“Normalization is a digital signal processing function that's available in a lot of 
digital audio editing software (for example Sound Tools, Sound Forge, Alchemy, 
and so on). It scans through the program material for the highest level, and if that 
level doesn't reach the maximum available dynamic range, the software boosts 
the overall signal so that the peak hits the highest level possible. For example, 
suppose you record a track of music and the highest peak registers at 6dB below 
the maximum available headroom. Normalization brings the entire track up by 
6dB. (Incidentally, most normalization functions allow normalizing to some 
percentage of the maximum available level; it needn't always be 100%.) There 
are some problems, though...” 
http://www.soundonsound.com/sos/1997_articles/nov97/normalisation.html  
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Roland’s PDF on the VS8F-3 card’s Mastering tool kit can be 
downloaded from this link, great info... 
http://www.rolandus.com/uploads/CMS/Downloads/291/VS8
F3_WS01.pdf 
 
The INPUT page of the MTK has: 
 
INPUT GAIN - which controls the overall level going into the 
Multi-band Exp/Comp. This setting is very important. You 
don't want any clipping here. I usually stay on the safe side 
with at least -1dB peaks (under the top line). Average levels 
between -12 and -4 (really whatever it takes to keep it from 
going over). 
 
D-TIME (detect time)- this should be left at 10ms if you're 
using the MTK to master. It gives the MTK more time to 
"work". If you were to use the MTK as a track insert effect 
you'd need to back this off unless you wanted an audible 
delay. 
 
L-SPLIT - this is a crossover point for the low frequency 
(have you ever worked with live PA systems?). It allows you 
to pick what freq to separate the "sub" freq from the mids. 
 
H-SPLIT - this sets the freq that separates the mids from the 
highs. 
 
So, as an example, you could set the L-SPLIT to 125Hz and 
the H-SPLIT to 4K.  
This will then allow you to use the Multi-band Comp to 
compress each freq range individually. 
20Hz (or whatever you set the BCut) to 125Hz with the Low 
Comp. 
125Hz to 4K with the Mid Comp. 
4K and up with the High Comp.          From VSP 
 
SELECTING A PATCH 

http://www.rolandus.com/uploads/CMS/Downloads/291/VS8F3_WS01.pdf
http://www.rolandus.com/uploads/CMS/Downloads/291/VS8F3_WS01.pdf
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It goes something like this, say the VS8F-3 card is in slot "A" so that's 
EFFECT 1 & 2. 
1)Click EFFECT> EFFECT 1> a window opens 
2)Click "F1 Plug-in" and another window opens 
3)Select the plug-in to use by highlighting it, let's say VS8F-3 MTKs 
4)Click "F5 Select" and another page comes up.. 
5)Click "F3 Patch" and the patches open up a list of presets... 
6)Highlight one of the patches/presets and click "F5 Select" now it loads the 
plug-ins patch you selected 
7)Now you can click "F5 EXIT" and be done or click "F4 EDIT" and setup 
you patch. 
By Frank Griffith 
 
First select the MTK on the card as you normally would do.  
Above the master fader there is a button called Tr1-16 or master 
block.  
 
Press and hold down the shift button and press the tr1-16, this will 
bring up the master edit block.  
In the tabs below you will see a tab called FX Insert.  
 
Press that and select the slot that has the MTK patched in, this has 
now placed the MTK over the stereo buss.  
This should give you a clean sound? 
 
From VSP. 
 
Waterman, Pete  
Uses these settings for live recordings in the MTK. 
MTK #231 "mixdown" 
EQ on  
Low Low mid Hi mid High In gain  
gain 0db 0db 1db 2db 0db 
freq 100hz 500hz 1800k 10k Level 
Q 1.0 1.0 1.0 1.0 2db 
shelv shelv 
 
B-cut off 
Enhancer off 
 
MTk In 
In Gain D-time 
3db 10ms 
Split Point 
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Low High 
3.5Hz 3.15 Khz 
 
Expander off 
 
MTK Comp on 
Low Mid High 
Thresh Ratio Thresh Ratio Thresh Ratio 
-9db 1:3.1 -9db 1:2.0 -15db 1:2.0 
Attack Release Attack Release Attack Release 
30ms 239ms 20ms 500ms 20ms 300ms 
 
Mix/ Low 0db Mid 0db High 0db 
 
MTK limiter on 
Thresh Attack Release 
-1db 2ms 1.377s 
 
Soft Clip off 
Hope this helps, 
Pete 
 
Gaws replied… 
Also in the MTK, turn the Boost Cut "on", and set it around -25, it's been said 
that that's where the "Mud" usually is.. if'n ya gotz mud. 
 
Theotherfredolsen uses the 3card MTK & LA2A like this…. 
I just checked --- here are the real numbers for the mastering of Jimmy Got 
a Gun  
 
- 3 MTK is insert FX1 in the mastering room everything is off except 
Bass Cut - 20 Hz, Soft Clip – on, Output - 1.5 dB 
 
- LA2A is insert FX2 in the mastering room switched to compress (not limit) 
Gain Reduction switch is in the middle position between +4 and -10 
Gain – 49, Peak Reduction - 45 
 
I guess I really did use a light touch on this one. 
at mix stage I used the -2 card FX looped with varying degrees of send on 
the channels 
P000 – reverb,P001 – reverb, P003 - delay 
there were a couple of printed effects on a couple of tracks 
 
Theotherfredolson MTK & LA2A 
Try the following settings: 
In the -3 MTK (assume everything off unless I give a setting): 
BassCut - ON @ 20 Hz, SoftClip - ON 
Output - 1.5 dB (or more so that your levels are high --- near 0 dB) 

http://www.vsplanet.com/mp3s/f/fredolsenJimmyGotaGun.mp3
http://www.vsplanet.com/mp3s/f/fredolsenJimmyGotaGun.mp3
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LA2A: 
Compress/Limit Switch - Compress 
GainReduction switch - Middle position 
Gain – 49, Peak Reduction – 45 
 
LDT2 Uses the VS8F-2 card’s “Mixdown” Patch for “Commercial 
Sound” with your master CD. 
Start with the MIXDOWN MTK patch. Turn everything off and start with 
the EQ and progress thru the MTK pages. 
 
I usually just drop a couple db of low mids (around 400hz to 500hz or 
whatever's bugging me) and raise the high's a couple db. Turn the low 
cut ON at 20hz or 25hz. The enhancer's up to you if you want to 
sparkle things a bit. 
 
Now as far as levels go.... 
 
1st, try setting the INPUT level so there are no 0dB peaks (stay under 
to be safe). Set your crossover frequencies however you like ( I 
usually drop the low/mid # and raise the mid/high #). 
 
2nd, set your Multi-band Comp so you're getting around -4 to -6 Gain 
Reduction on your Mids (depending on how "commercial" you want to 
squash it). Match that Threshold setting on your lows and drop 
another 2 numbers on your highs. Also bump the highs a couple 
numbers on the MIXER after the Comp. 
 
3rd, run the OUTPUT level at +3dB with the softclip ON. This usually 
slams it up a bit. Now, the solfclip actually works quite well, but it 
limits to about -1.9dB, so, go into the MIXER menu and select MASTER 
EDIT. Then click on FX INS. Now turn the RTN level for the MTK up 
1.9dB ( I've found that 2dB puts the levels over, but use whatever 
works for you). 
This will get you up to 0dB and give you that "commerial hot" sound. 
 
Also, remember to use a comercial CD of similar style as a reference. 
VERY important. 
 
Here's a little trick... you can pull the INPUT level down and it will 
change how hard the multiband comps hit the song overall.  
 
How low did you have the gain reduction set? 
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Try starting with -15db lows, -15 mids and -17 highs. Depending on 
how much INPUT you put into that, it'll make a big difference. 
 
More recent reply by Waterman on 2card MTK 
I have 4 2-vs8f so I use those MTK's for mastering. I use pattern 231 mixdown 
here's how I tweak it. 
 
First of all you said you were using the expander, I never use it. On all the 
effects in the MTK watch your input/output gain you might be driving 
something to hard? 
 
Here's what I use: 
1.EQ on, tweak to taste, I usually cut lows and mids a bit and boost the high 
freq's for a little high end sizzle. Again, watch your input and output gain! 
2. b-cut off 
3.Enhancer off, although someone here told me I should try it, it's cool? 
4.Mastering tool kit in, watch your input gain. 
5.Expander, never use it! 
6.Compressor on, tweak to taste, I'll mess with all the settings, 
Threshold, Ratio, Attack, Release. Low freq's like fast, attack and release. 
7.Mix set as default 
8.Limiter on 
9.Soft clip on 
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VS Pitch Correction/Auto-tune   by Frank Griffith 
In order to use the VS for pitch correction with Auto-tune you need to buy and install the 
VS8RF-3 Card. See other docs in this manual for more on VS8F-3 acrds. 
 
Auto-tune plug-in Settings 
These are basic settings to use as a starting point. 

1) Select Alto/Tenor etc your vocal range and then set (L + R) to MONO. 
2) Under SCALE select Chromatic. 
3) Set the RETUNE speed between 10 to 15 
4) Set the TRACKING to 1 for Choosey 
5) Select the proper KEY of the song. 
6) No vibrato, normal setting for vibrato are Depth 44, Rate 4.6, Delay 315. 

Once you have these settings selected you can use the Tracking and Retune speed to 
adjust Auto-tune to taste. It’s best to set Auto-tune so that you hear the effect changing 
the vocal then slowly back settings down until you can’t hear the effect. If needed, you 
can run a vocal thru Auto-tune several times to correct a vocal bit by bit to avoid hearing 
Auto-tune’s effect on the vocal. 
 
VS EFFECT P022 Vocal Multi for Pitch Correction.  By Lakestone Karl on VSP 
To use the pitch shifter, you must do some auto-mixing. 
But, you should be able to HEAR the shift, anyway! 
 
I use P022:Vocal_Multi for this. 
Turn OFF everything except the Pitch Shift section. 
In the Pitch Shift section: 
    1)  Set the FX_LVL to 100 
    2)  Set the DIR_LVL to 0 
    3)  The CHROMA control shift by half-steps (chromatically). 
    4)  The FINE control gets in-between notes. 
OK, Set up a patch where you are sending the vocal to the FX as a LOOP, not as an 
INSERT. 
To audition the adjustment, it will be lots easier if you auto-mix a little first. The idea is 
to hear ONLY the original track up until the note that is bad, then switch to hear ONLY 
the output of the FX during the bad note, then switch back to the original track after the 
bad note.  
Then, you can play the section, and adjust the FX's FINE pitch control until the note is in 
tune. 
Once that is done, I'd PRINT THE FX for that note to another track. If the fixed note is 
longer than half a second, you can edit it in place. Otherwise you must either use the 
same auto-mix trick with that "fixed" track, or jump thru some hoops to perform the edit. 
If you have enough tracks to host that fixed track, auto-mixing is easier. 
 
I have used this method to fix vocals and GTR solos with great success.  
 
JJC ask Question: Karl, got it set up like you said, but am missing something on "then 
switch to hear ONLY the output of the FX during the bad note, then switch back to the 
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original track after the bad note". Am I supposed to output JUST the effect & if so how? 
I'm hearing either the tracked note or both the original note AND the patch 
simultaneously. I toggle back & forth out of the patch but can't separate them, even tried 
copying the region (it's the last note of the song....16 beats-worth) to another track. Any 
idea what I might be doing wrong? – 
 
Answer: OK, for this to work, you must send the signal to the FX "PRE" fader....so the 
FX gets the signal, even when the source channel's fader is turned down. If your original 
track is VT2, and you are using FX3 to do the shift, set the AUX3_SEND in 
CHANNEL_2 from "PST" to "PRE". 
 
All you need to do is lower the fader of the original track, and at the same time raise the 
fader of FX3_RETURN. 
16 beats? That's a long note to "fix". Hoo Boy! 
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VS PRE/POST RECORDING & MIXING                                   By Frank Griffith 
Like I’ve said before, set faders to 0db on the inputs and track faders, use the 
SENS/PAD to set your levels and use the "F2 IN MIX" for setting inputs and then click 
on "F3TR MIX" for track levels to be sure they are the same with the meters set to 
POST. Once your levels are set where the meters are running at -12db with a few 
peaks turning on the yellow lights -11db to -5db, then record your track. This will 
leave headroom for adding EQ/Dyn/Comp/EFX in the mixing stage. I set my peak 
meter at -6db. 
 
Once tracks are recorded; during mixing remember, if you click on PRE and see any 
levels going into the OVER you need to back off on EQ, COMP or use the ATT knob on 
the CH-Edit page of the tracks that are going OVER, to bring the levels back below 
OVER and 0db. *There is a separate LED that lights up for the OVER mark. 
 
Once tracks are recorded, the PRE setting shows you the level that was recorded and 
what's been added with EQ & Compression. Do not let these levels go over 0db and 
turn on the RED OVER LED or it can add distortion. When you are playing the tracks 
and watching the meters on the PRE setting you will notice that the TRACK Faders 
will not affect the level of the meters. This is normal, PRE means you are seeing the 
signal before it arrives at the TRACK Fader. The only ways to control this level is by 
pressing the tracks CH-Edit button and adjusting the EQ, Compression Dynamics 
settings, using the ATT (Attenuate) knob or editing some EFFECTS patches levels. 
 
POST allows you to use the TRACK Faders to adjust the levels in the mix after the 
signals pass thru the TRACK Fader, it does not change the recorded level at all. The 
track faders do nothing to the meters on PRE, the only way to affect that level is by 
recording it over again or lowering the ATT, EQ, Compression and/or sometimes 
EFFECTS. 
 
Sometimes it can be tricky getting the right mix while watching both the PRE and 
POST meters. Adding EQ is the one thing that can change the signal the most, then 
compression comes next and then maybe some EFFECTs patched. I usually go for 
the EQ first to see if I can cut back on it some where when I see a hot PRE meter. 
Also, the ATT knob is a good knob parameter to use when you have a problem track 
that was recorded to hot and you can not get the performer back in the studio to 
record the track again. Use the ATT knob to bring the level down below 0db. 
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Preamp Distortion Test 

NOTE: All these steps CAN be completed WITHOUT listening to anything. TURN 
YOUR SPEAKERS AND 'PHONES OFF, or WAY WAY DOWN. 
 
 
1) Go to the GEN/OSC screen under your UTILITY menu. Select a 1KHz Sine Wave as 
the "SOURCE" (by left clicking and dragging thru the options). Turn the MIX button 
OFF. Turn on Direct Out 6. Turn the OSC. ON. 
 
2) Go to the EZRouting screen, upper right quad of the screen. Connect your analog 
output 6 to Direct Buss 6. You should now have a nice 1KHz sine wave emanating from 
analog output #6. You can verify this by connecting to any external amp (KEEP THE 
VOLUME DOWN!!). 
 
3) Turn ALL the SENS knobs MAX CCW (counter clock wise), and place ALL the 
PADs IN. Connect a 1/4" TRS cable between output #6 and the input to be tested. A 2 ft. 
cable should be long enough 
 
4) Invoke the Analyzer, again under the UTILITY menu, and set it to monitor the INPUT 
UNDER TEST, meaning, dial in IN 1 thru 16 one input at a time on the Analyzer. Also, 
select A, B, C or D for the slot of the effects processor you want to use during the test. 
Effetcs 1 & 2 are slot A, Effects 2&4 are B etc.The VS8F-3 card will not work so pick a 
VS8F-2 card. Also put the PRE/POST on PRE. 
 
5) SLOWLY rotate the SENS control, while monitoring the Level on the left side of the 
Analyzer display. You should see a SINGLE VERTICAL BAR @ 1KHz in the main 
portion of the Analyzer display. 
 
6) As you continue to SLOWLY raise the input control, the 1KHz bar will grow, and 
smaller sidebars will start at 800Hz and 1.2KHz. This is Normal. 
 
i.e. this is a visual of a good: 

 
 
7) When the input overloads, all kinds of Upper Harmonics will be displayed. If this 
occurs at 0dB on the input meter, that's cool. If it occurs at -4 or -6 dB on the input Meter, 
you need the fix. 
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i.e. this is bad: 

 
 
Keep in mind, once you overdrive the input, you might not notice the distortion on that 
channel for awhile. That's the quick theory behind the "Crank". Meaning, you can quickly 
turn an input up and then back down before recording what signal is on that input and 
possibly not run into the harmonic distortion. 

Text by: Lakestone Karl 
Graphics by: Falcon Eddy & later edited by: Frank Griffith (For Newbies). 

PARTS USED by MENGES & LINKS To do the preamp fix job yourself (Copy and paste some links, 
Ctrl+ L-Click others) 

I've done three with no problems.... E-mail me if you need any help. 
RadioShack.com  
Socket... 
http://www.radioshack.com/product/index.jsp?productId=2062604&cp=&kw=socket
&parentPage=search 
 
Resistors... 
http://www.radioshack.com/product/index.jsp?productId=2062351&cp=&fbn=Type
%2F1%26%23047%3B4+Watt+Resistors&f=PAD%2FProduct+Type%2F1%26%230
47%3B4+Watt+Resistors&fbc=1&kw =1m+resistors&parentPage=search 
 
Desolder... 
http://www.radioshack.com/product/index.jsp?productId=2062745&cp=&kw=desold
er&parentPage=search 
 
http://www.digikey.com/ 
2604... 
http://www.digikey.com/scripts/DkSearch/dksus.dll?Detail?Ref=114539&Row=4863
89&Site=US 
2134... 
http://www.digikey.com/scripts/DkSearch/dksus.dll?Detail?Ref=115842&Row=5315
10&Site=US 

DWEIL’S Parts list “Pimp My VS” LINK to Post. 

http://www.vsplanet.com/ubb/ultimatebb.php?ubb=get_topic;f=16;t=018614  

From Brett’s Site…   http://www.rolandvs2480.net/  Edited to make more sense by Frank Griffith 

http://www.digikey.com/
http://www.digikey.com/scripts/DkSearch/dksus.dll?Detail?Ref=115842&Row=531510&Site=US
http://www.digikey.com/scripts/DkSearch/dksus.dll?Detail?Ref=115842&Row=531510&Site=US
http://www.vsplanet.com/ubb/ultimatebb.php?ubb=get_topic;f=16;t=018614


 3 

 



 1 

VS REC & MIXING TRACKS               By Frank Griffith 
1) I record every thing between -12bd and -6db. Never below  -12db on the 
tracks. I EQ and compress bass, snare and kick the most so I record them at -
12db. On the tracks that I EQ less and want the loudest, like vocals, I'll let them 
peak no higher than the -6db mark. It just takes getting use to figuring out which 
tracks you want at what level for mixing afterwards. Also, the VS Master Bus 
does some summing of all tracks so this leaves less “Headroom” for EQ, 
Compression and Effects to be added. 
 
2) Then I mix and add my EQ, Comp & Effects to the tracks in POST. Now this is 
the important part. I then click on PRE and check all of the meter’s levels. Any 
thing that goes over 0db, I go to their CH-Edit page and I cut back on EQ and/or 
ATT knob it, the attenuate knob controls the levels before they go thru the track 
faders. Once they are all under 0db I move onto the final mixing. 
 
3) I click on POST and start with the tracks I want the loudest first, Vocals and 
Leads and get them as loud as I can without going over 0db.  Then I mix all the 
other tracks underneath those adjusting only volumes and panning and if I do EQ 
any thing, it's to cut. If I have to boost any track at that stage of the mixing then I 
go back and check the CH-Edit page and PRE levels again. 
 
4) Once I have the song the way I like it I press SHIFT+STORE and save it! Now 
I let the song sit and I take a break and come back for another listen after my 
ears have rested 15 minutes at the least and some times over night. Then come 
back and make final adjustments to the mix. 
 
5) Once I'm sure it's how I want it, I master the song and I Optimize that project. 
Once I have enough songs mastered and Optimized I do a backup of them. If it's 
really important, I do a backup of that song by it's self. Optimizing and SAVING 
projects are important. You can SHIFT+STORE any time a lot of work has been 
done that you don't want to lose and once the final mixing is done I optimize the 
project. 
 
*Note: If you set your input & track faders at 0db and use your SENS and PADS 
to set your levels they will be consistent from input to recorded track. If you 
record your signals at -12db then you won’t have to worry so much with the ATT 
knob after adding EQ and compression. Recording at -12db leaves you room for 
adding what ever you need in mix as long as it’s not an extreme amount. 
 
Panning & the Stereo Field 
Another thing to keep in mind is the stereo field. Where you place items in the 
mix helps to bring them out of the mix. If everything is panned to the center then 
you will wind up with a muddy mess. Think of the PAN knobs as being hands on 
a clock that can turn from 7 o’clock clock wise to 5 o’clock. Try to place 
instruments, vocals and drum parts through out the stereo field. A good way to 
think about where to place them is to think of a band on a stage and place them 
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where the members would be on the stage left to right. Now think of front to back. 
You can use volume to make the vocalist sound up front, the louder the closer 
and visa versa. You can also use REVERB to add distance as well. The more 
reverb, the further away an instrument sounds. Reverbs can also be used to 
emulate a space like halls, rooms, cathedrals etc.  
 
Then there’s EQ and Compression of which there are other documents on these 
subjects but briefly, compression can be used to add punch to parts of the drum 
kit and to instruments like bass to make it stand out in the mix. There is a rule 
with EQ and Compression, less is more. Mixing can be an art. It can also be a 
mater of preference. Everybody has their own way of mixing but the more they 
learn about it and the more they do it, the better they get mixing a good mix, IMO. 
 
Recently I have been mixing my tracks and using the PRE & POST fader settings 
and doing it this way might help you to mix easier. This is just another way of 
mixing and focusing more on the PRE/POST setting. PRE shows you the 
recorded track levels before they reach the TRACK FADER. POST is the level of 
the TRACKS after the FADER, meaning the FADER controls the level on the 
meters.  On PRE, the track fader does nothing to the levels but adding 
Compression and EQ does add to the recorded track level. 
 
Mixing with PRE & POST                                                     by Frank Griffith 
When recoding your tracks, you do not want your meters to go over. There is an 
"OVER" red light and I do not let it come on. Also, while recording the tracks I 
would have my PEAK HOLD set to -3db but -6db is even safer. That way, if it 
lights up I know I'm not leaving enough head room for EQ & Comp in the mixing 
stage. I try to record between -12 & -6db and use the -6db PEAK HOLD as the 
highest level that's acceptable. 
  
1. Bring all the track faders down. Set the MASTER RED fader to 0db. Then I 
start out with the drums and do each drum & percussion track one at a time by 
soloing them, then raising its track fader to around 0db. While on their channel 
edit pages I have the PRE button on. That way I am looking at what the recorded 
levels do as I add or cut EQ settings and Compression.  
  
2. Once all are sounding good one at a time, I turn them all on and go to POST 
and set the track levels so that the drums track levels sound good mixed all 
together. 
  
3. Now I add the bass track but I first solo it, bring it's track fader up to around 
0db and set the CH-Edit page on PRE and get it to sounding the best I can with 
EQ and/or Comp or none or both. Once I have it sounding good I take it off of 
solo and select POST and add it to the drum mix. Making sure the kick and bass 
is not drowning out the other and set the levels. If something can not be made to 
be heard, it's not loud enough, then lower all of the faders 2db and try again or 
add Comp or EQ or both. 
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4. Now I do the same thing with the rhythm guitars, SOLO then mix on their CH-
Edit pages with PRE on then solo off, go to POST and add them to the mix. Then 
do the same with lead guitars and last I do my vocals. 
  
5. Now is the time I start adding in REVERB to what ever track needs it and in 
what ever amounts I like. This stage can muddy up the mix if you are not careful 
so take your time and as I add reverb to tracks, I like to MUTE the others so I can 
really hear how much I am adding before adding the track with reverb to the mix. 
Just remember, LESS IS MORE. 
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Frank, here’s the doc. Karl sent me…. 
 
Region Arrange: 
These PMs are the best way, especially on weekends. 
 
OK, next time, you don’t need a new project for every song, but it will 
help ALOT to push PLAY then RECORD between songs, even for a half 
second. Even between every few songs is a benefit. 
 
The reason for this is the "non-destructive editing" as implemented on 
the 2480. Here's what happens.... 
 
The basic unit of audio on the 2480 is the PHRASE. A PHRASE is one 
continuous piece of audio on a single (or two, if linked) track. When 
you record something, all the audio from when you push RECORD to 
when you push PLAY or STOP, is a continuous PHRASE. If you were 
recording on three tracks, then there are three PHRASES, of 16 
PHRASES if recording on all 16 tracks. Got it? OK! 
 
So, if you pushed RECORD at the beginning of a set, and didn't push 
STOP or PLAY at all until the end of the set, each PHRASE you 
recorded is a whole set long! Still, it’s good with me. 
 
 
Now, let's think about what happens when we try to EDIT a PHRASE. 
Forgetting about the live project for a minute, let's just use a GTR solo 
track as an example. You started recording at the start of the song, 
but the GTR solo didn't come in until 1:45. So you decide to REGION 
ERASE the first section of the GTR SOLO track. 
 
Now, the GTR track LOOKS smaller, but is it really? Does it consume 
less disk space?? The answer is NO. Even after you ERASE part of a 
PHRASE, you can still recover it with a simple drag of your mouse. In 
fact, you can move a small slice of a PHRASE to a completely different 
track, then recover the entire phrase on the new track! Not that you 
would, but you could. 
 
OK, so let's apply this to the live project. A live set may be well over 
2GB in size! That's a lot of data to copy and backup. So, the natural 
thing to do is to make a copy of the original project, erase all but one 
song, and save the smaller project. But, beleive it or not, the PROJECT 
WILL BE THE SAME 2GB SIZE, even though only a single song is 
displayed. Not very efficient. 
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So here's how to get around it. It's not fast, but it works. 
 
First, MAKE A COPY OF THE ORIGINAL PROJECT, and edit the copy. I'd 
go ahead and PROTECT the original, so you have less chance of 
accidentally editing it. Make PROTECTED copies, then UNPROTECT the 
copy to edit. 
 
OK, now on to the business at hand. We're gonna use the REGION 
ARRANGE function on the 2480. The REGION ARRANGE function uses 
Markers, so let's drop a "000"Marker before and a "001"Marker after 
the song you wish to lift from the set. (I'm assuming these are the 
ONLY two markers in the project, if not, you just need to know what 
the markers number really are that delimit your selection. The marker 
numbers do NOT have to be consecutive.) 
 
ANYWAY, here we go. Invoke the REGION ARRANGE dialog from the 
TRACK menu. Press F1 to CREATE a region. Select 000 as the START, 
and 001 as the end, of the region (or substitute your own marker 
numbers). Press F5, NEXT. This is where you tell the 2480 WHERE to 
place that region. Just set it WAY OUT PAST THE END of any exiting 
audio, way out at 2 or 3 hours!! The exact placement is unimportant. 
Press F5 to perform the edit. 
 
Listen to the newly placed audio to make sure it is what you want, 
both at the start and the end of the song. It is better to leave it a little 
long at this point than to chop it too close.  
 
Anyway, when you're satisfied, move to the start of the newly-created 
section, and press OUT. Then locate to ZERO, and press IN.  
 
OK, here we go, no going back now....invoke the TRACK->REGION 
CUT menu item, and make sure the "AllVTr" option is set to ON. Press 
F1 to select tracks, then F2 to select ALL tracks. Now press F5 to CUT 
OUT ALL THE AUDIO EXCEPT THE RELOCATED AUDIO, thus bringing 
the relocated audio to ZERO in the process. Check it out, there should 
ONLY be the smaller section of audio showing, not the entire set.  
 
Even if you were to SAVE the project right now, it would STILL BE 
EXACTLY THE SAME 2GB SIZE!!! So now, you choose OPTIMIZE. 
OPTIMIZE will get rid of all the stuff that was CUT, leaving you with a 
single song, well less than 1GB. 
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Audio PC Setup 

This section is for anyone running a VS-2480 with the Roland R-BUS card (s). It's a 
basic setup to help you along the way to obtain audio from the 2480 to your PC and back 
again. Note that the RPC-1 from Roland is in fact designed and built by M-Audio, not 
Roland themselves. 
From this link on line… http://216.120.230.86/~rolandv/Audio%20PC%20Setup.htm 
Follow these instructions for correct installation: 
  
  
The dip – switches on the rear of the RPC-1 cards are for choosing the Clock source. In 
this case, the RPC-1 should be slaved to the 2480. To do this, the switch nearest to the 
RPC-1 cards 25 pin D-sub cable should be down, and the other switch should be up. 
  
You will need to open the RPC-1 software (Roland RPC-1 H-W) to check the about tab 
for the version number. 
It should be Version: 5.10.00.0033x6 
The Panel Version should read: 1.02.08. If yours matches, then you have updated your 
drivers correctly. The RPC-1 software (Roland RPC-1 H-W) should be in your Control 
Panel folder. You can get the latest drivers here for PC and here (both) Mac1, Mac2 for 
Macintosh - this is the latest official software update from Roland and fixes the ASIO 
distortion / sync problems for audio software using the ASIO protocol (10.11.03). Here 
are the latest Delta R-BUS drivers. Download the drivers related to your specific card 
make and model. 
  
Once you have checked for the Version in the About tab, choose the Hardware Settings 
tab and  make the following changes: 
  
Master Clock = External 
MultiTrack Driver Devices = Single and in sync (Multiple Card Sync for 2 or more RPC-
1 cards installed) 
DMA Buffer size = 384 
  
The Disable Control of…. And the Reset when idle… boxes should both be ticked. 
  

 
  
Adjust nothing else in the other tabs – they do not apply to the Roland RPC-1 card. These 
are for the M-Audio card only. 
  
You can save your setups, and I advise you to do so now. Call it whatever you want. I 
call mine RPC-1 PC Setup. 
  

http://216.120.230.86/~rolandv/old-site-content/RPC1_ver_33x6.zip
http://216.120.230.86/~rolandv/old-site-content/RPC-1_Installer_1011.sit
http://216.120.230.86/~rolandv/old-site-content/RPC-1_00C4.dmg.sit
http://www.midiman.com/
http://www.midiman.com/
http://216.120.230.86/~rolandv/old-site-content/RPC1_384ms.gif
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The External Clock Sample Rate should be set to the same sample rate as the 2480 
project you are working on. This is because the 2480 will be sending its Master Clock to 
the R-Bus, and of course your PC software. So if you are like me, this can stay at 44.1 
KHz. If you want to work higher, then you must have a 2480 project at the desired 
Sample Rate, and you must change the External Clock Sample Rate in the Roland RPC-1 
H-W each time. 
  
Remember also, that whenever you use your system, you must always turn the 2480 on 
first, leaving the PC the last thing in the chain to turn on. This is to ensure that the RPC-1 
card (s) gets the correct Master Clock. 
  
  
Now you need to go to the 2480 and check the following: 
  
Hit the Utility button and then F3 to bring up the Project Parameter page. Make sure that 
the Master Clock is set to INT. 
  
Dither and Digital Copy Protect should be OFF. 
R-BUS Coaxial Sel and R-BUS Optical should be left alone for now as they are. 
  
Still in Utility, you need to push the button for the SYNC Parameter page. Make sure the 
Sync Mode is INT. As a matter of interest, if you are running a sequencer on the PC and 
want to sync with Midi Time Code from the 2480, then make sure that you choose MTC 
in the R-BUS1 SYNC Gen. You will have to tell your software what type of 
synchronization you are using (MTC) and from where (Midi RPC-1). Then, when you 
play the 2480, as long as the Tempo of the 2480 matches the tempo of your software 
sequencer, you will see that they run in perfect sync! 
  

 
  
Remember to set up (EZ Routing) the RPC-1 inputs and Outputs on the 2480! This can 
be a bit confusing at first, but I will try and help! 
  
Press EZ Routing and View. Here, you should see that the R-Bus1 inputs are attached to 
IN 17-24. This merely means that the R-Bus 1 input is controlled by Input Channel 17, 2 
by 18 and so on. 
  

 
  

http://216.120.230.86/~rolandv/old-site-content/sync%20parameter_0001.png
http://216.120.230.86/~rolandv/old-site-content/EZ%20routing_0001.png
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Press Output. Here you can see that the R-Bus1 outputs are paired in stereo to the AUX 
outputs 1 – 8. If they are not, then move them so that they are, just for now. 
  

 
  
If you now flip to the Channel inputs 17-24, press the CH EDIT on Channel 17 and in the 
display, make 17 and 18 a stereo pair by choosing ChLINK On. This will pan them 
automatically, and put them both at 0 dB. Technically speaking, if you have set up your 
audio software correctly, the 2480 should play any signal coming from your RPC-1 to the 
speakers. 
  
With multiple cards, the RPC-1 returns from your PC/Mac can be sent to any channel you 
desire via the EZ Routing page. Generally, with my 2 cards, I send them RPC-1(1) to 
channels 9 - 16, and RPC-1(2) to channels 17 - 24. This leaves the analog inputs channels 
1 - 8 free for midi gear, FX returns etc. 
  
Don't forget that the RPC-1 cards can also be used as FX sends from AUX send to your 
music software, and back again to your input channels! Great for Reverbs etc!! 
 
From Brett’s site... 
http://www.rolandvs2480.net/ 
 
 

http://216.120.230.86/~rolandv/old-site-content/EZ%20routing_0002.png
http://www.rolandvs2480.net/
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VS File System: The VS2480 uses the FAT32 and older models FAT16 files system when formatting 
therefore making the hard drive compatible with PC setups with NTFS file systems. This means you can 
connect a VS hard drive to a PC for using various PC programs and tools to recover data from VS hard 
drives. The only unusual thing is the partition table: The VS uses up to 10 Primary Partition entries in the 
MBR whereas FAT Spec only defines 4 Primary. Therefore you will need to use a partition shuffling software 
to get to the remaining partitions. Below are examples from VSP members who reported doing this. Good 
luck, Frank.  
 
Brett’s Data Recovery renaming VR1 Song files at this link, copy and paste in a URL.... 
http://www.rolandvs2480.net/2480-
FAQs/Roland%20VS2480%20Hard%20Drive%20Recovery%20Procedure.htm 
  
VS ScanDiskinPCXP           From VS-Planet 

1. Install your 2480's HD into your computer, there should be an extra 
HD ribbon hanging from the main hard drive in your PC Tower. Set the 
PIN/Jumper on the VS hard drive to “Slave.” 
2. Boot PC to Windows XP once it’s up and running, 
3. Launch Windows Explorer to see if the drive is recognized. If so, 
continue to next step, if not then you may want to stop. 
4. Right click on the 2480 Drive> select Properties> then the Tools tab 
> Click the Check Now button. 
5. Check both boxes and then start. 
6. Wait until it is finished, may take a long time depending on PC 
speed, issues on hard drive and other problems. If it finds errors tell it 
to “Truncate” them. 
7. When finished, shutdown the PC and install the hard drive back into 
the 2480. 
8. Boot the 2480 and see if it worked. 

 
http://support.microsoft.com/kb/315265/en-us 
 
Here's the link to Microsoft’s Knowledge base site on how to run "Scandisk 
in Windows XP." It may or may not help. 
 

 
VS2480 Data Recovery                                      By Brett LaCroix 
http://www.rolandvs2480.net/2480-FAQs/2480-hangs-on-boot-up.htm 
 
Recovering Lost Songs or Directory from a Partition on the VS2480 Hard 
Drive 
 
 
First, you must remove the hard drive from the VS2480. Look closely at the 
pin configuration for your particular hard drive and note what the setting is 
for “Master” and for “Slave”.  
 
You will need to reset the “pin configuration” and hook up the VS2480 hard 
drive into your computer as a “Slave drive”. Once you are hooked up and 
your computer is turned on, make a “file folder” on the “desktop” and call it 

http://support.microsoft.com/kb/315265/en-us
http://www.rolandvs2480.net/2480-FAQs/2480-hangs-on-boot-up.htm
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“VSData” (just to keep things easy and clean). This is where you will “copy” 
VS2480 “SONG” information “to”.  
 
On the “desktop” of your computer, double click on the “My Computer” icon. 
The window will open up and show you all of the drives you have connected 
to your system. For example;  
 
3 1/2 Floppy (A:)  
Local Disk (C:) 
Compact Disk (D:) 
…etc… 
 
The VS2480 hard drive will show up as “letter! ” (IDE) drives, other than 
those listed above. (For example: partition “0” from the VS hard drive may 
be IDE (E:), partition “1” may be IDE (F:), and so on…). They may not be 
organized exactly one after another but the progressive lettering is in order, 
so pay close attention to what drive letters belong to the VS2480 hard drive. 
(Note that only the first 4 (IDE) partitions of the VS2480 hard drive may be 
listed). These new drive letters may not exceed (4), but the partition you 
need to recover is usually within the first 4 partitions anyway.  
 
When you open one of the VS2480 hard drive (IDE) partitions (that would 
not open on the VS2480), you will see a list of “file folders” like the following;  
 
SONG0001.VR1 
SONG0002.VR1 
SONG0003.VR1 
SONG0004.VR1 
…and so on… 
 
Following the SONG.VR1 file folders, there will be (14) more files in the list. 
These (14) files are what tell the VS2480 what to do with the information on 
that partition. One or more of these (! 14) files will be corrupted, and 
preventing the VS2480 from booting-up that partition, or preventing a 
specific SONG from loading.  
 
You will need to “copy” each SONG.VR1 file folder (and its contents), one at a 
time, over to the “VSData” file folder that you created on the desktop. But 
DO NOT copy the (14) files from the list following the SONG.VR1 file folders! 
 
For example: Once you have copied the SONG0001.VR1 file folder (with its 
contents), over to the “VSData” file folder, you can check the contents by 
opening the newly copied SONG0001.VR1 file in the “VSData” folder. You will 
see (21) files that look like the following; 
 
AMIXPCTL.VR1 
AUTOMIX0.VR1 
AUTOMIX1.VR1 



 3 

AUTOMIX2.VR1 
AUTOMIX3.VR1 
AUTOMIX4.VR1 
AUTOMIX5.VR1 
AUTOMIX6.VR1 
AUTOMIX7.VR1 
AUTOMIX8.VR1 
AUTOMIX9.VR1 
COMMENT.VR1 
EFFECT.VR1 
EVENTCFG.VR1 
EVENTLST.VR1 
MARKER.VR1 
MIXER.VR1SCENE.VR1 
SONG.VR1 
SYNCTRK.VR1 
SYSTEM.VR1 
 
After the first (21) files (that will always be in every song), there will be a 
number of TK.VR1 files. These “TK.VR1” files are the actual recorded audio 
track information. The number of TK.VR1 files that appear in each “SONG” 
will vary with the number of audio tracks recorded to each particular song.  
 
TK000004.VR1 
TK000242.VR1 
TK000431.VR1 
TK000492.VR1 
…and so on… 
 
Once all of the songs from the “corrupted” partition have been copied over to 
the “VSData” file folder on the desktop, you should make sure that the 
number of songs in the “VSData” file folder are equal to the number of songs 
from the VS2480 hard drive (IDE) partition. Take note of how many 
“SONG’s” you have. 
 
Only “AFTER” you are completely sure you have copied all of the songs (and 
their contents), over to the “VSData” file folder, you can “delete” ALL of the 
SONG’s and the (14) files. But ONLY from “that” particular VS2480 hard drive 
(IDE) partition! DO NOT delete anything from any other VS2480 hard drive 
(IDE) partitions! 
 
Now remove the VS2480 hard drive from the computer and reset the “pin 
configuration” back to the “Master” setting for that particular hard drive. Re-
install the VS2480 hard drive back into the VS2480 and turn on the power.  
 
The VS2480 should load up a “song” from one of the partitions (it doesn’t 
matter which one). Go to the “Project List” and select the IDE partition where 
the corrupted files “used to be”. Select “List” and a “New” song will open up 
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and be added into that partition. This song should be “InitProj.000”. Continue 
adding “New” songs to that partition (and don’t forget to SAVE each one as 
you go), until you have reached the number of songs you previously took 
note of earlier. 
 
Once you have the correct number of “empty” songs, shut down the VS2480, 
and remove the VS2480 hard drive again. Chang! e the “pin configuration” 
over to “slave”, then install the hard drive back into the computer. Turn the 
computer on and open the “My Computer” icon. Choose the previously 
corrupted (IDE) partition from the VS2480 hard drive. This partition will now 
have a list of “SONG” file folders equal to the number of “SONG” file folders 
saved to the “VSData” file folder on the desktop. AND the (14) files in the list 
will now be “corrected” for the VS2480 to read. These (14) files must not be 
touched from here on out!  
 
Open each SONG (one by one), in order, on the VS2480 hard drive (IDE) 
partition. First, “erase” the (21) files within the song, Then “copy” over the 
contents only (21 files and the TK.VR1 files), from the corresponding SONG 
in the “VSData” file folder, into the VS2480 hard drive (IDE) partition SONG 
file folder.  
 
You are done when all of the files within each SONG from the “VSData” file 
folder on the “desktop”, are copied into each SONG within the VS2480 hard 
drive (IDE) partition. The VS2480 hard drive can now be removed from the 
computer, the “pin configuration” reset to “master”, and finally reinstalled 
into the VS2480.  
 
Turn on the VS2480 and wait for a “song” to load. Go to the “Project List” 
and choose the (IDE) partition (that you are working on), by selecting “List”. 
All of the songs in that partition should now appear. Open a song (one by 
one), in that partition, and after it has fully loaded, you must “save” it. Then 
move to the next song in the list, load it, then save it, and so on, until you 
have done this to every song in that partition. Each time you “save” the 
song, the correct “name” and file “size” will be displayed as it was before the 
directory was corrupted (preventing you from accessing the partition or 
songs in the first place).  
 
All of the songs (or partition), should now be back the way they were. 
Unfortunately, there is no other way to reorganize or rebuild the directory o! 
f a VS2480 hard drive (IDE) partition once it is corrupted. You can fool the 
SONG file by copying data into it, but the VS2480 has to “write” the directory 
information from within the machine itself. 
 
A Shortcut… 
 
If, for example, partition “1” (or any of its songs), are corrupted and there is 
no data saved on partition “2”… 
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Then (while the VS2480 hard drive is still in the VS2480), open up partition 
“2” and create a number of “new” songs. If you are unsure of how many 
songs are to be recovered from partition “1”, then always make more “new” 
songs than you would possibly need. You can erase the un-needed songs 
later on.  
 
Follow the instructions above; by installing the VS2480 hard drive into the 
computer. Copy the SONGs from the VS2480 hard drive (IDE) partition “1” 
over to the “VSData” file folder on the desktop. Then copy the “VSData” 
SONG files back into the “newly” created VS2480 hard drive (IDE) partition 
“2” SONG files.   
 
This could save one complete step and perhaps a little time, BUT only when 
you are able to access the VS2480 hard drive to begin with. If you cannot 
access the VS2480 hard drive at all, you must follow the multiple steps… 
 
ALSO,  A success story with another data recovery process. 
Thanks to all who chimed in to help me out with this one, esp. Falcon Eddy, 
Brett Lacroix, and Lakestone Karl!!! 
 
I was in a very bad place because I accidentally erased a Project from the 
Project List. Thanks to someone's recommendation, I used GetBackData for 
FAT by Runtime.org. 
I HIGHLY recommend it. It found the deleted data no problem. OF COURSE, I 
hadn't written anything to the drive partition since making the mistake of 
erasing the project. I understand that doing so makes the chances unlikely.  
 
And then, thanks to Brett's "instructions for rebuilding the Directory", i was 
easily able to throw it back on the VS drive and it was back to the pleasing 
familiar file!!! 
 
For the record, I also tried Active Undelete, but it didn't find the file, so I'd 
recommend GETBACKDATA.                                                By Kurugod 
on VSP 
 
“Accidental Project Erase” Now how Kurugod did it… 
Frank.  
I just plugged the drive into a PC and ran the GetBackData app on the 
partition. It found a bunch of deleted stuff, so I picked the folder that was 
around the same size as the directory on the VS told me it was (2.71 gb).  
To verify, I opened the SONG.VR1 file in that folder with a simple Word 
processor app. That file had the project title "ZOA" embedded in it, so I knew 
it was the holy grail.  
At that point, I had to Buy the software in order to transfer the files to the 
PC. From there, I followed Brett's instructions on rebuilding the directory, 
which I'll list below.. 
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Brett's VS2480 Data Recovery 
 
Recovering Lost Songs or Directory from a Partition on the VS2480 Hard 
Drive 
 
 
First, you must remove the hard drive from the VS2480. Look closely at the 
pin configuration for your particular hard drive and note what the setting is 
for “Master” and for “Slave”.  
 
You will need to reset the “pin configuration” and hook up the VS2480 hard 
drive into your computer as a “Slave drive”. Once you are hooked up and 
your computer is turned on, make a “file folder” on the “desktop” and call it 
“VSData” (just to keep things easy and clean). This is where you will “copy” 
VS2480 “SONG” information “too”.  
 
On the “desktop” of your computer, double click on the “My Computer” icon. 
The window will open up and show you all of the drives you have connected 
to your system. For example;  
 
3 1/2 Floppy (A:)  
Local Disk (C:) 
Compact Disk (D:) 
…etc… 
 
The VS2480 hard drive will show up as “letter! ” (IDE) drives, other than 
those listed above. (For example: partition “0” from the VS hard drive may 
be IDE (E:), partition “1” may be IDE (F:), and so on…). They may not be 
organized exactly one after another but the progressive lettering is in order, 
so pay close attention to what drive letters belong to the VS2480 hard drive. 
(Note that only the first 4 (IDE) partitions of the VS2480 hard drive may be 
listed). These new drive letters may not exceed (4), but the partition you 
need to recover is usually within the first 4 partitions anyway.  
 
When you open one of the VS2480 hard drive (IDE) partitions (that would 
not open on the VS2480), you will see a list of “file folders” like the following;  
 
SONG0001.VR1 
SONG0002.VR1 
SONG0003.VR1 
SONG0004.VR1 
…and so on… 
 
Following the SONG.VR1 file folders, there will be (14) more files in the list. 
These (14) files are what tell the VS2480 what to do with the information on 
that partition. One or more of these (14) files will be corrupted, and 
preventing the VS2480 from booting-up that partition, or preventing a 
specific SONG from loading.  
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You will need to “copy” each SONG.VR1 file folder (and its contents), one at a 
time, over to the “VSData” file folder that you created on the desktop. But 
DO NOT copy the (14) files from the list following the SONG.VR1 file folders! 
 
For example: Once you have copied the SONG0001.VR1 file folder (with its 
contents), over to the “VSData” file folder, you can check the contents by 
opening the newly copied SONG0001.VR1 file in the “VSData” folder. You will 
see (21) files that look like the following; 
 
AMIXPCTL.VR1 
AUTOMIX0.VR1 
AUTOMIX1.VR1 
AUTOMIX2.VR1 
AUTOMIX3.VR1 
AUTOMIX4.VR1 
AUTOMIX5.VR1 
AUTOMIX6.VR1 
AUTOMIX7.VR1 
AUTOMIX8.VR1 
AUTOMIX9.VR1 
COMMENT.VR1 
EFFECT.VR1 
EVENTCFG.VR1 
EVENTLST.VR1 
MARKER.VR1 
MIXER.VR1SCENE.VR1 
SONG.VR1 
SYNCTRK.VR1 
SYSTEM.VR1 
 
After the first (21) files (that will always be in every song), there will be a 
number of TK.VR1 files. These “TK.VR1” files are the actual recorded audio 
track information. The number of TK.VR1 files that appear in each “SONG” 
will vary with the number of audio tracks recorded to each particular song.  
 
TK000004.VR1 
TK000242.VR1 
TK000431.VR1 
TK000492.VR1 
…and so on… 
 
Once all of the songs from the “corrupted” partition have been copied over to 
the “VSData” file folder on the desktop, you should make sure that the 
number of songs in the “VSData” file folder are equal to the number of songs 
from the VS2480 hard drive (IDE) partition. Take note of how many 
“SONG’s” you have. 
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Only “AFTER” you are completely sure you have copied all of the songs (and 
their contents), over to the “VSData” file folder, you can “delete” ALL of the 
SONG’s and the (14) files. But ONLY from “that” particular VS2480 hard drive 
(IDE) partition! DO NOT delete anything from any other VS2480 hard drive 
(IDE) partitions! 
 
Now remove the VS2480 hard drive from the computer and reset the “pin 
configuration” back to the “Master” setting for that particular hard drive. Re-
install the VS2480 hard drive back into the VS2480 and turn on the power.  
 
The VS2480 should load up a “song” from one of the partitions (it doesn’t 
matter which one). Go to the “Project List” and select the IDE partition where 
the corrupted files “used to be”. Select “List” and a “New” song will open up 
and be added into that partition. This song should be “InitProj.000”. Continue 
adding “New” songs to that partition (and don’t forget to SAVE each one as 
you go), until you have reached the number of songs you previously took 
note of earlier and copied to your “VSData” folder. 
 
Once you have the correct number of “empty” songs, shut down the VS2480, 
and remove the VS2480 hard drive again. Change the “pin configuration” 
over to “slave”, then install the hard drive back into the computer. Turn the 
computer on and open the “My Computer” icon. Choose the previously 
corrupted (IDE) partition from the VS2480 hard drive. This partition will now 
have a list of “SONG” file folders equal to the number of “SONG” file folders 
saved to the “VSData” file folder on the desktop. AND the (14) files in the list 
will now be “corrected” for the VS2480 to read. These (14) files must not be 
touched from here on out!  
 
Open each SONG (one by one), in order, on the VS2480 hard drive (IDE) 
partition. First “erase” the (21) files within the song. Then “copy” over the 
contents only (21 files and the TK.VR1 files), from the corresponding SONG 
in the “VSData” file folder, into the VS2480 hard drive (IDE) partition SONG 
file folder.  
 
You are done when all of the files within each SONG from the “VSData” file 
folder on the “desktop”, are copied into each SONG within the VS2480 hard 
drive (IDE) partition. The VS2480 hard drive can now be removed from the 
computer, the “pin configuration” reset to “master”, and finally reinstalled 
into the VS2480.  
 
Turn on the VS2480 and wait for a “song” to load. Go to the “Project List” 
and choose the (IDE) partition (that you are working on), by selecting “List”. 
All of the songs in that partition should now appear. Open a song (one by 
one), in that partition, and after it has fully loaded, you must “save” it. Then 
move to the next song in the list, load it, then save it, and so on, until you 
have done this to every song in that partition. Each time you “save” the 
song, the correct “name” and file “size” will be displayed as it was before the 
directory was corrupted (preventing you from accessing the partition or 
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songs in the first place).  
 
All of the songs (or partition), should now be back the way they were. 
Unfortunately, there is no other way to reorganize or rebuild the directory of 
a VS2480 hard drive (IDE) partition once it is corrupted. You can fool the 
SONG file by copying data into it, but the VS2480 has to “write” the directory 
information from within the machine itself. 
 
A Shortcut… 
 
If, for example, partition “1” (or any of its songs), are corrupted and there is 
no data saved on partition “2”… 
 
Then (while the VS2480 hard drive is still in the VS2480), open up partition 
“2” and create a number of “new” songs. If you are unsure of how many 
songs are to be recovered from partition “1”, then always make more “new” 
songs than you would possibly need. You can erase the un-needed songs 
later on.  
 
Follow the instructions above; by installing the VS2480 hard drive into the 
computer. Copy the SONGs from the VS2480 hard drive (IDE) partition “1” 
over to the “VSData” file folder on the desktop. Then copy the “VSData” 
SONG files back into the “newly” created VS2480 hard drive (IDE) partition 
“2” SONG files.  
!  
This could save one complete step and perhaps a little time, BUT only when 
you are able to access the VS2480 hard drive to begin with. If you cannot 
access the VS2480 hard drive at all, you must follow the multiple steps. 
 
Another success story with Funkyhamsta 
(Stuck on “Load Project” after normal shutdown the night before) 
 
Here's perhpas some useful experience for those who witness a random lock-
up like I did on the 'Load Project' stage. 
 
I duly removed the HDD from the 2480 and changed the jumpers on the 
back to be a slave drive on my Win XP SP2 PC. I hooked it up and booted up. 
 
The drive showed up with all it's (4) partitions and only partit. 1 was the one 
I was concerned with. The usual VR1 files and folders appeared.  
 
I ran scandisk and it found no errors. 
I then copied all the files from the partition onto my PC and all went well until 
the very last few files. I couldn't read the following files (Windows said they 
were corrupt) which were all located in the top level directory (i.e. not any of 
the song directories): 
 
TMPAMIX4.vr1 
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TMPAMIX5.vr1  
and so on up to 
TMPAMIX9.vr1 
 
also TMPSCENE.vr1 was corrupt (it was about 1.6MB in size). 
 
All the TMPAMIX files were 4kb and there were four still intact that would 
copy (TMPAMIX0 thru to TMPAMIX3.vr1) 
 
I then opened a DOS prompt window in XP and entered CHKDSK D: (which 
was the problem partition). 
 
It then created the FOUND dir and fragmented files which corresponded to 
the size of the corrupt files from before. 
 
The problem files were duly deleted and turned into Windows *.000 files. 
 
I then thought how about I *fake* the remaining TMPAMIX files that were 
corrupt by copying a complete TMPAMIX file and renaming it to the corrupt 
ones to replace them. 
 
I did this 4 or 5 times and replaced the corrupt TMPAMIX files 5 thru to 9. 
 
I stuck the drive back in the 2480 and BANG - straight in, all projects there, 
all tracks, all fine... 
 
BOY..I consider myself an unwitting genius or bloody lucky.... 
 
I hope someone else can gain some use from this experience and mild 
panic... 
 
Ecstatically dancing, 

 
MORE ON DATA RECOVERY BY Bear. 
 
VS2480 Data Recovery 
 
Recovering Lost Songs or Directory from a Partition on the VS2480 Hard Drive 
 
 
First, you must remove the hard drive from the VS2480. Look closely at the pin 
configuration for your particular hard drive and note what the setting is for 
“Master” and for “Slave”.  
 
You will need to reset the “pin configuration” and hook up the VS2480 hard drive 
into your computer as a “Slave drive”. Once you are hooked up and your 
computer is turned on, make a “file folder” on the “desktop” and call it “VSData” 
(just to keep things easy and clean). This is where you will “copy” VS2480 
“SONG” information “to”.  
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On the “desktop” of your computer, double click on the “My Computer” icon. The 
window will open up and show you all of the drives you have connected to your 
system. For example;  
 
3 1/2 Floppy (A:)  
Local Disk (C:) 
Compact Disk (D:) 
…etc… 
 
The VS2480 hard drive will show up as “letter” (IDE) drives, other than those 
listed above. (For example: partition “0” from the VS hard drive may be IDE (E:), 
partition “1” may be IDE (F:), and so on…). They may not be organized exactly 
one after another but the progressive lettering is in order, so pay close attention 
to what drive letters belong to the VS2480 hard drive. (Note that only the first 4 
(IDE) partitions of the VS2480 hard drive may be listed). These new drive letters 
may not exceed (4), but the partition you need to recover is usually within the 
first 4 partitions anyway.  
 
When you open one of the VS2480 hard drive (IDE) partitions (that would not 
open on the VS2480), you will see a list of “file folders” like the following;  
 
SONG0001.VR1 
SONG0002.VR1 
SONG0003.VR1 
SONG0004.VR1 
…and so on… 
 
Following the SONG.VR1 file folders, there will be (14) more files in the list. 
These (14) files are what tell the VS2480 what to do with the information on that 
partition. One or more of these (14) files will be corrupted, and preventing the 
VS2480 from booting-up that partition, or preventing a specific SONG from 
loading.  
 
You will need to “copy” each SONG.VR1 file folder (and its contents), one at a 
time, over to the “VSData” file folder that you created on the desktop. But DO 
NOT copy the (14) files from the list following the SONG.VR1 file folders! 
 
For example: Once you have copied the SONG0001.VR1 file folder (with its 
contents), over to the “VSData” file folder, you can check the contents by 
opening the newly copied SONG0001.VR1 file in the “VSData” folder. You will see 
(21) files that look like the following; 
 
AMIXPCTL.VR1 
AUTOMIX0.VR1 
AUTOMIX1.VR1 
AUTOMIX2.VR1 
AUTOMIX3.VR1 
AUTOMIX4.VR1 
AUTOMIX5.VR1 
AUTOMIX6.VR1 
AUTOMIX7.VR1 
AUTOMIX8.VR1 
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AUTOMIX9.VR1 
COMMENT.VR1 
EFFECT.VR1 
EVENTCFG.VR1 
EVENTLST.VR1 
MARKER.VR1 
MIXER.VR1 
SCENE.VR1 
SONG.VR1 
SYNCTRK.VR1 
SYSTEM.VR1 
 
After the first (21) files (that will always be in every song), there will be a 
number of TK.VR1 files. These “TK.VR1” files are the actual recorded audio track 
information. The number of TK.VR1 files that appear in each “SONG” will vary 
with the number of audio tracks recorded to each particular song.  
 
TK000004.VR1 
TK000242.VR1 
TK000431.VR1 
TK000492.VR1 
…and so on… 
 
Once all of the songs from the “corrupted” partition have been copied over to the 
“VSData” file folder on the desktop, you should make sure that the number of 
songs in the “VSData” file folder are equal to the number of songs from the 
VS2480 hard drive (IDE) partition. Take note of how many “SONG’s” you have. 
 
Only “AFTER” you are completely sure you have copied all of the songs (and their 
contents), over to the “VSData” file folder, you can “delete” ALL of the SONG’s 
and the (14) files. But ONLY from “that” particular VS2480 hard drive (IDE) 
partition! DO NOT delete anything from any other VS2480 hard drive (IDE) 
partitions! 
 
Now remove the VS2480 hard drive from the computer and reset the “pin 
configuration” back to the “Master” setting for that particular hard drive. Re-
install the VS2480 hard drive back into the VS2480 and turn on the power.  
 
The VS2480 should load up a “song” from one of the partitions (it doesn’t matter 
which one). Go to the “Project List” and select the IDE partition where the 
corrupted files “used to be”. Select “List” and a “New” song will open up and be 
added into that partition. This song should be “InitProj.000”. Continue adding 
“New” songs to that partition (and don’t forget to SAVE each one as you go), 
until you have reached the number of songs you previously took note of earlier. 
 
Once you have the correct number of “empty” songs, shut down the VS2480, and 
remove the VS2480 hard drive again. Change the “pin configuration” over to 
“slave”, then install the hard drive back into the computer. Turn the computer on 
and open the “My Computer” icon. Choose the previously corrupted (IDE) 
partition from the VS2480 hard drive. This partition will now have a list of 
“SONG” file folders equal to the number of “SONG” file folders saved to the 
“VSData” file folder on the desktop. AND the (14) files in the list will now be 
“corrected” for the VS2480 to read. These (14) files must not be touched from 
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here on out!  
 
Open each SONG (one by one), in order, on the VS2480 hard drive (IDE) 
partition. First “erase” the (21) files within the song. Then “copy” over the 
contents only (21 files and the TK.VR1 files), from the corresponding SONG in the 
“VSData” file folder, into the VS2480 hard drive (IDE) partition SONG file folder.  
 
You are done when all of the files within each SONG from the “VSData” file folder 
on the “desktop”, are copied into each SONG within the VS2480 hard drive (IDE) 
partition. The VS2480 hard drive can now be removed from the computer, the 
“pin configuration” reset to “master”, and finally reinstalled into the VS2480.  
 
Turn on the VS2480 and wait for a “song” to load. Go to the “Project List” and 
choose the (IDE) partition (that you are working on), by selecting “List”. All of 
the songs in that partition should now appear. Open a song (one by one), in that 
partition, and after it has fully loaded, you must “save” it. Then move to the next 
song in the list, load it, then save it, and so on, until you have done this to every 
song in that partition. Each time you “save” the song, the correct “name” and file 
“size” will be displayed as it was before the directory was corrupted (preventing 
you from accessing the partition or songs in the first place).  
 
All of the songs (or partition), should now be back the way they were. 
Unfortunately, there is no other way to reorganize or rebuild the directory of a 
VS2480 hard drive (IDE) partition once it is corrupted. You can fool the SONG file 
by copying data into it, but the VS2480 has to “write” the directory information 
from within the machine itself. 
 
A Shortcut… 
 
If, for example, partition “1” (or any of its songs), are corrupted and there is no 
data saved on partition “2”… 
 
Then (while the VS2480 hard drive is still in the VS2480), open up partition “2” 
and create a number of “new” songs. If you are unsure of how many songs are to 
be recovered from partition “1”, then always make more “new” songs than you 
would possibly need. You can erase the un-needed songs later on.  
 
Follow the instructions above; by installing the VS2480 hard drive into the 
computer. Copy the SONGs from the VS2480 hard drive (IDE) partition “1” over 
to the “VSData” file folder on the desktop. Then copy the “VSData” SONG files 
back into the “newly” created VS2480 hard drive (IDE) partition “2” SONG files.  
 
This could save one complete step and perhaps a little time, BUT only when you 
are able to access the VS2480 hard drive to begin with. If you cannot access the 
VS2480 hard drive at all, you must follow the multiple steps… 
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SOLOING A TRACK WITH EFFECTS LOOPED     
1) Make note of which FX RTN the looped effect is routed thru and 
Start on the TR1-16 fader button bank, Hold SHIFT and press "IN 1-16 
[SOLO]" (fader button above the master fader) let go while all CH-Edit 
buttons are flashing. 
 
2) Now  press the flashing CH-Edit button of the TRACK to solo and 
that CH-Edit button stops flashing and is lit solid.  
 
3) Now press the "TR 17-24 [FX RTN]" (fader buttons above master 
fader) to get to the flashing CH-Edit buttons for the FX return. (this is 
where you'll solo your EFFECT/FX RTN with your track) 
 
4) Now press the flashing CH-Edit button of the FX RTN you want to 
solo, this would correspond to the effect you have looped thru this FX 
RTN and made note of at the begining, like a reverb. 
 
5) To get out of this mode you need to hold SHIFT and press solo 
again the track and effect will still be soloed together for mixing. 
 
*Note: To clear all your soloed Tracks and FX RTN’s at once press and 
HOLD CLEAR and then press "In 1-16 [SOLO]. You can also CLEAR 
soloed TRACK’s & FX RTN’s by clicking on the little black arrow at the 
bottom of the solo row or “S’s” on the HOME screen. 
 
SOLO TRACK WITH EFFECTS SIMPLE 
Just MUTE all other tracks. If you are using just the TR1-16 tracks for 
a song then this is about the fastest and simplest way to do this. 
 
  
SOLOING FROM TRACK & FX RTN MIXER VIEW 
1) Click on the MIXER Menu, at the top of the screen, then select 
TRACK MIXER/FX RTN MIXER. The whole track view changes to show 
the track and FX RTN mixer. 
 
2) Then solo the TRACK using the “S” button above the virtual TRACK 
fader and PAN knob, click on it and it turns blue. (Look for a group of 
four dark buttons above the virtual Pan knobs.) 
 
3) Now find the FX RTN, bottom right of the screen, and click on the 
solo button “S” for the FX RTN the EFFECT is routed through. ( I also 
have a locator set to cue up the track I am checking the mix of the 
effect with.) 
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4) Now you are ready to do your mixing, checking levels of the effect, 
EQing etc by pressing the TRACK’s CH-Edit button. Press Play and 
make your adjustments. Press the CH-Edit button again and you are 
back to the TRACK MIXER view to select other tracks and effects if 
needed or just click HOME to return to the home screen.  
 
NOTE: To clear the soloed TRACK & FX RTN again, press and HOLD 
CLEAR and then press "In 1-16 [SOLO]. You can also CLEAR soloed 
TRACK’s & FX RTN’s by clicking on the little black arrow at the bottom 
of the solo row or “S’s” on the HOME screen or click on the “S” that’s 
soloing the TRACK and FX RTN on the TRACK MIXER screen.  
Thanks to teknail on VSP for help with this document, Frank Griffith. 
 
SOLOing EFFECTS on a SOLOed Track 
Go to your FX RTN Screen by pressing  

1) TR17-24/FX RTN then press 
2)  Channel Edit button of the FX to solo. 
3) Solo button over fader on VGA (next to MIX & MUTE). 
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Project SPLIT and COMBINE works faster than TRACK EXPORT/ WAVE IMPORT. 
Here's how to do it. 
 
It helps if all your tracks are in the same format. I prefer to make 24-bit MIXES 
without any MTK applied, and no fade outs. The MTK and fade-outs will be applied in 
the final CD version of the project. I often include fade-outs in working mixes, but 
omit them for this step. 
 
 
In each of your single-song projects, you want to PROJECT->SPLIT the final mixed 
stereo pair to it's own project. The SPLIT operation make a copy of the parent 
project with only the tracks you have selected, and puts the letter "A" as the last 
character in the name of the newly-SPLIT project. 
 
Now you end up with X-number of 1-song-1-track projects, in addition to your 
original projects. 
 
In each of these smaller projects, move the stereo pair to ZERO on a common V-
Track. For instance, move all the Mastered Tracks to VT23/24.1 in all the projects. 
Also remove any and all MARKERS within these projects. Hold SHIFT and press 
PREVIEW FROM (PROJECT END) and make sure the end of the project is indeed the 
end of the desired audio. 
 
Now choose the first song of the CD, and open its project. Rename this project as a 
Complied CD project, just to keep it straight. 
To add a song to the Complied CD project, choose PROJECT->COMBINE. Then select 
the exiting Compiled CD project, and the project that is the next song, and COMBINE 
them. This places the new song 4 seconds behind the end of the existing song(s). 
 
Repeat the COMBINE process until all the songs are in order, and in the same 
Complied CD project. 
 
Now you can go ahead and apply the MTK tools, automix fades, adjust playback 
levels, to create a cohesive project. 
 
By Karl Lakestone 
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VS SUB MIXES/BOUNCING. 
To sub mix several tracks down to one track or a pair, like all of your drum 
tracks or background vocals, decide which tracks to send where. Let’s say, 
drums on 1 thru 6 are to be sub mixed to Tracks 15 & 16. Usually a sub mix 
is done in stereo, so first let’s link TRACKS 15 & 16 

1)First PRESS the CH-Edit button of TRACK 15 and on the CH-Edit 
page of TR 15 select “CH LINK” below the ATT Knob on the right of 
that screen, then click HOME. 

Now let’s use QUICK ROUTING to route out SOURCE TRACKS to our 
DESTINATION TRACKS. [If you are using an effect then connect the FX 
RTN number that matches the effect number to your destination track on the 
RECORDING TRACK block or see bouncing with effects below.] 
 
2) PRESS and HOLD TRACK 15’s TRACK STATUS button till the 
QUICK ROUTING window opens. All track status and CH-Edit buttons 
will flash except the DESTINATION TRACKS, 15 & 16. 
 
3) Now PRESS the flashing CH-EDIT buttons of the TRACKS you want to 
send to TRACKS 15 & 16. This will link SOURCE TRACKS to the 
DESTINATION TRACKS in the Quick Routing window. When all are 
linked, click on “F6 EXIT.” 
*If a wrong connection was made you can PRESS the CH-Edit button of the 
SOURCE TRACK again to disconnect it before exiting the window. 
 
4) Now simply ARM TRACK 15 to RECORD, both TRACK STATUS 
buttons of 15 & 16 will flash RED. When ready to do a test mix just PRESS 
RECORD and PLAY. 
 
5)  When done mixing PRESS STOP, ZERO, and then MUTE all other 
TRACKS or SOLO TRACKS 15 & 16 and PRESS the TRACK STATUS 
button of TRACK 15 till 15 & 16 are GREEN to PLAY back your sub mix. 
 
6) If you don’t like the sub mix then PRESS the UNDO button and then the 
ENTER button and try it again. 
 
*Another way to do SUB MIXES using the Mastering Room is to select V-
Tracks on Tracks 23 & 24 to mix to, you can INSERT an MTK and after the 
mix is done, use TRACK EXCHANGE to exchange them with V-Tracks 1-
15 & V-Track 1-16 on tracks 23 & 24  and free up the Mastering Room for 
further Mastering. 
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BOUNCING A SINGLE TRACK 
This time we will bounce a single track without using Quick Routing. Let’s 
say you have a vocal on Track 5 and you want to bounce it to Track 15 for 
whatever reason, to have a double vocal or to loop or insert an effect. 
Make sure your AUX BUS 1 thru 8 and FX RTN 1 thru 8 FADERS are all 
up and set to 0db for routing any EFFECTS you might need. Now we will 
need to go to EZ Routing> Routing View> to do this…. 

 
1) On the EZ-Routing page you see TRACK MIXER 1-24 in the lower 

left quadrant of the screen, Click on your vocal TRACK 5’s number 5 
and drag a virtual cable up to the RECORDING TRACKS 1-24 and 
connect it to TRACK #15. Assuming you already have an effect 
patched into a processor, if you want to use a LOOP Effect on the 
Vocal going to Track 15 and have the EFFECT recorded with it, then 
click and drag the FX1 thru 8 Effect number your EFFECT is on and 
connect it to Track 15 too, FX RTN1 is EFFECT1, FX RTN2 is 
EFFECT2, FX RTN3 is EFFECT3 and so on. (If your Reverb is 
Patched into EFFECT 1 then FX RTN’s number 1 should be 
connected to the Recording Track number 15 also we do this for 
LOOPED Effects to an INPUT that’s sending a signal to a track to 
record. (We do not do this for INSERT EFFECTS). Now click 
HOME. 

 
2) If you want to use an INSERT Effect on the vocal going to TRACK 

15 and have that printed with the vocal then press the CH-Edit button 
of Track # 5 and on that page click on the FX1 thru 8 number with the 
EFFECT you want INSERTED, FX1 is EFFECT1, FX2 is EFFECT2, 
FX3 is EFFECT3 and so on,  if it’s the LOOPED reverb of EFFECT 1 
make sure the effects FX RTN is connected to the destination track in 
the RECORDING TRACK block then turn up the AUX 1 knob, on 
the CH-Edit page of TRACK #5, to complete the LOOP and add the 
amount of the reverb you want. Now click HOME. 

 
3) Now all we do is arm TRACK # 15 to record and PRESS Record & 

Play. Any fader movements made on TRACK 5 during the recording 
will be copied to TRACK 15 so make sure your Faders and levels are 
set the way you want them to record onto Track 15.  
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4) When done press STOP and check Track 15 and your bounce. If you 
want to do it over, now press UNDO> and a window opens with your 
last action highlighted now press ENTER to erase this one and start 
over. Once you do get the bounce right remember to take out any 
effects you INSERTED on TRACK 5 to free up that EFFECT and 
remove it from TRACK 5. If it was LOOPED then disconnect the FX 
RTN to RECORDING TRACK connection you made. 

 
*Bouncing Tracks are easy. You just go to the EZ Routing page and 
connect a track, or tracks, from the TRACK MIXER to the 
RECORDING TRACK, or a linked pair of tracks. Make sure the effects 
FX RTN is connected to the destination track in the RECORDING 
TRACK block if you are using looped effects, then ARM the destination 
track or linked tracks and press Record & Play. It gets a little tricky when 
you want to INSERT an EFFECT and more so if you want to LOOP an 
EFFECT. So, I keep the AUX and FX RTN Faders @ 0db. Also, too 
quickly link inputs or tracks just press and hold the odd numbered 
channel and press the even numbered one and this will link the pair for 
stereo inputs or tracks.  

 
 
If you want to add an INSERT EFFECT to a track, see the MS Word 
docs on EFFECTS. You just press the CH-Edit button of the track to 
INSERT the EFFECT, click on the EFX button of the EFFECT to 
INSERT. Now go to EFFECT> select the EFFECT number to patch in 
the EFFECT you want INSERTED. To LOOP the EFFECT, have it’s 
effects patch selected in the EFFECTS window, then for each track you 
want the EFFECT LOOPED to be used on, you just press the CH-Edit 
button of that TRACK and find the AUX knob that corresponds to that 
EFFECT processor and turn it up to use the EFFECT. Looped effects can 
be used with all tracks this way. That’s the big advantage of using 
LOOPED EFFECTS, is you can use one EFFECT across all TRACKS 
and INPUTS, don’t forget to connect the FX RTN virtual cable in EZ-
Routing to complete the LOOP on INSERTS and when BOUNCING and 
disconnect when done. *In theory, you are NOT adding the reverb to the 
tracks or inputs, you are routing their signal thru the master bus where the 
reverb is applied thru FX RTNS & AUXS. 
 
Another thing to keep in mind, once you finish a SUBMIX, you can go 
back to the tracks that were mixed down and either use TRACK 
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EXCHANGE to move those tracks to V-Tracks to save for future 
remixing, or you can just select a new V-Track for each of the tracks to 
have new tracks to record too. In the example above, we used tracks 1 
thru 6, each of those tracks have 16 V-Tracks, just click on the 1 to the 
right of the track number and a V-Track window opens, there you can 
select the 2nd V-Track to bring it forward for recording and the V-Track 1 
will be saved and you can now record new data to tracks 1 thru 6 but on 
their 2nd V-Track. See “VS V-Trks, Opti, Undo etc..” doc for more info 
on using V-Tracks. 

 
MASTERING ROOM BOUNCE 
You can also use the mastering room to bounce sub mixes. Just bring up the 
faders on the tracks you want to bounce and use the mastering room. It 
doesn’t matter which V-Tracks you bounce too just remember which. Also, 
set it to “Stay Here” instead of “Zero” if the tracks don’t happen to start at 
“To Zero”. After you Master/Bounce then use Track Exchange to move the 
stereo pair of master tracks where you want them.  
 
You could also use Region or Phrase Move with IN, OUT and TO points. 
Using the mastering room means, what you hear, you get. No mix ups here. 
See “VS MST BURN.doc” on mastering and “VS CpyMveExchExpt.doc” 
for more on Track Exchange. This is also good for creating stereo stems of 
back ground vocals, drum tracks etc. Now, what's odd or can be a bit 
confusing is this, when you have a track recorded dry and you want to add a 
reverb to it to be recorded in the mastering, you do not have to connect the 
FX RTN virtual cable to the destination tracks, that routing is done 
automatically in the mastering room.  
  
EZ ROUTING TOOLS 
To INITIALIZE, or reset all input-to-input channel routings click on 
“F1(IniPB)” at the bottom of the screen. To CLEAR all input-to-input 
channel routings click on “F2(ClrPB). 
 
To INITIALIZE all routings to the hard disk recorder tracks click on 
“F3(IniTra) and to CLEAR all routings to the hard disk recorder tracks click 
on “F4(ClrTra). 
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The smallest time delay and volume in sound signal arriving at each of our ears is 
what allows us to "place" where the sound is coming from. Our ears "pointing" 
forward creates a different reaction to sound waves arriving from the rear or above 
compared to directly in front, thus allowing us to pinpoint the sound source in a 3-
dimensional spherical position around us.  
 
Therefore if you are sitting in the middle of 2 speakers and the "same sound" arrives 
at each ear with the same character (time delays and volume), we percieve it to be 
in the middle. The small time delay you create between "copied" tracks is percieved 
as TWO sound source even if the volume is the same... thus the impression of 
"doubled" and the "center" image disappears. But if you are listening off-axis (not 
eque-distant between the speakers) then stereo imaging becomes biased and small 
pan position difference starts to disappear.  
 
Most consumer stereo system users hardly ever sit and listen at the "sweet spot". 
Full Left and Full Right pan of a mono track is much easier to percieve off-axis and 
away from the "sweet spot". 
 
Stereo panning is a manipulation of these time delays to attempt to re-create a sonic 
condition that "represents" the various recorded sounds to "be in a space" in front of 
you. Many forget that "stereo" ASSUMES that the listener IS in the "sweet spot"... 
equal distance from each speaker. 
 
Understanding "HOW" human ears hear is the basis of stereo playback system.  
 
--------------------------- 
 
I create the "time delay" of a mono track by : 
 
Lets say an acoustic guitar... 
 
Make a copy of the track. "MOVE" the copied track "forward" (delayed)in time about 
1/4 to 1/2 a frame (1 frame = 1/30 of a second). This miniscule "time delay" makes 
it sound doubled. Pan each in opposite direction to taste.  
 
Try this after you do the above... Pan the pair of tracks 50% left and 50% right. Set 
up 2 reverbs. Pan each stereo reverb biased the same 50% left and 50% right. Feed 
the left dry track to the right reverb and right dry track to left reverb. Set the "pre-
delay" on the reverbs to be different with the faster being at least twice the amount 
of the "time delay" created between the dry tracks. 
 
Additional experiment... 
EQ one of the dry track to be a bit more bottom heavy and the other to be a bit 
more "sparkly". 
 
Use different reverb types for the two reverb pair... like a "plate" on one side and a 
"hall" on the other. 
 
From on line some where? 
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UPDATING VS OS. 
*If you have an OS above 2.009 then it is not necessary to Format/Initialize 
the hard drive in your VS after updating! 
*To find out which OS you are running, hold down the TRACK STATUS & 
CH-EDIT buttons above Fader# 1 while powering up the VS. HOLD the 
buttons until you see a prompt on the LCD. All 4 digits of the OS will 
appear on the small LCD on the VS, from there you can answer the prompts 
with the ENTER/EXIT buttons to load a project. 
 
Updating a VS2480/2400 ( From Roland’s Site) 
  
You can update the operating system on your VS-2480/2400 from a CD-R that 
contains the proper update program. You MUST have the following to do this : 
 
- Built in CD-RW drive or a Roland approved external SCSI CD-RW drive (like the 
VS-CDR3). 
 
- You will also need the latest update CD for your VS model. You can get this from 
Roland Customer Service (323)890-3700 ext.2289, or you can create your own by 
downloading and burning the disc image file for the update to your computer's CD-
R.  
 
- The disc images to download are on the Rolandus.com website under 
SUPPORT/UPDATES&DRIVERS/DIGITAL RECORDING & MIXING/DIGITAL 
RECORDING/VS-2480 (VS-2400/2000). 
 
- Note you will need a Disc Image / CD burning utility installed on your computer 
(like the PC application ULTRAIso / or Toast for Macintosh)in order to create your 
own update CD. 
 
- WARNING!! - IT IS HIGHLY RECOMMENDED THAT YOU BACKUP THE 
DATA THAT IS ON YOUR VS-2480/2400/2000 PRIOR TO PERFORMING THE 
FOLLOWING UPDATE PROCEDURE. 
 
Procedure For Updating : 
 
1. Put the Update CD in your CD-RW drive. 
 
2. Press [SHIFT]+ [STOP] to shutdown the VS-2480/2400.  
 
3. Press [ENTER/YES] at the "Shutdown/Eject?" screen. 
 
4. Press [ENTER/YES] at the "Store Current?" screen. 
 



 2 

5. When it ejects the CD, push the CD tray back into VS. 
 
6. When the screen says "POWER OFF/RESTART", turn the power OFF with the 
power switch on the rear of the VS. 
 
7. After 10 seconds, turn the power ON with the power switch on the rear. The VS 
will startup, scan the CD and go into update mode. 
 
8. The VS will ask if you want to update with "System Update?". Press 
[ENTER/YES].  
 
9. The 2480 will ask you if you want to keep your User Settings. Press 
[ENTER/YES] or [EXIT/NO]. 
 
10. The 2480 will then start updating its operating system. 
 
11. After it’s finished, it will ask you to REBOOT. 
 
12. Remove the ejected Update CD from the CD-RW tray and use the power switch 
to turn the VS OFF. 
 
13. After 10 seconds, turn the power ON. Your VS will boot-up with the new 
operating system. 
 
Note: AFTER UPDATING, IT IS HIGHLY RECOMMENDED THAT YOU 
INITIALIZE/FORMAT YOUR HARD DRIVE IMMEDIATELY WITH 
PHYSICAL FORMAT - "ON" and SURFACE SCAN "ON". WARNING!!!!! – 
INITIALIZING OR FORMATTING YOUR HARD DRIVE WILL ERASE ALL 
PROJECTS ON YOUR HARD DRIVE. BACKUP YOUR DATA BEFORE 
FOLLOWING THIS UPDATE PROCEDURE OR FORMATTING YOUR HARD 
DRIVE.  
 
Depending on your hard drive capacity, Formatting could take anywhere from 4 to 
12 hours for the VS to complete : DO NOT REMOVE POWER FROM THE UNIT 
during this operation!! 
 
Page 114 - VS-2480 Owners Manual 
Page 108 - VS-2400 Owners Manual 
Page 117 - VS-2000 Owners Manual 
 
After formatting is completed, you’re done and ready to record again!! 
 
*If you have an OS above 2.009 then it is not necessary to Forrmat/Initialize 
the hard drive in you VS after updating! 
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*If you have a VS2480CD or DVD model VS, you insert the update CD in 
the internal burner while the VS is powered up. Then go thru normal 
shutdown procedures and power off the VS. Once the hard drive stops 
spinning power up the VS and it should boot to the update CD and you 
should see prompts on the LCD screen on the VS. 
 
*If you have the VS2480HD model with the external Roland CDR-II or 
CDR-III Burner you must have the update C in the burner. If your CDR is 
connected to the VS and is powered up and has the update CD in it all before 
powering up the VS2480, the VS2480 should boot to the CDR external 
burner and find the update CD. Then the small LCD screen on your VS 
should prompt you to update the VS. 
 
 
OS VERSION NUMBERS, to display all 4 digits. 
The VS only displays 3 of the OS digits on the VGA, to see all 4 digits of 
your current OS version; hold down the CH-Edit and Track Status buttons 
above fader#1 while powering up the VS, hold the buttons down until you 
see a prompt on the small LCD. There you will see all 4 digits of the current 
OS on the small LCD on the VS. Answer the prompts to load a project. 
 
Updating From 1.XXX to Current via MIDI 
http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Board=16&Number
=853723&Searchpage=2&Main=84247&Words=updating+OS&topic=0&Search=true#P
ost853723 posted by Paul Miller 
 
The VS-2480 has an Operating System that is software-based. This OS 
software can be easily updated when new features are added to enhance the 
functions in the VS-2480. The OS software resides in the VS-2480 on Flash 
ROM IC Chips, and therefore the update procedure does not affect the data 
existing on its hard drive; the new OS remains within the VS-2480 even 
when the internal hard drive is removed and/or exchanged. Before and After 
Updating to Version 2.5xx from Version 1.xx software it is important to 
perform a full physical formatting of the VS-2480's hard drive before 
attempting to load version 2.5 software into your VS-2480. It is also highly 
recommended to perform a quick format (physical format = off) after the 
version 2 software has been loaded into the VS-2480 and before any project 
data has been recovered or new project data recorded. Please see your 
Owner's Manual for details on performing these procedures. 
 

http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Board=16&Number=853723&Searchpage=2&Main=84247&Words=updating+OS&topic=0&Search=true#Post853723
http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Board=16&Number=853723&Searchpage=2&Main=84247&Words=updating+OS&topic=0&Search=true#Post853723
http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Board=16&Number=853723&Searchpage=2&Main=84247&Words=updating+OS&topic=0&Search=true#Post853723
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Updating the VS-2480 via Standard Midi Files. 
The VS-2480 OS software can be updated from Standard Midi Files 
containing system exclusive data. This method uses a common file format 
that is both PC (IBM-compatible) and Macintosh compatible. An SMF 
sequencer/player (software) and Midi interface (hardware) is required to 
send the data via Midi. Many hardware (stand-alone) Midi sequencers are 
capable of reading theSMF file format and playing the update sys ex data 
into the VS-2480 via Midi. 
 
NOTE: Hardware sequencers (such as the MC-80 or XP-50/60/80) are 
normally more reliable for 
transferring system exclusive MIDI data. 
Procedure: 
1. Connect the MIDI OUT port of the sequencer to the MIDI IN port of the 
VS-2480. 
2. Hold down [STATUS] buttons 2 & 3 and [CH EDIT] button 5 above the 
white faders while 
powering on the VS-2480. The message "System Update?" will be 
displayed. 
3. Press ENTER/YES. The message "Waiting MIDI-EX" will be displayed. 
4. Load the Standard MIDI Files into your sequencer. 
5. Play all Standard MIDI Files: "VS248000. MID" to "VS248031. MID" in 
order. 
6. After all SMF's have been played into the VS-2480, the message "--S- 
Update SysPRG?" will 
be displayed. 
7. Press [F1] so that "B-S- Update SysPRG?" is displayed. 
8. Press [F4] so that "B-Ss Update SysPRG?" is displayed. Press 
ENTER/YES. 
9. The message "Please Reboot OK" will be displayed. The system software 
of the VS-2480 has 
now been updated. 
10. Restart the VS-2480 (power off and then on again). 
 
Confirming the Updated Operating System. 
When updating the VS-2480 via standard midi files, it is extremely 
important to carefully follow every step in the procedure. To confirm the 
update has loaded correctly, perform the procedure outlined below: 
1. Hold down [CH EDIT] button 1 and [TRACK STATUS] button 1 (above 
the first white fader) 
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while powering on the VS-2480. Keep holding until you see a prompt on the 
LCD. A Version Information screen will be displayed. 
 
2. On the LCD screen, verify the Boot version and System version are the 
exact same number - that of the operating system most recently loaded. 
IMPORTANT: If these two values are different, you must perform the 
update procedure again or try updating via ZIP disk or CD. 
 
*NOTE: Software SMF player applications for both PC and Mac are 
available for download at http://www.rolandus.com. We have tested these 
files with the following computer-based MIDI sequencing programs; Vision 
(Opcode), Performer (MOTU), Cubase (Steinberg/Jones), and Logic 
(Emagic). We were successful in updating the VS-2480. Several 
manufacturers have demo versions of their sequencer programs available on 
the internet that will work for this use. ***If you have problems with the 
update procedure check your MIDI/interface setup.*** If you have problems 
downloading these files, you can also order disks directly from Roland. 
Please call Customer Service at 323-890-3700 ext. 2289 and request one of 
the following: 
SMF update - Part # 17041060 
CD update – Part # SU-44 
(c)2001 Roland Corporation U.S. Updating the VS-2480 Operating System  
 
UPGRADING VS2480CD to DVD  
(and replacing DVD burner in DVD model VS) 
 
If you have a VS2480CD model VS, you can install a laptop DVD burner in 
place of the CD burner in your VS. The VS defaults the CD write speed at 
CD4x and DVD1x but here’s the catch. DVD2x is as fast as CD18x so 
DVD1x is equal to CD8x when it comes to burning backups. Also, DVDs 
hold 4.7GB of data, that’s 4700MBs and CDs only hold 700MBs so 5 or 6 
CD backups will fit on one DVD in far less than half the time it takes to 
backup to CD. 
 
 I recommend you do this your self and save hundreds of dollars compared 
to buying the VS2480DVD model or an external DVD burner. It takes about 
30 minutes to change them out plus you will also know where the hard drive 
is and can change it on your own as well. Hard Drive specs: 7200RPM, 
8MB Cache, ata/100 or 133 Interface. No SATAs! Download the 
“Converting the VS2480CD to VS2480DVD” PDF from this direct link and 

http://www.rolandus.com./
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buy a Panasonic UJ-845-B Slot Loading DVD/CD Laptop Burner….  
http://www.rolandvs2480.net/VS2480CD%20to%20vs2480DVD%20Conve
rsion/Convert%20your%202480CD%20to%20a%202480DVD.htm 
The UJ-870 & UJ870QJ REPLACES:  
UJ-811, UJ-811B or -B,  UJ815, UJ-815, UJ-815B; UJ825, UJ-825, UJ-825-
B; UJ-830, UJ-830B,  UJ835, UJ-835, UJ-835-B, UJ-840-S, UJ845, UJ-845, 
UJ-845-B, UJ-845-S or UJ-845S,and UJ-85JS and UJ-850. The 
VS2480DVD comes with a Panasocic/Matshita UJ-840-S installed. Also, the 
UJ870 shows up as UJ870QJ in the CD-R Write window. Arjan  van gog on 
VSP, used a UJ-875 BXM Master DVD Burner and it worked. 
 
 
Link above is from Brett’s web site at this link… 
http://www.rolandvs2480.net/ 
You’ll be glad you did. If you need more help with it contact me at 
Fcgjabq@aol.com  
 
 
FORCE INITIALIZE/FORMAT HARD on start up. 
Hold down both the CH-Edit button and Track Status buttons above fader # 
4 and power up the VS, keep holding till you reach the LCD with a prompt. 
Use the ENTER/EXIT buttons to answer the prompts to format the hard 
drive. This will erase all data currently on the hard drive. 
*Note: This is also a way to get the VS back up and running after a start up 
has failed or you have shut down improperly and the VS will not open a 
project. 
 
VS DIAGNOSTIC MODE 
Hold down the PAGE button and F1 on the VS and power up the unit. Keep 
holding the buttons down until you see a prompt on the small LCD on the 
VS. From here you can check all of the functions of the VS, be sure not to 
press the wrong buttons on the screen or you could accidentally format your 
hard drive. 
 
Performing a Drive Check 
If you are having some problems with your VS running smoothly, loading 
projects, backing up etc then perform a drive check. 
Drive Check 

1) Select Project 
2) Select the drive to perform the check on. 

http://www.rolandvs2480.net/VS2480CD%20to%20vs2480DVD%20Conversion/Convert%20your%202480CD%20to%20a%202480DVD.htm
http://www.rolandvs2480.net/VS2480CD%20to%20vs2480DVD%20Conversion/Convert%20your%202480CD%20to%20a%202480DVD.htm
http://www.rolandvs2480.net/
mailto:Fcgjabq@aool.com
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3) Find the “F” button for “DrvChk’, you may have to page thru it to 
find it. 

4) Select “F1 DrvChk” and the VS ask you to Press ENTER/YES or 
EXIT/NO for drive check, select YES. 

5) Then it ask if you want to save any recent changes to the current 
project. 

6) Press YES to save Changes or NO to continue on with the drive 
check. 

Drive check examines the area where the project files are for corrupt data 
and problems. When it is done it will show you a report. If the drive check 
finds some corrupt data it can attempt to fix the problem but will tell you 
that you will lose data. The data lost is the corrupted data and is not needed. 
More on drive check on VSPlanet   
http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Numb
er=1154797&gonew=1#UNREAD 
 
 
Turn Off IDE Drive. 
To turn off the internal drive so the VS will boot to an external hard drive, 
Select UTILITY> SYSTEM PARAMETERS> [F2 Param2] and there you 
can check mark to turn off the IDE DRIVE. The VS should then boot to an 
external drive on reboot. 
 
VS2480 Fan Specs. 
San Cooler 80 by Sanyo Denki 
Model: 9A0812L403 
Voltage: DC 12V 
Current Draw: 0.06A 
 OR 
Silenx IXP5211 iXtrema Pro Fan    
80mm x 15mm, 
11dba, 18CFM 
TigerDirect.com has them for appx $11 
 
VS2480CD Hard Drive Model 1C35l090AVV207-0 
Hitachi Deskstar 80GB, 7200RPM, ATA/IDE June 2003 N155 
CD Burner is a UJDA340  
Roland gives these specs for hard drives: Maxtor DiamondMax Plus 9, 
80GB, 7200RPM, 2MB Cache, Ultra ATA/133, Average seek times 9.3ms. 
 

http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Number=1154797&gonew=1#UNREAD
http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Number=1154797&gonew=1#UNREAD
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Seagate ST380215A Barracuda 7200.10 Hard Drive - 80GB, 7200rpm, 
2MB, EIDE, OEM from Tiger Direct worked for me Apr. 2010. 
Here’s post on VSPlanet that list many models that are compatible... 
http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Number=677261&fpart=1 
AND 
http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Board=16&Number=976890&Search
page=7&Main=47033&Words=Hard+drive&topic=0&Search=true#Post976890 
AND 
http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Board=16&Number=102931
5&Searchpage=2&Main=97783&Words=Hard+Disk&topic=0&Search=true#Post1029315 
 
 
 

VS2400CD Hard Drive and Burner models 
Maxtor Fireball 3 ATA/133 40G 
CD Burner UJDA360 Panasonic April 2003 
Also UJDA340 and the newer UJDA780 with these specs on it. 
-HW: 1.01 
-FW: 1.00(-> Firmware) 
 
VS2480 Faderboard Part # 71561767 
 
Seunity on VSP about VS2480’s CPU and ram specs: 
CPU is M38881M2. 
The 32 bit CPUs (two) are HD6417014 and HD6417709. 
There's also a CPU DSP, TMS320VC5402 and a custom board. 
For the DRAM we have GM71VS16163CLT and HY57V641620HGT, for 
the flash memory TC58FVB321FT. Lets also throw in one more DSP, 
XCB56364FU100, along with bucket load of other stuff specifically fit 
together to do just what this machine does... 
 
VS2400 Replacing CD Burner or Hared drive (by Detroitroadrage 
onVSP) 
Step-By-Step: This is the procedure for both the burner and the hard drive. 
The drives are side-by-side right under the the bottom cover. 
1. Remove 16 screws holding back cover. 
2. Unplug the ribbon cable from the drive. 
3. Remove the four screws holding the drive mounting frame to the VS. 
4. Remove the four screws holding the drive to the mounting frame, also 
remove the two screws holding the "CDRW BOARD" to the frame. (These 
four screws are located on the sides of the drive and require a VERY small 
phillips screwdriver) 

http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Number=677261&fpart=1
http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Board=16&Number=976890&Searchpage=7&Main=47033&Words=Hard+drive&topic=0&Search=true#Post976890
http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Board=16&Number=976890&Searchpage=7&Main=47033&Words=Hard+drive&topic=0&Search=true#Post976890
http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Board=16&Number=1029315&Searchpage=2&Main=97783&Words=Hard+Disk&topic=0&Search=true#Post1029315
http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Board=16&Number=1029315&Searchpage=2&Main=97783&Words=Hard+Disk&topic=0&Search=true#Post1029315
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5. Unplug the "CDRW BOARD" from the drive. 
6. Install new drive in opposite order. Takes appx 10 minutes. 
 
 
The VS2480 has 5 CPU's and DSP's on board. Since this is a real-time 
embedded system Roland proprietary design, the hardware architecture is 
very different to PC hardware. 
 
02129089 TMS320VC5402 IC (CPU DSP) IC62 on MAB 1 
01672867 M38881M2-069FP IC (CPU) IC107 on MAB 1 
01679156 HD6417014 RF28 IC (32BIT CPU) IC1 on PRB 1 
02454289 HD6417709AF133 IC (32BIT CPU) IC5 on MAB 1 
02453878 AK4528VF IC 
(AD/DA)IC28,IC3,IC33,IC13,IC23,IC18,IC36,IC8 on JKB 8 
01342978 TC160G22AF-1253 IC (CUSTOM) IC5 on PRB 1 
02455712 GM71VS16163CLT-6 IC (DRAM) IC84 on MAB 1 
02673812 HY57V641620HGT-P IC (DRAM) IC2,IC10 on MAB 2 
02458978 XCB56364FU100 IC (DSP) 
IC57,IC56,IC53,IC59,IC50,IC52,IC58,IC51 on MAB 8 
02454867 TC58FVB321FT-10 IC (FLASH MEMORY) IC3 on MAB 1 
02568323 MBM29F400BC-90PFTN IC (FLASH MEMORY) IC2 on PRB 1 
02344912 M7G1120-0104FP IC (GATE ARRAY) 
 
Link to PDF on how to run the Roland VS2480 TEST MODE…. 
https://skydrive.live.com/?cid=5D8E5CEAA7967BC4&id=5D8E5CEAA79
67BC4%21606 
 
 
 

https://skydrive.live.com/?cid=5D8E5CEAA7967BC4&id=5D8E5CEAA7967BC4%21606
https://skydrive.live.com/?cid=5D8E5CEAA7967BC4&id=5D8E5CEAA7967BC4%21606
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 How to use the Vocoder Effect  
The 19-band Vocoder found in all V-Studios provides quite a stunning "talk box" effect. 
It can make your synth or guitar track sound like it is talking. It does this by applying the 
envelope or articulation of a vocal track to the instrumental track. The vocal track that 
provides the envelope can be either a pre-recorded vocal, or you can even plug in a 
microphone and use the vocoder in real-time during a performance! 

When you use the vocoder -there are always two tracks or channels involved, one is the 
voice, and one is the instrument track. For the voice, you can either use a vocal already 
recorded, or a live mic input. For the instrument, use a rich, thick synth pad for the best 
results. You can also experiment with a strumming acoustic or electric guitar that has a 
lot of sustain. The key is use an instrument track that has continuous sound that doesn't 
drop out at all, and has a lot of notes playing a time - something with a big, thick chord - 
lots of harmonics. 

Now, to make the Vocoder sound right when you use it, you need to connect it the right 
way. And there really is only one right way to connect it. To explain, I'll refer to the two 
parts as the VOICE and the PAD. 

First pick the effect. From the Effects List of your V-Studio, choose "VOC2: 19-band" as 
the best choice. (Note, when you choose this for Effect 1, Effect 2 can not be used.) 

To connect the vocoder, it must be inserted on both the VOICE and the PAD tracks. I use 
the rhyme "Insert right on the mic" to remind me to insert the right channel of the 
vocoder on the VOICE track (i.e. "InsR"), and insert the left channel of the vocoder on 
the PAD track. If you have it inserted on both parts, but it doesn't sound right, chances 
are you got the Insert Left and Insert Right switched. Simply un-insert it all, and then try 
it again. 

Once you press play, you'll hear the PAD track but only if the VOICE track is "talking". 
If the voice track isn't talking or singing at that particular part of the song, you won't hear 
anything. When the VOICE track is making sound, you'll hear just the PAD, but as 
modulated or articulated by the VOICE. 

When you want to use the Vocoder with a live mic as the VOICE, just make sure you 
insert it on the Input Mixer, and not on the Track Mixer. 

 

Fun with the VS Vocoder (or eight easy steps to schizophrenia)  
 
Here's my routing:  
Input #1- keyboard 
Input #3- microphone  
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Your routing may be different. If so, you can either substitute your routing 
numbers for mine (e.g. if your keyboard is Input #2, just substitute Input #2 
wherever I mention Input #1) or you can temporarily route your stuff the 
way that is. Using headphones is a good idea while playing with the Vocoder.  
 
1.) Make sure that your Fader Edit button is showing yellow. This will allow 
you to manipulate the Input rather than the Track or Effects Retun. What we 
want to do here is to allow you to experiment with the Vocoder before you 
record. If you happen to get something that you like, then you can just start 
recording and the effect will be printed to the track that your Inputs are 
assigned to.  
 
2.) Looking at the Input Mixer, play your keyboard using a nice rich texture. 
String sounds usually work pretty well using four or five voice chords. Bring 
up Input #1 until you can hear the keyboard fairly well.  
 
3.) Now speak into your microphone and bring up Input #3 until you can 
hear your voice fairly well. I've found compressor on the voice will help a bit 
with Vocoder experiments.  
 
4.) Play sounds on your keyboard and speak into the microphone at the 
same time. Can you hear them both well? Good.  
 
5.) Hit the Effect button, and assign FX1 to B84, VOC2:M19Band.  
 
6.) Hit the Select/Channel Edit button for Input #1, and scroll until you find 
the IN1 FX1 Ins screen. It should be showing "Off" right now. Roll your 
Time/Value control clockwise until the display shows IN1 FX1 Ins=InsertL. 
playing your keyboard. You should not hear it.  
 
7.) Hit the Select/Channel Edit button for Input #3, and scroll until you find 
the IN1 FX1 Ins screen. It should be showing "Off" right now. Roll your 
Time/Value control clockwise until the display shows IN1 FX1 Ins=InsertR. 
into the microphone. You should not hear it.  
 
8.) lay a big four or five voice chord on your keyboard while speaking into 
your microphone. Your voice should "Vocoded". Go ahead, try that Cher song 
that you've heard over and over and over again. Now try some four-letter 
words…Now that you've tried some of the easy stuff, think of some even 
better things, like talking cymbals (if you're into cymbalism). Or think about 
Vocoding a bass guitar with a kick drum- there's a tight rhythm section!  
 
Talking traffic is cool, too. Gives you a taste of what schizophrenia is all 
about. 

 

From Brett’s site…   http://www.rolandvs2480.net/ 
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Backups, Format & New VS8F-3 Card Install                   
by Frank Griffith 

1) Do your backups first!  
2) Update the OS, the 2.504 update CD should have come 
with the VS8F-3 card. Insert it into the CD Tray and 
shutdown the VS. Now, Power up the VS with Update CD 
in the CD Drive and follow the prompts on the 3” x 5” 
screen, using the ENTER button to answer the prompts. 
Once the OS is updated it will load an INT0000Project. 
3) Now it’s ready to be formatted. (See “Formatting 
Process below) 
4) Recover your projects. (Also below) 
5) Turn off the VS and install the VS8F-3 card in slot "A", 
(under the panel on the back of the VS.) 
6) Power up the VS and install the VS8F-3 card program 
and plug-ins using the VS8F-3 card "Setup Disc" CD that's 
already in the CD bay, there are more detailed 
instructions that came with the VS8F-3 card. You can 
Click on CD-RW Mastering Menu and select “Plug-in 
Install” and follow the directions on screen. 
7) After that make a Backup of the "Setup Disc" which is 
explained later in this document, by clicking on CD-RW 
Mastering> then select “Plug-in Backup” and answer the 
prompts on your screen. Yes, it’s that easy. 
 
VS8F-3card Install Procedure 
1. Insert 3card SETUP disc 
2. Press CD-RW and the menu screen should open. 
3. Select page 2 "Plug-in Inst" and YES/ENTER 
4. Press "F5 Install" and the install menu should open. 
5. Press YES/ENTER and the installation should begin 
6. Here the "Authorize" popup should appear so press 
YES/ENTER to Authorize, if not... 
7. Press EXIT/NO to install the "Trial Version" 
8. If you pressed YES/ENTER then authorization will begin 
and be written to the setup disc and hard drive. 
9. Confirm by pressing YES/ENTER 
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10. When done the CD-RW menu will open and you can 
remove setup disc. 
 
NOTE: It has been found that once you “Authorize” a 
plug-in with a key VS8F-3card in slot “A” you can later re-
install the “Authorized” plug-ins with that key VS8F-3card 
in any slot. If you buy a new plug-in, you have to have 
the key VS8F-3card that “Authorized” the other plug-ins 
back in slot “A” to install a new plug-in. Even if you have 
all VS8F-3cards in all slots, all plug-ins have to be 
installed and “Authorized” with the single key VS8F-3card 
that install and “Authorized” the other plug-ins. It appears 
that you can not run 2 key VS8F-3cards in the same VS 
and have different plug-ins “Authorized” by different 
VS8F-3cards. 

 
 
Formatting Process (See “BkUPFmtRcvy.doc” for more detail on 
a Formatting HD.) 

1) Do backups first!  
2) If update is needed power up the VS with CD in the VS. This 

makes the VS boot from disc, answer the prompts on the 
small LCD using the ENTER button on the VS. It’ll update 
the OS in minutes. To check the OS version later, power up 
the VS holding down the Track Status & CH-Edit button 
above Track # 1. The VS will show you all four digits of the 
current OS on the LCD, again answer the prompts using the 
ENTER button on the VS to load a Project. 

3) Format the HD. 80GB=6 ½ hours, 120GB=13 Hours. 
4) Install VS8F-3 card program and all plug-ins. 
5) Recover your projects. 
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INSTALL MORE PLUGINS 
Once the VS8F-3 card plug-ins have been installed, third party  
plug-ins are easier to install. 

1) Insert the New plug-in Installer disc into the VS2480’s CD-
RW 

2) Click on CD-RW Mastering> select PLUG-IN INSTALL> 
3) The Plug-in Install window opens, click “F5 INSTAL” 
4) It asks “INSTALL?” click “YES”, then it ask 

“AUTHORIZE?” click “YES” and “ARE YOU SURE?” 
click “YES” and wait… 

5) The disc will eject once the plug-in has been installed. 
 
LOADING & USING A PLUG-IN 
If you have your VS8F-3 card in slot “A” then we select the 
number one Effect to use the plug-in. Some plug-ins can use up 
Effects 1 & 2, the full effects processor in slot “A.” Now after you 
Insert Effect1 on a track, let’s use a plug-in on it. 

1) Click EFFECT> select EFFECT1> and the plug-in window 
opens. 

2) Click “F1 Plug-In” and the window changes to a list of plug-
in programs that are installed. 

3) Click on the one you want to highlight it and click “F5 
Select.” 

4) Now the window returns to the one before, after “Product 
Name:” should be the plug-in name. 

5) Click on “F3 PATCH” to patch in a preset effect you want to 
use. 

6) Highlight the Preset name in this list and click “F5 Select” to 
load that patch into the plug-in and wait… 

7) The window returns, now click “F4 EDIT” to load the visual 
of the plug-in on screen so that you can adjust its parameters 
or just exit out of it. 

8) Now press PLAY on the VS and listen to what this plug-in 
sounds like and make adjustments as needed if the edit 
window was left open.  
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9) When done click “F6 EXIT” and the plug-in leaves the 
screen but the effect is still INSERTED on that track for use 
as you left it. 

If you use the presets then they will load the plug-in as you left it 
the last time you shut down. If you make special changes to a plug-
in’s patch then click “F5 SAVE” and save it as a “User” Patch.  To 
select other patches just go to EFFECT> EFFECT1> then click on 
“F3 PATCH” and highlight another, click “F5 SELECT” and then 
“F4 EDIT” to bring the visual back up. Once a plug-in has been 
selected in an EFFECT,  it’s easy enough to go to that effect and 
PATCH in different patch selections and use the EDIT button to 
see what parameters are there to use. 
 
BACKUP PLUG-INS 
Once they are installed in the VS you should make a backup copy 
to a CD-R. It’s pretty easy to do, here’s how. 

1) Insert a blank CD-R into the VS’s CD-RW Drive 
2) Click on CD-RW Mastering> select PLUG-IN BACKUP> 

and the PLUG-IN BACKUP window opens 
3) Highlight the plug-in to backup by clicking on it.. 
4) Now click “F4 BACKUP” it will ask “Backup?” click “YES” 

and “Really Sure?” click “YES” and wait…. 
5) It will eject the disc when done so click “F6 EXIT” to close 

the window. 
 
USER Settings on Plug-ins 
Unlike the VS8F-2 card’s, you can not save USER settings you 
create using the VS8F-3 cards patches. You can do a Plug-in 
Backup and save your settings that way but you have no USER 
settings you can save on the VS8F-3 card. Also, SysEx does not 
work with VS8F-3 cards either. 
 
VS8F-3 Card Install AGAIN!     By Frank 
Griffith 
Follow the instructions that came with the card and this.  
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1) Do your backups first! See “VS BfUPFmtRcy.doc” for step by 
step info on this, Formatting & Recovering projects. 
 
2) Update the OS, the 2.504 update CD should have come with 
you VS8F-3 card. Insert it in the VS with it on, shutdown, 
power back up and watch the small LCD on the VS for prompts 
to answer using your ENTER/EXIT buttons. When it’s updated it 
loads a project, eject the Update CD and move on to the next 
step. 
 
3) Format the Hard Drive, seen manual for steps on formatting 
or my “VS BkUPFmtRcy.doc” for step by step info on this. Then 
install the VS8F-3 card with the VS off. 
 
4) Power up the VS and install the VS8F-3 card program and 
plug-ins using the VS8F-3 card "Setup Disc" CD that came with 
the VS8F-3 card, there are more detailed instructions that came 
with the VS8F-3 card, follow them. Also the VS8F-3 card "Setup 
Disc" will ask you if you want to "Authorize," answer YES. This 
will code the plug-ins to work only with that VS8F-3 card and 
allow you full use of the VS8F-3 card and plug-ins. The VS8F-3 
card's program and plug-ins are on the same "Setup Disc" CD 
and installed together. 
 
5) After that make a Backup of the "Setup Disc" by going to 
CD-RW Mastering and finding “Plug-in Backup” on the menu 
and select it. In the window that opens, highlight the VS8F-3 
card program name and click “OK” and insert a blank CD-R into 
the VS. 
 
 
NOTE: Have the VS8F-3 Owner's Manual handy when installing 
the card and programs. It'll only make since as you do the 
install, that's what worked for me. You can also call Roland's 
Free Tech line at 1-323-890-3741 M-F biz hours. Good luck. 
 
Install Third Party Plug-ins 
1) Insert the plug-in disc and select CD-RW Mastering> Plug-  
In Instal    
2) The VS scans drives and the plug-in window opens. Now 
click on “F5 INSTAL” a message ask “Install?” and you click 
“YES”.  
“Authorize?” and you click “YES”, “Really Sure?” and click 
“YES”  
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3) And the Plug-in Install progress bar begins. Wait a couple of 
minutes and the “In Preparation” progress bar starts then 
“Plug-in Authorize” begins and then “Eject Disc.” Done. 
4) Now go back to the CD-RW Mastering Menu, Insert a blank 
CD-R and select Plug-In Backup. The VS scans the drives and a 
“Plug-In Backup” window opens. 
5) In this window highlight the name of the plug-in to backup 
and       click “F5 BACKUP.” The VS scans the drive and ask 
“Backup?” and you click “YES”, “Really Sure?” and click “YES” 
and the VS scans the drive, “In Preparation” progress bar 
begins., then “Plug-In Backup” progress bar begins then “Eject 
Disc.” Click “F5 EXIT.” Done.  
 
ADDITIONAL INFO ON 3CARDS & PLUG-INS 
>>> I heard the term "  Vs8f 3  card getting "married" to the 
slot A used key card.?  Is this true?  
  
NO! What the deal is, in order to install the 3card and plug-ins, 
your 3card has to be in slot A in the VS. Then you can move 
that card to any other slot you choose after the setup disc has 
been installed, your 5 FREE plug-ins and 3rd party plug-ins. The 
“marry” part comes when you install a third party plug-in and 
choose “Authorize” on the install ie Auto-tune using that 3card, 
the Auto-tune is married/coded by that 3card and has to stay 
with that 3card. Once a 3card has installed all of your plug-ins 
in becomes the KEY 3card because it is the KEY that opens the 
locked plug-ins that it installed and “Authorized”.  
  
You can use the plug-ins as TRAIL versions and NOT have them 
married to a 3card but once you choose to "Authorize" a plug-
in during an install, it has to stay with that 3card it 
"Authorized" from then on. You can not sell that plug-in 
without its 3card or the plug-in will only work in TRAIL version 
mode and you will have a very unhappy buyer. 
  
The 3card install disc has the program on it that runs the 3card 
and any other 3card you install later. Once you have one 3card 
and install its setup disc, the rest of the 3cards you buy can be 
manually inserted in another slot and run off the first card's 
installed program. There are also five FREE plug-ins on that 
3card’s setup disc that you can install as well. You can run the 
3card without the FREE plug-ins and not install them and only 
install the third party plug-ins and run them or you can install 
both the 5 FREE and third party plug-ins for use.  
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The VS installs the 3card program on the last partition on your 
hard drive as well as any plug-ins you install. Therefore, any 
other 3card you manually insert into another slot in the VS will 
operate off what's already installed on the hard drive. They all 
share the one 3card’s setup disc program and all plug-ins it 
installed.  
 
Once you format your hard drive, every month or every 6 
months, you need to re-install every thing because the 
3card program and plug-ins get erased off the hard drive when 
you format. Before formatting, do backups of your entire plug-
ins and 3card program. Then you can use those to re-install 
every thing after the format. The original disc, some times fail 
after a couple of installs so backups are important to have and 
use, IMO. 
 
If you decide to buy all of the third party plug-ins available for 
the VS, you may want to buy a second 3card. The third party 
plug-ins has a lot of presets that use up the whole processor. 
You’ll have to bounce tracks with plug-in effects applied to free 
up a 3card to be used again. Many seem to like the MTKs on the 
3cards better than the ones on the 2cards. Probably has to do 
with the 3cards running plug-ins with a 56bit processing but 
also the full screen interfaces makes it easier to adjust 
settings. 
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V-Tracks-  
Next to every track's number is it's V-Track number, which would be a 
1. Just click on one of the Track's V-Track’s number 1 and a window 
opens up. The first V-Track is the one that, that track number has 
recorded your first take on. In the V-Track window, it will be a small 
black rectangle and a check mark beside it. “[Check 
mark, 1(rectangle):V.T  1- 1]” thru “[16_:V>T 1-16]” The other 15 V-
Tracks will be smaller black dashes. If you want to save a new TAKE 
of that track on a V-Track then Check Mark a different V-Track in the 
V-Track window, usually it's “[ 2_:V.T  1- 2]”. Then Click the Track's 
Number to EXIT the window and next to that Track's number will be 
number 2 for the V-Track you just selected. 
 
V-TRACK with EXTRA TAKES. 
If you want to keep a recording TAKE, let's say on Track 5, then click 
on the number 1 next to the 5 for track five, and in the V-Track 
window check mark “[2_:V.T  5- 2]” then click the 5 on track 5 to EXIT 
the V-Track window. Now you can record a second TAKE on Track 
5's V-Track # 2 and to the right of Track 5's number 5 will be a 2 for 
V-Track 2. There are 16 total V-Tracks per track. 
 
EASY ACCESS TO ALL V-TRACKS 
On the HOME screen in the track window there is an V-TRACK MAP. 
At the far right end of the ruler is a black left pointing arrow. Click on 
this arrow and it opens the “V.TRACK” map. Here the tracks that 
have data are colored, little yellow, blue and green squares. Just left 
click on any of the squares to switch to a different V-Track. A small 
widow opens confirming your selection and closes after a couple of 
seconds. *This is useful when auditioning different takes in you mix 
for deciding on what takes sound best. To close the V-Track map just 
click on the now right pointing black arrow. 
 
UNDO&OPTIMIZE.  
Recording take after take. If you just recorded a take and you don't 
want to keep it then immediately PRESS "UNDO" and in the UNDO 
window click on "ENTER" and that erases that bad TAKE. Another 
way to do this is, after you have recorded all of the tracks that you 
want to keep up to this point and you want to get rid of all of the re-
recording HISTORY then Click on PROJECT> and select OPTIMIZE. 
This will erase all of those bad takes but be sure you do not need to 
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go back and change anything before OPTIMIZING your project! Also, 
NEVER UNDO an OPTIMIZE, your project will disappear! The only 
way to retrieve the data is to REDO the UNDO by pressing and 
holding SHIFT + UNDO. To check the history map, PRESS UNDO 
and then PRESS EXIT/NO to shut it without undoing anything. 
  
AUTO PUNCH.  (Pg 192 in VS Manual) 
If you want to perform an AUTO-PUNCH, cue up the track's time line 
to the IN point and press and hold the "A.PUNCH" button down and 
press the IN button and release both, a RED down arrow will appear 
above the tracks in the RULER. Now cue the track's time line to the 
OUT point and press and hold down the "A.PUNCH" button and 
press the OUT button and release both, another RED down arrow will 
appear with a RED line connecting the two RED arrows. 
 
*NOTE: I like to PLAY the audio, keep the beat with my hand and 
count 1 and 2 and 3 and 4 and etc. Right after 4 on the “And” I press 
STOP and place my edit points or flags. This is usually a silent spot 
between beats. Practicing this will help you to get pretty precise at 
placing these flags. 
 
NOW let's say Track 5 is the one to punch IN & OUT of, press it's 
Track Status button till it's flashing RED. With your jog wheel back the 
time line up to before the IN point to give you time to get ready for the 
take to record and get in time with the beat. [You can place a 
LOCATOR button here as well if it’s lit just press 1 on the black area 
keypad, now you can cue up for several tries.] Now press Record and 
then when ready press Play. The music will play and when it reaches 
that IN point it will record on Track 5 until it reaches the OUT point 
where it will automatically exit record.  
 
Press STOP and turn the JOG wheel back to past the IN point and 
PLAY and listen to your take. You can leave the track flashing RED 
until you are sure you are keeping that take, if not then press UNDO 
and ENTER to erase it then press Record and Play and do it over or 
if you are keeping that take then press the Track Status button till it 
turns GREEN for PLAY.  
 
To get rid of the A.Punch markers hold down the "CLEAR" button 
with your left index finger and with the mouse in your right hand L-
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Click on the A.Punch's RED arrows while holding down “CLEAR” and 
the RED arrows with line will disappear. *If you do not do this, then 
when you try to record another track of audio, the VS will refuse to 
engage the record button. 
 
MANUAL PUNCH-IN/On the Fly. 
ARM the track to punch in on, back it up before the point you want to 
punch in at, play the song and when the VS gets to the point to punch 
in, press the RECORD button. When it gets to the point to punch out 
and stop recording press the RECORD button again. When done  
press STOP. 
  
AUTO or SOURCE.  
Also, during Auto-Punching some people like to hear the music play 
up to the edit point and after and some like to hear only the in point to 
out point section of music. To switch this parameter back and forth to 
do one or the other Select UTILITY> PLAY/REC PARAMETER> and 
in that window under "RECORD MONITOR" on page "F1 Param1" 
place a check mark by "SOURCE" or "AUTO", which ever is not 
selected, select it, then click EXIT. To hear your armed track’s INPUT 
signal with the RECORD engaged, select “AUTO”, when the 
RECORD is not engaged, to hear the armed track’s INPUT select 
“SOURCE” while practicing for the A-Punch.  
 
NOTE: In that same window on page "F2 Param2" is your PREVIEW 
Scub Lenghts and Preview TO & FROM times you can change by L-
Clicking with the mouse and moving it up and down. I have mine set 
at 1 Second, normally the default is too little time to understand what 
I’m hearing, now click EXIT to get out of this window and move on to 
the next item. 
 
 
 
REGION COPY. 
To copy a piece of one track to the same track but in a new position 
to cover up another piece of the same track, like copy a “chorus 3” 
vocal on track 6 to cover up a bad “chorus 2” vocal, do the following. 
Turn your jog wheel and place the time line at the beginning of  
“chorus 3” and press the IN button, then jog to the end on that chorus 
and place the time line there and press the OUT button.  
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Now jog to the beginning of “chorus 2” and press the TO button. 
Make sure your IN and TO points match the same beat and timing in 
each piece of that track 6.  
 
*NOTE: I also PLAY the audio, keep the beat with my hand and count 
1 and 2 and 3 and 4 and etc. Right after 4 on the “And” I press STOP 
and place my edit points or flags. This is usually a silent spot between 
beats. Practicing this will help you to get pretty precise at placing 
these flags. 
 
Now select TRACK, at top of screen, and select REGION COPY, 
when the REGION COPY window opens find the “F” button marked 
“SEL TRK” and click it, now the SELECT TRACK window opens, next 
to TRACK” 6-1”  place a check mark and you will see it change to 
“6-1   6-.1” so leave it there and click “F5  OK.”   
 
You will have to answer “Region Copy are you sure” by clicking 
“YES” and that’s it. If you want to redo it just press the UNDO button 
and click “ENTER” and try again. **Make sure there are not CHECK 
MARKS in other boxes from previous copies when selecting track. 
 
*Also, PRESS SHIFT+STORE often, to save your project during the 
process. Optimizing a project can cut down on project size as well. It 
cleans up the old editing data from erasing and editing. If you do 
Optimize, make sure that there is noting left that you need to UNDO.  
 
I always optimize when I am certain the song is done and that I have 
edited out all un-needed data. This cuts back on the amount of data 
to be backed up to DVD-R or RW or CD-R or RW disk later. Some 
projects at 250MB can wind up as small as 150MB after erasing extra 
data, and optimizing a project. This means you’ll need fewer disk to 
backup to in the end. 
 
MUTE & SOLO ETC. 
On your HOME screen you’ll notice that to the right of the area where 
you can have track names entered into, there are grayed out letters in 
boxes, “M”, “S”, “R” and “P.”  No, that does not stand for  
Manufacture’s Suggested Retail Price. The first two letters we will 
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discuss here. “Mute” & “Solo” because they can cause so much 
confusion in the future if one of them is on, especially Solo. 
 
Click on the “M” and you will Mute that track, meaning you will not 
hear it  play but will all the others. To Solo a track you can click on the 
“S” and it will light up BLUE. Soloing a track means that this track is 
the only one that will be heard out of the 24. If you accidentally have 
a track with nothing recorded on it Soloed then you will not hear any 
of the tracks that are recorded.  
 
Click on the “S” next to any track and watch at the bottom of the 
HOME screen to the left of the REMAIN graph. You will see a BLUE 
Solo flashing. Do the same for Mute and both will flash, Mute to Solo 
to Mute etc.  If you happen to have an INPUT Muted or Soloed you 
may not know it while looking at the tracks on the HOME screen.  
 
If you do not see any of the M’s or S’s lit but see Solo or Mute or both 
words flashing at the bottom of the screen then do this. At the very 
bottom of the list of M’s and S,s are tiny little black up arrows in 
grayed out boxes, click on those to turn off all of the Mutes & Solos. 
To the right of those are the “R” and “P.” The “R” is the Auto-mix 
Status button as on the VS and the “P” is for the Phrase Seq. Status 
button. The “PLY” acts like the TRACK STATUS buttons on the VS. 
Click on it to select from “PLY” for play to “OFF” to “REC” for arming a 
track to record.  
 
I know a lot of this is logical but I just wanted to make sure that users 
understood that these buttons can solo and mute tracks and that 
there has been some confusion in the past with users not hearing 
their tracks play. Even recording new tracks, seeing the gray record 
line of data as they record, then when they play the track, nothing! 
The final solution to the problem was to click on the ting little black 
arrows at the bottom of the M’s and S’s on the HOME screen. 
 
CH-LINK TRACKS & INPUTS 
Linking TRACKS for a stereo input is easy enough to do. Press TR1-
16 first. Now, you can either press the CH-Edit button for the odd 
numbered track and go to the CH-Edit page and find the CH-Link 
virtual button and click it or hold down the CH-Edit button of the odd 
numbered track and press the even numbered one’s CH-Edit button 
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until you see them link on the HOME screen in the track list. For 
linking INPUTS, press IN1-16 and do the same with their CH-Edit 
buttons or go to their CH-Edit page and click on the CH-Link virtual 
button.  
 
When bringing in stereo signals from an out side source, drum 
machines, keyboards etc, you will need to LINK both the INPUTS and 
the TRACKS to get a stereo signal recorded to the tracks. Either have 
them both LINKED or you can try UNLINKED but never have the 
INPUTS linked and not the TRACKS. This will confuse the VS and 
you will probably wind up with everything sounding centered. 
 
USING LOCATORS 
To the left of the JOG wheel are buttons numbered 0 thru 9, like a 
key pad with a dark gray background around them. Please, look at 
the VS and find them, OK? Above it says "Locator/Markers/Scenes"  
  
The easy way to use these multi function buttons is to use them as 
locators! It requires the least thought to use them as locators.  
  
IN TWO EASY STEPS DO THIS... 
1) Press the LOCATOR/Bank button to light it up. 
2) Turn the JOG wheel until the TIME LINE is where you want to 
place the LOCATOR ie the beginning of a song. 
3) Press any number on that pad you desire to remember that spot 
on the time line (maybe 0 or 1), the locator button will light up. Done. 
  
*Now, any time you want to go to that same spot on the time line 
quickly, press that same locator number. 
  
*If you ever want to CLEAR one of the LOCATORS, to the left of the 
number one LOCATOR is the CLEAR button on the VS, press and 
hold it down and then press the locator number you want to clear. 
You have 0 thru 9 LOCATORS you can use this way. There is a way 
to use up to 99, see the VS Manual for more. 
 
SCENES Storing a scene. 

1) Press and hold the SCENE/Bank button to light it up, then 
press a number on the keypad. 
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2) To bring up that SCENE from now on all you do is press the 
SCENE/Bank to light it up, then the number of the scene on the 
keypad. 

 
Clearing a scene... 

1) Clear a scene by pressing the SCENE/Bank button to light it up. 
2) While holding down the CLEAR button and press the scene’s 

number on the keypad. 
*To learn more about scenes see page 144 in the VS Manual. 
 
. 
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INCREMENTS of DATA              By Frank Griffith 
1) Check out the time in the upper left hand corner of the HOME 
screen. There is a yellow line under one of the double zero digits. 
There's 00h00m00s00f00 for hours, minutes, seconds, frames and 
something smaller, "Ticks" I guess. 
 
2) Press one of the Left or Right cursors to move the yellow line to 
seconds or frames and turn the JOG wheel. The TIME LINE moves in 
the smaller increments. This is good for use when editing tracks with 
them zoomed in on the wave files using WAVE DISP. You can easily 
line up the TIME LINE, (The RED LINE that crosses all tracks 
vertically) in very small increments for placing edit points. 
 
WAVE DISP Button (Wave Display) 
Any track that is selected will be displayed and fill the track screen 
when you press the WAVE DISP button. Also a wav disp blue icon is 
as the far right, bottom corner of the track screen’s scroll bars. You 
can just left click on it after selecting a track to view. 
 
So when you are doing a REGION COPY & MOVE you can use the 
WAVE DISP button to really zero in on the wave form and place your 
IN, OUT & TO points precisely. These buttons, IN, OUT, TO, FROM 
are on the second row of buttons below the LCD screen on the VS 
unit. 
 
Click Home and let’s REGION COPY something. Let’s say you want 
to repeat the last word on a verse once on track # 5. Move the TIME 
LINE to the front of the word just before you hear it play or play the 
track up to just before you hear it and press STOP. 
 
Now, on the HOME screen click on Track #5’s five(5) on the right of 
the HOME screen, to select it and highlight that track. 
 
Now press the WAVE DISP and see if you can see the word’s wave 
on the wave form, there will be a lot of tall vertical hash marks across 
the horizontal line. That’s the word. The flat line to the left of it is quiet 
space where you should place your IN point, but not just yet.  
 
Remember how far from the WORD WAVE your in point is. Using 
INCREMENTS as explained above, you can press the left or right 
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cursor buttons above the JOG wheel to change the amount to move. 
Watch the TIME DISPLAY and place the YELLOW/ORANGE colored 
line under “f” for frames by pressing the right cursor button>. Now 
place the TIME LINE on a flat, quiet place on the WAVE DISPLY by 
turning the JOG wheel. 
 
When the TIME LINE is in place, press IN. Now press HOME to come 
out of WAVE DISP and play the track and STOP it at the right end of 
the word, just after it.  
 
PRESS WAVE DISP and see where your TIME LINE is. Use the JOG 
wheel to place the TIME LINE on a flat place on the WAVE and now 
press the OUT button. Now you have placed and IN & OUT on this 
piece of wave for it to be selected, highlighted as the chunk of data to 
COPY later.  
 
SINCE we want the WORD to repeat it’s self, we just happen to be in 
the perfect spot to place the point where we are sending the selected 
word TO. We want it to come in and repeat where it went OUT. So… 
PRESS the TO button now so it’s in the same place the OUT point is. 
If you want it to be a beat later, then PLAY it and STOP it in the right 
place, and place the TO point in the new spot. 
 
Now go to TRACK menu and select REGION COPY, a window 
opens, click on “F1 Sel Trk” and on that window place a check mark 
in the empty box to the left of  
5-1   -“ and it’ll turn into “5-1  5-1” meaning you are copying a 
portion of track # 5 to track # 5. 
 
Now click OK and then click on EXIT to close the REGION COPY 
window. Play the tracks and see if the edit did what you wanted. If not 
you can press UNDO and then ENTER to try it again. 
 
*REGION COPY will copy a piece of audio and send it “TO” any track 
on the time line you want to send it “TO” leaving the original part in 
tact. REGION MOVE will MOVE that piece of audio to any track on 
the time line but not leave an original in tact. To send a copied piece 
of audio to a different track or V-Track, just select that track in the “F1 
Sel Trk” window mentioned above. It’s that simple.  
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VS2480 SHORT CUTS……….PS/2 KEYBOARD                 By Frank Griffith 
F1 – F6 = VS F1 – F6 …………………………………F7 = Dislay the EZRouting Screen 
SHIFT+ F7 = EZ Routing>EZ Patch Bay> …………...F10 = Track Menu 
SHIFT+ F8 = Mastering Room  ………………………F11 = Effect Menu 
F9 = Project Menu …………………………………….F12 = Utility Menu 
 
PRESS 
        Space Bar =…………………..Start, Stop and Continue Project 
     Arrow Keys =…………………. Moves the cursor on the display 
SHIFT+ Arrow Keys =………Zoom in and out vertically and horizontally  
        Ctrl+ S =…………………………Stores the current project 
Ctrl+ Alt+ Delete =……………………Shuts down the VS2480 
          Tab =………………………………….Page button 
         Enter =……………………….Enter/Yes or Left mouse button 
        Escape(Esc) =…………………………………Exit/No 
       Home = Home screen on VS 
 
VS2480 FUNCTION BUTTONS SHORT CUTS 
Quick Routing = Hold [Track Status]           / Snapshot = [Automix]+ [Snapshot]+ [TAP] 
 
Solo Ch. Clear = [Clear]+ [Solo (IN 1-16)]                /Automix = [SHIFT]+ [AUTOMIX] 
 
Mute Ch. Clear = [Clear]+ [Mute (IN 17-24)]                   / Marker = [Shift]+ [MARKER] 
 
Automix Status =  [Automix]+ [Automix Status]            / Tempo Map = [SHIFT]+ [TAP] 
 
Tr. Status REC =  [REC]+ [Track Status 1…24]     /REDO = [SHIFT]+ [REDO(UNDO)] 
 
Locator Clear =  [Locator (Bank)] [Clear]+ [0…9)] /Marker Erase = [CLEAR]+ [TAP] 
 
Scene Clear = [Scene (Bank)] [CLEAR]+ [0…9]    / Jump to IN point = [SHIFT]+ [IN] 
 
CD Track Number = [CD-RW (Mastering)]+ TAP /Jump to OUT point = [Shift]+ [OUT] 
 
Automix REC = [Automix]+ [REC]              / Jump to FROM point = [JUMP] + [FROM] 
 
All Markers Erase = [SHIFT]+ [CLEAR]+ [TAP]         / Jump TO point = [JUMP]+ [TO] 
 
Mastering Rom = [SHIFT]+ [Mastering (CD-RW)] / Loop From/To = [SHIFT]+ [LOOP] 
 
Sync Parameter = [SHIFT]+ [EXT SYNC]    / Reset Fader/Pan = [CLEAR]+ {CH-EDIT] 
 
Auto Punch IN/OUT = [SHIFT]+ [AUTO PUNCH] 
 
Tr. Status PLAY = [STOP]+ [Track Status 1…24]             
Found in VS Manual and Stickers 



 
 

What is the HoldID for? 
FAQ's - Tutorials - Tips 

There are a number of VGA and LCD commands that say ****ID next to them. What 
this does is give you two screens to work with at once.  
 
For example, you may push the IDHome button and the VGA screen remains the same 
but the LCD on the VS2480 changes to different views.  
 
If you like that view you can push the HoldID button and that screen will stay displayed 
even if the VGA screen changes pages.  You can have mixer view on the VS2480 LCD at 
all times or various others, a very handy feature.  

From Brett’s site on line.  
http://www.rolandvs2480.net/ 
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PC AUDIO & PERFORMANCE 
START> Control Panel>Classic View click System> Advanced> 
under Performance click Settings> then tick for Best Performance. 
  
Control panel> Classic View>Sounds and Audio Devices> Sounds 
tab> Sound Schemes, in the drop down menu select NO SOUNDS. 
  
Control panel>Classic View>Display> Settings> 1024 x 768 & Color 
@ Highest[32 Bit]. For Sonar Producer 4 select 24bit. 
  
Control Panel> Classic View> System> Advanced tab> under 
Performance click Settings> Advanced tab> there are 3 items: 
Processor Scheduling tick for BACKGROUND, Memory Usage tick 
PROGRAMS, Virtual Memory @ 1280, click Change to reset number 
if smaller than 1280. Why BACKGOUND? This lets your ASIO, 
DirectX and VSTs run better with less latency. 
 
Right-Click on bottom Task Bar> select Properties> uncheck “Show 
Clock”, this saves on CPU usage. 
 
START> Control Panel> System> Automatic Updates> Select “Turn 
Off Automatic Updates.” Check once a week when you want too. 
 
START> Control Panel> System> System Restore tab> Select “Turn 
Off System Restore” and click “OK.” This can happen at the most 
annoying times plus it uses up disk space. 
I recommend you set your own restore points weekly or monthly by 
going to START> All Programs> Accessories> System Tools> 
System Restore> and follow the directions given to create a restore 
point. You will have to turn it on first. Or, just move the space slider to 
halfway to have it use less disk space. 
 
Disable Remote Desktop and Assistance. START> Control Panel> 
System> Remote tab> Uncheck “Allow Remote Assistance…” and 
“Allow users to connect…” 
 
START> Control Panel> System> Hardware tab> Device Manager> 
[+] Disk Drives open> Highlight the Hard Drive and right click> Select 
“Properties”> Policies tab> Uncheck “Enable write caching on disk” 
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and click “OK.” You see the warning is has there about having it 
checked and data loss? 
 
START> Control Panel> Power Options> Power Schemes tab> 
Select “Home/Office in the first window and then select “NEVER” in 
the rest and click “Apply.” 
 
START>Control Panel> User Accounts> click on “Change the way 
users log on or off”> then uncheck “Use Fast User Switching” And 
click “Apply Options.” It uses too much CPU power. 
 
Right-Click on Desktop> Properties> Desktop tab> select 
Background None, and on Screen Saver tab> None.  
 
Also go to Internet Explorer> Tools> Internet Options> General Tab 
"Delete Cookies" and click “OK”, then “Delete Files” and click “OK”, 
now wait on the hour glass to go away & “Clear History” then click the 
“YES” and then Internet Options box’s “OK” to shut the window. 
 



ABOUT Frank’s VS Info. 
 
This is my manual and a quick start guide for Newbies written in the Dummies style, on 
the VS2480. A lot of this info works as well with the VS2400 and VS2000. Roland Tech 
Support taught me how to use my VS2480CD in 2002 and beyond and I have typed up 
step by step info, pretty much on all the features I have learned. I have had people who 
were fed up with the Roland manuals and selling their VSs, tell me that this info “saved 
the day.” So... I send it out FREE to VSPlanet members. 
 
The second doc, a CONTENTS doc, tells what’s covered in each .doc. The third is the 
QUICK START guide titled "Easy VS Info" that takes you from start of project to 
finished CD, step by step in 11 easy pages. Start with this document. Roland’s manuals 
do not really give you step by step instructions on how to use the VS with a mouse and 
the external VGA monitor connected; so I wrote this manual to help other Newbies learn 
to use their VSs like they do a computer with a monitor, mouse and keyboard. A lot of 
the language is in “plain English” and laid out very simple so just about anybody can 
follow it. You will need to have a PC style Monitor, mouse and keyboard connected to 
your VS to get the most out of these word docs. 
 
If you have any questions or need another copy sent, just email me at Fcgjabq@aol.com 
I am always updating this info as I learn more so you can also come back for updated 
copies. You will find that I have covered just about everything I have needed to know 
using mine since 2002. I cover the basics then have extra docs that take steps more in 
depth as well as links to info on line and added info from post that I have found helpful 
on VSPlanet. 
Start with the “Easy VS Info” and good luck, Frank. 
 
Last updated Oct 24, 2012 
 

mailto:Fcgjabq@aol.com
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CONTENTS OF VS DOCS 
Easy VS Info…Is a 10 page start to finished CD Quick Start doc to get you up and 
recording as quickly as possible and covers tons of good things to know. If you read 
nothing else at least read this one to teach you all of the basics about the VS. The most 
helpful word docs for Newbies are: Easy VS Info, VSCpyMveExchExprt, VS EFFECTS, 
VS INSERT EFX, VS LEVELsRecMSTclkTrk, VS Mastering CDs for Newbies, VS 
MST & BURN, VS SUB MIXESbounceLoop & VS V-TrkOptUndoAPnchRgnCpyEtc. 
This info was written using a Monitor, keyboard and mouse and will you need them too. 
 
“Easy VS Info” starts with the 5 Goals using the VS, then New Project & Initializing 
routing page settings, Setup Audio, Input & Track Fader Setup,  Input Levels, Recording 
Levels, Check Track, V-Tracks, Track naming, Recording Guitar w/ Hi-Z, Linking 
channels for stereo, Loop Effects, Insert Effects, Add Effects to Inputs, Edit Effetcs, 
Mixing Recorded Tracks,  Phrase Normalize, Analyzer, Mastering Tracks, Burning to 
CD, Backups, Bouncing Tracks w/ Effects, Bounce without Effects, EZRouting Clear 
Tools, CR-R Mode, Important to remember, No “Save As” only Copy project, Never do, 
Always do, Conclusion, Frank’s email address and Links to Videos, the Plancton DVDs 
and a post on VSP comparing the VS audio quality to Pro Tools. 
 
VS2480 SHORT CUTS….Shows you the VS shortcuts as well as shortcuts you can use 
on a PS/2 keyboard with the VS. IDHold for different views on LCD and VGA. 
 
VS 16bit w MTP...How to get 16bit .wav format files out of the VS2480 while in MTP 
24bit mode, from Brett’s site on line.  
 
VS & PC Progs…Shows you how to use PC programs like Acid and Wavelab to export 
.wav files from each other to disc or into the VS. 
 
VS & RPC-1Setup…Is just that, how to setup the VS to work with an RPC-1 card & PC. 
 
VS BitsSamplesWavsCDA... explains what windows burn what files in what bit rate, 
sample rate and file format. CD-R WRITE window, TRACK EXPORT window, 
Mastering Room and Project modes and settings that affect bit and sample rates. 
Post about Jerry Tubbs and VS wav files as good as Pro Tools. 
 
VS BkUPFmtRcvy…Covers Backups, Formatting your hard drive and recovering 
projects. Installing hard drives and models to use. Also formatting an external SCSI and 
links to VS2480CD to DVD Conversion and models used. 
 
VS BPMwTmpMp…Finding the BPM of a song using the TEMPO MAP. 
How to use the Metronome with recording and recording a click track. 
 
VS CompEQ PRM EDIT…How to assign the PAN knobs to become the parameters for 
the compressor and EQ for that track. 
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VS CompressExpGate…How to use the VS compress with Expander to create a GATE. 
A brief example of how to use the Compressor and Kick, Snare and Bass Guitar settings. 
 
VS CpyMveExchExprt…How to edit with the VS, copy, move, erase, cut audio, make a 
song shorter or longer, A-Punch, copy a song to another drive/partition, track exchange 
one track with another and how to copy parameters, Dyn, EQ & Level settings from one 
track’s or input’s Ch-Edit page to another. Also how to export .wav files to burn to CD 
and import them as well as IMPORT tracks and master tracks from other projects. Also, 
converting 48k tracks to 44.1k tracks using VS to PC to CD to VS. Also, CD Capture and 
TRACK IMPORT, importing tracks from other projects into an open one & Phrase 
Export phrases of tracks to CD-R/RW. 
 
VS Danielo Data Recover....So you powered down without saving the project or 
somebody unplugged your VS, or lightening struck, do what’s in this doc. 
 
VS DAO LIVE Rcdng…How to burn a live recording to disc using Disc at once. Also, 
how to separate songs into their own one song projects, in brief. 
 
VS De-esser EFX…How to use P022 Vocal Multi as a De-esser. 
 
VS EFFECTS... How to patch in effects and route them as INSERT or LOOPED effects, 
on INPUTS or TRACKS also some on EQ & Compression. Also how to edit effects 
patches and save them as USER patches. 
 
VS EQing Bas&Kic…Some tips on how to use the EQ Graph to mix the bass guitar and 
kick drum so they both come out in the mix. Also, how to use the ANALYZER to 
identify what frequency range an instrument or vocal is made up of. Plus a quicky list of 
freqs for all instruments, drums, vocals etc. Also a couple of tips on using compression 
and VS patches on bass guitar. Also, “Side Chaining” compression. & VSP post link. 
 
VS ERASE Silnt pts…How to get rid of the data between the vocal parts and solos, save 
on disc space by erasing un-wanted data, silent parts between takes etc. 
 
VS External EFX…How to setup the VS to work with external effects units. From VSP 
post by members. 
 
VS Faders Clean & Replace…Links to info on how to clean faders, parts to order for 
replacing faders and how to turn them On or Off. 
 
VS INSERT EFX…INSERT effects explained in more detail and the 4 positions of the 
EFX button. 
 
VS Install HD in VS2480CD... Describes how to install a new hard drive in the CD 
model VS2480,  provides a link to a PDF with pics to help with the install, a brief how to 
do and tools needed and what brands and specs to look for in hard drives. 
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VS LEVELsRecMSTclkTrk…Setting the recording levels at -12db to -4db to leave 
headroom for mixing, setting mastering levels, using 3card MTKs and how to use a click 
track. From VSP members post and setting levels for sending mixes to mastering houses. 
 
VS Mastering CDs for Newbees... Several tips on finishing off your CD, song order, 
keys, levels, tempo and setting the right mood. Adding the final touch to your CD. 
 
VS MasteringKarl…A VS-Planet post on mastering by Karl Lakestone. 
 
VS MST & BURN…Mastering and burning master disc in more detail. Protecting your 
master CDs with “Digital Copy Protect.”Also, how to master 24bit, 96k projects in the 
VS. 
 
VS MST DAO… Mastering the MTP, 44.1k 24bit Master Tracks using DAO (Disc At 
Once) by Importing them into a new project and adding track markers. 
 
VS MST Fade AutoMx…VSP setting up a master fade-out using Auto-Mix. How to use 
auto-mix to set a track or tracks volume and/or pan levels, EQ,Mute, Aux Sends, record 
movements, etc... 
 
VS MST TRKS Normalized…How to Normalize master tracks or any track. 
 
VS MTK USE…Different VSP Members give pointers on how to use the 
MTKs/Mastering Tool Kits in the VS8F-2 cards and 3cards. 
 
VS Pitch Correction... How to use the AUTO-TUNE plug-in to correct pitch and how to 
use the VS2480’s EFFECT P022 Vocal Multi to correct vocals and guitars. 
 
VS PRE POST Mix…How to use the PRE and POST fader settings when reading the 
meters durning recording and especially mixing. Also how to use the ATT knob to 
control some recorded levels. 
 
VS Preamp Test…How to test your VS’s preamps to see if they need the “FIX” to get 
rid of harmonic distortion. 
 
VS REC & MIX TRKs…How to use EQ, Compression and mix your tracks better. How 
to use the PRE and POST settings right. 
 
VS RegionArrange…How to use Region Arrange by VSP member Karl Lakestone. 
 
VS RPC1 PC Setup…More on how to setup the VS & RPC-1 card from Brett’s site. 
 
VS ScanDsk & DATA Recvy…VSP post on how to setup the PC to scan a VS hard 
drive for problems, I have never done this, do at your own risk. Also, Brett’s info on VS 
Data Recovery. 
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VS SOLO Trk with EFX… Explains 3 different ways to SOLO a TRACK with looped 
EFFECTS like reverb so you can set levels of the effects and mix the track alone. 
 
VS Split prjt COMBINE…Project Split & Combine by Karl Lakestone on VSP. 
 
VS SUB MIXESbounceLoop…How to bounce tracks with effects, bounce multiple 
tracks with or without effects and how to create SUB MIXES for drum tracks or backup 
vocals. Bouncing Effects with tracks and bouncing using the Mastering Room How to 
initialize and clear EZ Routing settings. 
 
VS Time Delay DBL Trk…Time delay and how we perceive what we hear from VSP. 
 
VS Updating & Upgrading…How to update the VS2480HD, CD & DVD model VSs 
properly, info from Roland’s site and post on VSPlanet. Checking the OS, updating from 
1.XXX via MIDI. Also, info on converting VS2480CD to DVD, force initialze/format 
button sequence and diagnostics check sequence. Performing a drive check and fixing 
corrupt data problems & turning off the IDE: Drive. VS2480 specs, hard drive and fan 
specs. How to replace CD and HD in a VS2400 and HD & CD model numbers. Link to a 
PDF on how to run the Roland VS2480 TEST MODE. 
 
VS Vocoder Effect… How to setup the vocoder effect in the VS8F-2 card properly. 
 
VS VS8F3 InsFmt&Plgn…How to install a VS8F-3 card and plug-ins and use plug-ins, 
formatting for installing.  
 
VS V-TrkOptiUndoPnchRgnEtc…Covers V-Tracks and V-Track maps, Optimizing 
projects, using UNDO and Auto-punch recording. Also Region Copy and some editing. 
LOCATORS and SCENES. 
 
VS WAVE DISP Incr…How to use the Wave Form and the Wave Display to edit the 
wave form and the jog wheel to move in small increments. 
 
XP PC SETUP AUDIO… Shows you some of the tweaks for XP to setup a PC for use 
with Audio programs so less CPU power is used and the aps run faster. 
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THE GOAL WITH THE VS2480 IS THIS:                                         by Frank Griffith 
1) Start by LEARNING how to record songs with the VS. I record one song per project 
to keep things simple. 
2) Once you have learned how the RECORDING stage works with one song, move on 
to the next, and the next till you have enough songs for a CD to present to listeners. 
3) Next is the MIXING stage, adding EQ, Dynamics, effects and panning. Once you 
have the songs mixed and ready for CD move on to the next item. 
4) Learn how to MASTER your songs in the MASTERING ROOM using the MTKs, 
(mastering tool kits) to have them ready for burning to CD. 
5) Now open each project with a completed song and learn the BURNING stage of the 
process, burning one song/project at a time to CD using the TAO (Track At Once) 
method or you can import the master tracks into a new project for burning DAO 
Now let’s begin. 
*First off, you need powered monitors or monitors you run thru an external power amp! I 
use Dynaudio BM5A monitors, Roland makes digital monitors for this unit, the DS50As 
and DS90As.  
To power up the VS, find the toggle switch on the right hand, back side of the unit. It 
takes a couple minutes to run thru the “Load Project” progress bar so be patient. Never 
power down the unit by just flipping the toggle switch off! Use the proper shutdown 
sequence discussed near the end of this document. 
 
NEW PROJECT: (Create a “Practice” song/project) by Frank Griffith                                                        
Click on PROJECT> select New> then in the PROJECT NEW Window Enter a name in 
the Name field for the project with your PS/2 keyboard, then you can click on the music 
note Icon and select one of six Icons to make it easier to identify your project., then if 
MTP and 44.1 is what you want just click on “OK” and YES to save these settings. Also, 
if you want to copy Utility settings or Mixer Parameters from the current project to this 
new one then check mark those as well, if this is your first project then don’t bother with 
it.  You can also left click and drag up and down on the music staff ICON to select from 
6 different project icons. *If you plan on presenting your music to listeners on Audio CDs 
then it is smarter to record at 44.1k in the first place rather than at a higher sample rate 
like 48k and convert it back to 44.1k on CD. Converting sample rates will result in a loss 
of audio quality. (VS manual pg 96.) 
 
SETUP AUDIO 
Once your new project is open and on the HOME page click on EZ-Routing> Routing 
View> for that screen to open. This screen is sectioned off into 4 quadrants. In the upper 
right hand quad you’ll see the OUTPUT ASSIGN. Let’s setup the headphones, master 
and monitors so they all work independently. *If you have already been messing around 
with this screen INITIALIZE the routings by clicking on [F1(IniPB)] and [F3(IniTra)] to 
set all the virtual cables to their default settings so later when we are routing tracks and 
inputs it’s less confusing.. 
 
If you have digital monitors then find the white lettered COAXOPT/LR/LR black virtual 
cables with tiny black squares on the ends. They come linked in pairs on the top right of 
this quad. With your mouse grab (L-Clk & Hold) the tiny squares and drag the black lines 
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down to connect them to the MON white lines. They will turn blue when selected. If you 
have regular analog monitors the black lines from MON/7&8/L&R should be connected 
to the MON white lines as default and the MST/LR/1&2 black to MST white lines as 
default. *Some of this maybe set by default but it’s good to know. 
 
Now find the white lettered PHONE/1&2/LR/LR black squares and click and drag those 
up to the MST white lines to connect them. Now all of your audio can be controlled 
independently with the 3 knobs and RED Master Fader on top of the VS unit. The White 
one with RED top is for the Monitors, the White ones with the blue tops are for the 
Headphones 1 & 2. You will find these to the left of the 3“x 5” VS LCD screen. Now 
click on HOME in the top upper right of the screen.  
 
INPUT & TRACK FADERS SETUP     CH-EDIT=Channel edit 
Let’s find these very important buttons. They are the 4 buttons above the MASTER fader 
in a white background labeled FADER. Press the one labeled IN1-16/SOLO, it will turn 
yellow. Let’s set all the faders to 0db. To the right of the RED/MASTER fader is a button 
labeled CLEAR, Press and hold down CLEAR while running a finger across all of the 
CH-EDIT buttons for each FADER  [There are 2 buttons above each FADER, one is the 
TRACK STATUS button and the one above that is the CH-EDIT button]. This will cause 
all of the FADERs to jump up to UNITY/0db GAIN. Now your inputs are ready and the 
input levels can be controlled by using the TRIM/SEN knobs and the blue PAD buttons. 
 
Now Press the FADER button labeled IN17-24/AUX MST. The FADERs change to 
INPUTS & AUX Busses. Let’s set these to 0db. Now press & hold CLEAR and run your 
fingers across the CH-EDIT buttons for these faders, 17-24. They should jump to 
UNITY/0db GAIN. Notice, your AUX Busses Faders are already up for routing. *As I 
said before, some of this is set by default. 
 
Now press the FADER button labeled TR17-24/FX RTN. The Faders change again. 
These Faders should all be at 0db UNITY GAIN as default, if not bring these up too. This 
sets up the effects returns with the aux busses so routing LOOP EFFECTS later is easy. 
Sometimes people move this and that and press this and that before they know what 
they’re doing so we’re just making sure things are set right.  Note: Bring all INPUT 
FADERS down before mixing after all recording is done! Also, Yellow Fader buttons for 
INPUTS and GREEN for TRACKS. 
 
Now press the FADER button labeled TR1-16/Master Edit. Now we’re back to your track 
Faders. Press and hold the CLEAR button and run your finger across the CH-EDIT 
buttons again. Now all tracks are up and ready. Set Master RED Fader at the 0db mark.  
 
INPUT LEVELS 
To check an INPUT and get a level lets plug a mic, guitar, bass or keys in to the INPUT # 
1 on top of the unit. It’s the first of the 16 TRS in jacks. Now with your mouse click on 
the virtual buttons at the bottom of the screen marked [F1 INPUT]. This will change the 
METERS to read the INPUT levels. As you do this, watch the meters in the middle of the 
HOME screen change. Make sure the meters are on PRE for now. Now play something 
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or sing something and slowly turn up the TRIM/SENS knob until you get a good level. 
You can also use the [F1 INPUT] and [F2 IN MIX] on PRE to set levels. [F2 IN MIX] on 
POST is what’s being recorded. *Be sure no Comp, EQs or Efx are on in the CH-Edit 
pages of the INPUTs when recording unless you intend to record these changes. 
 
 If the signal is too Hi turn the SEN down and press the blue PAD button above it and 
raise the SENS knob and set the level again. I shoot for -12db to -4db to leave 
HEADROOM for Dynamics & EQing later on. Try to get the best level you can with the 
PAD OFF. NOT 0db! In analog gear you want 0db but with the VS you need -12db with 
peaks around -4db. 0db and over can cause distortion and leaves no room for mixing. 
 
RECORD LEVELS 
Now click on the [F3 TR MIX] button at the bottom of the HOME page. The METERS 
change to read the TRACK levels. Press the TRAK STATUS buttons for each track until 
they are all GREEN for PLAY. Now press TRACK1’s TRACK STATUS button until it 
is flashing RED for record, or hold down the RECORD button and press the tracks 
STATUS button to arm it. Play the instrument you have plugged into input 1.*Note: You 
can also hold STOP and press the track status button to put it back to GREEN/Play mode.  
 
The TRACK METERS, on POST, should read the same as the INPUT METERs did. 
You can click back and forth between [F2 IN MIX] & [F3 TR MIX] to check it. Once the 
level is set you can press the big RED, with white dot, Record button to arm it and when 
you’re ready to record Track 1 press PLAY. Record some and press STOP and then 
ZERO. Note: Track Status button, RED=Recording, Flashing RED=Armed, Not lit=OFF 
and GREEN=Ready to play. CH-Edit Button GREEN=Displays CH-Edit page, not lit= 
back to Home screen. 
 
CHECK TRACK 
Now press TRACK1’s STATUS button till it turns GREEN for PLAY and press PLAY. 
You should hear your track playing back what you just recorded. If you don’t like what 
you recorded or it’s a test take you want to get rid of, press UNDO> in the window that 
opens it shows your recording and time, press ENTER and it erases it from the list. Now 
you’re ready to try again or try something else.  
 
Once you have recorded a good keeper track, move on to repeating this process to record 
the rest of your tracks in this song/project. Note: To check to make sure you have no 
distortion on the recorded track you can click on the PRE setting and PLAY the track/s 
and see if the level coming into the fader is in the -12db to -4db range, the TRACK Fader 
will not affect this reading. If you have too hot of a recorded signal then start over and 
record the track watching the INPUT meters to be sure you have a proper level.. *See 
“VS LEVELsRecMSTclkTrkdoc” for more on this subject. 
 
V-TRACKS 
The VS2480 has 24 tracks and each TRACK has 16 V-TRACKS. The number [ 1] next 
to each track number in the HOME screen represents the first V-Track for that track. L-
Click on that [ 1 ] and it opens up the V-track MAP for that track. Larger black dots 
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indicate data that’s been recorded to a V-Track, a dash is an empty V-Track. Click again 
to close the map. Also, the large BLACK arrow at the far right end of the ruler on the 
track window opens up full V-track MAP of all 24 tracks. Click on a V-track’s square 
(colored ones have data) to change V-Tracks, a small window opens and shuts. To open a 
TRACK’s CH-Edit page double click on the track number. Where the mouse rest on the 
CH-Edit page you’ll see V.TRACK, you can also open up the V-Track Map there.   
 
TRACK NAME 
To name your tracks click on TRACK> TRACK NAME> a window opens and the first 
track is highlighed, click on [F1 NAME] and in the next window type out the name of 
your track or click on the letters in the alphabet list below to spell it out one letter at a 
time.. Click [F5 OK] now you can high light another tracks to name or click [F6 EXIT]. 
You can name mastered tracks this way as well. 
 
RECORDING A GUITAR W/ Hi-Z INPUT 
Usually you plug guitars into the Hi-Z Input # 16 and turn it on by pressing in the blue 
pad-like button next to it. If you want to do this then the INPUT is number 16 and to send 
the guitar to TRACK 1, click EZ-Routing and select Routing View, when the View opens 
look in the lower left QUAD and find INPUT MIXER with 1----24 in white numbers and 
the RECORDING TRACK numbers 1----24.  
 
Find INPUT 16 in the INPUT MIXER and click on it with your mouse, it turns blue, now 
click and drag on the number 16 in the INPUT MIXER block and drag the blue line the 
number 1 on the RECORDING TRACK block leaving a blue square around 
RECORDING TRACK 1. Now INPUT 16 is connected to TRACK 1’s Recording Track 
to record it on Track 1. Now click HOME. Return to the section above, “Recording 
Levels” to record the guitar if need be. Record a bit of guitar for this next section. (Or  
bass.) 
If you use Auto punch to punch in and out, to hear audio before and after A-Punch edit 
points, go to UTILITY> Play/Rec Parameter> under “Record Monitor” on page [F1 
Param1] place a check mark by “Source” or “Auto”, which ever one is not checked, to 
hear the audio. 
*Another way to route the INPUT to the TRACK would be to HOLD down track 1’s 
TRACK STATUS button , a window opens, keep holding the status button down and 
now press the CH-Select button above Fader #16 to patch it to INPUT 16. 
*If you have a stereo signal ie piano, keyboard synths, you need to link the INPUTS and 
the TRACKS to keep the signal stereo. Left is the odd number and right is the even. You 
will find “CH.LINK” on the left-hand side of the CH-Edit pages of inputs and tracks. 
 
LOOP EFFECTS or Send & Return Effects/ Patching an effect 
Let’s add a Reverb to the recorded TRACK 1. Click on EFFECT> EFFECT1> the 
EFFECT1 window opens, click [F1 PATCH] Find [P001 :Reverb2 ] click on it to 
highlight it and click on [F5 SELECT]. Now Effect1 is PATCHED with REVERB P002. 
Click [F6 EXIT] twice to back out of the EFFECT window. Since all of the AUX Faders 
and FX RTN Faders have been brought up to UNITY/0db we can skip that step. Looped 
reverb fills out the sound of tracks, IMO. [See “VS EFFECTS.doc” for more on this.] 
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Now, play the recorded guitar track 1 so we can hear it and press the CH-EDIT button for 
TRACK 1. The page changes to Dynamics/Compression and EQ Parameters with graphs. 
At the bottom of this screen in the “AUX SEND” area turn up the AUX1 knob until you 
hear the reverb. About -15db on the AUX1 knob and above will add REVERB you can 
hear. It should already be ON/yellow and PST/blue. Each TRACK and INPUT has a CH-
EDIT button and page and each CH-EDIT page has AUX1 thru AUX8 for your 
EFFECTS1 thru EFFECTS8.  
 
If you had PATCHED in your REVERB P002 on EFFECT3 then we would be turning up 
the AUX3 knob to add reverb to the TRACKS or INPUTS. With the REVERB 
LOOPED, you can add as much of this reverb to each track 1-24 that you want by 
pressing its CH-EDIT button of the TRACK and turning up the AUX knobs and you can 
do the same with INPUTS but you have to connect the FX RTN from the effect to the 
destination track in EZ-Routing. *In theory, you are NOT adding the reverb to the 
tracks or inputs, you are routing their signal thru the master bus where the reverb 
is applied thru FX RTNS & AUXS. Do not press HOME yet, stay here. 
 
INSERT EFFECTS 
INSERT EFFECTS are different. Instead of the AUX knobs you click on FX1 thru FX8 
under the EFFECT INSERT to the left of the AUXs. You can only INSERT an EFFECT 
to ONE track at a time on the first position or 2 using the Left & Right positions of the 
FX1 thru 8 buttons. [See the “VS INSERT FX.doc” for more on this.] You do not turn up 
the AUX knobs, just click on FX1 to INSERT the EFFECT to this Track1. Each Track 
has this on its CH-EDIT page too. 
 
ADDING EFFECTS TO INPUTS 
You can Press Fader button IN 1-16 then the INPUTs CH-Edit button or Under MIXER 
at the top of the screen. Click on MIXER> “CH VIEW <INPUT>” and select “IN 16” to 
bring up the CH-EDIT screen for INPUT 16, that’s your HI-Z INPUT 16. Now you can 
INSERT or LOOP to INPUT 16 and INPUTs 1 thru 24 depending on which you want. 
This is how you can get to the CH-EDIT screen for all of the INPUTs 1 thru 24.  
 
Once you loop the effect, go to EZ-Routing> Routing View> and in the bottom left hand 
quad find the FX RTN 1 thru 8 block and connect the FX RTN number that corresponds 
to your Effect number and connect it to the destination TRACK on the Recording Track 
block that your INPUT is routed to. This completes the LOOP. You only connect the FX 
RTN virtual cables to the INPUTS or to a destination TRACK when bouncing with 
EFFECTS. You do not connect the FX RTN cables to TRACKS that are already recorded 
or being recorded. Now you click HOME.  
 
*VS8F-2 cards fill up 2 Effects under EFFECT. Effect1 thru 8 equals four of the VS8F-2 
Cards 1 thru 4, or Slots “A” thru “D” inside the unit under a back panel. EFFECT1 thru 8 
equals AUX1 thru 8 and FX RTN1 thru 8. Some EFFECTS use up the whole card but 
most are mono. You can select them as left & right and split up the effects into a total of 
16 effects.  
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TO EDIT EFFECTS 
Click EFFECT at the top of the screen, the select the EFFECT1 thru 8, in out case 
EFFECT1, here is where you can click on “EDIT” in the EFFECT window. Usually there 
are several boxed areas for effects in a chain but not on all. You can turn them on and off 
by clicking the small square in the box next to OFF. To get to the parameters just click, or 
double click on the name of the box in the chain and the parameter knobs will show up 
for that box in the chain. Click EXIT as few times to get out of the EFFECTs area. 
 
After adding Dynamics/Compression, EQ and EFFECTs to your tracks the PRE levels 
may rise above 0db. While playing back your tracks in the mix, set the METERS to PRE 
instead of POST. If any are pegging, slamming 0db, go to the CH-EDIT screen for that 
track and turn the ATT knob counter-clockwise into the MINUS area to bring the PRE 
METTERS Level down to and below 0db or readjust the Dynamics and/or EQ. The 
METERs are in Pairs of odd and even on the CH-Edit pages. Do this for each track that is 
OVER 0db on the PRE Meter/Fader setting.  
 
Once they are all below 0db then set the METER/Faders to POST and re-mix your song 
to record to Master Tracks. Note: Bring all INPUT FADERS  & SENS down and turn off 
the PADs to prevent adding noise to your mix before Mastering! Also, be sure you have 
all of your tracks recorded and the song complete before moving on to the mastering 
room and the mastering stage. You can master one song and burn to CD but most record 
several songs, one per project, then open each project one at a time and burn the mastered 
stereo tracks to disc, one at a time  
 
EDIT EFFECTS REVERB 
Click on EFFECT> EFFECT1, or which ever you want to edit. Let’s say P001:[Reverb 2] 
is patched in. In EFFECT1’s window you will see Reverb 2 and 2 Boxes; one is REV/on, 
the other EQ/on. To turn them on or off just click the tiny half round squares on & off. To 
edit “Rev”, click “Rev” twice and there are the 8 or so parameters you can adjust. Under 
“Type” you have 5 to choose from, Hall 1&2, Room 1&2 & Plate for example. Click 
EXIT and now you can do the same with EQ or click EXIT again to close the screen. 
Note. Again the section on “ADDING EFFECTS TO INPUTS” works for adding 
Dynamics/Compression & EQ too, it’s all on the CH-Edit page. 
 
REMEMBER 
Remember, in the EZ-Routing> Routing View> when we connected INPUT 16 to 
TRACK1, this means you turn up the SENS for 16 to set the track level/meters for 
TRACK1 to record. After tracks are recorded you can set their mix level with their 
faders. You can also add Dynamics/Compression & EQ to each track by pressing their 
CH-EDIT buttons to get to that screen. Just turn the EQ on or Compression and adjust 
away. Keep in mind, less is more. 
 
MIXING RECORDED TRACKS 
I always start with my drums, if they’re stereo loops then it doesn’t take much to get them 
sounding right. I add a little EQ on the top to brighten them up and a little on the bottom 
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to add thump to the kick. Once the drums sound good soloed, then bring in the Bass and 
get it sounding good soloed and then with the drums, then the rhythm guitar soloed and 
then with the rest the drums bass etc and repeat for the rest of the tracks, vocals, leads etc.  
 
To hear looped effects with a track you have to mute all other tracks, a track soled will 
not play the looped effect unless you solo the FX RTN. You can find FX RTNs on the 
MIXER menu> CH VIEW<FX RTN> or all FX RTNs on MIXER> TRACK MIXER/FX 
RTN MIXER>. (See “VS Solo Trks with EFX.doc” for more.) Try to PAN all your 
tracks so that each occupies its own space in the stereo field. Do not overlap tracks, this 
can make the mix muddy. Try to place the instruments left to right as they would be on a 
stage playing live and use reverb to place them front to back. Once you have your tracks 
sounding good, if there’s a track that needs to stand out more, try just turning on the 
Compressor with its default settings. *See “VS EQing Bas&Kic.doc”for more on EQing. 
 
Mix your tracks as hot as you can get them with out turning on the OVER light on the 
TRACK meters. If an OVER light comes on you are adding distortion and that can cause 
you problems.  Be sure to leave the MASTER Red fader at Unity/0db while mixing.  
Also, remember to bring down the INPUT faders on IN1-16 and IN17-24 and turn 
down the SENs and turn off all PADS before mixing so no stray signals or mics that 
may still be hot. get into the mix! 
 
PHRASE NORMALIZE 
If some of your tracks have high peaks and low lows, where there is too much meter 
movement to control them when setting levels for mixing. You can “Normalize” the track 
or tracks and it will act as a sort of limiter to smooth out the levels of the track or tracks. 
To do this click on TRACK> PHRASE NORMALIZE> a small window will open and 
you can place a check mark the track or tracks to NORMALIZE and click [F5 OK] and it 
will begin the process. It’ll take several minutes. I seldom use this feature. When done 
click EXIT, now check your tracks. 
 
ANALYZER 
The ANALYZER is a useful tool for checking out the frequencies of your INPUTS, 
TRACKS, Master bus etc. Click on UTILITY> ANALYZER> and it opens up in the 
HOME screen where the meters were. It uses up on whole processor/effects card to run it 
so you’ll need to decide which card to use. Under “Use Effect Board” select A, B, C or 
D. Under Source, you can click and hold and scroll thru all INPUTs, TRACKs, FX# 
RTNs, Gen/Osc, MST L & R,  Mon L & R, Auxs and Dirs (or use the jog wheel). The 
“Average Times” is speed at which the display is refreshed, 50 is a good number to use. 
Set “Average Type” to NRM for now, EXP is good for drum tracks. Solo a track and play 
it to see the frequencies displayed. (Lower freqs displayed left, higher ones to the right.). 
You don’t have to solo the track but it helps, IMO. I use Source - MST L to show the 
whole mix while mixing. You can set up the VS’s small LCD screen to display the 
ANALYZER giving you an independent display for this feature once setup and still have 
the meters on the HOME screen on the VGA. Click on Home, then select Page 3/3, then 
select [F4 IDAnlr] to show the Analyzer in the small LCD, click [F6 IDHold]. To turn off 
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the Analyzer, select OFF under “Use Effect Board.” *Remember, a processor/ effects 
card is tied up while using the analyzer. 
 
MASTERING TRACKS 
Go to CD-RW/Mastering> Mastering ROOM> now the METERS area becomes the 
Mastering room. Click Mastering Room “ON”/yellow. Click the STATUS button from 
GREEN/PLAY to RED/Record. In the V.TRACK window you should see 23/24-16. 
That’s the track you are recording to. (Click on 23/24-16, If you want to select other V-
Tracks to record too, you have 15 sets of 23/24 V-tracks you can use.) If you have an 
MTK (Mastering Tool Kit) patched into an EFFECT like EFFECT1 then click on FX1 to 
turn it yellow and add that MTK. Click nothing else! Why? See the note at the end of this 
document “CD-R Mode.” 
 
Now press the PLAY button and set you Master Levels to Unity/0db or slightly under. 
(you can also edit your MTK here as well.) Press STOP and cue up your tracks where 
you want the recording to begin. I usually press the LOCATOR button till its lit 
YELLOW then the #1 button to mark/locate this beginning point later. Press RECORD & 
PLAY and MIX your song live. Fade out at the end and press STOP. 
 
Now press the ZERO/Back button, bring up the Master RED Fader to Unity/0db, click on 
the mastering room’s STATUS button to GREEN/PLAY and press the PLAY button to 
hear what you recorded. The tracks should be GRAYED out and music playing. If you do 
not like this recording of your master tracks you can select a different set of V-Tracks to 
record to or press UNDO> ENTER> to erase it. *Note: Once again, master your songs in 
each project, one song per project and then burn the mastered pairs to disc one at a time 
from each songs project. Once you have several projects/songs completed and mastered 
burn them to disc. Before burning songs to CD SHIFT+STORE your project!! 
NOTE: If you need another copy of the project then you have to use Project Copy, 
there is no “Save As” function with the VS as there is with computers. 
 
NOTE* If you don’t have an effect’s processor open for using the MTK because you 
have used all the effects up in your project you can do one of 2 things. Either bounce 
tracks that are using up one of the effects cards to other tracks recording the effects with 
the tracks to new tracks OR you can master the project in the mastering room WITHOUT 
an MTK so all effects are recorded with the project to a stereo pair and then master the 
stereo pair in the mastering room using an effects MTK. 
 
BURN TO CD (Save project first!) 
To burn these to CD, be at this stage in the Mastering Room, Mastering Room ON and 
STATUS Play. Click CD-RW Mastering> select CD-WRITE, store current? Click 
“YES” and the INSERT a blank CD-RW or CD-R. The CD-R WRITE window will open. 
Make sure your V-Tracks 23/24-16 are shown in the L-Ch & R-Ch windows, (Just 
because you have them set right in the Mastering Room does not mean they will be the 
same here.)  
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Select “FINALIZE” to “OFF”, “WRITE METHOD” to (TAO)Track at Once, “SPEED” 
to MAX and click “OK” to burn. NOTE! If you do not have other Master Tracks in other 
projects to add to this CD then click “FINALIZE” to “ON”. If you do have more leave it 
“OFF” until the last song’s Master Tracks are ready to burn. This will close the CD so 
you can play it in a CD Player. If you forget to turn “FINALIZE” “ON” on the last song’s 
Master Tracks to the CD, then stick it back in and select “FINALIZE” to “OnlyFin.” for 
finalizing ONLY. Now it’s ready for playing and copying with PCs. Click “OK” then 
“YES”, “ENTER” and “YES” to burn 16bit, 44.1k in .cda format. 
*You can master and burn only one song to disc using this method, just select “Finalize” 
to “ON” and it will place the track marker for the song and close/finalize the CD. To 
protect the CD, go to UTILITY> Project Parameter> and set “Digital Copy Protect” ON. 
 
BACKUPS 
To backup songs click on Project> Project List> check mark the projects to backup, click 
to page ¾ and select “F1 BACKUP”& insert a CD-RW. In that window select Verify to 
“ON” and SPEED to MAX and click “OK”. To  RECOVER go to Project> Project List> 
and in that window scroll down to [SCSI—CR-RW--] click it and select LIST in the 
window that pops up, check mark projects to recover, on ¾ page and click on “F2 
RECOVER” and in that window click “OK”.  This will save all of the effects settings, 
undo history, track parameters, locators etc along with your audio to disk. 
 
BOUNCING TRACKS W/ EFFECTS                                                  
Let’s say we have a vocal on TRACK 5 that we want to bounce to TRACK 10 and use 
EFFECT1 to add and effect to the vocal. Let’s also say, we want to use P001:[Reverb 2] 
on that vocal. First off, click on EFFECT at the top of the screen and select EFFECT1. 
When the EFFECT1 window opens click “F1 PATCH”, now using the scroll arrows to 
the right of the patch list scroll down to P002 and click on it to highlight it, now click “F5 
SELECT” to select it, it will be listed under “Current” and click “F6 EXIT” twice to back 
out of the windows. *See VS manual for list of which are Insert vs. Looped effects. 
 
Now let’s click on EZ Routing> then Routing View> and in the lower left hand quad find 
TRACK MIXER underlined green, tracks 1 thru 24. L-Click and hold the track number 5 
and drag the blue line up to RECORDING TRACK number 10 and let go. You have now 
selected TRACK 5 to bounce to TRACK 10 without a Reverb EFFECT!  
 
Now let’s complete the LOOP of the Reverb on EFFECT 1 to the vocal by finding the 
FX RTN underlined in green, and click on the EFFECT/FX RTN number 1 and dragging 
its blue line over to the RECORDING TRACK number 10. Now you should see a black 
or blue “Virtual cable” from TRACK MIXER number 5 to RECORDING TRACK 
number 10 and a blue one from FX RTN 1 to RECORDING TRACK number 10. This 
will add the effect. Since we have all AUX & FX RTN Faders set to 0db, we don’t have 
to do that step. Click HOME. 
 
RECORD THE BOUNCE 
Press the TRACK STATUS button on TRACK 10 till its flashing red, cue up the vocal 
track to the verse to bounce with the reverb effect, and press RECORD and Play when 
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ready. After the vocal part records press STOP and cue the Recorded vocal track up and 
press the TRACK STATUS button of TRACK#10 till it’s green for PLAY and press 
PLAY to hear it. You can MUTE the other tracks to be sure and compare TRACK 5 with 
TRACK 10 to be sure. 
 
You can pretty much bounce any track to any track with effects added that you want. If 
you want to bounce TRACKs 5, 7 & 9 to TRACK 10 then in EZ ROUTING grab the 
TRACK MIXER number 7 and drag it up to the RECORDING TRACK number 10 and 
repeat for TACK MIXER number 9. It’s that easy. To bounce with an INSERT EFFECT, 
you would just go to TRACK#5’s CH-EDIT page and click on the FX1 thru 8 button that 
matches the EFFECT processor number you have the insert effect patched into. No EZ-
Routing for INSERT EFFECTS. *See “VS SUB MIXES.doc” for more. Also, to clear all 
the track routings to hard disk recorder tracks in the EZ Routing View click [F4(ClrTra)] 
at the bottom of the window. 
 
BOUNCE WITOUT EFFECT 
Do all the above but forget about patching an effect and grabbing the FX RTN cable. In 
other words, don’t add the effect. You can do SUB MIXES (See VS SUB MIXES) as 
well where you add more than one track to the destination track. Say you want to bounce 
all 6 drum tracks to a PAIR, or all background vocal tracks to a pair of tracks that’s how 
you would do it. Bouncing to a pair of tracks requires you to go to the CH-Edit page of 
the ODD numbered tracks and linking it with it’s even numbered track by clicking on the 
CH LINK button down below the ATT knob on the left hand side of the screen. 
 
EZ ROUTING TOOLS 
To INITIALIZE, or reset all input-to-input channel routings click on [F1(IniPB)] at the 
bottom of the screen. To CLEAR all input-to-input channel routings click on “F2(ClrPB). 
 
To INITIALIZE all routings to the hard disk recorder tracks click on [F3(IniTra)] and to 
CLEAR all routings to the hard disk recorder tracks click on [F4(ClrTra)]. 
 
SHUT-DOWN PROCEDURE 
To shutdown the VS2480, Click on PROJECT> select the last item on the list “SHUT 
DOWN/EJECT> A small “SHUTDOWN!” window opens, click YES then it ask if you 
want to STORE the project, I would select YES, then is goes thru the save procedure and 
puts up a small window with “POWER OFF/ RESTART” then you can flip the power’s 
toggle switch  to OFF. 
 
Note: “CD-R Mode”  
I master using the non-CD-R Mode in the mastering room. Why? Because the master 
tracks stay in 24bit and can be played back within the project they are mastered in. I also 
like to send my mastered pair of tracks thru my R-Bus outs to an RPC-1 card inside a PC 
for mastering them there with Wave Lab and/or T-Racks, PC version.  
 
If you use CD-R Mode  in an MTP 44.1k project then you have to import the mastered 
pairs into a new Empty CDR project for mastering just to listen to them. Then line up all 
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of the mastered pairs from all of the projects, one after another on their tracks, add CD-R 
markers and burn DAO(Disc At Once) to CD-R. I use TAO(Track At Once) and keep 
them at 24bit within the project so I can hear them, review them etc. Then I burn them 
TAO to CD-R from each project one mastered pair at a time. If you want to use the CD-R 
Mode that’s fine, I have a “VS MST DAO” doc that explains the process step by step. 
You can also use it to do the same with non-CD-R Mode mastered pairs, import them to 
an empty MTP project and import the tracks into it using the steps given in the “VS MST 
DAO” doc. That’s up to you. Also Mastering TAO had caused problems with Duplicators 
in the past,  but recently the newer duplicating gear claims it can work with both TAO & 
DAO. 
 
Important to remember: These documents are written to be used with your VS on and 
connected to a PS/2 mouse, PS/2 keyboard and VGA [external] PC Monitor. When using 
any of the VS info docs keep in mind, most of the things you do within a project can be 
un-done. You can practice anything you want with recording, bouncing, editing, adding 
effects, routings etc. anything with mixer settings and if you don’t want to keep the 
practice settings, just shutdown the VS and answer “NO” to saving the current project 
and it will revert back to the original state it was in when you first opened it. Also, most 
actions you take can be un-done by pressing UNDO> a small window opens with a list of 
actions, your last action will be at the top already highlighted so press the ENTER> 
button and it performs an UNDO on that action. So practice, practice & practice some 
more without worry! 
 
NEVER… 
OPTIMIZE> UNDO> and SAVE in a row. Your track data will disappear! If you do 
Optimize and UNDO go to Project> List> and reload the project! Also, Never, shutdown 
the VS power without going thru the proper shutdown procedure, you could cause the VS 
to lock up on next power up! Shutdown= Project> Shutdown/Eject> YES & YES. 
 
ALWAYS… 
Have a UPS (Battery Backup device) between the VS and wall socket to run you VS and 
condition the power. If the power ever goes off when your VS is up and running, you can 
loose your data or worse, cause the VS to lock up on power up! 
  
CONCLUSION 
The most helpful word docs for Newbies are: Easy VS Info, VSCpyMveExchExprt, VS 
EFFECTS, VS INSERT EFX, VS LEVELsRecMSTclkTrk, VS Mastering CDs for 
Newbies, VS MST & BURN, VS SUB MIXESbounceLoop & VS V-
TrkOptUndoAPnchRgnCpyEtc. 
 
If you go thru the “Easy VS Info.doc” instructions several times you should get the hang 
of using the VS2480 and actually get some good recording done. For more on recording 
go to www.studiobuddy.com and download their Studio Buddy program full of free info 
on how to record and with what etc. Seriously, it’s good info, it’s just that they have a 
stupid puppy dog logo, ignore the dog. Don’t let it influence your opinion of the 
information given. Also, if you have questions about this info email me at 

http://www.studiobuddy.com/
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Fcgjabq@aol.com and if you need even more help with the VS2480 call Roland’s Tech 
Support at 1-323-890-3741 on week days and for help all the time, go to VS-Planet.com. 
Now get some good music recorded and on CDs.  
Good Luck, Frank. 
 
LINKS TO VS PLANCTON & Videos on Youtube                                                                     
Here's the Youtube videos, parts 1 thru 12. 
I've been watching them today and this guy uses mainly the machine and it's buttons, not much 
VGA & Mouse. I found it confusing just to try and keep up with him and I'm no newbie. 
http://www.youtube.com/watch?v=dyHolMawEqk&playnext=1&list=PL8FCCE59C30CADE1E 
  
Here's the VS Plancton Videos that are on the Plancton DVDs done on a VS2400CD. 
http://www.youtube.com/watch?v=PXs9jz72SuI 
  
To buy the VS Plancton DVDs in English. 
http://www.plancton.de/english1.html 
 
Link to a post on VSP comparing the audio quality of the VS to Pro Tools. 
http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Board=16&Number=922073
&Searchpage=1&Main=89576&Words=Jerry+Tubbs&topic=0&Search=true#Post922073 
 

mailto:Fcgjabq@aol.com
http://www.youtube.com/watch?v=dyHolMawEqk&playnext=1&list=PL8FCCE59C30CADE1E
http://www.youtube.com/watch?v=PXs9jz72SuI
http://www.plancton.de/english1.html
http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Board=16&Number=922073&Searchpage=1&Main=89576&Words=Jerry+Tubbs&topic=0&Search=true#Post922073
http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Board=16&Number=922073&Searchpage=1&Main=89576&Words=Jerry+Tubbs&topic=0&Search=true#Post922073
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To use Acid, 
 Click on the (if you have my “ProgsPlugs” CD if not skip to Acid Pro) 
“ProgsPlugs”folder> acid pro> then Acid Pro file with ".exe" as an ending file 
name is the execute file for installing the program. Click on it and follow the 
recommended instructions to install Acid. Acid is a pretty simple program to use. 
When you install it, sooner or later it will ask you for a key. Acid Pro 4.0 
keygenerator.exe is what you click on then and copy and paste the number in the 
SERIAL window into Acid's window. If that doesn't work, try it again by clicking on 
GENERATE to generate a new key to use. You can make up a number for the 
computer ID window too, if need be.  
  
ACID PRO 
Now insert a Loop CD. Once Acid is installed you click on the Desktop Icon to 
open it. Don't fill out the name form and comments, just click OK.  Once it is 
open, find the EXPLORER window, bottom left. Next to it, right bottom, is the File 
Audition window. In then EXPLORER window click on My Computer> then the D: 
Drive the Loop CD is in and then click on one of the loop folders. Audio Wave 
files should appear in the Audition window. This window has a play and stop 
button you can use. Click on a file and use the play and stop buttons to listen to 
different loops. Once you find a loop you want to use Double Click on it and it will 
appear as a track in Acid's Track window above the Audition window. Find 
several loops to use for a test run and double click on them too. 
  
USING LOOPS 
Now with the mouse cursor, it will be a pencil instead of an arrow, left click and 
hold, on track one on, a grid line and draw, left to right, a LOOP out. Small 
indentions will appear on the top and bottom of the loop as it repeats. you can 
make them as long as you want. Any loop can be 1/4, 1/2 3/4 or full loops. It's up 
to you to decide how much of each loop to use and how many times to use it. 
Draw out a couple of repeats on track 1. Then on track 2, draw another one out 
where the last one ended and so on with the next track's loop and the next 
track's loop. Now at the bottom of this track window on the left are the play, stop, 
back, etc buttons. Play your drum loops you drew out to get an idea of how this 
works and sounds. Click stop. 
  
Now let's check out the grid spacing and snap to options. Click on OPTIONS> at 
the top of the program window, then Snapping> and make sure it's Enabled. 
Indented is ENABLE. This snaps the loops to lines on the grid. 
Now OPTIONS> GRID SPACING> and select "16th or 32nd  Note" for now. 
  
Now let's find the zoom buttons for the tracks window. On the Horizontal and 
Vertical scroll bars there are little + and - signs. On the Horizontal one click the + 
plus sign about 5 times quickly each click. This spreads out the loops so you can 
see if they are lined up on the grid lines evenly so the beat is steady from loop to 
loop and track to track. If any are off, left click and hold in the middle of a loop 
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and drag the loop left or right until they SNAP to a line. Once all are on the lines, 
one after another they should play seamlessly.  
  
SAVING A PROJECT 
Once you have all the loops from this CD in the project, you have to save them 
before using another loop CD. Click on FILE> SAVE AS...> In the SAVE window 
it should show a folder and 4.0, in FILE NAME enter a name, like "Practice 
Project", in SAVE AS TYPE click the down arrow and select "ACID Project With 
Embedded Media (*.acd-zip)" and click the SAVE button. Now, when you click on 
the Acid desktop window, this most current project will open. Close Acid and put 
another LOOP CD in then Open Acid again and you can add more LOOPs to this 
Project. If you don’t save them as “Embedded” then every time you want to play 
the loops in this project you’ll have to have the loop CD in the drive. 
  
BPM SLIDER 
Notice in Acid you have a BPM slider under the TRACK NAMES area midway 
down the left side. Also, a tuning fork displaying 4/4 time and the BPM of the 
song. The slider handle is what you use to drag it left to slow the song down or 
drag it right to speed it up. If you will notice, as you left click and hold the mouse 
on that handle, up next to the track names there is a divide/center point where 
color lines are on the right or left of this point. This shows how much a loop has 
been slowed down or sped up to match the BPM the slider has selected. Loops 
sped up too fast or slowed down too much can start to sound a bit funny and fast 
ones sound, impossible for a real drummer to play. Be careful with too big of a 
difference in the BPM of the loops you use. They may sound strange. 
  
Volume & Pan 
Each track/loop has its own VOLUME (Vol.) slider knob and normally it is set to -
6db. The more tracks/loops you add the more the total, over all volume is raised, 
so -6db is a good starting point. To PAN tracks/loops left or right, next to the Vol. 
is a drop down arrow, click on it and select PAN, now all Volume knobs are PAN 
sliders.  
  
ENVELOPES/Automation 
Another feature I like to use is the ENVELOPE feature. Click on a TRACK'S 
number to highlight/select that track then click INSERT> at top of window, Select 
ENVELOPE> and there are VOLUME and PAN selections. When you select PAN 
an ORANGE line will appear across the track and it's loops, select VOLUME and 
a BLUE line will appear. To use these have the tracks zoomed out some and on 
the line just double click and that places a square on the line. Add several of 
these on the line and then you can left click and drag them to where you want 
them. For PAN Up is LEFT and DOWN is RIGHT. The line will follow these 
squares as you drag them. Rest on them and a window opens to show in 
percentages how far left and right the PAN line is. With the Volume, UP is UP 
and DOWN is DOWN and it displays this in dbs. These come in handy for 
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panning cymbals and toms in a fill and for raising and lowering the volumes to 
add emphasis to the drums.  
  
SAVING CHANGES  
While you work on drum tracks, once you have saved it as embedded media, as 
you make changes to the tracks you can click the SAVE button to save it just 
incase something happens, your PC freezes, a power outage or whatever.  
  
SAVE AS .WAV & BURN TO CD 
Now let's say you are done with a songs drum tracks and you want to save them 
to disc and load them into the VS. After a song has been saved, I usually click 
the save button again to be sure, Click on FILE> RENDER AS..> in the SAVE IN: 
window, select a folder you can find on your hard drive, I created a "AAudio Wav" 
folder on my C: Drive, so have a folder selected you can get too. In FILE NAME: 
"Practice Project" as an example, in SAVE AS TYPE: select "Wave 
[Microsoft][*.wav]" and click the SAVE button.  
  
XP BURN WIZARD 
Now close Acid and INSERT a blank CD-RW into you PC burner drive, open it as 
a folder in it's own window and after it's open click on START> MY COMPUTER> 
Local Disk:C> and find your audio folder and open it up in it's own window. Find 
you audio file and Right Click on it and select COPY, now in the blank CD-RW 
window R-Click and select PASTE. If you have XP Home or XP Pro a Wizard 
should open, Name the disk to burn the wav file too, and select "Make Copies for 
Some computers and Players" or some thing like that, not the regular "Audio CD 
for CD Players" and follow thru the wizard and it'll burn a DATA copy of this WAV 
FILE to the CD-RW.  
  
IMPORT .WAV INTO VS 
Now in the VS2480 and INSERT the CD-RW with the wav file on it, click on CD-
RW Mastering> select WAV IMPORT> the VS scans the drive and a window 
opens, click on the CD-RW's folder and a smaller window opens, in that window 
select the WAVE FILE "Practice Project" and select the TRACKs or V-Tracks to 
send it too, Click OK and it'll say Done when finished. Click EXIT and eject your 
disk. These instructions are rather general but you'll be able to figure it out. 
That's how it's done. 
  
In Acid on some loop CDs you'll find single shots of kicks snares cymbals etc and 
intros and endings that you can use to create the opening intro to the songs drum 
tracks and their ending crashes. Single Shots are just that, a single hit of a snare, 
kick or crash or ting of a cymbal that can be place one at a time, a track at a time, 
anywhere on the time line of the drum tracks in Acid. Now play around with it 
once you get it and if you have more questions email me at Fcgjabq@aol.com for 
more help. 
 
 

mailto:Fcgjabq@aol.com
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Acid and Bussing 8 tracks of Audio to VS for use with 8 track loops thru an 
RPC-1 card. 
In Acid, Under Options> Preferences> Audio tab and under “Audio Devices 
Type” select “Roland RPC-1 ASIO” from the drop down menu, click APPLY & 
OK. Go to INSERT and on the drop down menu select Bus. This will insert “A” 
bus ½ with a Left & Right channel onto the bottom right hand side of Acid’s 
window next to the Master Bus. Go back to INSERT and select Bus 3 more times 
for Busses “B”, “C” & “D” for a total of 4 Busses. “B” will be 3/4 L&R, “C” 5/6 L&R 
and “D” 7/8 L&R.  
 
Now click on the Double square bus icon on A Bus and select “R-Bus Out ½ 
Roland RPC-1” now Bus B and select “R-Bus Out 3/4…” and Bus C and select 
“R-Bus Out 5/6 RPC-1” and Bus D and select “R-Bus Out 7/8..RPC-1” now you 
have 8 channels out to RPC-1 Card. Now click on the Bus Icon on each track 
and select Roland ½ for tracks 1 & 2, the tracks 3 & 4 select Roland 3/4 and so 
on for a total of 8 tracks. Now PAN track 1 left, track 2 right, track 3 left, track 4 
right, track 5 left, track 6 right, track 7 left and track 8 right. This will send Acids 
tracks 1 thru 8 to the VS thru RPC-1 card via R-Bus to INPUTS 17 thru 24 in the 
VS. You have to bring up the VS 17 – 24 input faders to hear them. If you are not 
using 8 tracks loops then pan all bus pairs left & right. Some loops have 5 
parts/tracks and some have 6 parts/tracks, depending on which Discrete Drums 
series loops you have or Drums On Demand (DOD). This means that with the 5 
and 6 track loops you only need to insert 3 Busses in Acid to send the tracks to 
your VS. 
 
Envelope in Acid  
More on using the ENVELOPE feature. Click on a TRACK'S number to 
highlight/select that track then click INSERT> at top of window, Select 
ENVELOPE> and there are VOLUME and PAN selections. When you select PAN 
an ORANGE  line will appear across the track and it's loops, select VOLUME and 
a BLUE line will appear. To use these have the tracks zoomed out some and on 
the line just double click and that places a square on the line. Add several of 
these on the line and then you can left click and drag them to where you want 
them. For PAN Up is LEFT and DOWN is RIGHT. The line will follow these 
squares as you drag them. Rest on them and a window opens to show in 
percentages how far left and right the PAN line is. With the Volume, UP is UP 
and DOWN is DOWN and it displays this in dbs. These come in handy for 
panning cymbals and toms in a fill and for raising and lowering the volumes to 
add emphasis to the drums.  
 
  
[*acd.] PROJECTS 
You can also save Acid projects as "Acid Project File[*.acd]" but it does not save 
the audio data with it, only the location this data can be found in. If another 
application like Cakewalk Home Studio has this data in a folder then Acid can 
find it and use this Acid project as a TEMPLATE on how to use this file. If you 
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saved loops from a disc this way then the next time you tried to play this Acid 
Project it would ask you for the disk that the loops came off of. That's why I save 
LOOPS as "Acid Project with Embedded Media [*.acd-zip]"so the data stays with 
the Acid Project and i don't have to search for the disk the loops were on. I often 
use loops from many loop disk. 
  
ACID PLUG-IN EFFECTS 
You can also add effects to tracks in Acid. Each track has a funny looking green 
FX Icon with a tiny drop down arrow on it's right side. Left click on this FX Icon 
and an "Audio Plug-In" window opens the Equalizer, EQ. It has 3 more of the 
green FX Icons in the upper right hand corner of this small window, the one on 
the left is the "EDIT CHAIN", rest the mouse pointer on it and you'll see it identify 
itself.  
  
Left click on this one and a larger "Plug-In Chooser" window opens with a list of 
effects in it. Here, you simply click on an effect name to select it, then click the 
"ADD" button and then click "OK." Now it has added the REVERB to the "Track 
EQ" with check marks beside them in a chain. The REVERB is now indented and 
ready for use.  
  
Play your Acid track and now you can select a "Reverberation Mode" from 
the modes drop down menu and see what it sounds like on your track. When you 
find one you like simply click the "X" to close the window or click on the "Track 
EQ" and make adjustments there and then close the window. The EQ is not on 
and working until you make adjustments to it. To delete either one of these plug-
in effects from the chain, have it's window open and left click on the second 
green FX Icon from the left, at the top right of it's window.  
  
Any time you want to come back to a track's FX chain just left click on the FX 
Icon on the track. This is fairly basic instructions for how to use Acid's effects but 
it will get you started. For more, see the Acid manual on in the Acid folder on the 
"ProgsPlugs" All In One disc or click on HELP in Acid and select "Contents and 
Index" from the menu. 
 
 
To Use Wave Lab 
Once Wave Lab is installed you can go to File> Open> Wave > and pull in a .wav 
file from a CD or folder on your PC to work with. 
 Play/Stop/back etc transports are at the top right of the screen, if not click on 
View> Tool Bars> Transport> and it will open. 
  
ADD EFFECTS/Plug-ins 
Under Effects at the right of the screen, click on #1 and the list has DirectX & 
VST there, select one from the pop up menu, or none to clear one. The plug-in 
opens, select some PRESETS till you find a sound you like. The plug-in window 
will open on top of the .wav file. You can move it around by grabbing it’s top blue 
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bar or minimize, fold etc. There will be parameters you can adjust and PRESETS 
where you see “PRESET” or “LOAD” if it has any. You can make your own by 
adjusting the parameters and then clicking EDIT, type in a name for it, click ADD 
and then OK or SAVE. You can add up to 8 plug-in effects that’s why there are 8 
effect’s blocks. To get rid of an effect click to open the list and select NONE. 
  
RENDERING A .WAV FILE 
Bottom right of the screen is a "Render" button, to add an effect or up to 8 effects 
plug-ins processed to a file, click on "Render"........... 
 
Then on the File tab tick "Create new file" and place a Check Mark in the box 
next to "Create Specific File".....Now click on the small yellow folder to the right of 
the little window and explore to an audio file you can find on your PC and select it 
and click OK. 
  
Now you can go to your audio folder like "My Music", if you selected it and saved 
the file there before, and send that file to a CD-RW to burn so you can use WAV 
IMPORT in the VS to place it on a track. See the XP BURN WIZARD in Acid 
above. 
  
Use Track Export in the VS to burn a .wav file of a track to a CD-RW to load into, 
Wave Lab, Acid or Sonar. 
 
Roxio 7 
Basically just click on the desktop icon with the disc in your PC that you want to 
copy music or data to and it’ll take a minute to load then it’ll ask you to agree to 
something, click OK and the main Roxio window opens. For DVDs and CDs, 
data, audio or video, that you want to copy click on “Disc Copier” and a window 
open and you can select Copy if it doesn’t.. In the “Roxio Disc Copier” window 
you have a “Source Drive” section and a “Destination Drive Section” with drop 
down menus that allow you to select the source and destination drives and disc. 
Usually it’ll show you where the blank disc is under the Drives selected. You can 
select write speed and number of copies and then click COPY. It’ll copy a CD in 
a couple of minutes and a DVD in several minutes depending on how much data 
or video is on it. Full DVD of data, appx 20 mins. using one drive, half that with 2 
drives. I like to make copies from one drive because Roxio stores the data on 
your hard drive and checks it for errors before burning it to disc. When burning is 
done click the CLOSE button to eject disc. It’ll show you how many minutes the 
burn took. 
 
To copy audio, video or data off of your hard drive select “Creator Classic”, you’ll 
see the loading wait window then “Creator Classic” window opens. You’ll have a 
“Select Source” window at the top and “Data Disc Project” window at the bottom. 
I click on the numbers next to the disc icon below “Disc Name” and enter a title 
for the disc, then at the top on the left side I use the explorer window to find my 
data clicking on the [+] sign by Local Disk (C:) and when I find the folder or 
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folders I’m looking for I click and drag the folder down to the Data Disc Project 
window’s right hand side and drop the folder under Name, Size etc…… Then I 
click the on the “BURN” icon and another window opens with Destination drive 
only and a Details page on the right of the burn window. If it’s not there, click on 
“Details”. Here you select how you want to burn and it’ll show you how much data 
you are burning and number of disc needed. When ready, click Burn. When the 
burn process is done, click the CLOSE button, that use to be CANCEL, and the 
disc will eject. Roxio ask if you want to save the project, I say NO. and close 
Roxio. 
 
T-Racks24 Brief how to.. 
T-Racks is pretty easy to install and use. There's and Open button to open an 
explorer window to bring in a .wav file. Then regular transport buttons to Play, 
Stop, Back etc.. To get to the presets click on the word Default in a little window, 
you can check out different presets while the file is playing. You also make 
adjustment to the different sections of the rack. When it sounds the way you like 
you click on the Process button and process and save the file. 
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VS & RPC-1 Card Setup                         By Frank Griffith 
Hardware/tab on the RPC-1 card Master Clock = External 
Multi/Track Driver Devices = Single and in sync 
DMA Buffer size = 384 
Tick Disable Control of... and the 
Reset when Idle...   both boxes should be ticked. 
Adjust nothing else in the other tabs.    Save these settings. 
Sample Rate should equal the VS projects sample rate, 24bit/44.1K 
Whatever sample rate & bit rate you need. 
*The dip switch's on the card,  the switch closest to the R-Bus 
connection(the one on the left) should be UP and the one furthest 
away from the R-Bus connection (On the right) should be DOWN. To 
SLAVE the RPC-1 card to the VS flip them the opposite way. 
 
  
VS UTILITY> Project Parameter page F3, 
Set master Clock to INT. 
Dither and Digital Copy Protect to OFF. 
Leave R-Bus Coaxial Sel & R-Bus Optical alone. 
  
UTILITY> SYNC Parameter> 
Make sure Sync Mode is set to INT. 
If you want to sync to MIDI Time code from the VS choose MTC in 
the R-BUS1 SYNC GEN. 
Set your software to MTC as well.  And from where(Midi RPC-1). PC 
& VS will sync. 
 
Now EZ-Routing>Set up RPC-1 Inputs & Outputs on the VS2480, R-
Bus1 Inputs are attached to IN 17-24. 
Under OUTPUT in EZ-Routing. R-Bus1 Outputs are paired in stereo 
Aux outputs 1-8. (You can connect the first 2 to MST if you want to 
send the stereo master bus to PC.) 
 
Press IN 17-24 and press the CH-Edit button of IN 17 and select the 
CH-Link to link IN17 & 18 so they will pan automatically and set their 
faders to 0db 
That's about it. 
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For setting up windows PC audio to be heard in the VS go to Start> 
Control Panel> Sounds & Audio Devices> select the Audio tab and 
use the drop down menus to select the RPC-1 card for playback. 
 
 
 
 
SONAR 4 
In Sonar Options> Audio...> General> I have my RPC-1 selected as 
Playback & Record Timing Master, bit depth 16 or you can use 24 
with VS? 
My buffer @ 4 and the slider set to “Fast.” 
 
Advanced Tab> I/O Buffer at 64, Driver Mode=WDM/KS. Dithering= 
Pow-r3 & Full Chased Clock ticked. 
 
Drivers Tab> 
All Input and Output Drivers are highlighted. 
 
Driver Profiles Tab> Roland RPC-1(10in, 8 out) 
Stream 16bit Data As= 32Bit PCM left-justified. 
 
*Some say you need the Sonar to be Master and the VS to be Slave 
to sync them both or the audio will glitch when recording. 
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> Getting 16bit .wav Files Out of the 2480 
                           While in MTP (24bit) Mode < 

Let's say that you want to get 16bit .WAV (wave) files out of the VS2480 in MTP (24 
bit) mode but you don’t have PC conversion software. And, you don’t want to go to the 
trouble of burning the 24bit files to CD-R and then importing back into M16 mode, and 
then have to burn them all over again at 16bit. 
  
It can be done using Mastering Room. As Mastering Room offers CD-R mode allowing 
conversion from 24bit to16bit. [*See below] 
  
Go to Mastering Room. In the V.Track section, the VS2480 default tracks are 23/24-16, 
being Tracks 23 and 24 (stereo) Virtual Track 16. However, you can choose the other 
V.Tracks by left clicking in the V.Track section.  23/24 V.Tracks 1, 2, 3, 4, 5 up to16. 
  
You can record two or more tracks as 16bit files using the SOLO buttons on any of 
your tracks. 
  
Simply SOLO two or more tracks that you want to convert to 16bit, two or more at a 
time. Then in Mastering Room select the V.Track 23/24 1-16 that you want the 16bit file 
to be recorded to i.e. if you plan to convert all 24 tracks to 16bit SOLO'ed two at a time 
you will need to record 12 times to 12 V.Tracks (23/24 – V.Tracks 1 through 12) as 
Stereo. [*See below] 
  
Set a LOCATOR point so that you can return to that exact point prior to each new 
recording. 
  
SOLO two or more of your recorded tracks (Blue SOLO buttons). 
  
Now just follow the Mastering Room procedure.  Hit the LOCATE point, very important, 
select V.Track 23/24 1-16, then Mastering Room [ON], CD-R Mode [ON] Status [Rec].  
Hit the transport REC (now blinking) and press play. Your SOLO'ed tracks are now 
recording, press stop when finished. Repeat this process again by SOLO’ing new tracks 
and choosing different V.Tracks in the Mastering Room. 
  
Mastering Room in CD-R Mode converts 24bit to16Bit, so now you might have up to 16 
Stereo V.Tracks on Tracks 23/24 (V.Track 1-16) and if CD-R Mode was on each time, all 
your recorded files will be 16bit. 
  
Now just TRACK EXPORT the Tracks to CD-R under CD-RW Mastering. Under CD-
RW Mastering go to TRACK EXPORT then press MAP [F2] under the 23/24 all your 
recorded CD-R Mode .WAV files will be there and they will all be 16bit.  Select them 
and burn to CD-R! That’s it. 
  
*All 16bit .WAV files EXPORTED like this are Stereo not Mono, I know of no way 
around this. 
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- Set a LOCATE Point prior to recording, return to it each time. 
- SOLO two or more tracks to be recorded as 16bit. 
- Use Mastering Room Procedure, CD-R MODE must be ON for 16bit. 
- Two tracks to 23/24 V.Tracks 1-16 Newly SOLO'ed tracks to NEW V-Tracks (don't 
record over the previous ones). 
- EXPORT TRACKS under 23/24 to CD-R they are all 16bit. 
 
From Brett’s Site…   http://www.rolandvs2480.net/ 
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VS BitsSamplesWavs 
PROJECT>>NEW>> 
When you CREATE a NEW project, you select bit rate, sample rate and project mode 
there. If you are in an MTP mode project which is the default, normally it'll have 24bit 
and 44.1k sample rate check marked for the projects sample and bit rate. IF SO... Then 
when you use TRACK EXPORT or PHRASE EXPORT thru the TRACK EXPORT 
window(or PHRASE), the files will be 24bit, 44.1k, .wav format files. 
................................................ 
CD-RW Mastering>>Mastering Room>> 
MASTERING. 
If you use the mastering room and DO NOT use CD-R Mode in the mastering room, then 
your master tracks will stay 24bit 44.1k and EXPORT as 24bit, 44.1k .wav files. 
 
If you use CD-R mode in the mastering room then your masters will be 16bit, 44.1k and 
TRACK EXPORT as 16bit 44.1k .wav files to CD-R... hence the CD-R mode. 
.................................................. 
 
CD-R MODE at 16bit and 44.1k is the standard that the market uses to BURN .cda 
format Music CDs. You buy a CD at the store, Pink Floyd, it most likely will be .cda 
audio format in 16bit, 44.1k. 
...............................................  
CD-RW Mastering>> CD-R WRITE>> 
BURNING Mastered Tracks to CD-R in VS. 
When you use the CD-R WRITE window to BURN your mastered songs in TAO(Track 
At Once) or DAO(Disc At Once) to CD-R making your own music audio CDs, the VS 
BURNS them (not considered exporting) in the standard 16bit, 44.1k .cda audio format. 
............................................... 
PROJECT  MODE. 
If you select CD-R Mode in the PROJECT>>NEW>> window and have CD-R Mode be 
your project mode then when you EXPORT tracks or phrases they will be in 16bit, 44.1k 
sample rate, .wav format files. Your Master Tracks BURN to CD as 16bit, 44.1k, in .cda 
format. 
What ever the project mode, bit rate and sample rate, the tracks will export in the same 
bit rate and sample rate and always be .wav format files. 
........................................................ 
CD-RW Mastering>>WAV IMPORT>> 
When you import .wav files into the VS, the VS will CONVERT them to match the 
project’s mode, bit rate and sample rate. It uses the WAV IMPORT window. Pg269 
You can IMPORT .wav format files that are 16bit and 24bit. 
................................................. 
CD-RW Mastering>> CD CAPRURE>> 
When you want to IMPORT .16bit, 44.1k, .cda format audio tracks off a market CD, you 
have to use the CD CAPTURE window. Thw VS will CONVERT them to match the 
Project Mode, bit rate and sample rate. 
................................................................ 
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*The VS can run projects in different sample rates and bit rates. The second most popular 
project mode is M24, 24bit, 48k sample rate.  
*Any time you use the CD-R WRITE window in the VS, the tracks will be BURNED in 
16bit, 44.1k sample rate, .cda format audio files. 
 
Here’s post where a Pro claims he can’t tell the difference between wav files out of a VS 
MTP project and wav files out of Pro Tools DAW. 
http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Board=16&N
umber=922073&Searchpage=2&Main=89576&Words=Frank+to+Jerry+tubbs&top
ic=0&Search=true#Post922073 
 

http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Board=16&Number=922073&Searchpage=2&Main=89576&Words=Frank+to+Jerry+tubbs&topic=0&Search=true#Post922073
http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Board=16&Number=922073&Searchpage=2&Main=89576&Words=Frank+to+Jerry+tubbs&topic=0&Search=true#Post922073
http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Board=16&Number=922073&Searchpage=2&Main=89576&Words=Frank+to+Jerry+tubbs&topic=0&Search=true#Post922073
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VS BkUPFmtRcvy 
*If you have an OS above 2.009 then it is not necessary to Format/Initialize 
the hard drive in your VS after updating to a higher version! 
 
BACKUPS (Formatting & Recovering Projects)          By Frank Griffith 
It’s best to click on PROJECT> Project List> and add up the mega bites of 
each Project on the list. To the right of each project title are the mega bites 
(MB) size of the project and a date below that. Group them into numbers 
that add up to less than 700MB, closer to 600MBs to be safe. So you can fit 
them on the 700MB CD-R or RWs. Usually 4 or 5 songs per CD-RW or 
CD-R are enough. Once you have done this you know which ones to check 
mark for each backup to the CDs. Insert a blank CD-R or RW. It’s important 
to note here that VS backups will only be able to be recovered on a VS 
machine. Most older model VS machines, 880, 1680 etc. backups can be 
recovered in VS2480s. My point is, VS backups are not an audio format or 
data file that can be used in a PC. DVD models use only DVD-R disc. 
 
Check Mark the first group of PROJECTS to BACKUP to CD. There are 
little empty boxes to the left of each project, click in them with your left 
mouse button to place a check mark. Do this for each one you want to 
backup to the CD. Then select PAGE ¾, bottom left of window, and click on 
“F1 BACKUP”. Click on it. Answer YES to the prompts and another 
window opens. In this window, select MAX Speed, check mark VERIFY  
and click “OK” to burn the Backup disk.  
 
5 songs will take about 20 minutes then it EJECTS the disk. Then you can 
repeat the process for each group of songs to backup to each disk. It’s 
always a good idea to perform a test RECOVER of a project to be sure the 
data is there. You do have to recover at least one project to do this, you can’t 
cancel a RECOVER but you can select another drive using the “F” buttons 
in the Recover window.  
 
Also, each time a project is recovered it is date/time stamped just like saving 
a project. This means that the projects you do test recover will have a current 
date/time stamp in the project list so you can tell them a part from the 
original song on the list. Just as long as you see the VS recover a 
project/song from the backup disk without giving you the “Operation 
Failed” message, you project/song recovered and the backup disk is good. 
See “Recovering Projects” below for step by step info on how to do this. 
Note: If you have an UPDATE, do it at this time. 
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FORMATTING THE HARD DRIVE 
Usually when backups are done you can FORMAT the hard drive. Go to 
PROJECT> PROJECT LIST> click on the scroll bar’s arrows to get to the  
IDE:0 Drive to place the rectangular box around it and at the bottom of the 
window select PAGE 4/4 and click on “F2 FmtDrv” to open the Format 
window. 
 
In this window select 10GB for Partition size then select PHYSICAL 
FORMAT ON, (Quick Scan For new HDs) and SURFACE SCAN ON to 
reformat. Next click OK to begin the formatting process. This will take 
about 6 ½ hours for an 80GB Hard Drive and 13 hours for a 120BG Hard 
drive. Most do this at night so it’ll be done during down time. You can tell 
it’s finished when it loads a “IntProject 001” when it is done. You can 
RENAME this one and use it or ERASE it. All of your old projects will be 
erased and this will be the only project showing in Project> Project List> 
until you recover them from the backup disk. 
 
RENAME PROJECT. To RENAME it just click on PROJECT> NAME> 
and type in a new name in the NEW PROJECT’s window.   
 
ERASE a PROJECT just select PROJECT> PROJECT LIST> and 
CHECK MARK the PROJECT to ERASE. Then select PAGE 2/4 and click 
on”F2 ERASE” and answer YES to the prompts. The project will be erased. 
 
RECOVERING PROJECTS 
Click on PROJECT> PROJECT LIST>in this window click on the scroll 
bar’s down arrow (right side of list) to move the rectangular box around 
“SCSI:  CD-RW  [---.-MB/---.-MB]” this will select the built in CD-RW 
drive, now INSERT the BACKUP disk of PROJECTS and click “F5 LIST” 
at the bottom of this window.  Answer YES to the prompts. A new window 
opens listing the PROJECTS on the disk. Check Mark the ones to 
RECOVER from the list by click on the empty box to the right of the song’s 
titles, when all of the projects you want to RECOVER have been check 
marked, click PAGE until you see “PAGE ¾” and then click “F2 
RECOVER.” A Recover window opens and click “F5 OK” to begin 
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recovery. This takes about ¼ the time it did to back them up. Once you LIST 
the projects on a disk, recover at least one to test recovering projects. You 
can back out of this operation without recovering a project by scrolling the 
rectangular box up to and around another drive, I select IDE:0 where my 
projects are and click “F6 LIST”, it’ll ask you if you’re sure you want to 
change to that drive, click YES and it’ll scan the IDE:0 drive for a bit and 
then LIST your projects. Then you can check mark a project and click on 
“F1 Select” and it’ll scan and load that project. Once the project is loaded 
you can PRESS the Eject button and eject your backup disk. OR If you want 
you can recover a song and then go to project list and ERASE it as explained 
above RECOVERING PROJECTS. 
*These instructions are a bit brief but they are easy enough to figure out. Just 
think logically about what you need to do with the VS and usually you can 
get the job done. 
 
 
 
FORMATTING EXTERNAL SCSI DRIVE  
Go to Project> Project List> select Page 4/4> Find “F2 FmtDrv” and select 
Partition Size: 10GB,  
Physical Format: On, 
Surface scan: On and OK.  
It’ll take about 6 ½ hours for 80GB and double that for 120GB. 
 
FORMAT A NEW HARD DRIVE 
Once it’s physically installed, turn the VS on and watch the small 3” x 4” 
LCD on the VS and answer the prompts using the ENTER/EXIT buttons, 
“F” buttons under the screen, the cursors to change box selections and the 
jog wheel to highlight the selections. You can do a “Quick” format with a 
new hard drive but it’s recommended to do the following:  
 
First you’ll see “Formatted Drive Not Found, Force Initialize? 
Press ENTER for YES then you select 10GB partitions, cursor down to Jog 
to highlight “Physical: ON”, then cursor over to select “Surface Scan: ON” 
then “F5” for [OK]. Next you have to “F button” for [SelDrv] to get to the 
next screen and Select Drive IDE 0. It becomes logical as you do it and 
finally you select “OK” and it’ll ask you twice if you want to do Format, 
answer “YES.” These instructions are brief but I added them from memory. 
It’ll take about 6 ½ hours for 80GB and appx double that for 120GB. 
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Brands: Seagate, Western Digital, Maxtor & IBM 
Specs: 40, 80 0r 120GB, 7200RPM, 8MB Cache/Buffer, ATA/100 or 133 
interface (NO SATA). I had to remove the master/slave jumper off of the 
hard drive before the VS would format mine and work. Important: Find a 
hard drive with average seek times less than 10ms! 
 
Formatting Hard drive in HD Model VS 
The hard drive comes in a caddy that the hard drive is mounted into with 4 
screws. After updating, if needed and backups, power down the VS 
1. Unplug the VS and touch a metal grounded piece of gear in the room to 
remove static electricity. 
2. Remove the face plate by removing the 2 Phillips head screws, from front 
right side of the machine. 
3. You can use a coin to unlock the caddy, straight up should be unlocked. 
4. Slide the caddy out and carefully pop the top metal cover off and then 
remove the 4 screws on the sides of the hard drive with a #2 screw driver. 
*Note: The metal cover may be on tight and may require a flathead screw 
driver to help pry it off, do not bend the cover. 
5. Lift the drive out and remove the power and data cables. They can be in 
pretty tight so you may have to pull on them hard. 
6. Check your new hard drive and make sure the jumper is set to MASTER 
before installing. Just follow these steps backwards to complete. 
 
When done plug in the VS2480HD and power up. Check the small LCD for 
prompts, “Force Initialize” answer YES with the enter button the select drive 
IDE0, Physical Format ON, Surface Scan ON and use the “F” buttons under 
the VSs LCD to select 10GB Partitions and Format the new hard drive. 
 
List of hard drives in a thread at VSlanet... 
http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Number=677261&fpart=1 
AND 
http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Board=16&Number=976890&Search
page=7&Main=47033&Words=Hard+drive&topic=0&Search=true#Post976890 
AND 
http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Board=16&Number=102931
5&Searchpage=2&Main=97783&Words=Hard+Disk&topic=0&Search=true#Post1029315 
 
*If you ever need to turn the hard drive off, say you are using the VS only as 
a control surface for a PC then click on Utility> System Parameter> Param 
2> IDE  Drive> Select OFF. If you have a hard drive that refuses to spin up 
and on, check this parameter and make sure it’s ON. 
 

http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Number=677261&fpart=1
http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Board=16&Number=976890&Searchpage=7&Main=47033&Words=Hard+drive&topic=0&Search=true#Post976890
http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Board=16&Number=976890&Searchpage=7&Main=47033&Words=Hard+drive&topic=0&Search=true#Post976890
http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Board=16&Number=1029315&Searchpage=2&Main=97783&Words=Hard+Disk&topic=0&Search=true#Post1029315
http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Board=16&Number=1029315&Searchpage=2&Main=97783&Words=Hard+Disk&topic=0&Search=true#Post1029315
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NOTE: If you have a VS2480CD model VS, you can install a laptop DVD 
burner in place of the CD burner in your VS. The VS defaults the CD write 
speed at CD4x and DVD1x but here’s the catch. DVD2x is as fast as CD18x 
so DVD1x is equal to CD8x when it comes to burning backups. Also, DVDs 
hold 4.7GB of data, that’s 4700MBs and CDs only hold 700MBs so 5 or 6 
CD backups will fit on one DVD in far less than half the time it takes to 
backup to CD. I recommend you do this your self and save hundreds of 
dollars compared to buying the VS2480DVD model or an external DVD 
burner. It takes about 30 minutes to change them out plus you will also know 
where the hard drive is and can change it on your own as well. Hard Drive 
specs: 7200RPM, 8MB Cache, ata/100 or 133 Interface. No SATAs! 
Download the “Converting the VS2480CD to VS2480DVD” PDF from this 
direct link and buy a Panasonic UJ-845-B Slot Loading DVD/CD Laptop 
Burner….  
http://www.rolandvs2480.net/VS2480CD%20to%20vs2480DVD%20Conve
rsion/Convert%20your%202480CD%20to%20a%202480DVD.htm 
 
The UJ-85J REPLACES: UJ-811, UJ-811-B, UJ815, UJ-815, UJ-815-B; 
UJ825, UJ-825, UJ-825-B; UJ835, UJ-835, UJ-835-B, UJ845, UJ-845, UJ-
845-B model DVD Burners that have worked and even the UJ-845-S or UJ-
845S model has worked. I have not heard of the UJ-85J being tried out in a 
VS2480CD as of yet. Also, the Panasocic/Matshita UJ-845-B, UJ-850 and 
UJ-870 was used which shows up as UJ870QJ in the CD-R Write window! 
Arjan  van gog on VSP, used a UJ-875 BXM Master DVD Burner and it 
worked. 
 
Link above is from Brett’s web site at this link… 
http://www.rolandvs2480.net/ 
You’ll be glad you installed a DVD Burner in your VS2480CD. If you need 
more help with it contact me at Fcgjabq@aol.com  
Also, the new VS2480DVD comes with the Matshita/Panasonic DVD-RAM 
UJ-840-S model burner. 
 
 
 
 
 
 
 
 
 

http://www.rolandvs2480.net/VS2480CD%20to%20vs2480DVD%20Conversion/Convert%20your%202480CD%20to%20a%202480DVD.htm
http://www.rolandvs2480.net/VS2480CD%20to%20vs2480DVD%20Conversion/Convert%20your%202480CD%20to%20a%202480DVD.htm
http://www.rolandvs2480.net/
mailto:Fcgjabq@aool.com
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Tempo Mapping/Find BPM    By Frank Griffith 
1) Load the project...find the TAP button and SHIFT. 
 
2) Play the song and tap the TAP button in time with the beat of the 
song. Tap out about four measures of beats. This will place yellow 
markers above the track window. 
 
3) Stop the project from playing and zoom in on the waves and adjust 
the yellow marker to line up on the waves beats as close as you can, 
using the mouse's grabby hand, L-click and drag them into place. 
 
4) Press SHIFT+TAP to bring up the Tempo Map window 
 
5) In that window select "F1 TM Cnv" for the Tempo Map Converter 
window. 
 
6) In this window select 
----a) Under CONVERT TYPE left click and scroll to the option              
"Tap -->       Tempo Map" 
----b) Under BEAT select 4/4 for a time signature 
----c) Under TAP BEAT select 4 for how many beats to calculate...       
(I tried 16 on a song I knew was 100BMP and it gave me 25BPM so I 
tried it at 4 and it gave me 100BMP) 
----d) Now click ENTER and answer YES to the prompt. It'll say 
"Done." 
 
7) Now click EXIT in the Tempo Map window. 
 
8) Press SHIFT+TAP to open the window again and see what the beats 
per minutes are if the window is not already there.  
 
9) You can add the notes sign BPM numbers all up and divide by the 
number of numbers to get the average. That's about as close as you 
can get. 
 
10) If you want to clear the yellow markers, hold the CLEAR button 
down and L-click on each marker. 
 
Metronome 
Click on the UTILITY menu then Click on METRONOME and a window 
opens up. There you will find all of the parameters for setting it up. 
To send the metronome to the MONITOR bus you check mark INT 
under METRONOME OUT at 0db by default. Under INT LEVEL you can 
set the level from –infinity to +6db. I use -10db. 
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METRONOME MODE lets you select whether you want it to be heard 
only when recording “Rec Only” or heard during both record and 
playback “Rec&Play”. You can check mark the one you want. 
 
TONE TYPE let’s you play a pair of clicks CLICK1, play a clave like 
sound CLICK2, or a drum like kick sound using with MIDI 
CLICK2<Note> or to use the metronomes programmable beat box 
DRUM. When you select DRUM the “F1” below becomes active and 
displays “F1 PtnEdt” (Pattern Edit). This brings up the Beat Box and 
parameters. For more on this and using the metronome with MIDI see 
the VS manual starting page 369. 
 
I would just check mark INT under METRONOME OUT, at what ever 
INT LEVEL sounds loud enough with your project playing, use -8db at 
first, check mark “Rec& Play”, check mark the CLICK2 Clave sound and 
“F6 EXIT” for easiest use. You can always come back and adjust the 
volume as needed. 
 
Use these settings for setting different BPMs, METRONOME OUT 
check INT, -8db INT LEVEL and DRUM for TONE TYPE then click on “F1 
PtnEdt” to get to the Current Tempo (92.1 to 120.0 default to 
140.0BPM) and Beat parameters (1/1 to 4/4 as default to 16/16) and 
change them to match what ever beat and tempo you need. Again, for 
more on this see pg369 in the VS Manual. 
 
Bobkat on VSP wrote: 
I read an interesting way of recording a click track using the internal 
metronome and the tempo map feature on the 2480 that might be 
useful. 
First make your metronome and tempo map settings.  
Then click Utility Menu;click Gen/Osc,click SW to ON,click Source to 
Metro and click F6 exit.Click Routing View in the Track Assign section 
to make the connection from Gen to the track you want to record to 
and then simply arm the track for recording. 
 
How to route the click to a track 
On the Utility Menu go to the GEN/OSC, Set the SOURCE to METRONOME. 
 
Then, go to EZROUTING, find the Gen/OSC and drag a line from GEN/OSC to 
the RECORDING TRACK of your choice. 
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VS “PRM EDIT” Button                     By Frank Griffith 
Any time you are working with Dynamics & EQ Parameters, there is a little 
feature that can come in handy if you do not like using the mouse to adjust 
the Dynamics & EQ settings. Any time you select a CH-Edit button for a 
TRACK or INPUT then return to the home page, to the left of the virtual 
PAN knobs on the screen is displayed what fader button has been selected, 
such as FADER and “TR 1-16” with a green line below it. PRESS TR 1-16 
fader button above the red master fader to see this, just below that should be 
the last CH-Edit button selected, press TRACK # 1’s CH-Edit button and 
below the TR 1-16 should be CH and “TR 1” for Track # 1’s CH-Edit 
selection. PRESS Track # 1’s CH-Edit button again. CH and TR 1 stays 
there. What is significant about this is this…  
 
Too the right end of the PAN knobs on top of the VS2480 is a button labeled 
“PRM EDIT.” PRESS “PRM EDIT,” it’ll light up RED and watch what 
happens to the virtual PAN knob display. It changes to show you all of the 
Compression Dynamics and EQ Parameter settings for that TRACK # 1.  
 
The PAN knobs on the VS are now knobs to adjust all of the parameters for 
the Dynamics and EQ of that track. To change it to another TRACK’s 
parameters, press any TRACK’s CH-Edit button once for the CH-Edit 
screen or twice just to use the knobs without the CH-Edit screen.  
 
To show an INPUTS Dynamics and EQ parameters while tracking, PRESS 
the fader button IN 1-16, then the CH-Edit button of the INPUT you want 
and then PRESS the fader button “TR 1-16.” Notice that the display to the 
right of the virtual PAN knobs on your VGA is displaying the “IN #” you 
selected and the Dynamics and EQ parameters for that INPUT are still there.  
 
To get back to the PAN knobs just press the “PRM EDIT” button again and 
the red light goes off. When working with mixing tracks you can PRESS the 
PRM EDIT button then double press any tracks CH-Edit button twice to see 
its Dynamics and EQ parameters for fast and easy adjustments. 
 
You can also assign the PAN knobs to be AUX Send 1-8 knobs and other 
functions but you’ll have to see your manual for more on that. I find it a bit 
more confusing to do more than use it for Dynamics and EQ parameters. 
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From VS-Planet 
Comp/Expander/Gate 
Basically we’ve got 48 of them, but what are they? A guide to dynamic 
processing. 
 
Most modern digital workstations have like the “big consoles” of the past build 
in dynamic processing. Every track- and input channel on a Roland 2480CD/HD 
has one such processor. 
 
In the last years several budget outboard preamps equipped with, or just stand 
alone, compressor/limiter/expander/gates have seen birth and launch on the 
market. They seem to be a miracle in itself to give the recordings that extra to 
become “outstanding”. 
 
As they are two means of using dynamics basically, ie.: reducing 
dynamics/noise-spill and as sort of effect. 
 
For starters: most digital dynamic processors lack the ability to perform as sort 
of effect, where they can excel as doing their job as dynamic processors. Sound 
strange? 
 
For this we need a little history. The first dynamic processors where as you 
guessed analogue. What they basically did was to reduce level, with a certain 
ratio above a certain input level. Hence the nomenclature on most units! This 
was mainly done by clever amplifier circuitry and more then once helped by 
light sensitive resistors. Especially the last option gave a smooth, laid back 
compressor with lots of side effects, which nowadays are called warm, vintage 
etc. Well at least you can call it character. Later on there came VCA controlled 
gear, which worked with less side effects, and had faster working times, making 
them more tight. 
 
So far, a few new things are introduced, such as laid back, warm and tight. The 
faster a compressor or any dynamic processor can work, the tighter it will sound. 
This is due to the fact on how long it will take the processor the reduced the 
signal level. In other words: as it takes longer, the first transients and signals get 
thru un-processed. Will it work very fast (like the digital and newer analogue 
ones) the initial transients/hits will be processed to. This makes a huge different 
on the processed sound. Lucky enough this time it will take and can be set with 
the attack-time control. Sometimes basically with fast/slow or with a rotary 
control. The same goes for the time it takes the processor to return to it’s 
original state of amplifying after the signal level is under the threshold level, 
which is called release time.  
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Ok, threshold is introduced..........basically this is what it says to be. Once the 
signal level exceeds the threshold, taking attack time in count, the processor 
starts doing it’s job. At least for compressors/limiters – which are basically the 
same in some accounts, whereby gates/expanders work the other way around. 
 
Let’s introduce another important thing: ratio. In case of compressors, ratio 
determinates how much compression there will be above the threshold.  For 
instance if we set a ratio of 1:3, and the level rises 12dB above the threshold, the 
compressor will apply 12–(12/3)=8 dB of gain reduction and only 4 dB above 
the threshold level is outputted. So if the threshold was set in this case at –6 dB, 
the output level shall be –2 dB on the meters. So as a theoretical rule you can 
apply the following: 
 
Output level = input - ([input-threshold] – [{input-threshold} /ratio]) 
 
VS ExpanGate 
Airproof, start with the KICK DRUM track. 
 
Invoke the EXPANDER on the TRACK CHANNEL. 
 
Set the Ratio pretty high, 4.00:1. 
 
Set the THRESHOLD to about 12dB. 
 
Set the ATTACK to 0.0, and the DECAY to about 250. 
 
Now, WATCH THE LED "GR" (Gain Reduction) meter, while you 
play the KICK track and mess about with the settings. 
 
That should get ya started. 
 
Gates work well with Kick and Toms, but not so great on OH or 
ROOM mics. Some interesting effects can be had by gating a 
strong SNARE, but not a soft (or brushed) snare. 
By Karl 
 
AND another post... 
In the "DYN Screen" of the recorded track 
switch to EXPANDER 
choose an extreme ratio (the lower line is steep) 
choose a short attack time 
then experiment with treshold level and release time 
 
on the meters you can see (what you hear ) if the gate is opened 
or closed 
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if you also want to add compression you can switch to 
"EXP+COMP" 
 
I would say, play with, there is nothing you can damage with your 
experiments. Listen to this track alone while adjusting and be 
aware that later with all tracks something will be covered - OK 
depends on the material. 
 
 
Compression In General  
Use the IN and OUT of each different section to see what effect 
that particular section has on the signal..... 
 
For example, take a kinda hot channel, and turn the compressor 
on, but turn the A.GAIN switch OFF. Now, the IN meter is the 
signal BEFORE compression, and the OUT is the signal AFTER. The 
GR meter shows how much reduction is being applied to the 
signal.  
 
Vary the THRESHOLD until you see the GR kick in ONLY on the "hot 
spots". Now, when the IN goes past that threshold, the OUT gets 
reduced. You can SEE the difference. 
 
Same deal with the EXPANDER and the EQ. Use the IN and OUT 
meters of each stage to ensure there is a clean signal all the way 
thru. 
 
 
Point is, any signal that goes OVER at ANY point in the chain will 
add distortion of some sort, and reducing the FADER simply passes 
a smaller picture of the signal, distortion and all, to the Mix. 
 Lakestone Karl. 
 
LDT2 
“The expander on each channel can be used as a noise gate. Just 
crank the ratio to infinity and adjust the threshold to where ever 
you need it and it'll gate to silence. You can fine tune with the 
release setting also.” 
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Well why do we need them, and how do we use them? 
 
First of all, it may be time to know the difference between the basic four of 
dynamic processors. 
 
The first group consist of two, ie.: compressors and limiters. Their names 
explain them a bit already: compressors do indeed compress the sound, so that 
the signal level will stay between the noise floor and “the red zone” of your 
metering. This is achieved by correct settings of the device (more on this later!). 
A limiter is slightly easier: one chooses the maximum level, and the limiter takes 
care that the signal level will not rise above the set level by cutting in on the 
volume/level once it rises above the threshold set. 
 
The second group consists of the noise gate or gate and the expander. These 
units work the other way around and are mainly used to restore dynamics and 
keep noise/spill out. Simply said the noise gate is the opposite of the limiter: 
once the signal goes below the threshold, the gate shuts, and silence is heard... 
Useful on multi miked drums etc. The expander on the other hand reacts more 
like a compressor, with a ratio of working below the threshold. It works more 
slight and can be good on use on instruments/vocals which have longer decays 
and/or release times. 
 
The time for some secrets.........not really! 
 
When, which and how much is the main question here for many of us. When is 
the first one. As a matter of fact, during recording, I try to avoid using any at all. 
This might seem a bit weird, but once recorded with the dynamics processed in 
any way or form is not a thing of undo or so; it’s recorded that way and 
irreversible!!! What could have been a good take without or with different 
settings is probably ruined by the wrong settings. (The same story goes for 
EQing and FX’s before the recording as far as I’m concerned). On very 
percussive and/or dynamic instruments/voices, I sometimes use limiting set at –
0.5 dB to avoid overshoots, and the uninvited digital distortion.  
 
So that was the first use for a limiter! It is also useful to pump up a track in the 
mix, but can be rude sounding, but he, maybe this is what you want for a 
track....... Compressors can do also a great job on getting the overall level of a 
track, or mix, a bit higher by pushing the lower levels up, and keeping the peak 
level within the save range. It’s hard to say use this or that setting for such a 
signal. Instead of looking at tables, numbers or so, it is better to understand and 
learn how a signal behaves. Is it percussive/dynamic or has it got a slow attack 
and long release, or something in the middle? By understanding the parameters 
we can adjust, and what kind of signal we have on a track will help us better. 
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Spend some time with (raw)tracks of snare drum with some spill and hear what 
a gate can do, or an expander if you like. Pump up a kick drum with gentle 
compression, or freak out on it with extreme parameter values. It’s also nice to 
play around with a clean guitar track and some expanding for the sheer fun of it. 
Try spending time on mix, and get vocals more upfront with compression 
settings, and try to get the feeling of what parameter values make sense for 
certain tasks. Playing around like this seems to be waste of precious studio time, 
but it will pay off one day when you are encountering a difficult mix and/or 
tracks during your sessions. It will also pay of in your overall sound quality in 
the future, and playing around also learns you to move faster on the machine. 
Common sense and experience will take you to a higher level of “wise” use of 
dynamic processing. 
 
Some words to end a summary of things........ 
 
First of all: do you really need any form of dynamic processing on a track? This 
is always good to ask. If things are proper recorded, and a good source, mics etc. 
are used, you don’t have to do much to get a good mix. Especially to much 
limiting and compressing can make your tracks and mix sound “un lively”, dull 
and less dynamic. This is something to be aware of. In general: unless used as 
effect, a good track/mix doesn’t need to much EQ, FX’s or dynamic processing. 
What was wrong during recording can’t always be fixed with the three groups of 
processing. If you need them (to) much, maybe it’s time to consider what went 
wrong with mic-setup, or choice of instruments, amps etc. 
 
Some terms short explained again: 
 
Threshold: 
 
The level at which a dynamic processor starts to work, depending on being 
limiting/compression above the threshold, and gates/expanders below it. 
 
Ratio: 
 
Amount of compression/expanding applied below/above the threshold. Limiters 
as well as gates have a ratio of 1:infinity. 
 
Attack time:  
 
The time it takes before the dynamic processor starts to kick in. Mostly in mili 
seconds, sometimes in slow/fast. 
 
Release time: 
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The time the processing works on, after the level is below/above the threshold 
again. (Compressor: below and expanders: above) 
 
Make up gain: 
 
The give a rise in overall level, gain can be applied to the compressed signal and 
the average level will be higher than the unprocessed signal. 
 
AIRPROOFING on VSP uses these Compressor settings... 
You'll need to work with it to suit what your signal is, but these can 
maybe get you started... 
 
Kick 
Threshold: -6dB 
Ratio: Between 4:1 and 6:1 
Attack: Between 40ms and 50 ms 
Release: Between 200 ms and 300 ms 
Gain: Adjust so that the output level matches the input level. You don't 
need much added gain. 
 
Snare 
Threshold: -4dB 
Ratio: Between 4:1 and 6:1 
Attack: Between 5 ms and 10 ms 
Release: Between 125 ms and 175 ms 
Gain: Adjust so that the output level matches the input level. You don't 
need much added gain. 
 
Bass Guitar 
Threshold: -4dB 
Ratio: Between 2.5:1 and 3:1 
Attack: Between 40 ms and 50 ms 
Release: About 180 ms 
Gain: Adjust so that the output level matches the input level. You don't 
need much added gain. 
 
Bruce 
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INCREMENTS of DATA 
*For making really precise edits and for placing the edit points more 
exact, use the WAVE DISP button above the cursor buttons to bring 
up the wave form display. 
 
1) Check out the time in the upper left hand corner of the HOME 
screen. There is a yellow line under one of the double zero digits. 
There's 00h00m00s00f00 for hours(h), minutes(m), seconds(s), 
frames(f) and something smaller, "Ticks" I guess. 
 
2) Press the Left or Right of the 4 cursors buttons above the JOG 
wheel to move the yellow line to seconds or frames and then turn the 
JOG wheel. The TIME LINE moves in the smaller increments across 
the tracks. This is good for use when editing tracks with them zoomed 
in on the wave files. You can easily line up the TIME LINE, (The RED 
LINE that crosses all tracks vertically) in very small increments for 
placing edit points. 
 
*Note: You can also use the zoom buttons on the scroll bars to zoom 
tracks in to show only 2 or 4 tracks and still get the wav form on 
screen for placing more precise edit points. I also PLAY the audio, 
keep the beat with my hand and count 1 and 2 and 3 and 4 and etc. 
Right after 4 on the “And” I press STOP and place my edit points or 
flags. This is usually a silent spot between beats. Practicing this will 
help you to get pretty precise at placing these flags. 
 
 REGION COPY or MOVE 
1) I like having the tracks zoomed in and showing only 4 tracks so I 
can use the wave form visual for better placement of the edit points. 
For copying or moving sections of music you can place the time line 
at the beginning of a section of audio, PRESS the IN button. I also 
PLAY the audio, keep the beat with my hand and count 1 and 2 and 3 
and 4 and etc. Right after 4 on the “And” I press STOP and place my 
edit points or flags. This is usually a silent spot between beats. 
Practicing this will help you to get pretty precise at placing these 
flags. 
  
2) Then move the time line to the end and PRESS the OUT button, 
this will select that chunk of audio to me copied or moved.  
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3) Then move the time line to the point where you want the audio to 
go and PRESS the TO button. The IN of the audio selected will be 
copied or moved to the TO point. Once IN, OUT & TO are set, the 
FROM is set automatically. If you are compiling tracks (making one 
good vocal track out of several takes) and the IN points and the TO 
point are in the same place on the time line then press the IN button 
then the TO and then the OUT. (* Also, you can select as many 
tracks as you want to copy, move, erase in the select track window.) 
  
4) Now click on TRACK> and select REGION COPY or MOVE to 
actually MOVE the audio> and in the next window click on "F1 Sel 
Trk" button to select the track or tracks with the IN & OUT edit 
points and the track or tracks to send it or them TO. 
  
5) Here you will see 3 rows of numbers and boxes to check mark. 
Check Mark the box of the track with your IN & OUT audio edits, then 
to the right of the arrow, with your mouse, or JOG wheel, dial in the 
track to send that selected audio too (the one with the TO point). If it’s 
the same track then you don’t have to change it, the same track is 
listed by default. To move from track to track (16 V-Tracks at a time) 
hold down SHIFT+JOG, to select V-Tracks then JOG only. 
  
6) Now click the "F5 OK" button and answer YES to the prompt. It'll 
say Done! Now click "F6 EXIT" to close the Region Copy or 
Move window. 
*Region Copy will "COPY" the data, Region Move "MOVES" the data. 
  
7) If you are not satisfied with the edit, PRESS the UNDO button and 
then ENTER to erase the current edit you just made. Clear your edit 
flags by left clicking on them while holding down the CLEAR button 
and start over, OR... 
You can leave the flags there and grab your TO flag and move it to a 
new position then click on TRACK> REGION MOVE> Sel Trk> etc... 
 
To CUT a section of audio, you just place an IN, then the OUT then 
select TRACK> REGION CUT> and in the window that open click on 
“F? Sel Trk” and in the next window check mark the tracks to cut the 
audio from and click OK. This removes that section of the time line as 
well so that space will be gone and the two pieces of audio on either 
side of the highlighted section of audio will jump together. 
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You can also left click at the IN point and drag to the OUT point, 
highlighting the audio and right-click and on the menu that pops up 
then select CUT. You could also select ERASE if you just want a 
silent spot of the time line left. 
Again... I PLAY the audio, keep the beat with my hand and count 1 
and 2 and 3 and 4 and etc. Right after 4 on the “And” I press STOP 
and place my edit points or flags. This is usually a silent spot between 
beats. Practicing this will help you to get pretty precise at placing 
these flags. 
 
COPY SONG/PROJECT 
If you want to copy a song to this same partition/drive so you can 
keep the original before region cutting a song to make it shorter or 
region copying a song to make it longer do this.  
 
Click on PROJECT> Project List> and in the Project List window click 
on the page button till you see 2/4 and “F1 COPY”.  Now check mark 
the project/song or songs to copy. Now turn the JOG wheel to place 
the box around the drive/partition number to copy the song or songs 
too. *To copy to the same partition jog the box all the way up to 
IDE:0. To copy to another partition jog the box down to IDE:1 or etc. 
 
Now click on “”F1 COPY” and the Project Copy window opens. On 
the left it shows the project/song to copy, below that what drive it’s 
on, then on the upper right, the drive to copy the song too and below 
that “Erase All Projects.” Make sure it is check marked “OFF.” 
*Unless you want to erase the destination drive clean.  
 
Now press “F5 OK” and it asks “Copy to (your drive you selected?” 
click on “YES” and “Store Current?” answer “YES” or “NO” if you 
don’t need to store the current project that’s open. Now the progress 
bar comes up “Loading… and Copy Project.”  
 
It’ll take a couple of minutes. When it’s done the windows disappear 
and the current project is still open.  If you copied the song/project to 
the same partition you can go to Project> Project List> and scroll to 
the end of the list of songs and find it there. You can go to Project> 
Name> and rename the current project so you don’t get them mixed 
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up. *To check a song on another drive you have to select that drive 
from the project list window. 
 
USING REGION MOVE TO SHORTEN A SONG 
HERE'S A VISUAL OF WHAT TO DO..... 
  
Song Intro      TO     Part to cut        IN                      Song End    OUT 
>>>wav>>>>>//>>>>>wav>>>>>>>//>>>>>>>>>>>>>>wav>>>>>>> 
Section # 1             Section # 2                                   Section # 3 
  
EDIT Points    TO                             IN                                        OUT> 
 
Jog the TIME LINE to the EDIT points and PRESS the appropriate 
button to place the EDIT points as shown above. 
 
You want to cover up section # 2 with section # 3 removing section # 
2 from the song. Placing the IN point and OUT point will highlight 
section # 3 to be moved over section # 2. The IN point will meet with 
the TO point once the edit is made covering up section # 2 leaving 
only sections # 1 & 3 to be heard when played. 
  
NOW click on TRACK>> REGION MOVE>> and a small window 
opens, click on the “F”1 Sel Trk">> another window opens. Select 
ALL tracks to REGION MOVE >>> then click “F5 OK” and “YES” 
you’re sure then “EXIT.”  
 
Now check your edit and see if you like it. If not press UNDO and 
ENTER to start over or if you like it, hold CLEAR down and click on 
the flags with your mouse and they’re gone. If you want to try again, 
you can just left click and drag the EDIT FLAGS to new positions and 
go to TRACK>> REGION MOVE>> and repeat the edit. If not then 
hold down the CLEAR button and press each edit button, IN, TO, 
OUT one at a time to clear out your edit points/flags and start over or 
left click on the edit flags with the mouse. 
 
Again” I PLAY the audio, keep the beat with my hand and count 1 
and 2 and 3 and 4 and etc. Right after 4 on the “And” I press STOP 
and place my edit points or flags. This is usually a silent spot between 
beats. Practicing this will help you to get pretty precise at placing 
these flags. 
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USE REGION COPY TO MAKE A SONG LONGER 
Let’s say you want to make a song longer. I like having the tracks 
zoomed into show just 4 tracks that will give me a good visual of the 
wave form for more accurate placement of my edit points. You’ll have 
to decide what sections to copy to where. 
 
For this example, let’s say you want to repeat the last chorus and 
solo. What you can do is jog the time line to place an IN point at the 
beginning of the chorus to repeat and then jog and place an OUT 
point after the song fades out. This has now selected that chunk of 
audio to Region Copy to a later point in the song. 
 
Jog the time line to the later point in the song, like at the end of the 
chorus and solo that’s to be repeated and place a TO point. The 
FROM is placed automatically. I like to PLAY the audio, keep the beat 
with my hand and count 1 and 2 and 3 and 4 etc. Right after 4 on the 
“And” I press STOP and place my edit points or flags. This is usually 
a silent spot between beats. Practicing this will help you to get pretty 
precise at placing these flags. 
  
Now to Region Copy click on TRACK> Region Copy> and in the 
window that opens select “F1 Sel Trk” and in the next window, check 
mark all of the tracks to be copied to their same track and click “OK.” 
Click “EXIT” to close the window and check your edit to see if you like 
it. If not press UNDO and ENTER to start over and try again or if you 
like it hold CLEAR down and left click on the edit flags with your 
mouse to remove them. 
 
USE REGION CUT TO SHORTEN A SONG 
Zoom the tracks in so only 4 tracks are showing, this will allow you to 
see the wave form better for placing your edit points. *We use Region 
Cut because if you copy the end of a song to the front part, you will 
have a tail of the original song at the end of the new shorter song that 
you will then have to perform a Region Erase on.  
 
Region Cut will cut out a solo or a chorus and bring together the two 
pieces on either side of the cut. You place an IN point at the 
beginning of a solo or chorus and an OUT point. *Notice the TO and 
FROM is automatically placed, you don’t have to worry with it.  
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Now click on Track> Region Cut> and in the window that opens 
select ”F1 Sel Trk” and check mark every track in the song to cut to 
their same track, then click “F5 OK” and “YES” you’re sure then 
“EXIT.” Now check your edit and see if you like it. If not press UNDO 
and ENTER to start over or if you like it, hold CLEAR down and click 
on the flags with your mouse and they’re gone. If you want to try 
again, you can just left click and drag the EDIT FLAGS to new 
positions and go to TRACK>> REGION CUT>> and repeat the edit. 
 
*NOTE: I also PLAY the audio, keep the beat with my hand and count 
1 and 2 and 3 and 4 etc. Right after 4 on the “And” I press STOP and 
place my edit points or flags. This is usually a silent spot between 
beats. Practicing this will help you to get pretty precise at placing 
these flags. 
 
TRACK EXCHANGE 
Sometimes we need to change the position on the tracks line up so 
we use the TRACK EXCHANGE feature in the VS. If you want to 
exchange, let’s say TRACK #1 with TRACK #10, then you… 

1) Click on TRACK at the top of the HOME screen and 
 
2) Select TRACK EXCHANGE from the drop down menu and a 

TRACK EXCHANGE window will open. In this window there are 
3 rows of 8 TRACKS and their V-Tracks. 

 
3) In the first row place a check mark in the empty box to the left 

of “1-1    -“, it will change to “1-1  1-1” and become 
highlighted. 

 
4) Now with your JOG wheel dial in  the right numbers “10-1” and 

the set should look like “1-1 10-1”, meaning TRACK #1’s V-
Track 1 will be exchanged with TRACK #10’s V-Track 1.  
Basically, TRACK #1 and TRACK #10 will exchange positions.   
You can also dial in V-Tracks here. 
 

5) Now click “F5 OK” and answer YES to the 2 prompts and the 
process will take place. If any track title has been type in then 
the title will move with the track too. You can also EXCHANGE 
pairs or several tracks at once. 
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6) Now click “F6 EXIT” to close the TRACK EXCHANGE window.  
 
*When using the TRACK EXCHANGE feature, make sure, when you 
are in the TRACK EXCHANGE window, that other tracks do not have 
check marks in their boxes because those tracks will be exchanged 
also. This can happen once you have done a previous TRACK 
EXCHANGE they can still be check marked the next time you go in to 
do another EXCHANGE, so be careful, tracks can get lost this way 
and create a lot of confusion. When this happens, I go in and tell it to 
do the EXCHANGE again to bring the lost tracks back to where they 
were in the first place. 
 
TRACK IMPORT (Between Projects) 
To move tracks from project to project use the TRACK Menu and 
select TRACK IMPORT. Open the project you want the tracks to end 
up in then TRACK> TRACK IMPORT> in this window find the 
project/song with the tracks you need and select it, then click “F5 
Select” and in this window you select the SOURCE TRACK by 
scrolling up or down to the tracks or V-tracks needed, and then select 
the DESTINATION TRACK you want the source tracks to end up on 
in the project. Click “F5 OK”, YES and sure yes etc. See MST DAO 
for better step by step on this process. 
 
COPY PARAMETERS 
To copy the Dynamics, EQ and Level settings from one Track’s or 
Input’s to another you have to Press the CH-Edit button of the Track 
or Input that you want these settings copied to. Let’s say you 
Exchanged Track#10 with Track#3 and you want Track#10’s Dyn,EQ 
& Level settings from it’s channel edit page to be moved to Track#3 
after the Track Exchange of Track#10 to Track#3, you would do this. 
 

1) Press the CH-Edit button on Track#3 and at the bottom of the 
page 1/5, you’ll see “F5 CpyPRM”. 

2) Click on “F5 CpyPRM” and a small “Copy Mixer Parameter” 
window opens with SOURCE Ch on the left and COPY 
TARGET on the right. 

3) Simply use the mouse to drag the SOURCE display to show 
TRACK 10 in the window (or highlight and jog) then in the 
COPY TARGET side select ALL. There are 4 selections here, 
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ALL, DYNAMICS,EQ and LEVEL so you can do all or one of 
them at a time. 

4) Once your selections are made click on ENTER and the copy 
will be made. You can not use UNDO to undo this step. 

*NOTE: Also, as you dial through the selections under SOURCE, 
linked tracks will show up as linked ie. Track 1/2. 
 
TRACK EXPORT (.wav format) 
To export a track or tracks to a CD-R or RW from a 24bit, 44.1k MTP 
project, just click on CD-RW Mastering> select TRACK EXPORT> 
and INSERT a blank disk. Now the EXPORT window opens. 
 
In the TRACK EXPORT window all tracks and V-Tracks are listed 16 
at a time in the window on the left. You will see an empty box and “1 
– 1: Your Track Name” for Track 1 V-Track 1. (It runs thru each 
track’s 16 v-tracks but boxes only appear next to tracks that have 
data). Place a check mark in the empty box to the left of the track 
name and use the down arrow to scroll to the next track “2 – 1: 
Another Name” and place a check mark there too and so on for all 
the tracks to be exported. (You can also export your master tracks 
using this method, just find the V-Tracks on tracks 23 and 24.) Once 
you have selected all tracks to export Click “F5 NEXT”. 
 
The VS scans your blank disc and puts up a list of all selected tracks. 
In this window select VERIFY to “ON” with a check mark and for CD 
Speed select “MAX” and then click “F5 OK” and the VS will start 
burning the selected tracks to disk unless there’s data on the CD-RW 
disc, it will say “Finalized Disc”, click ENTER, then in the next window 
click YES to ERASE the CD-RW disc. This can take several minutes 
just for a couple of tracks. You will see the blue progress bar and 
“Now working” in the middle of the screen. The disc will eject when 
done. CDs will not hold more than 700MB, I shoot for 650MB. 
 
The exported tracks will be mono data files in 24bit  @ 44.1k in .wav 
format from an MTP project for loading into other PC audio programs 
like Pro Tools & Sonar. They are not audio files to be played in a 
market/home CD player. *NOTE: The track export window will keep 
these files checked until you uncheck them so don’t go in and export 
other tracks without un-checking these or they will export again.  
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NOTE: Very early VS2480 HD models did not have the ability to 
import and export files. If you have this problem then you need to 
update the VS’s OS to get these functions to appear on the CD-R 
Mastering  and TRACK Menus. 
 
Also, if you put the CD-RW with the track on it into your PC, you can 
process it with Auto-tune or whatever audio application you have. 
Save it to a folder you can find, or name it differently so you can find 
the processed file instead of the original like naming it #2 or 
something.  
 
Then open that folder in its own window and then you can open a 
window to a blank CD in a CD Burner. Now you can drag and drop 
the processed file into the blank CD-RW window click File> Write 
these files to CD> and the XP Wizard will open, you can name the 
disc in the first window where there is a highlighted date then click 
NEXT, in this window be sure to select Data Audio not CD Audio for 
players, then after it burns it to disc stick it into the VS.  
 
Note: When you track export tracks using “Track Export” through the 
EXPORT WINDOW out of a 24bit 44.1k MTP project, they stay at 
24bit 44.1k. .wav files. If you master your tracks in the mastering 
room as non-CD-R Mode, those master tracks can also be 
EXPORTED out of the VS using this method and will be 24bit, 44.1k, 
.wav stereo files, same as the project’s mode, I suggest channel 
linking the master tracks before exporting.  
 
EXPORTING MASTER TRACKS 
When you get to the V-Track map in the TRACK EXPORT window, 
you’ll have to scroll thru all the tracks and their V-tracks to get to track 
23, check mark its V-track you mastered to then scroll to track 24 and 
check mark its same V-track you mastered to.  
 
Even though you have to check mark both the left and right mono 
tracks in the track export window, the VS will still combine them into 
one STEREO PAIR in to a single stereo file as long as you have them 
LINKED. Bring them forward in the HOME screen, selecting the V-
Tracks on the V-track map and then link them on track 23’s CH-Edit 
page. If you do not LINK them before exporting master tracks they 
will wind up being MONO left and right files.   
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Also, if you export mastered tracks, the CD-R Mode 16bit pairs will be 
exported as stereo .wav files but with the non-CD-R mode mastered 
tracks in 24bit, if you do not have them linked and check mark the L & 
R tracks to be exported, they will turn out to be MONO .wav files. If 
you want STEREO .wav files, be sure to link them and check both left 
& right to be exported at the same time.  
 
It can be tricky but you can export STEREO .wav format mastered 
tracks in 24bit. They will come out with a file name similar to this: 
2316V_T23_16.WAV. Notice, track 24 is not in the title, weird but OK. 
Once done linking the tracks and exporting them, don’t forget to go 
back and select empty V-tracks or the original V-tracks that were in 
the HOME screen. The stereo .wav files are 24bit so some apps that 
only play 16bit audio will not open them ie Window’s Media Player! 
 
WAV IMPORT Insert CD of .wav files, Now go to the CD-RW 
MASTERING menu and select WAV IMPORT, a window opens after 
the VS scans for the CD-RW, the WAV IMPORT screen opens with a 
list of files on the CD. (You may have to open a folder on the CD-
R/RW disc first by clicking “F5 ChgDir”). 
 
Highlight the file to IMPORT and click “F5 Select” and a destination 
screen opens.  Here you select which tracks to send the file to on the 
VS. Select the destination track and use NORMAL under “CONVERT 
TYPE”.  “TO” sets the time position to send the .wav to in the VS 
project. The Track Status lights on the VS light up when you send a 
wav file to them. Once all is set correctly click “F5 OK” to IMPORT the 
file. When the VS shows “DONE” click “F1 Back” to return to the 
IMPORT screen to import more files or click “F6 EXIT” to exit the wav 
import screen. This is a bit brief but you'll figure it out. See pages 354 
to 358 in the Roland manual. 
Note: You can only WAV IMPORT one file at a time. 
 
Now, if you use track export to export to CD and bring that into a PC 
audio program, you need to match the bit rate of 24bit in the audio 
application or have an audio program that will convert 24bit to 16bit if 
needed. Otherwise you can end up with noise in the .wav file when 
listening to it at the wrong bit rate. Anytime you use “Track Export” 
out of the VS, the file will match the projects bits rate and sample 
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rates i.e. a 48k project exports 24bit 48k .wav files. A CDR project 
exports 16bit 44.1k .wav files.  
 
When you use “Wav Import” in the VS the files will be converted to 
match the project. The VS accepts only ISO 9660 format data CDs, a 
standard for most. Just select “Wav Import” from the CD-RW 
Mastering Menu and insert the disc. Say you want to master 48k 
24bit masters you would use “Track Export” to export them to CD out 
of the 24bit 48k project and use “Wav Import” in the 24bit 44.1k 
project to convert them into 24bit 44.1k project .wav files. 
 
TRACK IMPORT(Importing tracks or master tracks from other 
projects) 

1) Open a new project and click on TRACK> select TRACK IMPORT, a 
window opens with a list of all of your songs on your hard drive on 
that partition. 

2) Now Select the track or master tracks to IMPORT, a rectangular box 
will surround it, 

3) Click “F5 Select” to get to that projects mastered V-Tracks or tracks, 
a new TRACK IMPORT window will open. Notice the track’s title is 
there and two areas, SOURCE   and Destination. 

4) In the SOURCE window click on the scroll bar’s UP and DOWN 
arrows to find the track or mastered pair of V-Tracks.  For master 
tracks, Make sure the first song’s LEFT V-Track is selected and 
appears in the small rectangular window under SOURCE. We can 
only Import one side at a time. The RIGHT V-Track will have to be 
done by it self next. So…select “23-16:V. T23-16” first! “24-
16:V.T24-16 next time around. 

5) Next, we have to select the DESTINATION track to send the 
SOURCE V-Track or track too. In the DESTINATION window, 
make sure that the master track “1L-1:V.T 1-1” or your track is 
selected and appears in the Destination window. It should be there this 
first step. If not, use the UP and DOWN scroll arrows to select it. 
Clicking on them moves it 1 track’s full 16 V-Tracks at once. 

6) Now click the “F5 OK” button and answer “Yes” to Are you Sure and 
“YES” to Store Current Project. A progress window will appear. 
When done, move on. 

7) For master tracks: Now Track# 1 has the Left track of the song 
IMPORTED to it. Click TRACK> TRACK NAME> and select “F1 
NAME” and name it the title of the Song. Click “F5 OK” and then 
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click “F5 EXIT” NOW……REPEAT STEPS 1 thru 7. This time 
IMPORT the R side V-Tracks to TRACK 2 in this project, then LEFT 
then RIGHT etc.   

*From what I understand, you can only TRACK IMPORT tracks from 
projects that are in the same sample rate and project mode. To IMPORT 
48k tracks into a 44.1k project, you have to transfer them to PC, burn 
them to a CD then IMPORT the 48k tracks from the CD into the 44.1k 
project. The VS will convert the 48k track to 44.1k using the WAV 
IMPORT feature on the CD-R Mastering menu in the 44.1k project. 
 
PHRASE EXPORT 
Place the time line across the phrase/s to EXPORT. 
1) Click on CD-RW MASTERING menu> select  PHRASE EXPORT> 

in the small PHRASE EXPORT window check mark the 
Phrases/tracks to export. (Only the phrases that the time line is 
touching will show up in this window)  

2) Once they are check marked, they will become highlighted on the 
HOME screen. Insert a CD-R/RW in the CD/DVD Drive and click 
NEXT. It will scan the drive then list the phrases in a new larger 
PHRASE EXPORT window. 

3) In the PHRASE EXPORT window the phrases are listed on the left, 
on the right check mark VERIFY to ON and then the SPEED, I select 
MAX. (If you have problems you can try slower speeds but my DVD 
burner only lets me select MAX.) Click  F5 OK  

4)  Now Working... pops up then a small Phrase Export with [EXIT] and 
a rolling “Now Working...” with blue progress bar. You’ll hear the 
drive speed up and down from time to time. 

5)  When done the smaller Eject Disc window opens and ejects the disc 
then Done... Click the close button on the PHRASE EXPORT 
window and that’s it. 

 
CD-CAPTURE 
Pretty basic, Open a new project, insert the CD in drive. Click on CD-
RW Mastering Menu> Select CD Capture> it’ll scan the CD, then in the 
window that opens you will see a list of the tracks/songs in the bottom 
right quad, highlight to select the track to capture,on the left where it says 
“Destination track” Left click and scroll the Track and V-track number to 
send the left side of the stereo tracks to and the right side just below it 
will follow, select Capture to Zero, Start of track, Capture whole track, 
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then click OK and it should send the track to the new project on the 
destination tracks you selected. 
 
USING A-Punch  
1. Jog the time line to where you want the A-Punch to come in, hold 

down the A-Punch button and press the IN edit button. 
2. Jog to the point where you want the A-Punch to end, hold down the 

A-Punch button and press the OUT edit button. 
3. Jog a ways before the IN point so you have time to get in rhythm with 

the song. 
4. Press Record/Play and then play along with the song. The A-Punch 

will automatically come in on the IN and go out on the OUT. You can 
also get out of it by just pressing the STOP button. 

5. Then hold down the CLEAR button and left click on the A-Punch edit 
flags to remove them. They will interfere with recording a regular 
track later. 

*NOTE: I also PLAY the audio, keep the beat with my hand and 
count 1 and 2 and 3 and 4 etc. Right after 4 on the “And” I press 
STOP and place my edit points or flags. This is usually a silent spot 
between beats. Practicing this will help you to get pretty precise at 
placing these flags. 

 
Manual A-Punch 

1. Jog the time line ahead of the point where you want to punch in and 
press PLAY. 

2. When the time line plays to the point you want to come in, press the 
RECORD button. 

3. Once you have played the part you want just press PLAY or STOP. 
 
*You may want to use the WAV DISP screen to clean up the edit points 
later, just highlight it, right click and select DELETE. I like using the Auto 
A-Punch, the edits in and out are usually cleaner and more precise. 
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So you powered off your 2480 without saving that great live gig you recorded last night? 
 
This document should guide you how to get at least some of the recording back by using 
VSWaveExport Software. 
 
First some clarifications to dampen the optimism: 

• The more fragmented your hard drive is, the lower the chance to get back a long 
continuous recording. This means if you recorded to a freshly formated partition you 
may get back 100%; if you heavily recorded and edited on that partition and the last 
format was 5 years ago, that percentage will be (much) lower 

• Everytime you hit stop and rec during the recording presumably also lowers this 
percentage. This means if you recorded 2 hours nonstop you have good chances to 
find a long continuous bunch of data you can recover 

• Every write operation to the partition in question after the unintentional power down 
will lower the percentage of recoverable data. If you, for example recorded another 
session or used a PC disk repair or recover program you may have overwritten the 
audio data you want to recover. 

 
So, lets get practical now. You have connected the VS internal IDE drive to your PC and the 
PC has recogized the drive? Fine! If you have not connected the drive by now and you are 
unsure of what to do then look out for descriptions on the web on how to connect an IDE 
harddrive to a PC. 
 
Start VS Wave Export. You should get a window like this: 

 
This shows all partitions of the drive. 
Now highlight the partition where your lost data is. 
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Then select ‘Partition Analysis’ from the Extras Menu 

 
 
 

Click onto PartitionX 
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Another window appears: 

 
The partition is now read, note the filecount increasing. This can take a while. When 
everything is finished it will look like that: 

 
The green/black/yellow area is a graphical interpretation of the FAT (File allocation table) 
and indicates used sections (clusters) on your drive. The green and yellow dots mean that a 
known file is allocating these clusters. Note that you can scroll the FAT graphic with the 
scrollbar. The data you are looking for is in the black areas. 
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Now activate ‘Play cluster’ in the ‘upon click in the FAT graphic’ area and select the Mode 
and Samplerate of the project you are looking for: 

 
 
 
OK, now turn your speakers down! If you click a wrong cluster you might get a terrible noise. 
Now move your mouse over the black area of the FAT grafic and click somewhere. VS Wave 
Export will play the content of the clicked cluster, no matter what is in there. 
One cluster equals more or less one second of audio. You should be able to determine what is 
recorded in that cluster. Look out for your gig. You can also set the app to play more than one 
cluster, which may make it easier to identify the material. 
But before doing this you must understand how multitrack recordings are saved by the VS: 
If you record 8 Tracks at the time, the VS will place the audio data  of this 8 Tracks in 
consecutive single clusters. This means that cluster 1 will hold one second of audio data for 
track 1, cluster 2 will hold one second for Track 2, …, cluster 8 holds one second of Track 8. 
After that the next recorded second follows: cluster 9 holds the 2nd second of Track 1, a.s.o. 
Therefore if we just play clusters 1,2,3 we would mixup Tracks. Instead we must play cluster 
1,9,17,25,33, aso to hear Track 1. 
You can do this by setting the ‘offset’ to the number of tracks you recorded at once: 2 for 2 
tracks, 8 for 8 tracks, 16 for 16. 

 

Activate ‚Play cluster’ 

Select Project Parameters 

Enter the number of tracks you recorded 
into the offset field. 
Enter the number of clusters you want to 
play in the count field 
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Every time you click into the FAT graphic the ‘from cluster’ value will be changed to the 
clicked cluster. 
Your task is now to find the right values for ‘from cluster’ and ‘count’ so that a long 
contiuous recording is played. Instead of clicking into the FAT, you can also edit the ‘from 
cluster’ field and hit the ‘Play’ Button to playback the selected clusters. 
You do not need to playback and listen to all selected clusters.  For example, if you recorded 
8 Tracks and found Track 1 starting at cluster 12345 and playing fine through the next 5 
clusters (12345, 12353,12361,12369,12377 and 12385) you could directly go to cluster 16345 
(=12345+500*8) and verify if Track 1 is still playing. If yes, the chance is very good that you 
found 500 consecutive clusters of Track 1. 
But be aware that every green spot (used cluster) in between will break up continuation, as the 
VS cannot use this cluster when recording, it will stop here and continue placing recorded 
data somewhere else. 
 
Once you found a passage that you want to recover, setup all cluster parameters (in the above 
example this would be ‘from cluster’=12345, ‘offset’=8, ‘count’=500) and press the ‘Save as’ 
button, you will be prompted to define where you want to save the recovered data, and to 
choose if it shall be saved as Wave or RDAC Format after that hit save and the file should be 
created. 
You can then continue to search for other contiuous blocks. 
 
After you extracted all data you could find, you can align the recovered data in your audio 
software. As a rule of thumb, consecutive recorded clusters should align perfectly at cluster 
boundaries. This means in the above example Track 1 recovered from clusters 12345, 
12353,12361,… to 16345 should line up with Track 2 recovered from 12346, 12354,12362,… 
to 16346 and Track 3 (12347-16347) a.s.o. 
 
 
Good Luck! 
 
 
Technical Stuff: 
1 cluster on a 10Gig Part formated with the 2480 equals  

• 32768 Bytes equals 32768 24bit samples at MTP or 
• 32768 16bit samples at MT1 or 
• 43680 16bit samples at MT2 
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VS DAO (Disc At Once) Live Recording     By Frank Griffith 
If you have a live recording of a performance with several songs in a roll 
that you want to burn to CD and have track markers for each track on the 
CD do this. 

1) Run the whole recording of the performance thru the Mastering Room 
using CD-R Mode. 

2) When done bring those mastered V-Tracks forward in the home 
screen by selecting them from the tracks 23 and 24’s V-Track map. 

3) Now place CDR Markers where you need them by holding down the 
“CD-RW Mastering” button and pressing “TAP.” This will place 
BLUE MARKERS that will make players recognize it as a Track 
Marker. Place no marker on the first song, it’s placed automatically 
during CD-R Write. 

4) Now you’re ready to burn the whole list of songs to CD-R. Just go to 
CD-RW Mastering Menu and select CD-R Write as you insert a blank 
CD and be sure to select “Disc At Once” MODE in the CD-R Write 
window, MAX speed and OK. That’s it. 

 
To separate each song into its own project, say you have 4 total: 
 
1) PROJECT> COPY the existing project 4 times. Now giving you (4) 
copies of the same project. 
 
2) Open each project, and use REGION CUT to cut out everything that you 
do not want in that project making it a one song project.  
 
3) Also, OPTIMIZE each of the projects to make it smaller, only holding 
one song instead of all four. Rename the projects for each song. 
 
4) DELETE the 3 unused projects you created leaving you with the original 
recording and the single song projects. 
 
If you take the time to NAME THE TRACKS in the original Project, each 
single-song project will also have the names in place.  
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 Settng up a De-esser Effect  
Although there is no specific effect patch for de-essing, Preset 022 (Vocal Multi) may be 
modified for that purpose. Use the following procedure to modify an effects preset to 
serve as a De-esser (in this example, Effect 1 is already set up as Preset 022): 
 
1. Press DISPLAY(HOME) to start from the main screen. 
 
2. Press EFFECT. Press F1(FX1) to choose the first effects processor. 
 
3. Press F3(EDIT) to edit the chosen effects patch. Press F2(Next->) to get to the next 
section of the effect. 
 
4. ''[Vocal Multi] lmt'' is displayed. CURSOR to the ''Mode'' option and choose ''De-
esser'' with the TIME/VALUE dial. 
 
5. Further adjstments for the De-esser effect (Sens and Freq) are now displayed. use 
CURSOR and the TIME/VALUE dial to change the values.  

From Brett’s site…  http://www.rolandvs2480.net/ 

*Basically you can choose one of the VOCAL MULTI presets (P139 thru P148), enter 
the LIMITER module, and you can select LIMITER or DE-ESSER mode. By Karl. 

LDT says…I usually use the analyzer to see which freq the ssss is most prominent to 
choose a freq point. 
 
Try turning the sens up to 50 to make it more audible, but be careful or you'll add a 
lisp to the vocal.  
 
Also bring the DES down to hit it harder (think of it as the threshold on a 
compressor). 

*You can find this info and much more on the VS at Brett’s site... 

http://www.rolandvs2480.net/ 

 

 

http://www.rolandvs2480.net/
http://www.rolandvs2480.net/
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LOOP EFFECTS (known as Send & Return EFX)            By Frank Griffith 
Loop effects work a bit differently, you have to SEND the effect thru the aux 
bus and RETURN it thru the FX RTNs (Effects Returns).   
PRESS TR 1-16. If you want to LOOP an EFFECT to a vocal TRACK 
that’s recorded on TRACK #5 here’s what you do. First, go to EZ-Routing> 
Routing View> and under “TRACK ASSIGN” you see the FX RTN Block 
with 1 thru 8 they match EFFECTS 1 thru 8, make sure nothing is connected 
from the FX RTN to the track you are recording too, the RECORDING 
TRACK number, which in this case is TRACK#5, we only use this when 
bouncing TRACKs with effects or adding effects to INPUTs for 
recording/printing effects and will cause feedback if connected at this time. 
Before you will hear an effect you have to PRESS IN 17-24/AUX MST 
Fader Button and make sure the AUX1 thru AUX8 Faders are set to 0db, 
then PRESS TR 17-24/FX RTN Fader Button and make sure FX RTN1 thru 
FX 8 Faders are set to 0db. Now PRESS TR 1-16 from the TRACK MIXER 
and then click HOME. *In theory, you are NOT adding the reverb to the 
tracks or inputs, you are routing their signal thru the master bus where the 
reverb is applied thru FX RTNS & AUXS. 
 
Now, PRESS the CH-Edit button above TRACK #5 and on the 
Dynamics/Compression and EQ Parameter graph screen at the bottom, find 
the AUX knobs. AUX 1 thru AUX 8 are routed to EFFECTS 1 thru 
EFFECT 8. These AUX knobs will control the amount of an effect to be 
used on a TRACK. Let’s say you have a REVERB you want on this vocal 
TRACK #5. Click on EFFECTS -> Select EFFECT 1-> a window opens, 
click on the “F1 PATCH”, in this window highlight P001 Reverb 2 and click 
“F5 SELECT”, now it is listed above SELECT as the “CURRENT” one 
patched in. (You can use the scroll bar arrows to find other effects patches 
when needed) Now click on “F6 EXIT” twice to back out of the EFFECTS 
window.  
 
Now you can turn up the AUX1 knob to 0db to add this EFFECT to the 
TRACK MIXER and TRACK#5. Now PRESS Play to hear the vocal track 
with reverb. Make sure TRACK #5’s TRACK STATUS Button is lit 
GREEN for PLAYBACK. 
 
Now, to adjust the amount of REVERB from EFFECT 1 that you want 
added to the Vocal TRACK #5 just PRESS the CH-Edit Button above 
TRACK 5’s Fader and use the AUX1 knob to turn it up or down with your 
mouse by Left Clicking and holding and moving your mouse up or down, or 
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you can click on the AUX parameter to select it and use your JOG wheel as 
a knob.  
 
Remember, Fader button IN 1-16/Solo takes you to the INPUT MIXER and 
FADERS and Fader Button TR-1-16/Master Edit takes you back to the 
TRACKS MIXER and FADERS. You can use the Fader Buttons IN 17-24 
and TR 17-24 in this same way. All INPUTS and TRACKS have their own 
CH-Edit page with Dynamics, EQ, Auxs and EFFECTS.  
 
LOOPED EFFECTS ON INPUTS (To print/record effects) 
To LOOP an EFFECT to an INPUT you would do the same as above. Have 
your EFFECT already PATCHED in, like P001 Reverb 2, and PRESS IN1-
16, find your INPUT, PRESS its CH-Edit button, and turn up the proper 
AUX knob. 
 
Now here’s what’s different. Go to EZ-Routing> Routing View> and in the 
left hand bottom side of the screen under “TRACK ASSIGN” there is a FX 
RTN1 thru 8. To complete the LOOP to the INPUT, you must connect that 
FX RTN number to the TRACK (on the RECORDING TRACK block) that 
the INPUT is sending it’s signal too. Let’s say you have a mic on INPUT1 
recording a vocal to TRACK #5, and you are adding the reverb of EFFECT1 
to it, then FX RTN1 must be connected to TRACK #5 to complete the 
LOOP for recording the reverb to that TRACK. This same connection has to 
be made when bouncing tracks with effects too. That’s the only way the 
effect will get recorded/printed with the track. 
 
Now, what's odd or can be a bit confusing is this, when you have a track 
recorded dry and you want to add a reverb to that dry track to be heard 
during playback or recorded  during mastering, you do not have to connect 
the FX RTN virtual cable to the destination tracks, that routing is done 
automatically on the track mixer for recording it in the mastering room to 
master stereo V-Tracks.  
 
INSERT EFFECTS 
First off, you need to know, each fader has two buttons above it. The first 
one is the TRACK STATUS Button. GREEN for PLAY, Blinking RED for 
ready to RECORD or ARMED, steady for recording and no color for OFF. 
The second button just above the TRACK STATUS Button is the CH-Edit 
Button, (channel edit). This button brings up a screen for each TRACK & 
INPUT and has your Dynamics/Compression and EQ Parameter graphs, 
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your INSERT EFFECTS and all of your AUX Busses on it. (Plus many 
other things we won’t worry about now.) 
 
On the CH-Edit page you can add INSERT or (Send & Return) LOOP 
Effects to the INPUTS and/or the TRACKS. All of them. When you PRESS 
TR 1-16 Fader Button (above the master red fader), the CH-Edit Button on 
each TRACK will open for use. When you PRESS IN 1-16, the CH-Edit 
Button will now open for use with the INPUT you are on. Each TRACK and 
INPUT has it’s own CH-Edit Button and page of EQ, Compression and 
EFFECTS abilities. Now let’s add an INSERT EFFECT to an INPUT to 
PRINT it when we record. 
 
PRESS IN 1-16/Solo button above the master red fader. Now your faders are 
set for INPUTS. If you are adding an EFFECT on INPUT #1 then PRESS 
the CH-Edit button above fader #1. The page with EQ and Compression 
graphs on it will fill the screen. Below the Compression graph is where you 
will find the EFFECT INSERT and under it, FX1 thru FX8. If you are using 
the EFFECTS Processor #1, then click on FX1 once. (It has 4 positions) You 
want the first position for now. See “VS INSERT EFX.doc” for more about 
these positions. 
 
Now Patch in your EFFECT by clicking on EFFECT> then EFFECT#1> a 
window opens, select the "F1 PATCH”, now in this window, highlight the 
effects patch you want to use, by default P000 is usually highlighted black, 
select P001 Reverb 2 for this exercise and click the "F5 SELECT”> then “F6 
EXIT”> twice. 
 
Now click HOME and above the Red Master fader, PRESS IN 17-24/AUX 
MST and make sure all AUX FADERS are set to 0db, then PRESS TR 17-
24/FX RTN button and make sure all of the FX RTN faders are set to 
0db(especially the one you are using, fader AUX1 &  FX1 for EFFECT1). 
Down the road you will need these up for LOOPED effects so it’s good to 
have them setup all the time anyway. 
 
Now, when you record INPUT #1 to any TRACK, the EFFECT Patch you 
selected to use, P002 Reverb 2 or any you may have chosen, will be printed 
to the TRACK as long as you connect the FX RTN of that EFFECT number 
to the DESTINATION Track in the RECORDING TRACK block.  
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How do you route and input? Click on EZ Routing> Routing View> and on 
the left hand side of the screen find INPUT MIXER with 1-24. INPUT #1 
can be clicked on, it'll turn blue and the other end of it can be dragged to any 
of the RECORDING TRACKS 1-24 below the INPUT MIXER. By default 
INPUT 1 is connected to RECORDING TRACK 1, 2 to 2, 3 to 3 etc. (You 
can connect any INPUT to any TRACK or several if you want.) Once you 
connect you input where you want it, click HOME. Now arm your track to 
record and record the INSERT EFFECT with your track.  
 
For this next part, keep in mind all AUX busses and FX RTNs numbers 
match the EFFECTS Processors numbers. EFFECT 1 routes thru AUX 1 and 
FX RTN 1, EFFECT 2 thru AUX 2 and FX RTN 2 and so on. 
 
EFFECTS, COMPRESSION & EQ IN BRIEF 
When you press the IN 1-16 fader button above the red master fader, all of 
the CH-Edit button on that bank take you to the INPUT side and you can add 
Compression, EQ, Insert & Loop Effects to the INPUT signal that gets 
recorded to the TRACK. For more on Dynamics & EQ Parameters see “VS 
EQ Bass&Kick.doc.”  
 
When you press the TR 1-16 fader button, all of the CH-Edit buttons now 
take you to the TRACK side and you can add Compression, EQ & Effects to 
already recorded tracks or to tracks while they are being recorded. That way 
you can hear the effect while recording but not actually record the Effect, 
Compression or EQ. Effects, EQ and Compression added to the track side 
only gets recorded when you are mastering your song or if you bounce a 
track with effects. See “VS SUB MIXES.doc” for more on bouncing tracks 
with effects and for more on Dynamics & EQ Parameters see “VS EQ 
Bass&Kick.doc.”  
 
*See VS Manual for a list of which effects are used as Insert and which you 
should use as a Looped effect.  
 
SOLOing EFFECTS on a SOLOed Track 
Go to your FX RTN Screen by pressing  

1) TR17-24/FX RTN then press 
2)  Channel Edit button of the FX to solo. 
3) Solo button over fader on VGA (next to MIX & MUTE). 

 
USER PATCHES (Edit and Save)  
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Page 224 in my 2001 Roland manual explains how to save regular patches as 
user patches. 
 
Basically, on any effect you just do this... 
Click Effect> Select an Effect1 thru 8>>  
 
Click [F1 PATCH] If a “P” is before the effect number it’s on the PRESET 
list, if “U” is before the numbers it’s on the USER list. Start with a PRESET. 
Then highlight a patch/effect and click [F5 SELECT], now this effect is 
selected. 
 
Click [F6 EXIT] to get to the edit button. 
  
Click [F3 EDIT] then make your adjustments then  
 
Click [F5 Save] to view the EFFECT PATCH SAVE screen. 
In this window, a USER memory location patch will be highlight, the one 
you created will replace the one you have selected.   
 
Next click [F1 NAME] then name the patch what you want or leave it 
named as is and then you Click [F5 OK].  It asks if you’re sure, click YES 
and you're done. The effect window is still open so click [F6 EXIT]. 
 
When you select an effects processor and click [F1 PATCH] you’ll see [F1 
PRESET] and [F2 USER]. You can get to the PRESET list or USER list. 
What’s cool is you can get to this new USER patch you saved, from any 
Effects VS8F-2 card in the VS machine. 
*You do not have to save the project to save this effects edit, weird but true. 
Good luck, Frank.  
 
*NOTE: VS8F-2 cards fill up 2 Effects under EFFECT. Effect1 thru 8 equals 
four of the VS8F-2 Cards 1 thru 4, or Slots “A” thru “D” inside the unit 
under a back panel. EFFECT1 thru 8 equals AUX1 thru 8 and FX RTN1 
thru 8. Some EFFECTS use up the whole card but most are mono. You can 
select them as left & right and split up the effects into a total of 16 effects.  
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EQing Bass & Kick 
The “Q” is default at 2.00, it’s the bottom row of knobs under the EQ graph. 
These can be turned up to 5.00 or more and that’ll make the middle red 
arrows on the graph have a sharp point when you drag them upward or a 
sharp dip when you drag them downward. Once you do that you can sweep 
them left & right to find certain frequencies in the signal that may sound bad 
or good. The good ones you want to drag up, the bad ones you want to drag 
down. That’s how you first, find the frequencies in question then carve a hole 
in them to either get rid of a signal or carve a hole to let another signal come 
through. 
 
Now, Press the CH-Edit button of the bass track to get to the Parametric EQ 
graph. Take your bass guitar track and bring it up about 1-3kh in the 
parametric EQ by grabbing the second red arrow from the right and dragging 
it up. Now turn the “Q” knob, the one on the left and turn it up to around 
5.00.  This is the bass "burp" area of the frequency. This is called a notch. 
 
 
Now, while the bass is playing...solo out the bass and kick...left click and 
grab the second red arrow from the left side of the EQ graph notch and 
sweep that kick frequency back and fourth (left & right), you will notice at 
one point that... 
 
Your kick drum will "disappear" some what, when sweeping (moving the red 
arrow notched back and fourth)...this is where your bass and kick are sharing 
the same frequency. Take that frequency and drag it all the way down to 
carve out a hole in your bass track so the kick can come through. Adding 
anything below 200Hz can add muddiness to the bass track so keep that in 
mind. 
 
 
Now take between 40 and 60hz on the kick channel and slowly turn it up 
until the low end on both the kick and the bass is clearly heard at around the 
same increase in decibels. Now take and grab the red arrow around 4-6k on 
the kick and turn that up by dragging the red arrow up until your kick gets 
the desired amount of "crack". 
 
By notching and sweeping both tracks you can find the frequencies that you 
want add too and cut away. Experiment with this on both the bass and kick 
tracks till both sound right to you. Only you can hear this and decide what 
sounds best. The bass and kick are so close that in some cases they over lap 
the same frequencies so carving out holes in one or both can help to hear 
each better in the mix.  
 
Using Filters, LP, HPF, BPF & BEF 
Lo-Pass, Band Pass, Band Eliminate and Hi-Pass filters in the VS EQ section are 
very important things to work with in any mix. Usually, by default they are set to 
OFF, the "F" (Freq) @ 1.00k Hertz and the Q @ 0.71. If not then you can check it 
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out by clicking on the "OFF" and a small menu pops ups with Off, LPF, HPF, BPF 
& BEF options for setting the EQ graph to one of these choices. These are 
important for general purpose use, the HPF, BPF BEF & LPF. Low pass means 
just that. The graph will cut off the high frequencies so only the low frequencies 
pass through, hence Low Pass Filter.  Band Pass cuts off the Hi and Low 
frequencies, Band Eliminate cuts only the middle and Hi Pass cuts off the low 
frequencies so only the Hi frequencies pass through. 
  
These are used in conjunction with the "F" and "Q" knobs to set where the 
frequency cut off begins and how sharp or flat the curve of the cut off is. That 
way you can set the graph to cut off higher or lower than the default setting to 
match it better with what you are hearing on a track.  
  
Using the LPF on your bass and kick will help to keep the bass and kick from 
bleeding over into the mids and mudding them up. You have to listen to the track 
by its self when setting these to really hear what's happening then with the mix to 
see how it sits in the mix. 
  
Using the HPF on you cymbals, lead guitars, higher vocals etc can also help to 
keep the mids from sounding muddy.  
  
The BPF can be used on instruments that are in the mids like rhythm guitars and 
other instruments but I would adjust it a bit more open than the default. 
  
Using the BEF for finding bad frequencies such as hums and noises will help to 
clean up any problems in a signal and eliminate it. Also you can use it on a Bass 
or kick to carve out an area for one or the other to come out in a mix. The Bass 
and kick sit in the same are of frequencies and if the kick is being hidden behind 
the bass guitar then use this on the bass and see if you can place that dip in the 
area where the kick sits, allowing it to come though the mix. 
  
These are brief descriptions of what these filters are and how to use them so 
research more about EQ in your VS manual and on line, read up on frequencies 
and where each instrument sits in the frequency range, and how others are using 
these filters.  
 
Analyzer and Freqs 
Using the ANALYZER on the UTILITY menu is another good tool for find out 
what frequency range an instrument or vocal is made up of. Click on UTILITY> 
Select Analyzer and it appears where the meters were on your HOME screen. 
The A, B, C, D stands for effects processor slots so pick an effects processor 
that’s not in used by checking the letter that corresponds then select the Track or 
Input for SOURCE ie TR1 or IN1. You should be able to figure it out easy 
enough. Play the track or if it’s an input play the instrument that’s connected to 
that input.  
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Stuff you can do to de-muddy a mix: 
#1) HPF: Use it on EVERY TRACK! Let your ears be your guide, but 
here's a rough guide to get ya started: 

 BAS - 40Hz  
 GTR - 80Hz  
 VOX - 120Hz  
 OTHER - 100Hz                           Karl Lakestone VSP 

Here’s a good link to start with about using EQ. 
http://www.trinitysoundcompany.com/eq.html  
 
Here is the bulk of the material from that web site… 
Understanding EQ and its Effects on Signals  
There are two areas of equalization that I want to cover. Those two areas are vocals and 
music. I'd like to discuss the different effects of frequencies within audio signals. What 
do certain frequencies do for sound and how we understand those sounds. Why are some 
sound harsh? Why do things sound muddy? Why can't I understand the vocals? I'll try 
and answer all of these question and hopefully bring some light to the voodoo world of 
EQ.  

   

Vocals  
Roughly speaking, the speech spectrum may be divided into three main frequency bands 
corresponding to the speech components known as fundamentals, vowels, and 
consonants.  
Speech fundamentals occur over a fairly limited range between about 125Hz and 250Hz. 
The fundamental region is important in that it allows us to tell who is speaking, and its 
clear transmission is therefore essential as far as voice quality is concerned.  
Vowels essentially contain the maximum energy and power of the voice, occurring over 
the range of 350Hz to 2000Hz. Consonants occurring over the range of 1500Hz to 
4000Hz contain little energy but are essential to intelligibility.  
For example, the frequency range from 63 to 500Hz carries 60% of the power of the 
voice and yet contributes only 5% to the intelligibility. The 500Hz to 1KHz region 
produces 35% of the intelligibility, while the range from 1 to 8KHz produces just 5% of 
the power but 60% of the intelligibility.  
By rolling off the low frequencies and accentuating the range from 1 to 5KHz, the 
intelligibility and clarity can be improved.  
Here are some of the effect EQ can have in regards to intelligibility. Boosting the low 
frequencies from 100 to 250Hz makes a vocal boomy or chesty. A cut in the 150 to 
500Hz area will make it boxy, hollow, or tube like. Dips around 500 to 1Khz produce 
hardness, while peaks about 1 and 3Khz produce a hard metallic nasal quality. Dips 
around 2 to 5KHz reduce intelligibility and make vocals woolly and lifeless. Peaks in the 
4 to 10KHz produce sibilance and a gritty quality.  

http://www.trinitysoundcompany.com/eq.html
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Effects of Equalization on Vocals  
For the best control over any audio signal, fully parametric EQ's are the best way to go.  

   

80 to 125  

160 to 250 

315 to 500 

Sense of power in some outstanding bass singers.  

Voice fundamentals 

Important to voice quality 

630 to 1K 
Important for a natural sound. Too much boost in the  

315 to 1K range produces a honky, telephone-like quality. 

1.25 to 4K  

5 to 8K 
Accentuation of vocals  

   
Important to vocal intelligibility. Too much boost between 2 and 4KHz  
can mask certain vocal sounds such as 'm', 'b', 'v'. Too much boost between  
1 and 4KHz can produce 'listening fatigue'. Vocals can be highlighted at the 3KHz  
area and at the same time dipping the instruments at the same frequency.  
Accentuation of vocals:  
The range from 1.25 to 8K governs the clarity of vocals. Too much in the area of 5 to 
16K can cause sibilance.  

   

Instruments  
Mic'ing instruments is an art ... and equalizers can often times be used to help an engineer 
get the sound he is looking for. Many instruments have complex sounds with radiating 
patterns that make it almost impossible to capture when close mic'ing. An equalizer can 
compensate for these imbalances by accenting some frequencies and rolling off others. 
The goal is to capture the sounds as natural as possible and use equalizers to straighten 
out any non-linear qualities to the tones.  
Clarity of many instruments can be improved by boosting their harmonics. In fact, the ear 
in many cases actually fills in hard-to-hear fundamental notes of sounds, provided the 
harmonics are clear. Drums are one instrument that can be effectively lifted and cleaned 
up simply by rolling off the bass giving way to more harmonic tones.  
Here are a few ideas on what different frequencies do to sounds and their effects on our 
ears.  
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31Hz to 
50Hz 

These frequencies give music a sense of power. If over emphasized 
they can make things muddy and dull. Will also cloudy up some 
harmonic content. 

80Hz to 
125Hz Too much in this area produces excessive 'boom'. 

160Hz 
to 
250Hz 

This is the problem area of a lot of mixes. To much of this area can take 
away from the power of a mix but is still needed for warmth. 160Hz is 
a pet-peeve frequency of mine. Also, the fundamental of bass guitar 
and other bass instruments sit here. 

300Hz 
to 
500Hz 

Fundamentals of string and percussion instruments. 

400Hz 
to 1K 

Fundamentals and harmonics of strings, keyboards and percussion. This 
is probably the most important area when trying to control or shape to a 
natural sound. The 'voice' of an instrument is in the mids.  

To much in this area can make instruments sound horn-like. 

800Hz 
to 4K 

This is a good range to accentuate instruments or warm them up. Too 
much in this area can produce 'listening fatigue'. Boosts in the 1K to 2K 
range can make instruments sound tinny. 

4K to 
10K 

Accentuation of percussion, cymbals, and snare drum.  

Playing with 5K makes the overall sound more distant or transparent. 

8K to 
20K 

This area is often what defines the quality of a recording or mix. This 
area can also help define depth and 'air' to mix. Too much can take 
away from the natural sense of a mix by becoming shrill and brittle. 

   
Here are a few other pin point frequencies to start with for different instruments. In a live 
sound situation, I might event pre set the console's eq to these frequencies to help save 
time once the sound check is under way. These aren't the answers to everything... just a 
place to start at.  
Kick Drum:  
Besides the usual cuts in the 200Hz to 400 area, some tighter Q cuts at 160Hz, 800Hz and 
1.3k may help. The point of these cuts makes for space for the fundamental tones of a 
bass guitar or stand up. I have also found a high pass filter at 50Hz will help tighten up 
the kick along with giving your compressor a signal it can deal with musically. 5K to 7K 
for snap.  
Snare Drum:  
The snare drum is an instrument that can really be clouded by having too much low end. 
Frequencies under about 150Hz are really un-usable for modern mixing styles. I would 
suggest a high pass filter in this case. Most snares are out front enough so a few cuts 
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might be all that is needed. I like to start with 400Hz, 800Hz, and some 1.3K. This are 
just frequencies to play with. Doesn't mean you will use all. If the snare is too transparent 
in the mix but I like the level it is at, a cut at 5K can give it a little more distance and that 
might mean a little boost at 10K to brighten it up.  
High Hats:  
High hats have very little low end information. I high pass at 200Hz can clean up a lot of 
un-usable mud in regards to mic bleed. The mid tones are the most important to a high 
hat. This will mean the 400Hz to 1K area but I've found the 600Hz to 800Hz area to be 
the most effective. To brighten up high hats, a shelving filter at 12.5K does nicely.  
Toms and Floor Toms:  
Again, the focus here is control. Most toms could use a cut in the 300Hz to 800Hz area. 
And there is nothing real usable under 100Hz for a tom... unless you are going for a 
special effect. Too much low end cloud up harmonics and the natural tones of the 
instrument. Think color not big low end.  
Over Heads:  
In my opinion, drum over heads are the most important mics on a drum kit. They are the 
ones that really define the sound of the drums. That also give the kit some ambience and 
space. These mics usually need a cut in the 400Hz area and can use a good rolling off at 
about 150Hz. Again, they are not used for power.... these mics 'are' the color of your 
drum sound. Roll off anything that will mask harmonic content or make your drums 
sound dull. Cuts at 800Hz can bring more focus to these mics and a little boost of a 
shelving filter at 12.5K can bring some air to the tones as well.  
Bass Guitar:  
Bass guitar puts out all the frequencies that you really don't want on every other 
instrument. The clarity of bass is defined a lot at 800Hz. Too much low end can mask the 
clarity of a bass line. I've heard other say that the best way to shape the bass tone is to roll 
off everything below 150Hz, mold the mids into the tone you are looking for, then slowly 
roll the low end back in until the power and body is there you are looking for. If the bass 
isn't defined enough, there is probably too much low end and not enough mid range 
clarity. Think of sounds in a linear fashion, like on a graph. If there is too much bass and 
no clarity, you would see a bump in the low end masking the top end. The use of EQ can 
fix those abnormalities.  
Guitar/piano/ etc.:  
These instruments all have fundamentals in the mid range. Rolling off low end that is not 
needed or usable is a good idea. Even if you feel you can't really hear the low end, it still 
is doing something to the mix. Low end on these instruments give what I call support. 
The tone is in the mids. 400Hz and 800Hz are usually a point of interest as are the upper 
mids or 1K to 5K. Anything above that just adds brightness. Remember to look at 
perspective though. Is a kick brighter than a vocal? Is a piano bright than a vocal? Is a 
cymbal brighter than a vocal?  

   

In Closing  
Equalizers are one of the most over looked and misused pieces of gear in the audio 
industry. By understanding equalizers better, an engineer can control and get the results 
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he or she is looking for. The key to EQ'ing is knowing how to get the results you are 
looking for. Also, knowing if it’s a mic character or mic placement problem. EQ can't fix 
everything. It can only change what signal it’s working with. Equalizers are also a lot 
more effective taking away things in the signal than replacing what was never there.  
Another link to good info on EQing… 
http://www.recordingwebsite.com/articles/eqprimer.php 
 
Here's the FREQS for each instrument, drums, vocal etc... 
Listen to a track you have recorded and if it needs more of something ie fullness or less of it then 
this list will help you to know where to find these freqs to add or cut freqs according to your own 
taste. 
  
Bass Guitar == Bottom @ 50 - 80Hz;   Attack @ 700Hz;  snap @ 2.3kHz 
Kick Drum == Bottom @ 80 - 100Hz;  Hollowness @ 400Hz;  Point @ 3-5kHz 
Snare == Fatness @ 120 - 240Hz;  Boing @ 900Hz;  Crisp @ 5kHz;  Snap @ 10kHz 
Floor Toms == Fullness @ 80 - 120Hz;  Attack @ 5kHz 
Toms == Fullness @ 240 - 500Hz; Attack 5 - 7kHz 
HiHat & Cymbals == Clang @ 200Hz;  Sparkle @ 8 - 10kHz 
Congas == Ring @ 200Hz;  Slap @ 5kHz 
Elec. Guitar == Fullness @ 240 - 500Hz;  Presence @ 1.5 - 2.5kHz 
Acoustic Guitar == Fullness @ 80+Hz;   Body @ 240Hz;  Presence 2 - 5kHz 
Organ == Fullness @ 80+Hz;  Body @ 240Hz; Presence @ 2 - 5kHz 
Piano == Fullness @ 80=Hz;  Presence @ 2.5 - 5kHz, Honk @ 2.5kHz 
Horns == Fullness @ 120Hz; Piercing @ 5kHz 
Voice == Full @ 120Hz;  Boomy @ 240Hz; Presence @ 5kHz; Sibilance 5kHz;  Air @ 5 - 10kHz 
Strings == Fullness @ 240Hz;  Scratchiness @ 7 - 10kHz 
 
Compression on Bass Guitar 
Threshold: -4dB 
Ratio: Between 2.5:1 and 3:1 
Attack: Between 40 ms and 50 ms 
Release: About 180 ms 
Gain: Adjust to taste, don't need too much but even out the in and out meters if you can. 
The Higher the ratio, the louder it may sound as well. 
 
Nothing is set in stone here, every bass and player is different. 
 
By Lakestone Karl on VSP 
Here's my latest bass EQ scheme: 
 
RECORDING (INPUT MIXER): 
I use the DI'd BASS PATCH on the -2 card. 
I also use a "USER PATCH", a PEQ set up for My Bass.  
HPF @ 40Hz (for 4-string bass, 32 Hz for 5-string bass) 
 
PLAYBACK: 
I use the COMPRESSED BASS PATCH on the -2 card. 
HPF @ 40Hz (for 4-string bass, 32 Hz for 5-string bass) 
LoShelf -3dB @ ~250-300 
LoMid -2dB @ 120Hz 
HiShelf (if needed) 
 
After you set this much up, raise the Q of the HPF to restore the very low end of the bass. 
 

http://www.recordingwebsite.com/articles/eqprimer.php
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By Waterman on VSP 
I always HPF the bass starting 40Hz, lately I've been going as high as 60hz (but that's because 
I've been doing an acoustic 3 piece with no drums). 
 
Most bass mud is in the 250-500hz range I'll notch that out a few db.  
Attack or pluck is increased at 700 to 1k 
Bottom added at 60 to 80 Hz 
String noise at 2.5k 
boost added around 1 to 2k 
 
compression: 
2.5 gain 
threshold 17db 
attack 7ms 
release 233ms 
I never use autogain, I set that by ear and also watch the meter to see much I'm compressing the 
signal. 
 
 
SIDE CHAINING                                                    by headwerkn2 on VSPlanet 
Within the Channel or Track View screen you can select the side  chain input to 
the compressor - on the Roland VS is this called Key In. Obviously Roland 
couldn't call it "Side chain In" because that would have been too logical ;-) 
 
This from the VS2480 manual (VS2400 is similar except it doesn't have the 
EXP+COMP option). 
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This is the VGA view (from the VS2400 manual) 
 

 
 
By default it's set to the actual input you're editing eg. track 1 for track 1, etc. 
etc. so that the compressor is operating off its source signal - usual compressor 
operation. You can adjust the Key In input to another track, which will give you 
a side chain type setup. 
 
For example, if you wanted to use the Kick Drum on Track 1 to compress the 
Bass on Track 7 so the kick 'punches through' the bass - a pretty typical 
dance/techno effect that also works well with rock drums - you'd set KeyIn on 
Track 7's compressor to TR 1. The kick's attack will then trigger the bass's 
compressor. 
 
The track being used to control a compressor doesn't need to be audible and 
can exist solely to control another track's compressor. If you don't want to 'lose' 
a playback track solely for side chaining another track's compressor, you can 
set Key In to an Input channel and sequence or play in real time the 'keying' 
track from another source, like a keyboard or even an oscillator/sound 
generator to create tremolo effects. 
 
Another use is 'look ahead gating', where a gate effect (EXP) is triggered by a 
copy of the track being gated that is moved ahead a few milliseconds... this 

http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Number=1106171&gonew=1##
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way the gate itself opens just before the attack of the source material, 
allowing strong/effective gating without affecting the transients adversely. 
Most newer compressor plug-ins actually have this option inbuilt now. 
 
http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Number
=1106171&gonew=1#UNREAD 
 
 
 
 
 
 
 
 
  
 
 

http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Number=1106171&gonew=1#UNREAD
http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Number=1106171&gonew=1#UNREAD
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ERASE SILENT PARTS          By Frank Griffith 
Once you are through recording all of your tracks you might have places in 
between vocals and lead guitar solos that you want to get rid of, erase them 
from the background to eliminate the extra room noise. A simple way to do 
this is to…. 

1) Left Click and hold the cursor at the beginning of the piece of track to 
erase… 

2) Drag the mouse to the left, to the end of the piece to ERASE and then 
let go… 

3) Place the mouse cursor in the highlighted area of the piece to erase… 
4) Right Click and select ERASE from the drop-down menu. 

 
To get a more precise edit point for placing the IN and OUT  points, select 
the TRACK so it is highlighted then…. 

1) Place the time line on your IN point and PRESS the WAVE DISP 
button, check that your IN point is in between beats and not on a 
signal, a quiet spot, Press WAVE DISP to zoom back out… 

2) Now we’re on full screen, JOG the time line to the OUT point and 
PRESS the OUT button, the check it on the WAVE DISP again and 
back as above… 

3) Click on TRACK> and select REGION ERASE and a window opens 
4) Click on “F1 Sel Trk” and in the next window… 
5) Place a check mark in the box next to the Track number you are 

ERASING from… 
6) Now click “F5 OK” and answer YES to “REGION ERASE Sure?” it 

will display “Done.” 
7) To shut the REGION ERASE window click on “F6 EXIT” and you’re 

done. 
8) Click HOME to get out of the WAVE DISP display. To CLEAR out 

the edit flags HOLD the CLEAR button and PRESS the IN, OUT and 
TO buttons and the flags are gone. 

 
If you had trouble jogging in small enough increments you can go to the 
TRACK TIME DISPLAY area of the HOME screen and with your mouse 
click on one of the 2 digits to move the yellow under-line from “h” to “m” to 
“s” to “f” to jog in hours, minutes, seconds or frames. Frames are good for 
the smallest increment. You can also PRESS on the left & right CURSOR 
buttons above the jog wheel to do the same. Another reason to erase the 
silent spots is to get rig of any noises the singer made or guitarist in between 
parts. If this leaves a void in the mix then record a whole track of the mic at 
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the same level the singer sang at and edit that in later to add space to the mix 
without the noise of the singer grunting, coughing or breathing. You would 
be surprised at what does get recorded between segments like this. 
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VS with External Effects Units from VSP By Karl & Others 
All I want to do is record vocal tracks 3-4 thru my external effects and 
back into the 2480 on trks 7-8 using a wet and dry signal input. I want 
to use trks 23-24 for the effects and trks 3-4 (orig dry signal). Then 
rec them both to trks 7-8. So therefore I have the dry signal recorded 
with the wet signal on 7-8 trks.OK, try this.... 
 
Reply 
You have dry tracks on 3/4, and your FX coming in on 23/24. You 
want to mix them to 7/8. 
 
OK, first select Fader Bank TR1-16. Press and hold the Track Status 
button over Fader7 until the EZRouting screen is displayed, and all the 
buttons begin to blink. 7/8 don't blink, cause that's your chosen 
destination track pair. 
 
Now, press the CH EDIT button over Track3. This connects Track3/4 to 
Track7/8. 
 
Now, while the buttons still flash, select FaderBank IN17-24, and press 
the CH EDIT button over Fader23. Now, both Track3/4 AND 
Input23/24 are routed to Track 7/8. Exit the EZRouting screen. 
 
That's it, you're there! No AUX busses required! Simply record on 7/8, 
dry volume on 3/4, wet volume on Input23/24. 
 
Notice you are NOT actually recording the Wet signal by itself, and are 
NOT using any Track Mixer channels for the Wet signal. 
 
 
 
 
More on External Effects 
I want to route recorded tracks 1-8 (drums)out to a pair of dbx 160x 
comp/limiter. Via a pair of stereo buss's hit them fairly hard and then 
route back into a pair of tracks and tuck them underneath the original 
tracks. However getting a little confused here in terms of how to get 
the original tracks to a pair of buss's. Thanks 
 
 
Reply By Karl 
First step is to LINK a pair of AUX busses. Go to the MIXER->MASTER 
EDIT menu, and LINK AUX3&4, for example. 
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Now go to each of the 8 drum tracks, and create a mix that will feed 
the outboard gear, using the AUX3/4 SEND and PAN controls. 
 
In the OUTPUT ROUTING area, drag the AUXA_LR_OUTPUT to the 
AUX3&4 buss. Connect the AUXA_LR outputs to your outboard gear. 
Remember that the AUX3/4 MASTER FADER will also control the mix 
going to the outboard gear. 
 
Explained Again by Karl 
You treat the OUTPUT OF THE EFFECT the same as any other input. 
Bring it in thru an input channel, either thru an analog or digital input. 
If all you want to do is have the XFX appear on the MIX bus, all you 
need is the MIX button turned on for whatever input channel(s) you 
have used. If you wish to print the FX to a track(s) for further 
processing, then you must record it, just like any other input (synth, 
etc.) 
 
Now, getting the signal from the 2480 to the XFX kind of depends on 
what you are sending. If it's only a single track, you can use the 
DIRECT outs in the CH.EDIT screen. But if it's a group of tracks, you 
will need to use an AUX buss to sum the tracks and send them to the 
XFX. Either way, you connect one of the ANALOG OUTS to either the 
selected DIR or AUX buss. 
 
By Karl one more time… 
By default, AUXA and AUXB outputs (Output jacks 3, 4, 5, and 6) are 
routed to AUXBUSS1, 2, 3, and 4. Confusing. 
 
So I go in to the EZ ROUTING screen, in the OUTPUT ASSIGN section, 
and connect AUXA to AUX3/4 and AUXB to AUX5/6. Much easier to 
understand. 
 
OK, so now, on the kick drum channel, when you raise the AUX4 
SEND, the kick goes out JACK4 in the back of the 2480. You can send 
as many thing as you wish out JACK4 at the same time by adding 
other tracks via their AUX4 SEND levels. 
 
Bring the FX back into an input channel, just like you would a mic or 
synth. You can choose to print the FX return, or simply allow it to 
enter the mix via the INPUT channel. 
 
External Effects by Calypso on Virtual Planet. 
It is just like using an internal effect, but you need to route the AUX 
bus to one of the analog outputs, run a cable to your effect, run a 
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cable from the effect output to one of the analog inputs (1-16), and 
route that input to an empty recording track. Now you can "SEND" 
signal to the AUX bus and it will return to a new recording track. 
 
To avoid feedback, turn off the "MIX" button on the INPUT channel 
where the effect comes back into the 2480. (The input channels send 
signal to the master bus mix when the machine drops out of RECORD 
mode.) 
 
To use the effect purely as an insert, turn off the "MIX" button on the 
dry track you are using as the source - then you will only hear the 
return track with the effect already applied in the mix. (In this case 
you will probably be sending all of the signal to the AUX bus.) This is 
preferred over using the "solo" button. 
 
The internal effects have their own "busses" inside the machine which 
makes it simple. An external effect has to come back through an 
INPUT channel before it can go to a new recording track. Once you get 
that INPUT leveled, removed from the mix and routed to an empty 
recording track then everything is golden. 



To turn the faders On or off…  
Go to UTILITY menu>  MIDI PARAMETER> LOCAL CONTROL> SW [On/Off]. 
VS2480 Faderboard Part # 71561767 
         
<<<<<<<<<<< Threads & Info on cleaning, repairing and replacing faders 
>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>> 
Searched VS2480 Forum, Past 5 years, “Faderboard” in Subject and Body. 
 
Seunity on VSP… 
http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Number
=831954#Post831954 
 
I've done the manual cleaning like suggested in earlier threads here.  
 
Remove the slider knobs (!), turn the VS around and open the bottom plate. 
Unscrew and remove the faderboard carefully, paying attention to the three 
connections on the edge of the board; the wires are short so don't yank the 
board out too hard. This all is easy enough to do. 
 
For the actual cleaning I used cotton swabs, Q-tips, anything small enough to 
get to the the tracks inside the fader housing. I used PRF 6-68 "dry" cleaning 
solvent for the first round and applied just a tiny dab of PRF 7-78 lubricant 
after that. You have to be careful to not leave any pieces of cotton etc. inside 
the housing while cleaning, this could just make things worse. 
 
From about 10 sticky faders that I had, I was able to cure 8 like this. Not totally 
smooth movements, but not sticking that bad either. 
 
Later on I went in the second time, trying to fix the two faders which were still 
acting up, but couldn't make any difference with further cleaning. There was 
not even any kind of dirt coming up this time around. 
 
 
Worth to notice; the driver belts which actually move the faders will wear out 
eventually. I noticed several which were loose or had worn gearing, quaranteed 
to slip at some point. Unfortunately there seemed to be no way to tighten the 
belts to fix this. 
 
When I finally got compressed air in spray can, I went in the 3rd time. This is 
what messed up the whole faderboard! All of a sudden I got several more 
faders which were all over the place, not moving much anymore or not getting 
into exact spot, slippin past or lagging behind etc. Based on these experiences, 
I would certainly warn against some procedures, like Frank already said. 
 
In the end I contacted the Roland service here and found out that they won't 
sell you the whole faderboard. For that you'd have to have a broken board, not 

http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Number=831954#Post831954
http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Number=831954#Post831954


just the faders. What they will sell are the individual faders, of which there are 
two types; with longer and shorter housings. That means some soldering but I'm 
ready, as soon as they'll get the faders in. 
 
 
<<<<<<<<<<<<<<<<<<<<<<<<<<<<<UPDATE On FADER 
REPLACEMENT>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>> 
Update on fader replacement. 
 
I finally got the faders from the Roland service and did the job. Two types of 
faders, 8 and 9 pieces. There are total of 204 connections to be desoldered, 12 
on each fader. 
 
Desoldering went fast until I ran out of rosin braid and had to use no clean wick 
for the rest. All in all it took about 6 hours to take out the old faders and 
solder the new ones in. 
 
When done I noticed something which is worth mentioning, since this might 
trouble others as well. While most of the new faders really snapped into their 
positions fast and easy, there were two which were still sticky, pretty much 
like they were before the replacement. Taking out the fader knobs I noticed 
that the shafts of those two were leaning pretty close to the edge of the panel. 
So when the knobs were in place, they would rub against the panel, thus 
making them sticky! All the other shafts were more or less in the middle of 
their panel cutouts, all fine there. 
 
I went back in to check my work, but all the faders were set pretty much level. 
So what I did is, I desoldered those sticky faders and tilted them a little bit so 
that I got the shafts to line up more in the middle. Reassembled, everything 
worked fine. 
 
I don't know if the front panel is offset a little from the fader board or what it 
is, but since there are so many parts and boards piled up in the box, there 
certainly is a chance of having some of them misaligned. Even a little bit can 
make a difference, at least with faders, it seems. 
 
<<<<<<<<<<<<<<<<<<<<<<<<<<<<<<<Replacing the faderboard 
>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>> 
http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Board=1
6&Number=436070&Searchpage=1&Main=46858&Words=faderboard&topic=0&Se
arch=true#Post436070 
 
 
<<<<<<<<<<<<<<How much did you pay for thr faderboard its 
self?>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>> 
V Jo Go “Crystal Studios”.... 

http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Board=16&Number=436070&Searchpage=1&Main=46858&Words=faderboard&topic=0&Search=true#Post436070
http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Board=16&Number=436070&Searchpage=1&Main=46858&Words=faderboard&topic=0&Search=true#Post436070
http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Board=16&Number=436070&Searchpage=1&Main=46858&Words=faderboard&topic=0&Search=true#Post436070


It took me an hour >> just to study the diagram, of all the screws to remove 
(thanks to FRANK) I figured I could complete the job in 6 hours, and then not 
sure it would be operational...I paid nearly $500 with shipping ... 
>>>>>>> 
Jim Sharp...... 
Frank, I paid $289 from bmp music.com There was no shipping charge. The new 
faders work fine. Now I'm cleaning up the hard drives on both of my 2480s and 
tomorrow I'll switch over the 3 card and put the one with the new faders as my 
primary unit. It's the one with the DVD burner. The one I've had to use over the 
summer has only an external CD burner. 
>>>>>>> 
C Jo Go... 
I think I may try the next time ---there are maybe 30 screws ~~ with 12 varities 
....but there is just one ribbon and an "easy to align into place" fader ? Should 
be able to attempt that fete >> will give it a try ~~ hope to obtain another 2 
years, on this board. 
 
<<<<<Thread on Sticky Faders and Cleaning 
them>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>
>>>> 
http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Board=16&Number
=408966&Searchpage=1&Main=44111&Words=faderboard&topic=0&Search=true#Post
408966 
AND another... 
 
<<<<<< FADER MAINTENANCE 
>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>
>>>>>>>>>>> 
http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Number=1099564
&gonew=1#UNREAD 
 
 
 
<<<<<<<<<<<<<<<<<<<<<<<<<<<<<Where to get the fader board for $300? 
>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>> 
http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Board=16&Number
=386405&Searchpage=1&Main=41912&Words=faderboard&topic=0&Search=true#Post
386405 
>>>>>>> 
Slobbermonster.... 
CRAP DUDE just order the fader board for $300 from Roland and swap the 
whole board, faders and all. 
 
The only thing attached to the board is a ribbon cable. It's so simple an 
operation that anyone who can run a screw driver can do it. No soldering and 
no sweat. And it only takes about an hour. 

http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Board=16&Number=408966&Searchpage=1&Main=44111&Words=faderboard&topic=0&Search=true#Post408966
http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Board=16&Number=408966&Searchpage=1&Main=44111&Words=faderboard&topic=0&Search=true#Post408966
http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Board=16&Number=408966&Searchpage=1&Main=44111&Words=faderboard&topic=0&Search=true#Post408966
http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Number=1099564&gonew=1#UNREAD
http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Number=1099564&gonew=1#UNREAD
http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Board=16&Number=386405&Searchpage=1&Main=41912&Words=faderboard&topic=0&Search=true#Post386405
http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Board=16&Number=386405&Searchpage=1&Main=41912&Words=faderboard&topic=0&Search=true#Post386405
http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Board=16&Number=386405&Searchpage=1&Main=41912&Words=faderboard&topic=0&Search=true#Post386405


 
Do the guys "fixing" yours provide any vaseline? 
 
 
<<<<<<<<<<<<<<<<<<<<<<<<<<<<<<<<<<<<<Fader 
Calibration>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>> 
>>>>>> 
Poplikecrazy.... 
Had this same problem Larry, luckily doing a fader calibration at startup solved 
the problem in my case " One thing to try...calibration. When you boot it up 
hold down PAGE + F1. Then select Fader Test. You'll see all the faders center, 
then go up and down one at a time. "...heres a link to previous post 
http://www.vsplanet.com/cgi-
bin/ubb/ultimatebb.cgi?ubb=get_topic;f=16;t=014078 (link does not work) 
 
This should be enough info to help. 
Frank. 
<<<<<<<<<<<<<<<<<<<<<<<<<<<<<<<<<<<<<<<<<<<>>>>TURN OFF 
FADERS>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>> 
 
UTILITY Menu> MIDI PARAMETER >> LOCAL CONTROLL SW>>> (OFF/ON) 
 
<<<<<<<<<<<<<<<<<<<<<<<<<<<<<<<<<<<<<<<<<<<<< VS FADERS ARE 
60MM>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>> 
 
They are regular 60mm motorized faders. 
IC704-720 are BA6208F-E2 motor drivers which will move the faders as 
commanded from the various screens. 
IC701-703 are TC74HC4052AF CMOS circuits routing the fader values (resistive 
load affecting the voltages) back to the system. This is the information system 
will use to decipher (show in the screens) what is or should be the current 
fader position (dB value). 
VS2480 Faderboard Part # 71561767 
 
 
 

http://www.vsplanet.com/cgi-bin/ubb/ultimatebb.cgi?ubb=get_topic;f=16;t=014078
http://www.vsplanet.com/cgi-bin/ubb/ultimatebb.cgi?ubb=get_topic;f=16;t=014078
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INSERT EFFECTS     By Frank Griffith 
PRESS IN 1-16/Solo button, above the master red fader. Now your faders 
are set for INPUTS. If you are adding an EFFECT on INPUT #1 then 
PRESS the CH-Edit button above fader #1. The page with EQ and 
Compression graphs on it will fill the screen. Below the Compression graph 
is where you will find the INSERT EFFECT FX1 thru FX8. If you are using 
the EFFECTS Processor #1, then click on FX1 once. (It has 4 positions) You 
want the first. See NOTE below for more on these buttons & positions.  
 
Now Patch in your EFFECT by clicking on EFFECT> then EFFECT1> a 
window opens, select the "F" button for PATCH, now in this window, 
highlight the effects patch you want to use and click the "F" button for 
SELECT> then EXIT> twice. 
 
Now click HOME and above the red master fader, PRESS IN 17-24/AUX 
MST and make sure all AUX FADERS are set to 0db, then PRESS TR 17-
24/FX RTN button and make sure all of the FX RTN faders are set to 
0db(especially the one you are using, fader FX1 for EFFECT1).  
 
Now, when you record INPUT number one to any TRACK, the EFFECT 
Patch you select to use, like reverb or a vocal multi, will be printed to the 
TRACK. How do you route and input? Click on EZ Routing> Routing 
View> and on the left hand side of the screen find INPUT MIXER with 1-
24. INPUT one can be clicked on, it'll turn blue and the other end of it can 
be dragged to and of the RECORDING TRACKs 1-24 below the INPUT 
MIXER. By default INPUT 1 is connect to RECORDING TRACK 1, 2 to 2, 
3 to 3 etc. Once you connect you input where you ant it click HOME and 
arm your track to record and record the INSERT EFFECT with your tracks 
now. 
 
Make sure the effect you are inserting has not been LOOPED in the EZ-
Routing screen. Go to EZ-Routing> Routing View> and under “TRACK 
ASSIGN” you see the FX RTN Block with 1 thru 8 they match EFFECTS 1 
thru 8, disconnect the FX RTN that matches that effect’s number you are 
inserting if it’s connected to the destination track. For more on this and 
LOOPED EFFECTS see “VS EFFECTS.doc.” 
 
NOTE: The two BLUE BARS to the right of the YELLOW effects button, 
you click on to turn the effect on, can be clicked on and held, then you can 
push the mouse up and down to adjust the SEND or the RETURN LEVELS 
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of the effect. Also, below the YELLOW buttons where the patch number of 
the effect is displayed, you can click on that to open the effect’s window for 
patching and editing effects. Clicking on the YELLOW FX buttons runs it 
thru 4 positions Ins., InsL., InsR. and InsS then to OFF. 
 
Ins. The channel’s signal is processed by both sides of the stereo effect. 
InsL. The channel’s signal is processed by the Left side only. 
InsR. The channel’s signal is processed by the Right side only. 
InsS. The channel’s signal is processed by the Left side and then the Right 
side. I use the first setting for a full stereo effect sound. Splitting the effect 
up into Left and then Right allows you to use the same insert effect on a left 
track and then on a second Right track. 
 
*See VS manual for list of which are Insert vs. Looped effects and when and 
why to use them. Mainly, reverbs, choruses and delays work best LOOPED. 
To use one INSERT Effect on 2 different tracks you have to select the InsL 
position on the effect for one track and InsR on the effect for the other track. 
This way you can setup all 8 Effects to use 2 Mono INSERT Effects in each 
instance for a total of 16 INSERT Effects. 
 
NOTE: VS8F-2 cards fill up 2 Effects under EFFECT. Effect1 thru 8 equals 
four of the VS8F-2 Cards 1 thru 4, or Slots “A” thru “D” inside the unit 
under a back panel. EFFECT1 thru 8 equals AUX1 thru 8 and FX RTN1 
thru 8. Some EFFECTS use up the whole card but most are mono. You can 
select them as left & right and split up the effects into a total of 16 effects.  
 



 1 

VS Install HD in VS2480CD 
First, you need to download the “Converting VS2480CD to DVD” PDF 
from this link... 
http://www.rolandvs2480.net/VS2480CD%20to%20vs2480DVD%20Conve
rsion/Convert%20your%202480CD%20to%20a%202480DVD.htm 
The hard drive and the CD burner are in the same caddy inside the 
VS2480CD model VS. This PDF will guide you step by step thru the 
process of removing the VS CD models back cover and caddy all with detail 
pictures and info. 
 
Briefly: 
1) Flip the VS over onto a pillow on top of a table and remove all of the 
screws from the back cover and use an egg carton to keep the different size 
and threaded screws in, you will need a medium and very small phillips head 
screw driver. 
2) Once inside the VS locate the caddy that has the hard drive and burner 
mounted in it and remove the screws holding the caddy in the VS. 
3) Unplug the data and power ribbons from the caddy and work on the caddy 
separately so you do not risk dropping any screws inside the VS. 
4) Remove the old hard drive from the caddy and replace it with the new 
hard drive. Make sure to set the pin to master just like the old drive. Some 
times it can be hard to get the new hard drive in place in the caddy. Also, do 
not strip the small screws and only tighten them hand tight.  
5) Now plug in the ribbons and mount the caddy back in the VS, put on the 
back cover and screws and flip the VS over to format the hard drive. 
 
FORMAT A NEW HARD DRIVE 
Once it’s installed, turn the VS on and watch the small 3” x 4” LCD on the 
VS and answer the prompts using the ENTER/EXIT buttons, “F” buttons 
under the screen and the jog wheel. You can do a “Quick” format with a new 
hard drive but it’s recommended to do the following:  
 
First you’ll see “Formatted Drive Not Found, Force Initialize? 
Press ENTER for YES then you have to Select Drive, IDE 0 and then 
Partition size 10GB, Check “Physical Format” and surface scan “ON”. I 
think you use the jog wheel to highlight items and the ENTER to select and 
the “F” buttons to page through the menus. It becomes logical as you do it 
and finally you select “OK” and it’ll ask you twice if you want to do this, 
answer “YES.” These instructions are brief but I added them from memory. 
It’ll take about 6 ½ hours for 80GB and double that for 120GB. 

http://www.rolandvs2480.net/VS2480CD%20to%20vs2480DVD%20Conversion/Convert%20your%202480CD%20to%20a%202480DVD.htm
http://www.rolandvs2480.net/VS2480CD%20to%20vs2480DVD%20Conversion/Convert%20your%202480CD%20to%20a%202480DVD.htm
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Brand hard drives and Specs. 
Just about any brand name should work with the right specs. 
Seagate Barracuda is one of the best, Maxtor, Western Digital, Hitachi 
Deskstar, IBMs etc. 
Specs:  40, 80, 120GB hard drive, 7200RPM, 8MB Cache ( 2MB & 16MB 
has worked), ATA/100 or 133 interface and this is important, less than 10ms 
average seek times. So in a nut shell use a hard drive with these specs. 
*7200RPM, 8MB Cache, ATA/100 or 133 with less than 10ms average seek 
times. 
VSPlanet Thread with a list of hard drives that have worked for others... 
http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Number=677261&fpart=1 
AND 
http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Board=16&Number=976890&Search
page=7&Main=47033&Words=Hard+drive&topic=0&Search=true#Post976890 
Good luck, Frank. 
 
 

http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Number=677261&fpart=1
http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Board=16&Number=976890&Searchpage=7&Main=47033&Words=Hard+drive&topic=0&Search=true#Post976890
http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Board=16&Number=976890&Searchpage=7&Main=47033&Words=Hard+drive&topic=0&Search=true#Post976890
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VS LEVEL SETTINGS From Post On VS-Planet 
…………………………………………………………………………….. 
Question: What meters do I watch during recording??? 
…………………………………………………………………………… 
Reply: I set the INPUT and TRACK faders to 0db then I use the SENS 
knob and PAD to set my levels and start with the INPUT meters by 
clicking on the "F" INPUT then "F" IN MIX" then once that's set I click 
on the "F" TR MIX" and then record. Try to shoot for -12db on the 
meters.  
 
The Track has to be armed to get a meter reading. I read some where 
that you should use the PAD and keep the SENS as low as possible 
when setting the levels. Then you can use the PRE and POST buttons 
to switch back and forth from INPUT and TRACK Meters to make sure 
you’re no going over any where. Leave it on POST for recording and 
mixing. 
………………………………………………………………………………………………………………… 
Reply: look at your eq/dyn screen under the compressor, is the auto 
gain button on? If so that is what’s pushing your levels up on the track 
mixer. Most folks turn the auto gain off and use the manual gain 
"knob" right under the button. 
Always watch your input meters when your tracking, you don't want 
those clipping. 
As far as your guitar re-amping goes, look at the eq/dyn screen again 
for that channel and there is a "mix" button on the right side of the 
screen, I think its above the "virtual" fader. That button will take that 
track out of the playback mix. 
…………………………………………………………………………………………………………………. 
Reply: yes but 
your compressor is after the input peak light and before the recorder 
so yes you have to watch both meters. 
………………………………………………………………………………………………………………….. 
Reply: Also remember that if you use compression on the input you're 
stuck with it because it will be printed to your track. 
And Mike's warning about the dynamics can really get you in a mess if 
you don't watch it (check meters post and pre often). 
I always adjust comp for bass on the track channel while I'm tracking 
(if I use it) to hear what it would sound like, but it doesn't get 
recorded with the track so you can change it later if you choose. 
 
Frank's got the right idea here, keep the input faders at 0db and 
adjust the pre (sens) levels. 
Set the meters to ANALOG INPUT so you'll know what's actually 
coming in (use INPUT MIXER if altering input channels). Use the pads 



 2 

as needed. 
The track levels are basically for monitoring purposes while you're 
tracking. Think of the 2480 in separate sections; 
Use the pre's across the top with the input mixer at unity gain (0db) 
when tracking. 
 
INPUT MIXER to apply effects, EQ and dynamics while tracking (if you 
want to, but remember you're stuck with whatever you do here). 
 
TRACK MIXER to apply effects, EQ, dynamics and level adjustments for  
monitoring while tracking and final mixing. 
………………………………………………………………………………………………………………….. 
quote:  

 
Originally posted by What does this button do?: 
When I'm recording, which level do I need to pay the most 
attention to?  

 
Reply: There's a lot of info in these replies, but it's spread across 
three or four of them. 
 
Assuming you're using ONLY the 2480, things to remember are in the 
order of the 2480's internal signal chain. Each stage and process must 
stay below the clipping point, and the addition of every change to the 
original signal should slightly change those levels at the next tier. 
 
Each stage is critical, starting with the INPUT. 
If analog, you must adjust the INPUT using the SENS knob while 
viewing the INPUT meters. Keep the signal well below clipping and 
make sure you know if the clip indicator is set at -6dB, -3dB, or 0dB. 
 
Next, you'll need to set the INPUT MIXER levels using the fader sliders. 
This is also the level adjustment when using a digital source. View this 
level/adjustment by selecting the INPUT MIXER and the POST level 
position. This will ensure the actual levels being recorded are not 
clipping. The INPUT MIXER in POST is what's being recorded.  
 
You can flip back and forth between PRE and POST (without touching 
the INPUT MIXER faders) to see if you have any changes in levels. 
However, this can be difficult to do with constantly changing source 
levels. But, it can also help to identify if you have dynamics, EQ, or 
effects accidentally (or intentionally) turned on. Once they're printed 
to the track, you'll have to live with them. 
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Don't be fooled by the audio output of the TRACK MIXER and faders in 
TRACK mode. These sliders change NOTHING in regards to what's 
being recorded. They only modify the audio output that your hear. 
 
Lastly, just remember that it's easy to overlook unwanted items in the 
signal chain, and double check your settings with use of the PRE and 
POST meters, as well as your ears. 
…………………………………………………………………………………………………………………. 
 
What you have is an INPUT MIXER and a TRACK MIXER and the signal 
path is pretty much the same for both. 
 
INPUT to SEN+Pad to IN Meter> 
TRACK to Phrase parameter >  BOTH FOLLOW THE PATH OF……. 
DYN Meter IN> Dynamics Block> Level> DYN Meter OUT> EFX Send 
Inserts 1 thru 8> EFX RTN> ATT knob> EQ Meter IN> EQ Block>EQ 
Meter OUT> Aux Sends Pres 1 thru 8> Pre Fader> Post Fader> Aux 
Send Post 1 thru 8. 
 
Setting Levels for Mastering 
With the 2 card, in the MTK MixDown patch, P231, I never use the soft 
clip. I use the EQ, compression, and the limiter on that patch if 
needed.  
Here's what I do to get the levels hot at the end. 
First of all make sure none of your track levels are going over 0db, 
bring your track levels down so that hottest track is below 0db and you 
have some headroom, it's best that your not slamming the master 
buss, and never have your master fader below 0db. You will see where 
the master levels are at, I try to get the master level peaks as close to 
0db even if that means raising the master fader, (this is of course with 
the MTK inserted), I use the limiter set at -1db to get the occasional 
spike. 
So far no problems getting my CD's to sound pretty close to 
commercial, but you have to realize they really slam these new CD's 
with compression to get them loud, I'd rather have a great sounding 
CD than one that's loud. 
Pete on VSPlanet 
 
VS8F-3 card & Plug-ins for Mastering. 
I have the VS8F-3 card and use the same settings in it. It seems to 
work much better than the VS8F-2 card’s MixDown patch. All of the 
MTKs on the 3card sound better and do a better job of mastering, 
IMO. Also, T-Racks for the PC has many Presets that sound good and 
really add that market CD compression some like. I hear that the VS 
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version of T-Racks can do the same for you. Buying the VS8F-3 card 
and plug-ins like T-Racks and the UA Bundle can really add a lot of 
options for mastering as well as better recordings of individual tracks. 
The MTKs on the 3 card also fill up your screen with all of the 
parameters so that it is much easier to understand and use. Frank.  
 
Mastering to send to a Mastering House 
If you’re recording tracks and mastering your stereo pairs without 
MTKs to be sent out to be mastered by a professional then you need to 
record your tracks at lower levels and mix at lower levels. Record 
between -12 to -6db and mix every thing at those levels then run the 
master red fader a couple db below zero as well. Also, the less 
compression you use, the better. This will leave HEADROOM for the 
mastering houses to work with. Maybe send a test mix first to see if 
they can work with the mixes you are doing before mastering them all. 
 
Recording a click track 
Go to UTILITY menu> Select the Gen/OSC screen and turn it on, then 
go to EZ Routing> Routing View> and route the output of the 
GEN/OSC to a free tracks and record enable, arm, that track. 
Page 288 in the VS POWER book. Frank. 
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VS  MASTERING CDs FOR THE NEWBEE 
Mastering should be the process of just adding the icing on the cake, polishing up the 
mastered mixes. Making them sound better and putting them in the best listening order on 
the CD. You could take your mixes to a mastering house but in today’s world with this 
technology at you finger tips, you can do a decent job as well. You just need some simple 
guidance, IMO. Also see my “VS MTK USE .doc” using the VS’s Mastering Tool Kits to 
get the most out of your mixes. 
 
*Before getting to the mastering stage, it’s very important that you record all of your 
tracks at consistent levels so songs are at consistent levels in the mastering stage. I always 
setup my VS with all faders at 0db and use only the SENS/TRIM knobs and PADs to set 
my recording levels so that none are below -12db and the peaks go no higher than -4db. 
When I get to the mastering stage in the VS I like to use the “Mixdown” patch in the 
MTK to master my stereo pair of tracks. Learn how to use the MTKs and you can get a 
good and loud enough CD out of the VS.  
 
*You need to make sure you have a treated room to mix your songs in and good set of 
flat frequency response monitors. Check these sites for info on treating your room. 
www.auralexuniversity.com and www.acoustics101.com . For monitors in the $1,000 
range check out Dynaudio BM5A’s and Adams A7’s. Now onto mastering the whole CD 
project. 
 
*Trim al1 of your mastered tracks. Make sure the fade outs are good and don’t have dead 
air space at the beginning or end of your songs. Don’t have a second of silence before the 
track begins or at the end. The VS can add that silence between each track automatically 
using TAO or if you use DAO and have to set the track markers yourself, set those 2 
seconds apart and have the track start playing in a split second, 10 or so frames of a 
second before the song begins! 
 
*Pacing the CD’s track order. You need to organize the tracks in a good order to set a 
good flow from track to track. Make a rough CD and listen to the songs in random order, 
see what songs sound best together. Arrange the keys of the songs in ascending or 
descending order and see what they sound like. Try not to have 2 songs in the same key 
together. Some songs may sound good in pairs so consider putting them together or even 
cross-fading from one to the next. 
 
*Decide if you want the song order to build or taper off. Do you want the CD to start off 
slow and build or to build excitement at the start with fast tempo songs and get faster 
with each song after? You could then back off with slower tempos to end on a calmer 
tempo. It’s all up to you and what sounds best with your songs.  
 
*Always lead off with your best songs, especially if this is to be used as a demo CD to 
shop around. If you don’t get their attention with the first song and hook, you have lost 
them, IMO. Also, keep your songs short, 2:30 to 4:00 is a good length. My motto is 
always leave them wanting more! 
 

http://www.auralexuniversity.com/
http://www.acoustics101.com/
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* You can normalize all of your songs if you want using NORMALIZE in the VS or in 
some PC programs but it’s important to make sure all of your songs on your CD can be 
listened to with out having to adjust the volume knob of the player. Master them all at a 
consistent level. If a softer song doesn’t sound loud enough and you can’t get the volume 
up, then use dynamics to help it to sound louder. Add some compression to the Mastered 
V-Tracks if needed and re-master. 
 
*Check your CD’s volume levels by comparing them with market CDs. Pick a market 
CD in the same style of music your style is and see if your CD is in the same volume 
range. If yours is louder that’s OK but if your CD’s over all volume is lower then you 
will want to go back and re-master them with the MTKs. Some times it’s best to burn the 
first mastered song to CD and check it with a market CD before mastering them all. 
 
*If some of these tips don’t work for you, no problem, just use them as guidelines and do 
the best you can. Remember, less is more. Get your tracks right in the mix so you don’t 
have to try and fix it in the mastering stage. 
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"OK, here's how to get you Mix to CD...I'll assume you have a VGA monitor.... 
 
Go to CD-RW MASTERING->MASTERING ROOM menu item. The "Mastering Room" is 
displayed. 
 
Click the Mastering Room OFF button to ON. 
 
Change the STATUS to RECORD. 
 
Set CDR REC MODE to ON. 
 
Select the VTRACK PAIR on which you wish to record. 
 
Set AUTO MARKER to ON (if desired). 
 
Set the AFTER REC to "to Last Phrs:4s". 
 
If desired, and an FX engine is available, you may insert an MTK patch in the Mastering Room. 
 
That's the setup. Now run your mix while RECORDING in the Mastering Room. Place the 
Mastering Room in PLAY mode after recording. 
 
This method produces 16-bit CDR-ready tracks. There are variations of this method for other 
purposes." 
  
then he came back later and answered; 
 

    "OK, one error on kirk's part....the MasterPair is the same VTrack# on both 23 and 24. Initially it 
is set to VTrack23/24.16. You can change the VTrack number to 15, but it will effect both Tracks 
23 & 24. It's like linking stereo tracks, the VTrack# is the same for both. OK? Good. 
 
Now, the way I detailed produces 16-bit audio. BUT, if you leave the CDR MODE button OFF, the 
Master Tracks are created in the native format of the project (24 bit!). Just like any other stereo 
pair. In fact, you can exit the Mastering Room, select VTracks23/24.16 (or whatever), and play 
the mastered mix as a regular stereo pair. 
 
Now, hopefully, you have saved that mix as a SCENE. Cause now that it is mixed, you no longer 
NEED those FX to be what they were. You can un-assign all the FX, and invoke an MTK patch 
for the Mastering tracks/24.16 through the MTK, with CDR MODE ON, recording them to 
VTracks23/24.15!!!! 
 
I hope you followed all this. It's a 2-step process. MASTER your MIX in 24-bit mode with full FX. 
Then, "MASTER" that stereo mix thru the MTK to create a "MASTERED" 16-bit CDR version." 
  
.........the mtk patches on the vs3 really give it a different overall sound. i unassigned the effects 
and saved 3 scenes using different mtk patches but some of them seem to add distortion. i'm 
going to be a better writer than engineer until i get better recording techniques.  
...........same thing everyday here about this time. bad storm and lightning. gotta unplug the puter 
till it passes. later....... kib 

By Karl Lakestone on VSP 
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MASTERING TRACKS & BURNING TO CD USING TAO 
At this stage of the process we want to create a stereo mix of our 
Project/Song so we can later, burn them to a Master CD-R or RW. Some like 
to use CD-R Mode but that turns your stereo pairs into 16bit masters that 
you cannot listen to until you burn them to a disk or import them to a CDR 
Mode project. I was taught not to use CD-R Mode so the mastered pairs stay 
in 24bit so that I can then listen to my final mixed pairs before burning them 
TAO (Track At Once) to disk. Now for mastering, if you want to use an 
MTK (Mastering Tool Kit) then patch that into an effects processor now, it 
will use up both sides of the effects process, one full card. Then we begin 
with mastering your mix. Leave your meters on “F3 TR MIX” for now at the 
bottom of the HOME screen, if you do not see this click on the page button 
on the right hand side of the task bar. 
 
Go to CD-RW/Mastering> Mastering ROOM> now the METERS area on 
the HOME screen becomes the Mastering room. Click Mastering Room to  
“ON”, it’ll turn yellow. Your tracks will be grayed out. Click the STATUS 
button from GREEN/PLAY to RED/Record and the color comes back to 
your tracks.  
 
Now, in the V.TRACK window you should see V-Tracks 23/24-16. That’s 
the pair of V-Tracks you are recording this song’s mix too in stereo. (You 
can Click on 23/24-16 if you want to select another pair of V-Tracks to 
record too if these have a previous mastered pair on them. If this is your first 
time then leave it as is, 23/24-16 is the default.) It’s important to make sure 
you know what V-Tracks you are using here, there are 16 pairs of 23/24. 
 
If you have an MTK (Mastering Tool Kit) patched into an EFFECT like 
EFFECT1 then click on FX1 to turn it yellow and add that MTK to the mix. 
Click nothing else! No Auto Marker or CD-R Mode. After Rec. should read, 
“to ZERO” as default. 
 
Now press the PLAY button and set your Master Levels to 0db or slightly 
under, watch you master meters so they do not go over to 0db. Once your 
levels are set press STOP and cue up your tracks where you want the 
recording to begin. (You can also edit you MTK here as well. Bring up the 
EFFECT that has the MTK patched into it and click on EDIT and adjust the 
parameters while your master tracks play). I usually have a LOCATOR 
button setup to this point and press that locator number to go back to. (To 
use a LOCATOR just place the TIME LINE where you want it and press 
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one of the 0 thru 9 buttons. It will light up and any time you need to jump to 
this point just press it again. To clear it, hold CLEAR and press it again.)  
 
Now press RECORD & PLAY and MIX your song live, watch your master 
meters.  (*If you need to see your TRACK METERS then click “F6 EXIT” 
at the bottom of the screen to EXIT the mastering room and watch your 
track mix meters. Remember, we left them on “F3 TR MIX” at the 
beginning. Before the end of the song you can click on CD-RW Mastering> 
Mastering Room to bring the Mastering Room back up at any time while 
recording your mix.) Now fade out at the end of the mix using the RED 
MASTER FADER and press STOP. 
 
Now press the ZERO/Back button, bring up the Master RED Fader to 
Unity/0db, click on the mastering room’s STATUS button to GREEN/PLAY 
and press the PLAY button to hear what you recorded. The tracks should be 
GRAYED out again and music playing. If you don’t like the mix PRESS 
UNDO and you’ll see “Master Rec” in the small window, PRESS ENTER. 
Now do the MIX over.  
 
You can also open the effects and select a different MTK patch if you want 
while in the Mastering Room.  If you have the mastering Room “ON” and 
STATUS green to PLAY with the tracks GRAYED out, you won’t hear 
them if you press PLAY on the VS. You can either turn the Mastering Room 
“OFF” or click STATUS red to REC to PLAY the mastered tracks.  
 
* If you have problems with the volume levels you can use the two blue 
lines on the inserted MTK in the mastering to boost the signal. To the right 
of the yellow FX block are two lines, the top blue line is for boosting/cutting 
the level of the mix coming into the MTK and the bottom blue line is for 
boosting/cutting the level coming out of the of the MTK. Click on one of the 
blue lines and use your value dial on the jog wheel to set levels. 
 
If you’re done, then you can leave the Mastering Room as is and move on to 
the next Project/Song or begin the burning process. I usually leave the 
Mastering Room as is so I can jot down the Master V-Tracks numbers 
during the burning process and keep track of which pairs I used on each 
Master CD-R or RW. I always hear something wrong with one of my songs 
and have to re-master. Sometimes you can do this 3 or 4 times before you’re 
satisfied with your final mixes. Press SHIT+STORE and SAVE project! 
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NOTE* If you don’t have an effect’s processor open for using the MTK 
because you have used all the effects up in your project you can do one of 2 
things. Either bounce tracks that are using up one of the effects cards to 
other tracks recording the effects with the tracks to new tracks OR you can 
master the project in the mastering room WITHOUT an MTK so all effects 
are recorded with the project to a stereo pair and then master the stereo pair 
in the mastering room using an effects MTK. 
 
BURN TO CD (Save the project before burning!) 
To burn these Projects/Songs to CD, be at this stage in the Mastering Room, 
Mastering Room ON and STATUS Play. That’s why I left mine that way in 
the last stage of mastering my Projects/Songs. The Mastering Room defaults 
to 23/24-16 after every burn so make sure you select the right 23/24-V-
tracks to burn to disk, in the next window. 
 
Selecting the V-Tracks in the CD-R Write window, you have the LEFT side 
of the pair on top with the RIGHT side of the pair underneath the LEFT. I 
always click L-Click on the LEFT side pair to adjust the V-Tracks because 
the RIGT side will follow suit with the left. If you adjust the RIGHT side, 
the LEFT will not move and you could wind up with a song on the left 
speaker and a different one on the right! It’s happened to me so make sure 
you have the right, LEFT & RIGHT V-Tracks! 
 
Click CD-RW Mastering> select CD-WRITE, store current? Click “YES” 
and the INSERT a blank CD-RW or CD-R. The CD-R WRITE window will 
open. Make sure your V-Tracks 23/24-16 are shown in the L-Ch & R-Ch 
windows, (Check the window to be sure the right, Left and Right 23/24-V-
Tracks are selected here.)  
 
Select “FINALIZE” to “OFF”, “WRITE METHOD” to (TAO)Track At 
Once, “SPEED” to MAX and click “OK” to burn. NOTE! If you do not have 
other Master Tracks in other projects to add to this CD then click 
“FINALIZE” to “ON”. If you do have more leave it “OFF” until the last 
song’s Master Tracks are ready to burn. This will close the CD so you can 
play it in a CD Player. Then click “YES”, “ENTER” and “YES” to burn. 
 
If you forget to turn “FINALIZE” “ON”, on the last song’s Master Tracks to 
the CD, then stick it back in and select “FINALIZE” to “OnlyFin.” For 
finalizing ONLY. Now it’s ready for playing and copying with PCs to be 
played in stereos. Also, a message comes up asking you if you want to 
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“Write Another CD” and you answer “NO.” This happens after burning a 
TAO song to disc. What it’s asking is if you have another CD you want to 
write this same song to besides the one you are working on. If you are 
burning only one song to disc then follow these steps and “Finalize” the CD. 
 
DIGITAL COPY PROTECT 
To lock and protect the Master Song CDs you burn go to  UTILITY> Project 
Parameter> and Turn “Digital Copy Protect” ON. This will protect your CD 
so that others can not RIP songs off of your CD using Nero, Roxio, 
Windows Media Player etc. 
 
NOTE: If you want to record your Master Tracks using CD-R Mode and at 
16bit you can use the VS manual to find out more about it. It makes your 
mastered pairs 16bit, 44.1k so you have to create a new empty CD-R Mode 
project and IMPORT the mastered pairs into that CD-R mode project from 
the other project to burn them to disc in .cda format. The IMPORTING 
process is explained in detail in “VS MST DAO.doc.” Your 16bit CD-R 
Mode mastered pairs will not playback in a MTP, 44.1k , 24bit project, 
that’s why I keep them 24bit.You can also use the mastering room to create 
sub-mixes and use Track Exchange to move the sub mix to new tracks in the 
project. See my “VS SUB MIX.doc” for more on this. 
 
Mastering 24bit 96k Projects 
It's a work around just using the 2480 for sample rate conversion. 
Let's say you have a beautiful 12 track 24 bit 96K mix and want to burn it to 
CD. Simply mix down to the mastering room with CD-R Mode=off. Then 
perform a Track Export of those two tracks. This will create a stereo 24 bit 
96K .wav File on CD-R or CD-RW. 
 
Then create a new project in CDR mode, 16 bit 44.1k, and use .wav import 
to grab the mix. The 2480 automatically converts the sample rate to match 
the new project! 
 
This is also a great way to get from one recording mode to another, MTP to 
MT1 etc. 
By Laura Tyson 
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MASTER DAO               By Frank Griffith 
Master CD “Disc At Once”, 24bit When songs are mastered without CD-R 
Mode, one song per project do this! 
First create a new EMPTY or MTP 24bit Project with the Name being the 
name of the CD. Once this is done it’s time to use the TRACK IMPORT 
feature to IMPORT all of the Mastered V-Tracks from all of the 
SONGS/PROJECTS that are to be on this CD.   
NOTE: If your mastered pairs are CDR Mode with Auto-marker then the 
New Master Project must be CDR Mode 16bit.  
 
With the NEW Master Project Open 

1) Click on TRACK> select TRACK IMPORT, a window opens with a 
list of all of your songs on your hard drive on that partition. 

2) Now Select the first song to go on the CD, a rectangular box will 
surround it, 

3) Click “F5 Select” to get to that song’s mastered V-Tracks, a new 
TRACK IMPORT window will open. Notice the track’s title is there 
and two areas, SOURCE   and Destination. 

4) In the SOURCE window click on the scroll bar’s UP and DOWN 
arrows to find the Mastered pair of V-Tracks. Make sure the first 
song’s LEFT V-Track is selected and appears in the small rectangular 
window under SOURCE. We can only Import one side at a time. The 
RIGHT V-Track will have to be done by it self next. So…select “23-
16:V. T23-16” first! “24-16:V.T24-16 next time around. 

5) Next, we have to select the DESTINATION track to send the 
SOURCE V-Track too. In the DESTINATION window, make sure 
that “1L-1:V.T 1-1” is selected and appears in the Destination 
window. It should be there this first step. If not, use the UP and 
DOWN scroll arrows to select it. Clicking on them moves it 1 track’s 
full 16 V-Tracks at once. 

6) Now click the “F5 OK” button and answer “Yes” to Are you Sure and 
“YES” to Store Current Project. A progress window will appear. 
When done, move on. 

7) Now Track# 1 has the Left track of the song IMPORTED to it. Click 
TRACK> TRACK NAME> and select “F1 NAME” and name it the 
title of the Song. Click “F5 OK” and then click “F5 EXIT” 
NOW……REPEAT STEPS 1 thru 7. This time IMPORT the R side 
V-Tracks to TRACK 2 in this project, then LEFT then RIGHT etc.   
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Once you have IMPORTED all of the SONGS LEFT & RIGHT V-Tracks, 
one at a time, into this project we need to line them all up on the same pair 
of tracks. We will use Tracks 1 & 2. To make it easier to move them we will 
do it in pairs so let’s go to the CH-Edit page of each odd number pair of each 
song.  

1) PRESS the CH-Edit button of TRACK #1 and click on “CH 
LINK”, it should turn yellow. It’s below the ATT knob on the 
left-hand side of the screen.  Now PRESS the CH-Edit button 
of TRACK #3 and click it’s “CH LINK” button on, then repeat 
for TRACKS #5’s & #7’s etc.  Once they are all linked, we 
need to move the LINKED PAIRS of all SONGS to TRACKS 
1 & 2. 

2) Click HOME and now PRESS the ZERO button.  To perform a 
REGION MOVE, 

3) PRESS the IN button, now JOG to the END of the second song 
on tracks 3 & 4, position the RED time line at the END and 
PRESS the OUT button 

4) Now lets position the RED time line 3 to 4 seconds PAST the 
first song on TRACKS 1 & 2 and PRESS the TO button plus, 
press LOCATOR # 1. This will send the BEGINNING of the 
SONG on 3 & 4,  2 seconds AFTER the END of the second 
song on TRACKS 3 & 4. Once all edit points and the first 
locator button is set. 
* Note* Some place tracks as close as 2 seconds apart but some 
CD players can’t find tracks that fast so I suggest you use 3 or 4 
seconds between songs. 

5) Click TRACK>, at the top of the screen, and select REGION 
MOVE> , the REGION MOVE window opens… 

6) Click “F1 Sel Trk” to select the TRACKS to move, in this 
window select TRACKS 3 & 4, since they are linked, placing a 
check mark in the odd number, automatically check marks the 
even one. We are moving TRACKS 3 & 4 to TRACKS 1 & 2. 

7) Now, with the JOG wheel dial in TRACKS 1 & 2, just turn in 
counter-clock-wise till it no longer changes. That will be 
TRACKS 1 & 2’s first V-Tracks where the FIRST song is.  
When ready click on “F5 OK” and answer “YES” to the 
prompts. 

8) This will MOVE the SECOND song on TRACKS 3 & 4 to 3 or 
4 seconds after the END of TRACKS 1 & 2. Now you need to 
repeat steps 1 thru 7 for the rest of the songs. Send the THIRD 
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song on Tracks 5 & 6 to 2 seconds PAST the MOVED second 
song that was on TRACKS 3 & 4 but now on TRACKS 1 & 2. 
And so on and so on.  *You will be pressing IN, OUT, TO & 
the next LOCATOR not lit up, on each song’s pair of tracks. 

 
Once all of your SONG’S LINKED TRACKS are REGION MOVED to 
TRACKS 1 & 2 we need to use the LOCATORS you placed, with each 
SONG’S press of the TO button, to place our CD track markers so players 
can find each individual track on the disk. The first song on TRACKS 1 & 2 
does not need one, it will be automatically placed by the CD-R Write 
process. Now….. 

1) PRESS LOCATOR #1 (for the beginning of song #2) , Now set TIME 
on seconds, just click on the “s” for seconds and turn the jog wheel 3 
or 4 clicks back to lay a track marker 3 or 4 seconds before the song 
begins.  
NOTE* If you used 4 seconds between the songs in the last procedure 
then that should leave you one second after the first track/song ended 
and 3 seconds before the second track/song begins. If you used 3 
seconds of space between the songs then click it back just 2 seconds, 
leaving 1 second after the first song and 2 seconds before the next 
song begins.  

2) Now, HOLD down the CD-RW button and PRESS the TAP button, a 
BLUE down arrow TRACK MARKER will appear above the tracks. 

3) PRESS LOCATOR #2 (for the beginning of song #3), JOG 2 or 3 
click back and HOLD the CD-RW button down and PRESS the TAP 
button, repeat this process until all of the songs have a BLUE CD-RW 
marker at their beginnings. Once they are all done we can MASTER 
the CD. 

 
MASTER THESE SONGS TO CD 

1) Click on CD-RW MASTERING> and select CD-R WRITE, answer 
YES to Store current Project, you will see NOW WORKING………..,  

2) INSERT a BLANK CD-R in to the CD bay,  the CD –R Write 
window will open 

3) Select TRACKS 1 & 2 in the L-Ch SOURCE TRACK &  the R-Ch 
SOURCE TRACK area, 

4) Under FINALIZE, I select ON with a check mark, I’m told it’s not 
necessary but to be safe I do anyway, 

5) Under METHOD Of WRITE, select “Disc At Once” 
6) Under SPEED, select MAX and click 
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7) OK….Audio CD Write? Answer “YES”,  License agreement? Answer 
“YES” etc.. and you will see a progress window “MAKE IMAGE.” It 
took about 15 minutes for my 8 songs to go thru this step then it 
changes to “CD Write DAO” for a couple more and EJECTS the CD. 
Done!  

Doing my non-CD-R Mode Mastered V-Tracks with DAO (Disc At Once) 
seemed to take just as long, if not longer, than doing them TAO (Track At 
Once). CD-R Mode knocks them down to 16 bit also. Mastering them this 
way keeps them at 24 bit until they hit CD-R Write window, then the CD-
Write method turns them into 16bit CD Audio. If you were to transfer them 
to PC thru an RPC-1 card or other audio cards, they can be kept at 24bit in 
PC aps like Sonar, Cubase and Wave Lab. Total process took about 50 
minutes. 
 
Karl’s Project Split and Combine process basics. 
You want to create 24bit Stereo Mixes of each song. This mix should be on 
it's own VTrack (naturally). 
 
In each project, perform a PROJECT SPLIT of the 24bit Stereo Mix only. 
This yields one project with only the stereo mix per song. 
 
In each of these projects, move the Stereo Mix to the same virtual Track 
Pair, at ZERO. All these files must be on the same partition. 
 
Open the project that is the song you want to be first on the CD. Select 
PROJECT->LIST from the Menu. MARK both the current project, and the 
project that is the second song, and choose COMBINE (F4 on page2). This 
adds the second song to the first. 
 
Repeat this until all the songs are in one project. You can then master the 
project as a CD. 
 
*You can also do this another way. If you have most of your songs in one 
project you can master them to V-Tracks on 23/24, then Region Move them 
all to one set of 23/24 V-tracks, add the CD-R+TAP track markers and then 
select those V-tracks to be burned DAO, “Disc At Once” in the CD-R Write 
window. If you have other songs mastered tracks in other projects you can 
use TRACK> Track Import> to import them to the V-tracks in this project 
and they will import after what ever song is on the V-tracks. This means you 
can import them in the order you want them to appear. Them move them to 
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leave 2 seconds (or however long you want) in between them and add the 
CD-R+TAP track markers and burn DAO. If you record your master tracks 
with CD-R Mode, then they are linked automatically and I am told they will 
burn to CD faster. Thing is, they all have to be in CD-R Mode to burn them 
DOA or all not! The bit rates and sample rates must match. 
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Master Fade-Out Auto-mixing Step-by-Step:                       By Karl Lakestone on VSP 

 Hold SHIFT and press AUTOMIX. In the AUTOMIX setup dialog, unclick PAN, and set 
the MASTER to RECORD. All other items should be at IGNORE status. Close this dialog.  

 Go to the start of your song, or a second before the start. Hold SHIFT and press the 
Tr17-24 FX RET/MASTER EDIT button. Make sure the Master Fader is set to Unity. 
Close the Master Edit dialog.  

 Hold REC and press AUTOMIX to enable Auto-mix Recording. Hold AUTOMIX and press 
TAP to take a SNAPSHOT of the Master fader at Unity to start the song.  

 Move to where you want the Fade-Out to begin. Press IN and take another SNAPSHOT 
(both needed for the Gradation process)  

 Move to where you want the Fade-Out to end, move the Master Fader to Infinity 
(OFF). Press OUT, and take another SNAPSHOT (again both for the Gradation 
process).  

 Choose the UTILITY->AUTOMIX EDIT menu item. Notice how the Playlist Area changes 
to darker colors, indicating AUTOMIX EDIT mode.  

 Above the list of track names, choose MASTER from the first drop-down list, and 
LEVEL from the second. A single track should become visible in the playlist area, this is 
your Master Automation track. You should be able to see both your IN and OUT points 
on the screen.  

 Press F3 to SELECT the area between IN and OUT. The area becomes highlighted.  
 Press the yellow GRADATION button, located very close to the WAV DISP button. You 

should see the fade out represented on the screen. 

 
Make sure to set the Master back to Auto-mix PLAY mode to test your work. 
By: Lakestone Karl on VSPlanet.com 
 
 
 
AUTOMIX Volume and Pan on a Track or Tracks 
 

1) At the top of the HOME screen under the date there is a [A] button. Click on it to turn 
on AUTOMIX. It will turn YELLOW and so will all the track’s smaller [A]’s next to the 
mute and solo buttons on screen. The CH-Edit buttons will turn YELLOW as well. 

 
2) Now click on the track or track’s YELLOW [A]’s to turn them RED to ARM them to 

record auto-mix data. *(Red for record, Yellow for ignore & green to play). 
 

 
3) Now back at the top of the screen click on the black dot record button next to the [A] 

auto-mix button and turn the black dot RED for RECORD. 
 
4) Now you’re ready to record auto-mix on the tracks you have the smaller [A]’s set to 

RED. PRESS the PLAY button on the VS and record your VOLUME/Fader  or PAN/knob 
movements and when you are done PRESS the STOP button on the VS. Then 
ZERO/Store button to return to the front of the project. 

 
 
5) Now click on the track’s smaller [A] or [A]’s to turn them GREEN for PLAY and you can 

now PRESS the PLAY button on the VS and see the Volume and/or Pan knobs move. 
 
• Notes: There is an UNDO arrow to the right of the auto-mix record button so if you 

don’t like what you recorded you click it and start over. 
 
• Also, under UTILITY> AUTOMIX SETUP>> you will see that the Volume and Pan are 

checked by default, you also have several other items you can check mark for 
recording auto-mix with ie EQ, Mute, Aux Sends etc... 
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• Even though all tracks you did not record data to have their [A]’s yellow, don’t worry, 

this means that track is to ignore auto-mix data. 
 
• To turn off all auto-mix yellow button you click on the top [A] button that is YELLOW 

and it will go gray and all the smaller track [A]’s will go off. 
 

By Frank Griffith 
 

VS AUTO-MIX 
Auto-mix automation is a pretty easy feature to use on the VS. You can use 
different actions to perform on all tracks or just one or a few at a time. You 
can use auto-mix to record all of your fader movements and other changes 
you make with your tracks to have a hands free mixing when recording your 
masters. 
 
Auto-Mix Panning 
OK, let's Auto-mix Track1 from L63 to R63, starting at 10seconds and 
ending at 15seconds (short song)..... 
 
Place locators or markers on or at 10 and 15 seconds, so we can get 
there quickly and accurately. 
 
First, let's limit our work to the PAN settings. Hold SHIFT and press 
AUTOMIX, then make sure only PAN/Bal is selected in the WRITING 
PARAMETER. Set the AFTERPUNCHOUT to "KEEP". Close this screen. 
 
Now turn Auto-mix ON by pressing the AUTOMIX button. Place Track1 
into AUTOMIXRECORD by holding AUTOMIX and pressing Track1's 
CH.EDIT button, turning it red. 
 
Now let's switch to AUTOMIX EDIT mode, under the UTILITY menu.  
 
Just above the Track Names, there are two drop-down menus, SECT 
and PRM. Set SECT to TRACK MIXER, and PRM to PAN. 
 
OK, so Track1 is going to start on the left, so go to the start of the 
song (ZERO), set Track1's PAN to L63. Hold AUTOMIX and press 
RECORD, or simply click on the AUTOMIX RECORD ICON on the VGA 
monitor, to put the 2480 in “Auto-mix Record Mode”. Now take a 
SNAPSHOT of Track1's PAN setting by either clicking on the icon or 
holding AUTOMIX and pressing TAP. 
 
Now, let's locate to 10seconds, where the pan will start. Once again 
we need to take a snapshot at the beginning of the PAN activity. We 
should still be in “Auto-mix-Record-Mode”, so take another snapshot. 
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While we are here, press IN to denote the start of the PAN activity to 
be automated. 
 
Now locate to 15seconds, the end of the PAN. Set Track1's PAN setting 
to R63, and take another snapshot. Also press OUT to mark the e nd 
of the PAN activity. 
 
OK, now to invoke the magic..... 
 
Make sure that Track1's play list area is highlighted. Press F3 to 
SELECT the area between IN and OUT on Track1's Auto-mix Edit 
display. Now press the GRADATION button (above the WAVE DISP), 
and select linear..., Now you have automatic panning! 
 
Remember to set Track1 back to Auto-mix PLAY mode to audition the 
edit. 
By Karl on VSP 
 
VS Gradual Fade Out Automix 
Like Mark sats, the "missing info" is that there MUST be a Automix Event at the 
*exact* START and END points of the area to which the gradation is to be 
applied. 
 
I use IN and OUT instead of Markers. The IN and OUT both NEED to be there for 
the gradation to work, anyway. 
 
Set IN to the start of the fade. Set OUT to the end of the fade. Hold SHIFT, 
press IN to return to the IN Point. Take a snapshot of the Master at Unity. Hold-
SHIFT, press OUT to return to the OUT point. Take a snapshot of the Master at 
Infinity. Press F3 to select the area between IN and OUT. Apply the gradation. 
 
Takes longer to type it than to do it! 
 
LakeStone Karl on VSP 

With a GROUP, you only need to automate ONE member of the grup, and 
they will all follow. 
 
Gigpig, GROUPS work proportionally, no worries about starting at different 
levels, they will all reach "infinity" at the same time. 
 
To use the GRADATION feature,  
 
1) Set the IN Point where you want the fade to start, and the OUT point 
where you want the fade to end.  
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2) Hold SHIFT, press IN, to return to the IN point. Take an AUTOMIX 
SNAPSHOT of the track(s) you wish to fade. 
 
3) Hold SHIFT, press OUT, to return to the OUT point. Move the desired 
Faders to Infinity. Take an AUTOMIX SNAPSHOT of the track(s) you wish to 
fade. 
 
4) Invoke the AUTOMIX EDIT screen, use you cursor to move to the desired 
track(s) and press F3 to select each track you wish to automate. The area 
between IN and OUT should become highlighted as each track is selected. 
 
5) Press the GRADATION button, select your slope (Exponention at the 
beginning, Linear, or Exponential at the End), press OK, and the 2480 draws 
nice smooth transitions for you. 
 
And another way to perform a gradation from Karl.... 
 
1)Invoke AUTOMIX EDIT. Set the TARGET if required. 
 
2) Go to where you want the fadeout to start. Press IN. 
 
3) Go to where you want the fadeout to end, Press OUT. 
 
4) Hold SHIFT and press IN to return to the Start Point. TAKE A SNAPSHOT!! 
 
5) Hold SHIFT and press OUT to return to the End Point. TAKE A SNAPSHOT!! 
 
6) Press F3 to SELECT the REGION. The GRADATION button should now be illuminated. 
 
7) Press the GRADATION button.  

 
For me, taking the snapshots AFTER setting the IN and OUT points is the Magic Ingredient 
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Normalizing Mastered Tracks without VS MTK Inserts. 
If you are sending your master mix out to other gear or PCs for mastering the 
mastered tracks and having trouble with the Left & Right levels being un-equal 
and not loud enough you can do this. Master them without any VS MTKs then 
PHRASE NORMALIZE the master pair. Normalizing acts like a limiter and brings 
the levels up to a more even stage and can tame some peaks. 
A) Mastering room> 
Turn it on, then the PLAY button RED for RECORD and select your 23/24-16 V-
Tracks or what ever ones you want to record too. 

1) Play the auto mix tracks and set the levels on the meters, not the 
master fader, to 0db or -1db. Never light up the “OVER” RED light! 
 
2) Cue the song up to where you want it to begin recording to the master 
and press the RECORD BUTTON, on the VS and PLAY when ready to 
record the master. When the master mix is done, FADE OUT. 
 
3) Press STOP and the back to ZERO button on the VS. Now click on the 
RECORD in the mastering room to change it to GREEN to PLAY the 
master tracks. They should show up grayed out on the screen. If they 
sound good then STOP and ZERO and let's move on to the next step. 

 
B) Normalize 

1) Click HOME and go to tracks 23 & 24 and click on the "1" to open the 
V-Track map and select V-Track#16 on both tracks, 23 & 24 to bring them 
forward in the home screen like regular tracks.  
 
2) Now click on TRACK> and select PHRASE NORMALIZE> and in this 
window place check marks by 23 & 24 and click "OK". It'll take several 
minutes to NORMALIZE the pair of tracks. When done go to the CH-Edit 
page of Track 23 and click CH-Link to link them. Now, send them out. 

 
C) Norm/Masters to Outboard gear or PC 

1) Click Mastering Room to "ON" and GREEN for PLAY and the tracks 
should be grayed out. Press the PLAY button on the VS and set the 
meters to 0db or -1db but never "OVER". When the levels are set, STOP.  
 
2) Now press the back to ZERO button on the VS to cue up the mastered 
pair of normalized tracks and when you're ready to send them to the 
Avalon press the PLAY button on the VS. When the mastered mix gets to 
the end of the song…  
 
3) Watch the meters and when they go all the way down where the song 
fades out press the STOP button on the VS. Now, Zero and you’re DONE! 
*This may not be for every body but if you like the results then do it! 
Also, you can UNDO/ENTER and try again if you like. 
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PHRASE NORMALIZE 
From time to time, when I have tracks that are having LEVEL problems, I 
will NORMALIZE them. What this does is something similar to what 
compression does to a signal. It will take the track and level out the lows and 
highs in a signal. Bring the lows up and the highs a touch down on the 
peaks. When I look at the wave form visually, they look the same but 
listening to them, they sound louder and tighter. You can even do this with 
your mastered pair of master tracks if you like.  
 
To NORMALIZR a track… 
 

1.) Have the TIME LINE touching the tracks data in the home screen, 
then Click on TRACK> select PHRASE NORMALIZE> in this 
window, all track PHRASES that the TIME LINE is touching will 
show up here. 

2.) Select the track to NORMALIZE  by placing a check mark in the 
empty box to the left of it and then click “F5 OK”. 

3.) It’ll take several minutes for the VS to NORMALIZE the whole track 
and if the track has breaks in the data, you’ll have to reposition the 
time line so that it touches them as well and repeat the process on each 
one. 

 
This can be a time consuming process. Stereo tracks about 4 minutes long 
will take about 10 minutes or longer to do. Almost 3 times as long as the file 
in time. The more tracks you have, the longer it’ll take. Some like 
normalizing the master tracks instead, I can’t tell m too much difference my 
self. Always experiment with new processes and make up your own mind 
about what you like best. 
 
Sound on Sound Definition: (they spelled it with an “S”?) 
“Normalization is a digital signal processing function that's available in a lot of 
digital audio editing software (for example Sound Tools, Sound Forge, Alchemy, 
and so on). It scans through the program material for the highest level, and if that 
level doesn't reach the maximum available dynamic range, the software boosts 
the overall signal so that the peak hits the highest level possible. For example, 
suppose you record a track of music and the highest peak registers at 6dB below 
the maximum available headroom. Normalization brings the entire track up by 
6dB. (Incidentally, most normalization functions allow normalizing to some 
percentage of the maximum available level; it needn't always be 100%.) There 
are some problems, though...” 
http://www.soundonsound.com/sos/1997_articles/nov97/normalisation.html  
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Roland’s PDF on the VS8F-3 card’s Mastering tool kit can be 
downloaded from this link, great info... 
http://www.rolandus.com/uploads/CMS/Downloads/291/VS8
F3_WS01.pdf 
 
The INPUT page of the MTK has: 
 
INPUT GAIN - which controls the overall level going into the 
Multi-band Exp/Comp. This setting is very important. You 
don't want any clipping here. I usually stay on the safe side 
with at least -1dB peaks (under the top line). Average levels 
between -12 and -4 (really whatever it takes to keep it from 
going over). 
 
D-TIME (detect time)- this should be left at 10ms if you're 
using the MTK to master. It gives the MTK more time to 
"work". If you were to use the MTK as a track insert effect 
you'd need to back this off unless you wanted an audible 
delay. 
 
L-SPLIT - this is a crossover point for the low frequency 
(have you ever worked with live PA systems?). It allows you 
to pick what freq to separate the "sub" freq from the mids. 
 
H-SPLIT - this sets the freq that separates the mids from the 
highs. 
 
So, as an example, you could set the L-SPLIT to 125Hz and 
the H-SPLIT to 4K.  
This will then allow you to use the Multi-band Comp to 
compress each freq range individually. 
20Hz (or whatever you set the BCut) to 125Hz with the Low 
Comp. 
125Hz to 4K with the Mid Comp. 
4K and up with the High Comp.          From VSP 
 
SELECTING A PATCH 

http://www.rolandus.com/uploads/CMS/Downloads/291/VS8F3_WS01.pdf
http://www.rolandus.com/uploads/CMS/Downloads/291/VS8F3_WS01.pdf
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It goes something like this, say the VS8F-3 card is in slot "A" so that's 
EFFECT 1 & 2. 
1)Click EFFECT> EFFECT 1> a window opens 
2)Click "F1 Plug-in" and another window opens 
3)Select the plug-in to use by highlighting it, let's say VS8F-3 MTKs 
4)Click "F5 Select" and another page comes up.. 
5)Click "F3 Patch" and the patches open up a list of presets... 
6)Highlight one of the patches/presets and click "F5 Select" now it loads the 
plug-ins patch you selected 
7)Now you can click "F5 EXIT" and be done or click "F4 EDIT" and setup 
you patch. 
By Frank Griffith 
 
First select the MTK on the card as you normally would do.  
Above the master fader there is a button called Tr1-16 or master 
block.  
 
Press and hold down the shift button and press the tr1-16, this will 
bring up the master edit block.  
In the tabs below you will see a tab called FX Insert.  
 
Press that and select the slot that has the MTK patched in, this has 
now placed the MTK over the stereo buss.  
This should give you a clean sound? 
 
From VSP. 
 
Waterman, Pete  
Uses these settings for live recordings in the MTK. 
MTK #231 "mixdown" 
EQ on  
Low Low mid Hi mid High In gain  
gain 0db 0db 1db 2db 0db 
freq 100hz 500hz 1800k 10k Level 
Q 1.0 1.0 1.0 1.0 2db 
shelv shelv 
 
B-cut off 
Enhancer off 
 
MTk In 
In Gain D-time 
3db 10ms 
Split Point 
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Low High 
3.5Hz 3.15 Khz 
 
Expander off 
 
MTK Comp on 
Low Mid High 
Thresh Ratio Thresh Ratio Thresh Ratio 
-9db 1:3.1 -9db 1:2.0 -15db 1:2.0 
Attack Release Attack Release Attack Release 
30ms 239ms 20ms 500ms 20ms 300ms 
 
Mix/ Low 0db Mid 0db High 0db 
 
MTK limiter on 
Thresh Attack Release 
-1db 2ms 1.377s 
 
Soft Clip off 
Hope this helps, 
Pete 
 
Gaws replied… 
Also in the MTK, turn the Boost Cut "on", and set it around -25, it's been said 
that that's where the "Mud" usually is.. if'n ya gotz mud. 
 
Theotherfredolsen uses the 3card MTK & LA2A like this…. 
I just checked --- here are the real numbers for the mastering of Jimmy Got 
a Gun  
 
- 3 MTK is insert FX1 in the mastering room everything is off except 
Bass Cut - 20 Hz, Soft Clip – on, Output - 1.5 dB 
 
- LA2A is insert FX2 in the mastering room switched to compress (not limit) 
Gain Reduction switch is in the middle position between +4 and -10 
Gain – 49, Peak Reduction - 45 
 
I guess I really did use a light touch on this one. 
at mix stage I used the -2 card FX looped with varying degrees of send on 
the channels 
P000 – reverb,P001 – reverb, P003 - delay 
there were a couple of printed effects on a couple of tracks 
 
Theotherfredolson MTK & LA2A 
Try the following settings: 
In the -3 MTK (assume everything off unless I give a setting): 
BassCut - ON @ 20 Hz, SoftClip - ON 
Output - 1.5 dB (or more so that your levels are high --- near 0 dB) 

http://www.vsplanet.com/mp3s/f/fredolsenJimmyGotaGun.mp3
http://www.vsplanet.com/mp3s/f/fredolsenJimmyGotaGun.mp3
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LA2A: 
Compress/Limit Switch - Compress 
GainReduction switch - Middle position 
Gain – 49, Peak Reduction – 45 
 
LDT2 Uses the VS8F-2 card’s “Mixdown” Patch for “Commercial 
Sound” with your master CD. 
Start with the MIXDOWN MTK patch. Turn everything off and start with 
the EQ and progress thru the MTK pages. 
 
I usually just drop a couple db of low mids (around 400hz to 500hz or 
whatever's bugging me) and raise the high's a couple db. Turn the low 
cut ON at 20hz or 25hz. The enhancer's up to you if you want to 
sparkle things a bit. 
 
Now as far as levels go.... 
 
1st, try setting the INPUT level so there are no 0dB peaks (stay under 
to be safe). Set your crossover frequencies however you like ( I 
usually drop the low/mid # and raise the mid/high #). 
 
2nd, set your Multi-band Comp so you're getting around -4 to -6 Gain 
Reduction on your Mids (depending on how "commercial" you want to 
squash it). Match that Threshold setting on your lows and drop 
another 2 numbers on your highs. Also bump the highs a couple 
numbers on the MIXER after the Comp. 
 
3rd, run the OUTPUT level at +3dB with the softclip ON. This usually 
slams it up a bit. Now, the solfclip actually works quite well, but it 
limits to about -1.9dB, so, go into the MIXER menu and select MASTER 
EDIT. Then click on FX INS. Now turn the RTN level for the MTK up 
1.9dB ( I've found that 2dB puts the levels over, but use whatever 
works for you). 
This will get you up to 0dB and give you that "commerial hot" sound. 
 
Also, remember to use a comercial CD of similar style as a reference. 
VERY important. 
 
Here's a little trick... you can pull the INPUT level down and it will 
change how hard the multiband comps hit the song overall.  
 
How low did you have the gain reduction set? 
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Try starting with -15db lows, -15 mids and -17 highs. Depending on 
how much INPUT you put into that, it'll make a big difference. 
 
More recent reply by Waterman on 2card MTK 
I have 4 2-vs8f so I use those MTK's for mastering. I use pattern 231 mixdown 
here's how I tweak it. 
 
First of all you said you were using the expander, I never use it. On all the 
effects in the MTK watch your input/output gain you might be driving 
something to hard? 
 
Here's what I use: 
1.EQ on, tweak to taste, I usually cut lows and mids a bit and boost the high 
freq's for a little high end sizzle. Again, watch your input and output gain! 
2. b-cut off 
3.Enhancer off, although someone here told me I should try it, it's cool? 
4.Mastering tool kit in, watch your input gain. 
5.Expander, never use it! 
6.Compressor on, tweak to taste, I'll mess with all the settings, 
Threshold, Ratio, Attack, Release. Low freq's like fast, attack and release. 
7.Mix set as default 
8.Limiter on 
9.Soft clip on 
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VS Pitch Correction/Auto-tune   by Frank Griffith 
In order to use the VS for pitch correction with Auto-tune you need to buy and install the 
VS8RF-3 Card. See other docs in this manual for more on VS8F-3 acrds. 
 
Auto-tune plug-in Settings 
These are basic settings to use as a starting point. 

1) Select Alto/Tenor etc your vocal range and then set (L + R) to MONO. 
2) Under SCALE select Chromatic. 
3) Set the RETUNE speed between 10 to 15 
4) Set the TRACKING to 1 for Choosey 
5) Select the proper KEY of the song. 
6) No vibrato, normal setting for vibrato are Depth 44, Rate 4.6, Delay 315. 

Once you have these settings selected you can use the Tracking and Retune speed to 
adjust Auto-tune to taste. It’s best to set Auto-tune so that you hear the effect changing 
the vocal then slowly back settings down until you can’t hear the effect. If needed, you 
can run a vocal thru Auto-tune several times to correct a vocal bit by bit to avoid hearing 
Auto-tune’s effect on the vocal. 
 
VS EFFECT P022 Vocal Multi for Pitch Correction.  By Lakestone Karl on VSP 
To use the pitch shifter, you must do some auto-mixing. 
But, you should be able to HEAR the shift, anyway! 
 
I use P022:Vocal_Multi for this. 
Turn OFF everything except the Pitch Shift section. 
In the Pitch Shift section: 
    1)  Set the FX_LVL to 100 
    2)  Set the DIR_LVL to 0 
    3)  The CHROMA control shift by half-steps (chromatically). 
    4)  The FINE control gets in-between notes. 
OK, Set up a patch where you are sending the vocal to the FX as a LOOP, not as an 
INSERT. 
To audition the adjustment, it will be lots easier if you auto-mix a little first. The idea is 
to hear ONLY the original track up until the note that is bad, then switch to hear ONLY 
the output of the FX during the bad note, then switch back to the original track after the 
bad note.  
Then, you can play the section, and adjust the FX's FINE pitch control until the note is in 
tune. 
Once that is done, I'd PRINT THE FX for that note to another track. If the fixed note is 
longer than half a second, you can edit it in place. Otherwise you must either use the 
same auto-mix trick with that "fixed" track, or jump thru some hoops to perform the edit. 
If you have enough tracks to host that fixed track, auto-mixing is easier. 
 
I have used this method to fix vocals and GTR solos with great success.  
 
JJC ask Question: Karl, got it set up like you said, but am missing something on "then 
switch to hear ONLY the output of the FX during the bad note, then switch back to the 
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original track after the bad note". Am I supposed to output JUST the effect & if so how? 
I'm hearing either the tracked note or both the original note AND the patch 
simultaneously. I toggle back & forth out of the patch but can't separate them, even tried 
copying the region (it's the last note of the song....16 beats-worth) to another track. Any 
idea what I might be doing wrong? – 
 
Answer: OK, for this to work, you must send the signal to the FX "PRE" fader....so the 
FX gets the signal, even when the source channel's fader is turned down. If your original 
track is VT2, and you are using FX3 to do the shift, set the AUX3_SEND in 
CHANNEL_2 from "PST" to "PRE". 
 
All you need to do is lower the fader of the original track, and at the same time raise the 
fader of FX3_RETURN. 
16 beats? That's a long note to "fix". Hoo Boy! 
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VS PRE/POST RECORDING & MIXING                                   By Frank Griffith 
Like I’ve said before, set faders to 0db on the inputs and track faders, use the 
SENS/PAD to set your levels and use the "F2 IN MIX" for setting inputs and then click 
on "F3TR MIX" for track levels to be sure they are the same with the meters set to 
POST. Once your levels are set where the meters are running at -12db with a few 
peaks turning on the yellow lights -11db to -5db, then record your track. This will 
leave headroom for adding EQ/Dyn/Comp/EFX in the mixing stage. I set my peak 
meter at -6db. 
 
Once tracks are recorded; during mixing remember, if you click on PRE and see any 
levels going into the OVER you need to back off on EQ, COMP or use the ATT knob on 
the CH-Edit page of the tracks that are going OVER, to bring the levels back below 
OVER and 0db. *There is a separate LED that lights up for the OVER mark. 
 
Once tracks are recorded, the PRE setting shows you the level that was recorded and 
what's been added with EQ & Compression. Do not let these levels go over 0db and 
turn on the RED OVER LED or it can add distortion. When you are playing the tracks 
and watching the meters on the PRE setting you will notice that the TRACK Faders 
will not affect the level of the meters. This is normal, PRE means you are seeing the 
signal before it arrives at the TRACK Fader. The only ways to control this level is by 
pressing the tracks CH-Edit button and adjusting the EQ, Compression Dynamics 
settings, using the ATT (Attenuate) knob or editing some EFFECTS patches levels. 
 
POST allows you to use the TRACK Faders to adjust the levels in the mix after the 
signals pass thru the TRACK Fader, it does not change the recorded level at all. The 
track faders do nothing to the meters on PRE, the only way to affect that level is by 
recording it over again or lowering the ATT, EQ, Compression and/or sometimes 
EFFECTS. 
 
Sometimes it can be tricky getting the right mix while watching both the PRE and 
POST meters. Adding EQ is the one thing that can change the signal the most, then 
compression comes next and then maybe some EFFECTs patched. I usually go for 
the EQ first to see if I can cut back on it some where when I see a hot PRE meter. 
Also, the ATT knob is a good knob parameter to use when you have a problem track 
that was recorded to hot and you can not get the performer back in the studio to 
record the track again. Use the ATT knob to bring the level down below 0db. 
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Preamp Distortion Test 

NOTE: All these steps CAN be completed WITHOUT listening to anything. TURN 
YOUR SPEAKERS AND 'PHONES OFF, or WAY WAY DOWN. 
 
 
1) Go to the GEN/OSC screen under your UTILITY menu. Select a 1KHz Sine Wave as 
the "SOURCE" (by left clicking and dragging thru the options). Turn the MIX button 
OFF. Turn on Direct Out 6. Turn the OSC. ON. 
 
2) Go to the EZRouting screen, upper right quad of the screen. Connect your analog 
output 6 to Direct Buss 6. You should now have a nice 1KHz sine wave emanating from 
analog output #6. You can verify this by connecting to any external amp (KEEP THE 
VOLUME DOWN!!). 
 
3) Turn ALL the SENS knobs MAX CCW (counter clock wise), and place ALL the 
PADs IN. Connect a 1/4" TRS cable between output #6 and the input to be tested. A 2 ft. 
cable should be long enough 
 
4) Invoke the Analyzer, again under the UTILITY menu, and set it to monitor the INPUT 
UNDER TEST, meaning, dial in IN 1 thru 16 one input at a time on the Analyzer. Also, 
select A, B, C or D for the slot of the effects processor you want to use during the test. 
Effetcs 1 & 2 are slot A, Effects 2&4 are B etc.The VS8F-3 card will not work so pick a 
VS8F-2 card. Also put the PRE/POST on PRE. 
 
5) SLOWLY rotate the SENS control, while monitoring the Level on the left side of the 
Analyzer display. You should see a SINGLE VERTICAL BAR @ 1KHz in the main 
portion of the Analyzer display. 
 
6) As you continue to SLOWLY raise the input control, the 1KHz bar will grow, and 
smaller sidebars will start at 800Hz and 1.2KHz. This is Normal. 
 
i.e. this is a visual of a good: 

 
 
7) When the input overloads, all kinds of Upper Harmonics will be displayed. If this 
occurs at 0dB on the input meter, that's cool. If it occurs at -4 or -6 dB on the input Meter, 
you need the fix. 
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i.e. this is bad: 

 
 
Keep in mind, once you overdrive the input, you might not notice the distortion on that 
channel for awhile. That's the quick theory behind the "Crank". Meaning, you can quickly 
turn an input up and then back down before recording what signal is on that input and 
possibly not run into the harmonic distortion. 

Text by: Lakestone Karl 
Graphics by: Falcon Eddy & later edited by: Frank Griffith (For Newbies). 

PARTS USED by MENGES & LINKS To do the preamp fix job yourself (Copy and paste some links, 
Ctrl+ L-Click others) 

I've done three with no problems.... E-mail me if you need any help. 
RadioShack.com  
Socket... 
http://www.radioshack.com/product/index.jsp?productId=2062604&cp=&kw=socket
&parentPage=search 
 
Resistors... 
http://www.radioshack.com/product/index.jsp?productId=2062351&cp=&fbn=Type
%2F1%26%23047%3B4+Watt+Resistors&f=PAD%2FProduct+Type%2F1%26%230
47%3B4+Watt+Resistors&fbc=1&kw =1m+resistors&parentPage=search 
 
Desolder... 
http://www.radioshack.com/product/index.jsp?productId=2062745&cp=&kw=desold
er&parentPage=search 
 
http://www.digikey.com/ 
2604... 
http://www.digikey.com/scripts/DkSearch/dksus.dll?Detail?Ref=114539&Row=4863
89&Site=US 
2134... 
http://www.digikey.com/scripts/DkSearch/dksus.dll?Detail?Ref=115842&Row=5315
10&Site=US 

DWEIL’S Parts list “Pimp My VS” LINK to Post. 

http://www.vsplanet.com/ubb/ultimatebb.php?ubb=get_topic;f=16;t=018614  

From Brett’s Site…   http://www.rolandvs2480.net/  Edited to make more sense by Frank Griffith 

http://www.digikey.com/
http://www.digikey.com/scripts/DkSearch/dksus.dll?Detail?Ref=115842&Row=531510&Site=US
http://www.digikey.com/scripts/DkSearch/dksus.dll?Detail?Ref=115842&Row=531510&Site=US
http://www.vsplanet.com/ubb/ultimatebb.php?ubb=get_topic;f=16;t=018614
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VS REC & MIXING TRACKS               By Frank Griffith 
1) I record every thing between -12bd and -6db. Never below  -12db on the 
tracks. I EQ and compress bass, snare and kick the most so I record them at -
12db. On the tracks that I EQ less and want the loudest, like vocals, I'll let them 
peak no higher than the -6db mark. It just takes getting use to figuring out which 
tracks you want at what level for mixing afterwards. Also, the VS Master Bus 
does some summing of all tracks so this leaves less “Headroom” for EQ, 
Compression and Effects to be added. 
 
2) Then I mix and add my EQ, Comp & Effects to the tracks in POST. Now this is 
the important part. I then click on PRE and check all of the meter’s levels. Any 
thing that goes over 0db, I go to their CH-Edit page and I cut back on EQ and/or 
ATT knob it, the attenuate knob controls the levels before they go thru the track 
faders. Once they are all under 0db I move onto the final mixing. 
 
3) I click on POST and start with the tracks I want the loudest first, Vocals and 
Leads and get them as loud as I can without going over 0db.  Then I mix all the 
other tracks underneath those adjusting only volumes and panning and if I do EQ 
any thing, it's to cut. If I have to boost any track at that stage of the mixing then I 
go back and check the CH-Edit page and PRE levels again. 
 
4) Once I have the song the way I like it I press SHIFT+STORE and save it! Now 
I let the song sit and I take a break and come back for another listen after my 
ears have rested 15 minutes at the least and some times over night. Then come 
back and make final adjustments to the mix. 
 
5) Once I'm sure it's how I want it, I master the song and I Optimize that project. 
Once I have enough songs mastered and Optimized I do a backup of them. If it's 
really important, I do a backup of that song by it's self. Optimizing and SAVING 
projects are important. You can SHIFT+STORE any time a lot of work has been 
done that you don't want to lose and once the final mixing is done I optimize the 
project. 
 
*Note: If you set your input & track faders at 0db and use your SENS and PADS 
to set your levels they will be consistent from input to recorded track. If you 
record your signals at -12db then you won’t have to worry so much with the ATT 
knob after adding EQ and compression. Recording at -12db leaves you room for 
adding what ever you need in mix as long as it’s not an extreme amount. 
 
Panning & the Stereo Field 
Another thing to keep in mind is the stereo field. Where you place items in the 
mix helps to bring them out of the mix. If everything is panned to the center then 
you will wind up with a muddy mess. Think of the PAN knobs as being hands on 
a clock that can turn from 7 o’clock clock wise to 5 o’clock. Try to place 
instruments, vocals and drum parts through out the stereo field. A good way to 
think about where to place them is to think of a band on a stage and place them 
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where the members would be on the stage left to right. Now think of front to back. 
You can use volume to make the vocalist sound up front, the louder the closer 
and visa versa. You can also use REVERB to add distance as well. The more 
reverb, the further away an instrument sounds. Reverbs can also be used to 
emulate a space like halls, rooms, cathedrals etc.  
 
Then there’s EQ and Compression of which there are other documents on these 
subjects but briefly, compression can be used to add punch to parts of the drum 
kit and to instruments like bass to make it stand out in the mix. There is a rule 
with EQ and Compression, less is more. Mixing can be an art. It can also be a 
mater of preference. Everybody has their own way of mixing but the more they 
learn about it and the more they do it, the better they get mixing a good mix, IMO. 
 
Recently I have been mixing my tracks and using the PRE & POST fader settings 
and doing it this way might help you to mix easier. This is just another way of 
mixing and focusing more on the PRE/POST setting. PRE shows you the 
recorded track levels before they reach the TRACK FADER. POST is the level of 
the TRACKS after the FADER, meaning the FADER controls the level on the 
meters.  On PRE, the track fader does nothing to the levels but adding 
Compression and EQ does add to the recorded track level. 
 
Mixing with PRE & POST                                                     by Frank Griffith 
When recoding your tracks, you do not want your meters to go over. There is an 
"OVER" red light and I do not let it come on. Also, while recording the tracks I 
would have my PEAK HOLD set to -3db but -6db is even safer. That way, if it 
lights up I know I'm not leaving enough head room for EQ & Comp in the mixing 
stage. I try to record between -12 & -6db and use the -6db PEAK HOLD as the 
highest level that's acceptable. 
  
1. Bring all the track faders down. Set the MASTER RED fader to 0db. Then I 
start out with the drums and do each drum & percussion track one at a time by 
soloing them, then raising its track fader to around 0db. While on their channel 
edit pages I have the PRE button on. That way I am looking at what the recorded 
levels do as I add or cut EQ settings and Compression.  
  
2. Once all are sounding good one at a time, I turn them all on and go to POST 
and set the track levels so that the drums track levels sound good mixed all 
together. 
  
3. Now I add the bass track but I first solo it, bring it's track fader up to around 
0db and set the CH-Edit page on PRE and get it to sounding the best I can with 
EQ and/or Comp or none or both. Once I have it sounding good I take it off of 
solo and select POST and add it to the drum mix. Making sure the kick and bass 
is not drowning out the other and set the levels. If something can not be made to 
be heard, it's not loud enough, then lower all of the faders 2db and try again or 
add Comp or EQ or both. 
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4. Now I do the same thing with the rhythm guitars, SOLO then mix on their CH-
Edit pages with PRE on then solo off, go to POST and add them to the mix. Then 
do the same with lead guitars and last I do my vocals. 
  
5. Now is the time I start adding in REVERB to what ever track needs it and in 
what ever amounts I like. This stage can muddy up the mix if you are not careful 
so take your time and as I add reverb to tracks, I like to MUTE the others so I can 
really hear how much I am adding before adding the track with reverb to the mix. 
Just remember, LESS IS MORE. 
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Frank, here’s the doc. Karl sent me…. 
 
Region Arrange: 
These PMs are the best way, especially on weekends. 
 
OK, next time, you don’t need a new project for every song, but it will 
help ALOT to push PLAY then RECORD between songs, even for a half 
second. Even between every few songs is a benefit. 
 
The reason for this is the "non-destructive editing" as implemented on 
the 2480. Here's what happens.... 
 
The basic unit of audio on the 2480 is the PHRASE. A PHRASE is one 
continuous piece of audio on a single (or two, if linked) track. When 
you record something, all the audio from when you push RECORD to 
when you push PLAY or STOP, is a continuous PHRASE. If you were 
recording on three tracks, then there are three PHRASES, of 16 
PHRASES if recording on all 16 tracks. Got it? OK! 
 
So, if you pushed RECORD at the beginning of a set, and didn't push 
STOP or PLAY at all until the end of the set, each PHRASE you 
recorded is a whole set long! Still, it’s good with me. 
 
 
Now, let's think about what happens when we try to EDIT a PHRASE. 
Forgetting about the live project for a minute, let's just use a GTR solo 
track as an example. You started recording at the start of the song, 
but the GTR solo didn't come in until 1:45. So you decide to REGION 
ERASE the first section of the GTR SOLO track. 
 
Now, the GTR track LOOKS smaller, but is it really? Does it consume 
less disk space?? The answer is NO. Even after you ERASE part of a 
PHRASE, you can still recover it with a simple drag of your mouse. In 
fact, you can move a small slice of a PHRASE to a completely different 
track, then recover the entire phrase on the new track! Not that you 
would, but you could. 
 
OK, so let's apply this to the live project. A live set may be well over 
2GB in size! That's a lot of data to copy and backup. So, the natural 
thing to do is to make a copy of the original project, erase all but one 
song, and save the smaller project. But, beleive it or not, the PROJECT 
WILL BE THE SAME 2GB SIZE, even though only a single song is 
displayed. Not very efficient. 
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So here's how to get around it. It's not fast, but it works. 
 
First, MAKE A COPY OF THE ORIGINAL PROJECT, and edit the copy. I'd 
go ahead and PROTECT the original, so you have less chance of 
accidentally editing it. Make PROTECTED copies, then UNPROTECT the 
copy to edit. 
 
OK, now on to the business at hand. We're gonna use the REGION 
ARRANGE function on the 2480. The REGION ARRANGE function uses 
Markers, so let's drop a "000"Marker before and a "001"Marker after 
the song you wish to lift from the set. (I'm assuming these are the 
ONLY two markers in the project, if not, you just need to know what 
the markers number really are that delimit your selection. The marker 
numbers do NOT have to be consecutive.) 
 
ANYWAY, here we go. Invoke the REGION ARRANGE dialog from the 
TRACK menu. Press F1 to CREATE a region. Select 000 as the START, 
and 001 as the end, of the region (or substitute your own marker 
numbers). Press F5, NEXT. This is where you tell the 2480 WHERE to 
place that region. Just set it WAY OUT PAST THE END of any exiting 
audio, way out at 2 or 3 hours!! The exact placement is unimportant. 
Press F5 to perform the edit. 
 
Listen to the newly placed audio to make sure it is what you want, 
both at the start and the end of the song. It is better to leave it a little 
long at this point than to chop it too close.  
 
Anyway, when you're satisfied, move to the start of the newly-created 
section, and press OUT. Then locate to ZERO, and press IN.  
 
OK, here we go, no going back now....invoke the TRACK->REGION 
CUT menu item, and make sure the "AllVTr" option is set to ON. Press 
F1 to select tracks, then F2 to select ALL tracks. Now press F5 to CUT 
OUT ALL THE AUDIO EXCEPT THE RELOCATED AUDIO, thus bringing 
the relocated audio to ZERO in the process. Check it out, there should 
ONLY be the smaller section of audio showing, not the entire set.  
 
Even if you were to SAVE the project right now, it would STILL BE 
EXACTLY THE SAME 2GB SIZE!!! So now, you choose OPTIMIZE. 
OPTIMIZE will get rid of all the stuff that was CUT, leaving you with a 
single song, well less than 1GB. 
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Audio PC Setup 

This section is for anyone running a VS-2480 with the Roland R-BUS card (s). It's a 
basic setup to help you along the way to obtain audio from the 2480 to your PC and back 
again. Note that the RPC-1 from Roland is in fact designed and built by M-Audio, not 
Roland themselves. 
From this link on line… http://216.120.230.86/~rolandv/Audio%20PC%20Setup.htm 
Follow these instructions for correct installation: 
  
  
The dip – switches on the rear of the RPC-1 cards are for choosing the Clock source. In 
this case, the RPC-1 should be slaved to the 2480. To do this, the switch nearest to the 
RPC-1 cards 25 pin D-sub cable should be down, and the other switch should be up. 
  
You will need to open the RPC-1 software (Roland RPC-1 H-W) to check the about tab 
for the version number. 
It should be Version: 5.10.00.0033x6 
The Panel Version should read: 1.02.08. If yours matches, then you have updated your 
drivers correctly. The RPC-1 software (Roland RPC-1 H-W) should be in your Control 
Panel folder. You can get the latest drivers here for PC and here (both) Mac1, Mac2 for 
Macintosh - this is the latest official software update from Roland and fixes the ASIO 
distortion / sync problems for audio software using the ASIO protocol (10.11.03). Here 
are the latest Delta R-BUS drivers. Download the drivers related to your specific card 
make and model. 
  
Once you have checked for the Version in the About tab, choose the Hardware Settings 
tab and  make the following changes: 
  
Master Clock = External 
MultiTrack Driver Devices = Single and in sync (Multiple Card Sync for 2 or more RPC-
1 cards installed) 
DMA Buffer size = 384 
  
The Disable Control of…. And the Reset when idle… boxes should both be ticked. 
  

 
  
Adjust nothing else in the other tabs – they do not apply to the Roland RPC-1 card. These 
are for the M-Audio card only. 
  
You can save your setups, and I advise you to do so now. Call it whatever you want. I 
call mine RPC-1 PC Setup. 
  

http://216.120.230.86/~rolandv/old-site-content/RPC1_ver_33x6.zip
http://216.120.230.86/~rolandv/old-site-content/RPC-1_Installer_1011.sit
http://216.120.230.86/~rolandv/old-site-content/RPC-1_00C4.dmg.sit
http://www.midiman.com/
http://www.midiman.com/
http://216.120.230.86/~rolandv/old-site-content/RPC1_384ms.gif
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The External Clock Sample Rate should be set to the same sample rate as the 2480 
project you are working on. This is because the 2480 will be sending its Master Clock to 
the R-Bus, and of course your PC software. So if you are like me, this can stay at 44.1 
KHz. If you want to work higher, then you must have a 2480 project at the desired 
Sample Rate, and you must change the External Clock Sample Rate in the Roland RPC-1 
H-W each time. 
  
Remember also, that whenever you use your system, you must always turn the 2480 on 
first, leaving the PC the last thing in the chain to turn on. This is to ensure that the RPC-1 
card (s) gets the correct Master Clock. 
  
  
Now you need to go to the 2480 and check the following: 
  
Hit the Utility button and then F3 to bring up the Project Parameter page. Make sure that 
the Master Clock is set to INT. 
  
Dither and Digital Copy Protect should be OFF. 
R-BUS Coaxial Sel and R-BUS Optical should be left alone for now as they are. 
  
Still in Utility, you need to push the button for the SYNC Parameter page. Make sure the 
Sync Mode is INT. As a matter of interest, if you are running a sequencer on the PC and 
want to sync with Midi Time Code from the 2480, then make sure that you choose MTC 
in the R-BUS1 SYNC Gen. You will have to tell your software what type of 
synchronization you are using (MTC) and from where (Midi RPC-1). Then, when you 
play the 2480, as long as the Tempo of the 2480 matches the tempo of your software 
sequencer, you will see that they run in perfect sync! 
  

 
  
Remember to set up (EZ Routing) the RPC-1 inputs and Outputs on the 2480! This can 
be a bit confusing at first, but I will try and help! 
  
Press EZ Routing and View. Here, you should see that the R-Bus1 inputs are attached to 
IN 17-24. This merely means that the R-Bus 1 input is controlled by Input Channel 17, 2 
by 18 and so on. 
  

 
  

http://216.120.230.86/~rolandv/old-site-content/sync%20parameter_0001.png
http://216.120.230.86/~rolandv/old-site-content/EZ%20routing_0001.png
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Press Output. Here you can see that the R-Bus1 outputs are paired in stereo to the AUX 
outputs 1 – 8. If they are not, then move them so that they are, just for now. 
  

 
  
If you now flip to the Channel inputs 17-24, press the CH EDIT on Channel 17 and in the 
display, make 17 and 18 a stereo pair by choosing ChLINK On. This will pan them 
automatically, and put them both at 0 dB. Technically speaking, if you have set up your 
audio software correctly, the 2480 should play any signal coming from your RPC-1 to the 
speakers. 
  
With multiple cards, the RPC-1 returns from your PC/Mac can be sent to any channel you 
desire via the EZ Routing page. Generally, with my 2 cards, I send them RPC-1(1) to 
channels 9 - 16, and RPC-1(2) to channels 17 - 24. This leaves the analog inputs channels 
1 - 8 free for midi gear, FX returns etc. 
  
Don't forget that the RPC-1 cards can also be used as FX sends from AUX send to your 
music software, and back again to your input channels! Great for Reverbs etc!! 
 
From Brett’s site... 
http://www.rolandvs2480.net/ 
 
 

http://216.120.230.86/~rolandv/old-site-content/EZ%20routing_0002.png
http://www.rolandvs2480.net/
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VS File System: The VS2480 uses the FAT32 and older models FAT16 files system when formatting 
therefore making the hard drive compatible with PC setups with NTFS file systems. This means you can 
connect a VS hard drive to a PC for using various PC programs and tools to recover data from VS hard 
drives. The only unusual thing is the partition table: The VS uses up to 10 Primary Partition entries in the 
MBR whereas FAT Spec only defines 4 Primary. Therefore you will need to use a partition shuffling software 
to get to the remaining partitions. Below are examples from VSP members who reported doing this. Good 
luck, Frank.  
 
Brett’s Data Recovery renaming VR1 Song files at this link, copy and paste in a URL.... 
http://www.rolandvs2480.net/2480-
FAQs/Roland%20VS2480%20Hard%20Drive%20Recovery%20Procedure.htm 
  
VS ScanDiskinPCXP           From VS-Planet 

1. Install your 2480's HD into your computer, there should be an extra 
HD ribbon hanging from the main hard drive in your PC Tower. Set the 
PIN/Jumper on the VS hard drive to “Slave.” 
2. Boot PC to Windows XP once it’s up and running, 
3. Launch Windows Explorer to see if the drive is recognized. If so, 
continue to next step, if not then you may want to stop. 
4. Right click on the 2480 Drive> select Properties> then the Tools tab 
> Click the Check Now button. 
5. Check both boxes and then start. 
6. Wait until it is finished, may take a long time depending on PC 
speed, issues on hard drive and other problems. If it finds errors tell it 
to “Truncate” them. 
7. When finished, shutdown the PC and install the hard drive back into 
the 2480. 
8. Boot the 2480 and see if it worked. 

 
http://support.microsoft.com/kb/315265/en-us 
 
Here's the link to Microsoft’s Knowledge base site on how to run "Scandisk 
in Windows XP." It may or may not help. 
 

 
VS2480 Data Recovery                                      By Brett LaCroix 
http://www.rolandvs2480.net/2480-FAQs/2480-hangs-on-boot-up.htm 
 
Recovering Lost Songs or Directory from a Partition on the VS2480 Hard 
Drive 
 
 
First, you must remove the hard drive from the VS2480. Look closely at the 
pin configuration for your particular hard drive and note what the setting is 
for “Master” and for “Slave”.  
 
You will need to reset the “pin configuration” and hook up the VS2480 hard 
drive into your computer as a “Slave drive”. Once you are hooked up and 
your computer is turned on, make a “file folder” on the “desktop” and call it 

http://support.microsoft.com/kb/315265/en-us
http://www.rolandvs2480.net/2480-FAQs/2480-hangs-on-boot-up.htm
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“VSData” (just to keep things easy and clean). This is where you will “copy” 
VS2480 “SONG” information “to”.  
 
On the “desktop” of your computer, double click on the “My Computer” icon. 
The window will open up and show you all of the drives you have connected 
to your system. For example;  
 
3 1/2 Floppy (A:)  
Local Disk (C:) 
Compact Disk (D:) 
…etc… 
 
The VS2480 hard drive will show up as “letter! ” (IDE) drives, other than 
those listed above. (For example: partition “0” from the VS hard drive may 
be IDE (E:), partition “1” may be IDE (F:), and so on…). They may not be 
organized exactly one after another but the progressive lettering is in order, 
so pay close attention to what drive letters belong to the VS2480 hard drive. 
(Note that only the first 4 (IDE) partitions of the VS2480 hard drive may be 
listed). These new drive letters may not exceed (4), but the partition you 
need to recover is usually within the first 4 partitions anyway.  
 
When you open one of the VS2480 hard drive (IDE) partitions (that would 
not open on the VS2480), you will see a list of “file folders” like the following;  
 
SONG0001.VR1 
SONG0002.VR1 
SONG0003.VR1 
SONG0004.VR1 
…and so on… 
 
Following the SONG.VR1 file folders, there will be (14) more files in the list. 
These (14) files are what tell the VS2480 what to do with the information on 
that partition. One or more of these (! 14) files will be corrupted, and 
preventing the VS2480 from booting-up that partition, or preventing a 
specific SONG from loading.  
 
You will need to “copy” each SONG.VR1 file folder (and its contents), one at a 
time, over to the “VSData” file folder that you created on the desktop. But 
DO NOT copy the (14) files from the list following the SONG.VR1 file folders! 
 
For example: Once you have copied the SONG0001.VR1 file folder (with its 
contents), over to the “VSData” file folder, you can check the contents by 
opening the newly copied SONG0001.VR1 file in the “VSData” folder. You will 
see (21) files that look like the following; 
 
AMIXPCTL.VR1 
AUTOMIX0.VR1 
AUTOMIX1.VR1 
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AUTOMIX2.VR1 
AUTOMIX3.VR1 
AUTOMIX4.VR1 
AUTOMIX5.VR1 
AUTOMIX6.VR1 
AUTOMIX7.VR1 
AUTOMIX8.VR1 
AUTOMIX9.VR1 
COMMENT.VR1 
EFFECT.VR1 
EVENTCFG.VR1 
EVENTLST.VR1 
MARKER.VR1 
MIXER.VR1SCENE.VR1 
SONG.VR1 
SYNCTRK.VR1 
SYSTEM.VR1 
 
After the first (21) files (that will always be in every song), there will be a 
number of TK.VR1 files. These “TK.VR1” files are the actual recorded audio 
track information. The number of TK.VR1 files that appear in each “SONG” 
will vary with the number of audio tracks recorded to each particular song.  
 
TK000004.VR1 
TK000242.VR1 
TK000431.VR1 
TK000492.VR1 
…and so on… 
 
Once all of the songs from the “corrupted” partition have been copied over to 
the “VSData” file folder on the desktop, you should make sure that the 
number of songs in the “VSData” file folder are equal to the number of songs 
from the VS2480 hard drive (IDE) partition. Take note of how many 
“SONG’s” you have. 
 
Only “AFTER” you are completely sure you have copied all of the songs (and 
their contents), over to the “VSData” file folder, you can “delete” ALL of the 
SONG’s and the (14) files. But ONLY from “that” particular VS2480 hard drive 
(IDE) partition! DO NOT delete anything from any other VS2480 hard drive 
(IDE) partitions! 
 
Now remove the VS2480 hard drive from the computer and reset the “pin 
configuration” back to the “Master” setting for that particular hard drive. Re-
install the VS2480 hard drive back into the VS2480 and turn on the power.  
 
The VS2480 should load up a “song” from one of the partitions (it doesn’t 
matter which one). Go to the “Project List” and select the IDE partition where 
the corrupted files “used to be”. Select “List” and a “New” song will open up 
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and be added into that partition. This song should be “InitProj.000”. Continue 
adding “New” songs to that partition (and don’t forget to SAVE each one as 
you go), until you have reached the number of songs you previously took 
note of earlier. 
 
Once you have the correct number of “empty” songs, shut down the VS2480, 
and remove the VS2480 hard drive again. Chang! e the “pin configuration” 
over to “slave”, then install the hard drive back into the computer. Turn the 
computer on and open the “My Computer” icon. Choose the previously 
corrupted (IDE) partition from the VS2480 hard drive. This partition will now 
have a list of “SONG” file folders equal to the number of “SONG” file folders 
saved to the “VSData” file folder on the desktop. AND the (14) files in the list 
will now be “corrected” for the VS2480 to read. These (14) files must not be 
touched from here on out!  
 
Open each SONG (one by one), in order, on the VS2480 hard drive (IDE) 
partition. First, “erase” the (21) files within the song, Then “copy” over the 
contents only (21 files and the TK.VR1 files), from the corresponding SONG 
in the “VSData” file folder, into the VS2480 hard drive (IDE) partition SONG 
file folder.  
 
You are done when all of the files within each SONG from the “VSData” file 
folder on the “desktop”, are copied into each SONG within the VS2480 hard 
drive (IDE) partition. The VS2480 hard drive can now be removed from the 
computer, the “pin configuration” reset to “master”, and finally reinstalled 
into the VS2480.  
 
Turn on the VS2480 and wait for a “song” to load. Go to the “Project List” 
and choose the (IDE) partition (that you are working on), by selecting “List”. 
All of the songs in that partition should now appear. Open a song (one by 
one), in that partition, and after it has fully loaded, you must “save” it. Then 
move to the next song in the list, load it, then save it, and so on, until you 
have done this to every song in that partition. Each time you “save” the 
song, the correct “name” and file “size” will be displayed as it was before the 
directory was corrupted (preventing you from accessing the partition or 
songs in the first place).  
 
All of the songs (or partition), should now be back the way they were. 
Unfortunately, there is no other way to reorganize or rebuild the directory o! 
f a VS2480 hard drive (IDE) partition once it is corrupted. You can fool the 
SONG file by copying data into it, but the VS2480 has to “write” the directory 
information from within the machine itself. 
 
A Shortcut… 
 
If, for example, partition “1” (or any of its songs), are corrupted and there is 
no data saved on partition “2”… 
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Then (while the VS2480 hard drive is still in the VS2480), open up partition 
“2” and create a number of “new” songs. If you are unsure of how many 
songs are to be recovered from partition “1”, then always make more “new” 
songs than you would possibly need. You can erase the un-needed songs 
later on.  
 
Follow the instructions above; by installing the VS2480 hard drive into the 
computer. Copy the SONGs from the VS2480 hard drive (IDE) partition “1” 
over to the “VSData” file folder on the desktop. Then copy the “VSData” 
SONG files back into the “newly” created VS2480 hard drive (IDE) partition 
“2” SONG files.   
 
This could save one complete step and perhaps a little time, BUT only when 
you are able to access the VS2480 hard drive to begin with. If you cannot 
access the VS2480 hard drive at all, you must follow the multiple steps… 
 
ALSO,  A success story with another data recovery process. 
Thanks to all who chimed in to help me out with this one, esp. Falcon Eddy, 
Brett Lacroix, and Lakestone Karl!!! 
 
I was in a very bad place because I accidentally erased a Project from the 
Project List. Thanks to someone's recommendation, I used GetBackData for 
FAT by Runtime.org. 
I HIGHLY recommend it. It found the deleted data no problem. OF COURSE, I 
hadn't written anything to the drive partition since making the mistake of 
erasing the project. I understand that doing so makes the chances unlikely.  
 
And then, thanks to Brett's "instructions for rebuilding the Directory", i was 
easily able to throw it back on the VS drive and it was back to the pleasing 
familiar file!!! 
 
For the record, I also tried Active Undelete, but it didn't find the file, so I'd 
recommend GETBACKDATA.                                                By Kurugod 
on VSP 
 
“Accidental Project Erase” Now how Kurugod did it… 
Frank.  
I just plugged the drive into a PC and ran the GetBackData app on the 
partition. It found a bunch of deleted stuff, so I picked the folder that was 
around the same size as the directory on the VS told me it was (2.71 gb).  
To verify, I opened the SONG.VR1 file in that folder with a simple Word 
processor app. That file had the project title "ZOA" embedded in it, so I knew 
it was the holy grail.  
At that point, I had to Buy the software in order to transfer the files to the 
PC. From there, I followed Brett's instructions on rebuilding the directory, 
which I'll list below.. 
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Brett's VS2480 Data Recovery 
 
Recovering Lost Songs or Directory from a Partition on the VS2480 Hard 
Drive 
 
 
First, you must remove the hard drive from the VS2480. Look closely at the 
pin configuration for your particular hard drive and note what the setting is 
for “Master” and for “Slave”.  
 
You will need to reset the “pin configuration” and hook up the VS2480 hard 
drive into your computer as a “Slave drive”. Once you are hooked up and 
your computer is turned on, make a “file folder” on the “desktop” and call it 
“VSData” (just to keep things easy and clean). This is where you will “copy” 
VS2480 “SONG” information “too”.  
 
On the “desktop” of your computer, double click on the “My Computer” icon. 
The window will open up and show you all of the drives you have connected 
to your system. For example;  
 
3 1/2 Floppy (A:)  
Local Disk (C:) 
Compact Disk (D:) 
…etc… 
 
The VS2480 hard drive will show up as “letter! ” (IDE) drives, other than 
those listed above. (For example: partition “0” from the VS hard drive may 
be IDE (E:), partition “1” may be IDE (F:), and so on…). They may not be 
organized exactly one after another but the progressive lettering is in order, 
so pay close attention to what drive letters belong to the VS2480 hard drive. 
(Note that only the first 4 (IDE) partitions of the VS2480 hard drive may be 
listed). These new drive letters may not exceed (4), but the partition you 
need to recover is usually within the first 4 partitions anyway.  
 
When you open one of the VS2480 hard drive (IDE) partitions (that would 
not open on the VS2480), you will see a list of “file folders” like the following;  
 
SONG0001.VR1 
SONG0002.VR1 
SONG0003.VR1 
SONG0004.VR1 
…and so on… 
 
Following the SONG.VR1 file folders, there will be (14) more files in the list. 
These (14) files are what tell the VS2480 what to do with the information on 
that partition. One or more of these (14) files will be corrupted, and 
preventing the VS2480 from booting-up that partition, or preventing a 
specific SONG from loading.  
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You will need to “copy” each SONG.VR1 file folder (and its contents), one at a 
time, over to the “VSData” file folder that you created on the desktop. But 
DO NOT copy the (14) files from the list following the SONG.VR1 file folders! 
 
For example: Once you have copied the SONG0001.VR1 file folder (with its 
contents), over to the “VSData” file folder, you can check the contents by 
opening the newly copied SONG0001.VR1 file in the “VSData” folder. You will 
see (21) files that look like the following; 
 
AMIXPCTL.VR1 
AUTOMIX0.VR1 
AUTOMIX1.VR1 
AUTOMIX2.VR1 
AUTOMIX3.VR1 
AUTOMIX4.VR1 
AUTOMIX5.VR1 
AUTOMIX6.VR1 
AUTOMIX7.VR1 
AUTOMIX8.VR1 
AUTOMIX9.VR1 
COMMENT.VR1 
EFFECT.VR1 
EVENTCFG.VR1 
EVENTLST.VR1 
MARKER.VR1 
MIXER.VR1SCENE.VR1 
SONG.VR1 
SYNCTRK.VR1 
SYSTEM.VR1 
 
After the first (21) files (that will always be in every song), there will be a 
number of TK.VR1 files. These “TK.VR1” files are the actual recorded audio 
track information. The number of TK.VR1 files that appear in each “SONG” 
will vary with the number of audio tracks recorded to each particular song.  
 
TK000004.VR1 
TK000242.VR1 
TK000431.VR1 
TK000492.VR1 
…and so on… 
 
Once all of the songs from the “corrupted” partition have been copied over to 
the “VSData” file folder on the desktop, you should make sure that the 
number of songs in the “VSData” file folder are equal to the number of songs 
from the VS2480 hard drive (IDE) partition. Take note of how many 
“SONG’s” you have. 
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Only “AFTER” you are completely sure you have copied all of the songs (and 
their contents), over to the “VSData” file folder, you can “delete” ALL of the 
SONG’s and the (14) files. But ONLY from “that” particular VS2480 hard drive 
(IDE) partition! DO NOT delete anything from any other VS2480 hard drive 
(IDE) partitions! 
 
Now remove the VS2480 hard drive from the computer and reset the “pin 
configuration” back to the “Master” setting for that particular hard drive. Re-
install the VS2480 hard drive back into the VS2480 and turn on the power.  
 
The VS2480 should load up a “song” from one of the partitions (it doesn’t 
matter which one). Go to the “Project List” and select the IDE partition where 
the corrupted files “used to be”. Select “List” and a “New” song will open up 
and be added into that partition. This song should be “InitProj.000”. Continue 
adding “New” songs to that partition (and don’t forget to SAVE each one as 
you go), until you have reached the number of songs you previously took 
note of earlier and copied to your “VSData” folder. 
 
Once you have the correct number of “empty” songs, shut down the VS2480, 
and remove the VS2480 hard drive again. Change the “pin configuration” 
over to “slave”, then install the hard drive back into the computer. Turn the 
computer on and open the “My Computer” icon. Choose the previously 
corrupted (IDE) partition from the VS2480 hard drive. This partition will now 
have a list of “SONG” file folders equal to the number of “SONG” file folders 
saved to the “VSData” file folder on the desktop. AND the (14) files in the list 
will now be “corrected” for the VS2480 to read. These (14) files must not be 
touched from here on out!  
 
Open each SONG (one by one), in order, on the VS2480 hard drive (IDE) 
partition. First “erase” the (21) files within the song. Then “copy” over the 
contents only (21 files and the TK.VR1 files), from the corresponding SONG 
in the “VSData” file folder, into the VS2480 hard drive (IDE) partition SONG 
file folder.  
 
You are done when all of the files within each SONG from the “VSData” file 
folder on the “desktop”, are copied into each SONG within the VS2480 hard 
drive (IDE) partition. The VS2480 hard drive can now be removed from the 
computer, the “pin configuration” reset to “master”, and finally reinstalled 
into the VS2480.  
 
Turn on the VS2480 and wait for a “song” to load. Go to the “Project List” 
and choose the (IDE) partition (that you are working on), by selecting “List”. 
All of the songs in that partition should now appear. Open a song (one by 
one), in that partition, and after it has fully loaded, you must “save” it. Then 
move to the next song in the list, load it, then save it, and so on, until you 
have done this to every song in that partition. Each time you “save” the 
song, the correct “name” and file “size” will be displayed as it was before the 
directory was corrupted (preventing you from accessing the partition or 
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songs in the first place).  
 
All of the songs (or partition), should now be back the way they were. 
Unfortunately, there is no other way to reorganize or rebuild the directory of 
a VS2480 hard drive (IDE) partition once it is corrupted. You can fool the 
SONG file by copying data into it, but the VS2480 has to “write” the directory 
information from within the machine itself. 
 
A Shortcut… 
 
If, for example, partition “1” (or any of its songs), are corrupted and there is 
no data saved on partition “2”… 
 
Then (while the VS2480 hard drive is still in the VS2480), open up partition 
“2” and create a number of “new” songs. If you are unsure of how many 
songs are to be recovered from partition “1”, then always make more “new” 
songs than you would possibly need. You can erase the un-needed songs 
later on.  
 
Follow the instructions above; by installing the VS2480 hard drive into the 
computer. Copy the SONGs from the VS2480 hard drive (IDE) partition “1” 
over to the “VSData” file folder on the desktop. Then copy the “VSData” 
SONG files back into the “newly” created VS2480 hard drive (IDE) partition 
“2” SONG files.  
!  
This could save one complete step and perhaps a little time, BUT only when 
you are able to access the VS2480 hard drive to begin with. If you cannot 
access the VS2480 hard drive at all, you must follow the multiple steps. 
 
Another success story with Funkyhamsta 
(Stuck on “Load Project” after normal shutdown the night before) 
 
Here's perhpas some useful experience for those who witness a random lock-
up like I did on the 'Load Project' stage. 
 
I duly removed the HDD from the 2480 and changed the jumpers on the 
back to be a slave drive on my Win XP SP2 PC. I hooked it up and booted up. 
 
The drive showed up with all it's (4) partitions and only partit. 1 was the one 
I was concerned with. The usual VR1 files and folders appeared.  
 
I ran scandisk and it found no errors. 
I then copied all the files from the partition onto my PC and all went well until 
the very last few files. I couldn't read the following files (Windows said they 
were corrupt) which were all located in the top level directory (i.e. not any of 
the song directories): 
 
TMPAMIX4.vr1 
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TMPAMIX5.vr1  
and so on up to 
TMPAMIX9.vr1 
 
also TMPSCENE.vr1 was corrupt (it was about 1.6MB in size). 
 
All the TMPAMIX files were 4kb and there were four still intact that would 
copy (TMPAMIX0 thru to TMPAMIX3.vr1) 
 
I then opened a DOS prompt window in XP and entered CHKDSK D: (which 
was the problem partition). 
 
It then created the FOUND dir and fragmented files which corresponded to 
the size of the corrupt files from before. 
 
The problem files were duly deleted and turned into Windows *.000 files. 
 
I then thought how about I *fake* the remaining TMPAMIX files that were 
corrupt by copying a complete TMPAMIX file and renaming it to the corrupt 
ones to replace them. 
 
I did this 4 or 5 times and replaced the corrupt TMPAMIX files 5 thru to 9. 
 
I stuck the drive back in the 2480 and BANG - straight in, all projects there, 
all tracks, all fine... 
 
BOY..I consider myself an unwitting genius or bloody lucky.... 
 
I hope someone else can gain some use from this experience and mild 
panic... 
 
Ecstatically dancing, 

 
MORE ON DATA RECOVERY BY Bear. 
 
VS2480 Data Recovery 
 
Recovering Lost Songs or Directory from a Partition on the VS2480 Hard Drive 
 
 
First, you must remove the hard drive from the VS2480. Look closely at the pin 
configuration for your particular hard drive and note what the setting is for 
“Master” and for “Slave”.  
 
You will need to reset the “pin configuration” and hook up the VS2480 hard drive 
into your computer as a “Slave drive”. Once you are hooked up and your 
computer is turned on, make a “file folder” on the “desktop” and call it “VSData” 
(just to keep things easy and clean). This is where you will “copy” VS2480 
“SONG” information “to”.  
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On the “desktop” of your computer, double click on the “My Computer” icon. The 
window will open up and show you all of the drives you have connected to your 
system. For example;  
 
3 1/2 Floppy (A:)  
Local Disk (C:) 
Compact Disk (D:) 
…etc… 
 
The VS2480 hard drive will show up as “letter” (IDE) drives, other than those 
listed above. (For example: partition “0” from the VS hard drive may be IDE (E:), 
partition “1” may be IDE (F:), and so on…). They may not be organized exactly 
one after another but the progressive lettering is in order, so pay close attention 
to what drive letters belong to the VS2480 hard drive. (Note that only the first 4 
(IDE) partitions of the VS2480 hard drive may be listed). These new drive letters 
may not exceed (4), but the partition you need to recover is usually within the 
first 4 partitions anyway.  
 
When you open one of the VS2480 hard drive (IDE) partitions (that would not 
open on the VS2480), you will see a list of “file folders” like the following;  
 
SONG0001.VR1 
SONG0002.VR1 
SONG0003.VR1 
SONG0004.VR1 
…and so on… 
 
Following the SONG.VR1 file folders, there will be (14) more files in the list. 
These (14) files are what tell the VS2480 what to do with the information on that 
partition. One or more of these (14) files will be corrupted, and preventing the 
VS2480 from booting-up that partition, or preventing a specific SONG from 
loading.  
 
You will need to “copy” each SONG.VR1 file folder (and its contents), one at a 
time, over to the “VSData” file folder that you created on the desktop. But DO 
NOT copy the (14) files from the list following the SONG.VR1 file folders! 
 
For example: Once you have copied the SONG0001.VR1 file folder (with its 
contents), over to the “VSData” file folder, you can check the contents by 
opening the newly copied SONG0001.VR1 file in the “VSData” folder. You will see 
(21) files that look like the following; 
 
AMIXPCTL.VR1 
AUTOMIX0.VR1 
AUTOMIX1.VR1 
AUTOMIX2.VR1 
AUTOMIX3.VR1 
AUTOMIX4.VR1 
AUTOMIX5.VR1 
AUTOMIX6.VR1 
AUTOMIX7.VR1 
AUTOMIX8.VR1 
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AUTOMIX9.VR1 
COMMENT.VR1 
EFFECT.VR1 
EVENTCFG.VR1 
EVENTLST.VR1 
MARKER.VR1 
MIXER.VR1 
SCENE.VR1 
SONG.VR1 
SYNCTRK.VR1 
SYSTEM.VR1 
 
After the first (21) files (that will always be in every song), there will be a 
number of TK.VR1 files. These “TK.VR1” files are the actual recorded audio track 
information. The number of TK.VR1 files that appear in each “SONG” will vary 
with the number of audio tracks recorded to each particular song.  
 
TK000004.VR1 
TK000242.VR1 
TK000431.VR1 
TK000492.VR1 
…and so on… 
 
Once all of the songs from the “corrupted” partition have been copied over to the 
“VSData” file folder on the desktop, you should make sure that the number of 
songs in the “VSData” file folder are equal to the number of songs from the 
VS2480 hard drive (IDE) partition. Take note of how many “SONG’s” you have. 
 
Only “AFTER” you are completely sure you have copied all of the songs (and their 
contents), over to the “VSData” file folder, you can “delete” ALL of the SONG’s 
and the (14) files. But ONLY from “that” particular VS2480 hard drive (IDE) 
partition! DO NOT delete anything from any other VS2480 hard drive (IDE) 
partitions! 
 
Now remove the VS2480 hard drive from the computer and reset the “pin 
configuration” back to the “Master” setting for that particular hard drive. Re-
install the VS2480 hard drive back into the VS2480 and turn on the power.  
 
The VS2480 should load up a “song” from one of the partitions (it doesn’t matter 
which one). Go to the “Project List” and select the IDE partition where the 
corrupted files “used to be”. Select “List” and a “New” song will open up and be 
added into that partition. This song should be “InitProj.000”. Continue adding 
“New” songs to that partition (and don’t forget to SAVE each one as you go), 
until you have reached the number of songs you previously took note of earlier. 
 
Once you have the correct number of “empty” songs, shut down the VS2480, and 
remove the VS2480 hard drive again. Change the “pin configuration” over to 
“slave”, then install the hard drive back into the computer. Turn the computer on 
and open the “My Computer” icon. Choose the previously corrupted (IDE) 
partition from the VS2480 hard drive. This partition will now have a list of 
“SONG” file folders equal to the number of “SONG” file folders saved to the 
“VSData” file folder on the desktop. AND the (14) files in the list will now be 
“corrected” for the VS2480 to read. These (14) files must not be touched from 
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here on out!  
 
Open each SONG (one by one), in order, on the VS2480 hard drive (IDE) 
partition. First “erase” the (21) files within the song. Then “copy” over the 
contents only (21 files and the TK.VR1 files), from the corresponding SONG in the 
“VSData” file folder, into the VS2480 hard drive (IDE) partition SONG file folder.  
 
You are done when all of the files within each SONG from the “VSData” file folder 
on the “desktop”, are copied into each SONG within the VS2480 hard drive (IDE) 
partition. The VS2480 hard drive can now be removed from the computer, the 
“pin configuration” reset to “master”, and finally reinstalled into the VS2480.  
 
Turn on the VS2480 and wait for a “song” to load. Go to the “Project List” and 
choose the (IDE) partition (that you are working on), by selecting “List”. All of 
the songs in that partition should now appear. Open a song (one by one), in that 
partition, and after it has fully loaded, you must “save” it. Then move to the next 
song in the list, load it, then save it, and so on, until you have done this to every 
song in that partition. Each time you “save” the song, the correct “name” and file 
“size” will be displayed as it was before the directory was corrupted (preventing 
you from accessing the partition or songs in the first place).  
 
All of the songs (or partition), should now be back the way they were. 
Unfortunately, there is no other way to reorganize or rebuild the directory of a 
VS2480 hard drive (IDE) partition once it is corrupted. You can fool the SONG file 
by copying data into it, but the VS2480 has to “write” the directory information 
from within the machine itself. 
 
A Shortcut… 
 
If, for example, partition “1” (or any of its songs), are corrupted and there is no 
data saved on partition “2”… 
 
Then (while the VS2480 hard drive is still in the VS2480), open up partition “2” 
and create a number of “new” songs. If you are unsure of how many songs are to 
be recovered from partition “1”, then always make more “new” songs than you 
would possibly need. You can erase the un-needed songs later on.  
 
Follow the instructions above; by installing the VS2480 hard drive into the 
computer. Copy the SONGs from the VS2480 hard drive (IDE) partition “1” over 
to the “VSData” file folder on the desktop. Then copy the “VSData” SONG files 
back into the “newly” created VS2480 hard drive (IDE) partition “2” SONG files.  
 
This could save one complete step and perhaps a little time, BUT only when you 
are able to access the VS2480 hard drive to begin with. If you cannot access the 
VS2480 hard drive at all, you must follow the multiple steps… 
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SOLOING A TRACK WITH EFFECTS LOOPED     
1) Make note of which FX RTN the looped effect is routed thru and 
Start on the TR1-16 fader button bank, Hold SHIFT and press "IN 1-16 
[SOLO]" (fader button above the master fader) let go while all CH-Edit 
buttons are flashing. 
 
2) Now  press the flashing CH-Edit button of the TRACK to solo and 
that CH-Edit button stops flashing and is lit solid.  
 
3) Now press the "TR 17-24 [FX RTN]" (fader buttons above master 
fader) to get to the flashing CH-Edit buttons for the FX return. (this is 
where you'll solo your EFFECT/FX RTN with your track) 
 
4) Now press the flashing CH-Edit button of the FX RTN you want to 
solo, this would correspond to the effect you have looped thru this FX 
RTN and made note of at the begining, like a reverb. 
 
5) To get out of this mode you need to hold SHIFT and press solo 
again the track and effect will still be soloed together for mixing. 
 
*Note: To clear all your soloed Tracks and FX RTN’s at once press and 
HOLD CLEAR and then press "In 1-16 [SOLO]. You can also CLEAR 
soloed TRACK’s & FX RTN’s by clicking on the little black arrow at the 
bottom of the solo row or “S’s” on the HOME screen. 
 
SOLO TRACK WITH EFFECTS SIMPLE 
Just MUTE all other tracks. If you are using just the TR1-16 tracks for 
a song then this is about the fastest and simplest way to do this. 
 
  
SOLOING FROM TRACK & FX RTN MIXER VIEW 
1) Click on the MIXER Menu, at the top of the screen, then select 
TRACK MIXER/FX RTN MIXER. The whole track view changes to show 
the track and FX RTN mixer. 
 
2) Then solo the TRACK using the “S” button above the virtual TRACK 
fader and PAN knob, click on it and it turns blue. (Look for a group of 
four dark buttons above the virtual Pan knobs.) 
 
3) Now find the FX RTN, bottom right of the screen, and click on the 
solo button “S” for the FX RTN the EFFECT is routed through. ( I also 
have a locator set to cue up the track I am checking the mix of the 
effect with.) 
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4) Now you are ready to do your mixing, checking levels of the effect, 
EQing etc by pressing the TRACK’s CH-Edit button. Press Play and 
make your adjustments. Press the CH-Edit button again and you are 
back to the TRACK MIXER view to select other tracks and effects if 
needed or just click HOME to return to the home screen.  
 
NOTE: To clear the soloed TRACK & FX RTN again, press and HOLD 
CLEAR and then press "In 1-16 [SOLO]. You can also CLEAR soloed 
TRACK’s & FX RTN’s by clicking on the little black arrow at the bottom 
of the solo row or “S’s” on the HOME screen or click on the “S” that’s 
soloing the TRACK and FX RTN on the TRACK MIXER screen.  
Thanks to teknail on VSP for help with this document, Frank Griffith. 
 
SOLOing EFFECTS on a SOLOed Track 
Go to your FX RTN Screen by pressing  

1) TR17-24/FX RTN then press 
2)  Channel Edit button of the FX to solo. 
3) Solo button over fader on VGA (next to MIX & MUTE). 
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Project SPLIT and COMBINE works faster than TRACK EXPORT/ WAVE IMPORT. 
Here's how to do it. 
 
It helps if all your tracks are in the same format. I prefer to make 24-bit MIXES 
without any MTK applied, and no fade outs. The MTK and fade-outs will be applied in 
the final CD version of the project. I often include fade-outs in working mixes, but 
omit them for this step. 
 
 
In each of your single-song projects, you want to PROJECT->SPLIT the final mixed 
stereo pair to it's own project. The SPLIT operation make a copy of the parent 
project with only the tracks you have selected, and puts the letter "A" as the last 
character in the name of the newly-SPLIT project. 
 
Now you end up with X-number of 1-song-1-track projects, in addition to your 
original projects. 
 
In each of these smaller projects, move the stereo pair to ZERO on a common V-
Track. For instance, move all the Mastered Tracks to VT23/24.1 in all the projects. 
Also remove any and all MARKERS within these projects. Hold SHIFT and press 
PREVIEW FROM (PROJECT END) and make sure the end of the project is indeed the 
end of the desired audio. 
 
Now choose the first song of the CD, and open its project. Rename this project as a 
Complied CD project, just to keep it straight. 
To add a song to the Complied CD project, choose PROJECT->COMBINE. Then select 
the exiting Compiled CD project, and the project that is the next song, and COMBINE 
them. This places the new song 4 seconds behind the end of the existing song(s). 
 
Repeat the COMBINE process until all the songs are in order, and in the same 
Complied CD project. 
 
Now you can go ahead and apply the MTK tools, automix fades, adjust playback 
levels, to create a cohesive project. 
 
By Karl Lakestone 
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VS SUB MIXES/BOUNCING. 
To sub mix several tracks down to one track or a pair, like all of your drum 
tracks or background vocals, decide which tracks to send where. Let’s say, 
drums on 1 thru 6 are to be sub mixed to Tracks 15 & 16. Usually a sub mix 
is done in stereo, so first let’s link TRACKS 15 & 16 

1)First PRESS the CH-Edit button of TRACK 15 and on the CH-Edit 
page of TR 15 select “CH LINK” below the ATT Knob on the right of 
that screen, then click HOME. 

Now let’s use QUICK ROUTING to route out SOURCE TRACKS to our 
DESTINATION TRACKS. [If you are using an effect then connect the FX 
RTN number that matches the effect number to your destination track on the 
RECORDING TRACK block or see bouncing with effects below.] 
 
2) PRESS and HOLD TRACK 15’s TRACK STATUS button till the 
QUICK ROUTING window opens. All track status and CH-Edit buttons 
will flash except the DESTINATION TRACKS, 15 & 16. 
 
3) Now PRESS the flashing CH-EDIT buttons of the TRACKS you want to 
send to TRACKS 15 & 16. This will link SOURCE TRACKS to the 
DESTINATION TRACKS in the Quick Routing window. When all are 
linked, click on “F6 EXIT.” 
*If a wrong connection was made you can PRESS the CH-Edit button of the 
SOURCE TRACK again to disconnect it before exiting the window. 
 
4) Now simply ARM TRACK 15 to RECORD, both TRACK STATUS 
buttons of 15 & 16 will flash RED. When ready to do a test mix just PRESS 
RECORD and PLAY. 
 
5)  When done mixing PRESS STOP, ZERO, and then MUTE all other 
TRACKS or SOLO TRACKS 15 & 16 and PRESS the TRACK STATUS 
button of TRACK 15 till 15 & 16 are GREEN to PLAY back your sub mix. 
 
6) If you don’t like the sub mix then PRESS the UNDO button and then the 
ENTER button and try it again. 
 
*Another way to do SUB MIXES using the Mastering Room is to select V-
Tracks on Tracks 23 & 24 to mix to, you can INSERT an MTK and after the 
mix is done, use TRACK EXCHANGE to exchange them with V-Tracks 1-
15 & V-Track 1-16 on tracks 23 & 24  and free up the Mastering Room for 
further Mastering. 
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BOUNCING A SINGLE TRACK 
This time we will bounce a single track without using Quick Routing. Let’s 
say you have a vocal on Track 5 and you want to bounce it to Track 15 for 
whatever reason, to have a double vocal or to loop or insert an effect. 
Make sure your AUX BUS 1 thru 8 and FX RTN 1 thru 8 FADERS are all 
up and set to 0db for routing any EFFECTS you might need. Now we will 
need to go to EZ Routing> Routing View> to do this…. 

 
1) On the EZ-Routing page you see TRACK MIXER 1-24 in the lower 

left quadrant of the screen, Click on your vocal TRACK 5’s number 5 
and drag a virtual cable up to the RECORDING TRACKS 1-24 and 
connect it to TRACK #15. Assuming you already have an effect 
patched into a processor, if you want to use a LOOP Effect on the 
Vocal going to Track 15 and have the EFFECT recorded with it, then 
click and drag the FX1 thru 8 Effect number your EFFECT is on and 
connect it to Track 15 too, FX RTN1 is EFFECT1, FX RTN2 is 
EFFECT2, FX RTN3 is EFFECT3 and so on. (If your Reverb is 
Patched into EFFECT 1 then FX RTN’s number 1 should be 
connected to the Recording Track number 15 also we do this for 
LOOPED Effects to an INPUT that’s sending a signal to a track to 
record. (We do not do this for INSERT EFFECTS). Now click 
HOME. 

 
2) If you want to use an INSERT Effect on the vocal going to TRACK 

15 and have that printed with the vocal then press the CH-Edit button 
of Track # 5 and on that page click on the FX1 thru 8 number with the 
EFFECT you want INSERTED, FX1 is EFFECT1, FX2 is EFFECT2, 
FX3 is EFFECT3 and so on,  if it’s the LOOPED reverb of EFFECT 1 
make sure the effects FX RTN is connected to the destination track in 
the RECORDING TRACK block then turn up the AUX 1 knob, on 
the CH-Edit page of TRACK #5, to complete the LOOP and add the 
amount of the reverb you want. Now click HOME. 

 
3) Now all we do is arm TRACK # 15 to record and PRESS Record & 

Play. Any fader movements made on TRACK 5 during the recording 
will be copied to TRACK 15 so make sure your Faders and levels are 
set the way you want them to record onto Track 15.  
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4) When done press STOP and check Track 15 and your bounce. If you 
want to do it over, now press UNDO> and a window opens with your 
last action highlighted now press ENTER to erase this one and start 
over. Once you do get the bounce right remember to take out any 
effects you INSERTED on TRACK 5 to free up that EFFECT and 
remove it from TRACK 5. If it was LOOPED then disconnect the FX 
RTN to RECORDING TRACK connection you made. 

 
*Bouncing Tracks are easy. You just go to the EZ Routing page and 
connect a track, or tracks, from the TRACK MIXER to the 
RECORDING TRACK, or a linked pair of tracks. Make sure the effects 
FX RTN is connected to the destination track in the RECORDING 
TRACK block if you are using looped effects, then ARM the destination 
track or linked tracks and press Record & Play. It gets a little tricky when 
you want to INSERT an EFFECT and more so if you want to LOOP an 
EFFECT. So, I keep the AUX and FX RTN Faders @ 0db. Also, too 
quickly link inputs or tracks just press and hold the odd numbered 
channel and press the even numbered one and this will link the pair for 
stereo inputs or tracks.  

 
 
If you want to add an INSERT EFFECT to a track, see the MS Word 
docs on EFFECTS. You just press the CH-Edit button of the track to 
INSERT the EFFECT, click on the EFX button of the EFFECT to 
INSERT. Now go to EFFECT> select the EFFECT number to patch in 
the EFFECT you want INSERTED. To LOOP the EFFECT, have it’s 
effects patch selected in the EFFECTS window, then for each track you 
want the EFFECT LOOPED to be used on, you just press the CH-Edit 
button of that TRACK and find the AUX knob that corresponds to that 
EFFECT processor and turn it up to use the EFFECT. Looped effects can 
be used with all tracks this way. That’s the big advantage of using 
LOOPED EFFECTS, is you can use one EFFECT across all TRACKS 
and INPUTS, don’t forget to connect the FX RTN virtual cable in EZ-
Routing to complete the LOOP on INSERTS and when BOUNCING and 
disconnect when done. *In theory, you are NOT adding the reverb to the 
tracks or inputs, you are routing their signal thru the master bus where the 
reverb is applied thru FX RTNS & AUXS. 
 
Another thing to keep in mind, once you finish a SUBMIX, you can go 
back to the tracks that were mixed down and either use TRACK 
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EXCHANGE to move those tracks to V-Tracks to save for future 
remixing, or you can just select a new V-Track for each of the tracks to 
have new tracks to record too. In the example above, we used tracks 1 
thru 6, each of those tracks have 16 V-Tracks, just click on the 1 to the 
right of the track number and a V-Track window opens, there you can 
select the 2nd V-Track to bring it forward for recording and the V-Track 1 
will be saved and you can now record new data to tracks 1 thru 6 but on 
their 2nd V-Track. See “VS V-Trks, Opti, Undo etc..” doc for more info 
on using V-Tracks. 

 
MASTERING ROOM BOUNCE 
You can also use the mastering room to bounce sub mixes. Just bring up the 
faders on the tracks you want to bounce and use the mastering room. It 
doesn’t matter which V-Tracks you bounce too just remember which. Also, 
set it to “Stay Here” instead of “Zero” if the tracks don’t happen to start at 
“To Zero”. After you Master/Bounce then use Track Exchange to move the 
stereo pair of master tracks where you want them.  
 
You could also use Region or Phrase Move with IN, OUT and TO points. 
Using the mastering room means, what you hear, you get. No mix ups here. 
See “VS MST BURN.doc” on mastering and “VS CpyMveExchExpt.doc” 
for more on Track Exchange. This is also good for creating stereo stems of 
back ground vocals, drum tracks etc. Now, what's odd or can be a bit 
confusing is this, when you have a track recorded dry and you want to add a 
reverb to it to be recorded in the mastering, you do not have to connect the 
FX RTN virtual cable to the destination tracks, that routing is done 
automatically in the mastering room.  
  
EZ ROUTING TOOLS 
To INITIALIZE, or reset all input-to-input channel routings click on 
“F1(IniPB)” at the bottom of the screen. To CLEAR all input-to-input 
channel routings click on “F2(ClrPB). 
 
To INITIALIZE all routings to the hard disk recorder tracks click on 
“F3(IniTra) and to CLEAR all routings to the hard disk recorder tracks click 
on “F4(ClrTra). 
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The smallest time delay and volume in sound signal arriving at each of our ears is 
what allows us to "place" where the sound is coming from. Our ears "pointing" 
forward creates a different reaction to sound waves arriving from the rear or above 
compared to directly in front, thus allowing us to pinpoint the sound source in a 3-
dimensional spherical position around us.  
 
Therefore if you are sitting in the middle of 2 speakers and the "same sound" arrives 
at each ear with the same character (time delays and volume), we percieve it to be 
in the middle. The small time delay you create between "copied" tracks is percieved 
as TWO sound source even if the volume is the same... thus the impression of 
"doubled" and the "center" image disappears. But if you are listening off-axis (not 
eque-distant between the speakers) then stereo imaging becomes biased and small 
pan position difference starts to disappear.  
 
Most consumer stereo system users hardly ever sit and listen at the "sweet spot". 
Full Left and Full Right pan of a mono track is much easier to percieve off-axis and 
away from the "sweet spot". 
 
Stereo panning is a manipulation of these time delays to attempt to re-create a sonic 
condition that "represents" the various recorded sounds to "be in a space" in front of 
you. Many forget that "stereo" ASSUMES that the listener IS in the "sweet spot"... 
equal distance from each speaker. 
 
Understanding "HOW" human ears hear is the basis of stereo playback system.  
 
--------------------------- 
 
I create the "time delay" of a mono track by : 
 
Lets say an acoustic guitar... 
 
Make a copy of the track. "MOVE" the copied track "forward" (delayed)in time about 
1/4 to 1/2 a frame (1 frame = 1/30 of a second). This miniscule "time delay" makes 
it sound doubled. Pan each in opposite direction to taste.  
 
Try this after you do the above... Pan the pair of tracks 50% left and 50% right. Set 
up 2 reverbs. Pan each stereo reverb biased the same 50% left and 50% right. Feed 
the left dry track to the right reverb and right dry track to left reverb. Set the "pre-
delay" on the reverbs to be different with the faster being at least twice the amount 
of the "time delay" created between the dry tracks. 
 
Additional experiment... 
EQ one of the dry track to be a bit more bottom heavy and the other to be a bit 
more "sparkly". 
 
Use different reverb types for the two reverb pair... like a "plate" on one side and a 
"hall" on the other. 
 
From on line some where? 
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UPDATING VS OS. 
*If you have an OS above 2.009 then it is not necessary to Format/Initialize 
the hard drive in your VS after updating! 
*To find out which OS you are running, hold down the TRACK STATUS & 
CH-EDIT buttons above Fader# 1 while powering up the VS. HOLD the 
buttons until you see a prompt on the LCD. All 4 digits of the OS will 
appear on the small LCD on the VS, from there you can answer the prompts 
with the ENTER/EXIT buttons to load a project. 
 
Updating a VS2480/2400 ( From Roland’s Site) 
  
You can update the operating system on your VS-2480/2400 from a CD-R that 
contains the proper update program. You MUST have the following to do this : 
 
- Built in CD-RW drive or a Roland approved external SCSI CD-RW drive (like the 
VS-CDR3). 
 
- You will also need the latest update CD for your VS model. You can get this from 
Roland Customer Service (323)890-3700 ext.2289, or you can create your own by 
downloading and burning the disc image file for the update to your computer's CD-
R.  
 
- The disc images to download are on the Rolandus.com website under 
SUPPORT/UPDATES&DRIVERS/DIGITAL RECORDING & MIXING/DIGITAL 
RECORDING/VS-2480 (VS-2400/2000). 
 
- Note you will need a Disc Image / CD burning utility installed on your computer 
(like the PC application ULTRAIso / or Toast for Macintosh)in order to create your 
own update CD. 
 
- WARNING!! - IT IS HIGHLY RECOMMENDED THAT YOU BACKUP THE 
DATA THAT IS ON YOUR VS-2480/2400/2000 PRIOR TO PERFORMING THE 
FOLLOWING UPDATE PROCEDURE. 
 
Procedure For Updating : 
 
1. Put the Update CD in your CD-RW drive. 
 
2. Press [SHIFT]+ [STOP] to shutdown the VS-2480/2400.  
 
3. Press [ENTER/YES] at the "Shutdown/Eject?" screen. 
 
4. Press [ENTER/YES] at the "Store Current?" screen. 
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5. When it ejects the CD, push the CD tray back into VS. 
 
6. When the screen says "POWER OFF/RESTART", turn the power OFF with the 
power switch on the rear of the VS. 
 
7. After 10 seconds, turn the power ON with the power switch on the rear. The VS 
will startup, scan the CD and go into update mode. 
 
8. The VS will ask if you want to update with "System Update?". Press 
[ENTER/YES].  
 
9. The 2480 will ask you if you want to keep your User Settings. Press 
[ENTER/YES] or [EXIT/NO]. 
 
10. The 2480 will then start updating its operating system. 
 
11. After it’s finished, it will ask you to REBOOT. 
 
12. Remove the ejected Update CD from the CD-RW tray and use the power switch 
to turn the VS OFF. 
 
13. After 10 seconds, turn the power ON. Your VS will boot-up with the new 
operating system. 
 
Note: AFTER UPDATING, IT IS HIGHLY RECOMMENDED THAT YOU 
INITIALIZE/FORMAT YOUR HARD DRIVE IMMEDIATELY WITH 
PHYSICAL FORMAT - "ON" and SURFACE SCAN "ON". WARNING!!!!! – 
INITIALIZING OR FORMATTING YOUR HARD DRIVE WILL ERASE ALL 
PROJECTS ON YOUR HARD DRIVE. BACKUP YOUR DATA BEFORE 
FOLLOWING THIS UPDATE PROCEDURE OR FORMATTING YOUR HARD 
DRIVE.  
 
Depending on your hard drive capacity, Formatting could take anywhere from 4 to 
12 hours for the VS to complete : DO NOT REMOVE POWER FROM THE UNIT 
during this operation!! 
 
Page 114 - VS-2480 Owners Manual 
Page 108 - VS-2400 Owners Manual 
Page 117 - VS-2000 Owners Manual 
 
After formatting is completed, you’re done and ready to record again!! 
 
*If you have an OS above 2.009 then it is not necessary to Forrmat/Initialize 
the hard drive in you VS after updating! 
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*If you have a VS2480CD or DVD model VS, you insert the update CD in 
the internal burner while the VS is powered up. Then go thru normal 
shutdown procedures and power off the VS. Once the hard drive stops 
spinning power up the VS and it should boot to the update CD and you 
should see prompts on the LCD screen on the VS. 
 
*If you have the VS2480HD model with the external Roland CDR-II or 
CDR-III Burner you must have the update C in the burner. If your CDR is 
connected to the VS and is powered up and has the update CD in it all before 
powering up the VS2480, the VS2480 should boot to the CDR external 
burner and find the update CD. Then the small LCD screen on your VS 
should prompt you to update the VS. 
 
 
OS VERSION NUMBERS, to display all 4 digits. 
The VS only displays 3 of the OS digits on the VGA, to see all 4 digits of 
your current OS version; hold down the CH-Edit and Track Status buttons 
above fader#1 while powering up the VS, hold the buttons down until you 
see a prompt on the small LCD. There you will see all 4 digits of the current 
OS on the small LCD on the VS. Answer the prompts to load a project. 
 
Updating From 1.XXX to Current via MIDI 
http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Board=16&Number
=853723&Searchpage=2&Main=84247&Words=updating+OS&topic=0&Search=true#P
ost853723 posted by Paul Miller 
 
The VS-2480 has an Operating System that is software-based. This OS 
software can be easily updated when new features are added to enhance the 
functions in the VS-2480. The OS software resides in the VS-2480 on Flash 
ROM IC Chips, and therefore the update procedure does not affect the data 
existing on its hard drive; the new OS remains within the VS-2480 even 
when the internal hard drive is removed and/or exchanged. Before and After 
Updating to Version 2.5xx from Version 1.xx software it is important to 
perform a full physical formatting of the VS-2480's hard drive before 
attempting to load version 2.5 software into your VS-2480. It is also highly 
recommended to perform a quick format (physical format = off) after the 
version 2 software has been loaded into the VS-2480 and before any project 
data has been recovered or new project data recorded. Please see your 
Owner's Manual for details on performing these procedures. 
 

http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Board=16&Number=853723&Searchpage=2&Main=84247&Words=updating+OS&topic=0&Search=true#Post853723
http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Board=16&Number=853723&Searchpage=2&Main=84247&Words=updating+OS&topic=0&Search=true#Post853723
http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Board=16&Number=853723&Searchpage=2&Main=84247&Words=updating+OS&topic=0&Search=true#Post853723
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Updating the VS-2480 via Standard Midi Files. 
The VS-2480 OS software can be updated from Standard Midi Files 
containing system exclusive data. This method uses a common file format 
that is both PC (IBM-compatible) and Macintosh compatible. An SMF 
sequencer/player (software) and Midi interface (hardware) is required to 
send the data via Midi. Many hardware (stand-alone) Midi sequencers are 
capable of reading theSMF file format and playing the update sys ex data 
into the VS-2480 via Midi. 
 
NOTE: Hardware sequencers (such as the MC-80 or XP-50/60/80) are 
normally more reliable for 
transferring system exclusive MIDI data. 
Procedure: 
1. Connect the MIDI OUT port of the sequencer to the MIDI IN port of the 
VS-2480. 
2. Hold down [STATUS] buttons 2 & 3 and [CH EDIT] button 5 above the 
white faders while 
powering on the VS-2480. The message "System Update?" will be 
displayed. 
3. Press ENTER/YES. The message "Waiting MIDI-EX" will be displayed. 
4. Load the Standard MIDI Files into your sequencer. 
5. Play all Standard MIDI Files: "VS248000. MID" to "VS248031. MID" in 
order. 
6. After all SMF's have been played into the VS-2480, the message "--S- 
Update SysPRG?" will 
be displayed. 
7. Press [F1] so that "B-S- Update SysPRG?" is displayed. 
8. Press [F4] so that "B-Ss Update SysPRG?" is displayed. Press 
ENTER/YES. 
9. The message "Please Reboot OK" will be displayed. The system software 
of the VS-2480 has 
now been updated. 
10. Restart the VS-2480 (power off and then on again). 
 
Confirming the Updated Operating System. 
When updating the VS-2480 via standard midi files, it is extremely 
important to carefully follow every step in the procedure. To confirm the 
update has loaded correctly, perform the procedure outlined below: 
1. Hold down [CH EDIT] button 1 and [TRACK STATUS] button 1 (above 
the first white fader) 
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while powering on the VS-2480. Keep holding until you see a prompt on the 
LCD. A Version Information screen will be displayed. 
 
2. On the LCD screen, verify the Boot version and System version are the 
exact same number - that of the operating system most recently loaded. 
IMPORTANT: If these two values are different, you must perform the 
update procedure again or try updating via ZIP disk or CD. 
 
*NOTE: Software SMF player applications for both PC and Mac are 
available for download at http://www.rolandus.com. We have tested these 
files with the following computer-based MIDI sequencing programs; Vision 
(Opcode), Performer (MOTU), Cubase (Steinberg/Jones), and Logic 
(Emagic). We were successful in updating the VS-2480. Several 
manufacturers have demo versions of their sequencer programs available on 
the internet that will work for this use. ***If you have problems with the 
update procedure check your MIDI/interface setup.*** If you have problems 
downloading these files, you can also order disks directly from Roland. 
Please call Customer Service at 323-890-3700 ext. 2289 and request one of 
the following: 
SMF update - Part # 17041060 
CD update – Part # SU-44 
(c)2001 Roland Corporation U.S. Updating the VS-2480 Operating System  
 
UPGRADING VS2480CD to DVD  
(and replacing DVD burner in DVD model VS) 
 
If you have a VS2480CD model VS, you can install a laptop DVD burner in 
place of the CD burner in your VS. The VS defaults the CD write speed at 
CD4x and DVD1x but here’s the catch. DVD2x is as fast as CD18x so 
DVD1x is equal to CD8x when it comes to burning backups. Also, DVDs 
hold 4.7GB of data, that’s 4700MBs and CDs only hold 700MBs so 5 or 6 
CD backups will fit on one DVD in far less than half the time it takes to 
backup to CD. 
 
 I recommend you do this your self and save hundreds of dollars compared 
to buying the VS2480DVD model or an external DVD burner. It takes about 
30 minutes to change them out plus you will also know where the hard drive 
is and can change it on your own as well. Hard Drive specs: 7200RPM, 
8MB Cache, ata/100 or 133 Interface. No SATAs! Download the 
“Converting the VS2480CD to VS2480DVD” PDF from this direct link and 

http://www.rolandus.com./
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buy a Panasonic UJ-845-B Slot Loading DVD/CD Laptop Burner….  
http://www.rolandvs2480.net/VS2480CD%20to%20vs2480DVD%20Conve
rsion/Convert%20your%202480CD%20to%20a%202480DVD.htm 
The UJ-870 & UJ870QJ REPLACES:  
UJ-811, UJ-811B or -B,  UJ815, UJ-815, UJ-815B; UJ825, UJ-825, UJ-825-
B; UJ-830, UJ-830B,  UJ835, UJ-835, UJ-835-B, UJ-840-S, UJ845, UJ-845, 
UJ-845-B, UJ-845-S or UJ-845S,and UJ-85JS and UJ-850. The 
VS2480DVD comes with a Panasocic/Matshita UJ-840-S installed. Also, the 
UJ870 shows up as UJ870QJ in the CD-R Write window. Arjan  van gog on 
VSP, used a UJ-875 BXM Master DVD Burner and it worked. 
 
 
Link above is from Brett’s web site at this link… 
http://www.rolandvs2480.net/ 
You’ll be glad you did. If you need more help with it contact me at 
Fcgjabq@aol.com  
 
 
FORCE INITIALIZE/FORMAT HARD on start up. 
Hold down both the CH-Edit button and Track Status buttons above fader # 
4 and power up the VS, keep holding till you reach the LCD with a prompt. 
Use the ENTER/EXIT buttons to answer the prompts to format the hard 
drive. This will erase all data currently on the hard drive. 
*Note: This is also a way to get the VS back up and running after a start up 
has failed or you have shut down improperly and the VS will not open a 
project. 
 
VS DIAGNOSTIC MODE 
Hold down the PAGE button and F1 on the VS and power up the unit. Keep 
holding the buttons down until you see a prompt on the small LCD on the 
VS. From here you can check all of the functions of the VS, be sure not to 
press the wrong buttons on the screen or you could accidentally format your 
hard drive. 
 
Performing a Drive Check 
If you are having some problems with your VS running smoothly, loading 
projects, backing up etc then perform a drive check. 
Drive Check 

1) Select Project 
2) Select the drive to perform the check on. 

http://www.rolandvs2480.net/VS2480CD%20to%20vs2480DVD%20Conversion/Convert%20your%202480CD%20to%20a%202480DVD.htm
http://www.rolandvs2480.net/VS2480CD%20to%20vs2480DVD%20Conversion/Convert%20your%202480CD%20to%20a%202480DVD.htm
http://www.rolandvs2480.net/
mailto:Fcgjabq@aool.com
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3) Find the “F” button for “DrvChk’, you may have to page thru it to 
find it. 

4) Select “F1 DrvChk” and the VS ask you to Press ENTER/YES or 
EXIT/NO for drive check, select YES. 

5) Then it ask if you want to save any recent changes to the current 
project. 

6) Press YES to save Changes or NO to continue on with the drive 
check. 

Drive check examines the area where the project files are for corrupt data 
and problems. When it is done it will show you a report. If the drive check 
finds some corrupt data it can attempt to fix the problem but will tell you 
that you will lose data. The data lost is the corrupted data and is not needed. 
More on drive check on VSPlanet   
http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Numb
er=1154797&gonew=1#UNREAD 
 
 
Turn Off IDE Drive. 
To turn off the internal drive so the VS will boot to an external hard drive, 
Select UTILITY> SYSTEM PARAMETERS> [F2 Param2] and there you 
can check mark to turn off the IDE DRIVE. The VS should then boot to an 
external drive on reboot. 
 
VS2480 Fan Specs. 
San Cooler 80 by Sanyo Denki 
Model: 9A0812L403 
Voltage: DC 12V 
Current Draw: 0.06A 
 OR 
Silenx IXP5211 iXtrema Pro Fan    
80mm x 15mm, 
11dba, 18CFM 
TigerDirect.com has them for appx $11 
 
VS2480CD Hard Drive Model 1C35l090AVV207-0 
Hitachi Deskstar 80GB, 7200RPM, ATA/IDE June 2003 N155 
CD Burner is a UJDA340  
Roland gives these specs for hard drives: Maxtor DiamondMax Plus 9, 
80GB, 7200RPM, 2MB Cache, Ultra ATA/133, Average seek times 9.3ms. 
 

http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Number=1154797&gonew=1#UNREAD
http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Number=1154797&gonew=1#UNREAD
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Seagate ST380215A Barracuda 7200.10 Hard Drive - 80GB, 7200rpm, 
2MB, EIDE, OEM from Tiger Direct worked for me Apr. 2010. 
Here’s post on VSPlanet that list many models that are compatible... 
http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Number=677261&fpart=1 
AND 
http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Board=16&Number=976890&Search
page=7&Main=47033&Words=Hard+drive&topic=0&Search=true#Post976890 
AND 
http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Board=16&Number=102931
5&Searchpage=2&Main=97783&Words=Hard+Disk&topic=0&Search=true#Post1029315 
 
 
 

VS2400CD Hard Drive and Burner models 
Maxtor Fireball 3 ATA/133 40G 
CD Burner UJDA360 Panasonic April 2003 
Also UJDA340 and the newer UJDA780 with these specs on it. 
-HW: 1.01 
-FW: 1.00(-> Firmware) 
 
VS2480 Faderboard Part # 71561767 
 
Seunity on VSP about VS2480’s CPU and ram specs: 
CPU is M38881M2. 
The 32 bit CPUs (two) are HD6417014 and HD6417709. 
There's also a CPU DSP, TMS320VC5402 and a custom board. 
For the DRAM we have GM71VS16163CLT and HY57V641620HGT, for 
the flash memory TC58FVB321FT. Lets also throw in one more DSP, 
XCB56364FU100, along with bucket load of other stuff specifically fit 
together to do just what this machine does... 
 
VS2400 Replacing CD Burner or Hared drive (by Detroitroadrage 
onVSP) 
Step-By-Step: This is the procedure for both the burner and the hard drive. 
The drives are side-by-side right under the the bottom cover. 
1. Remove 16 screws holding back cover. 
2. Unplug the ribbon cable from the drive. 
3. Remove the four screws holding the drive mounting frame to the VS. 
4. Remove the four screws holding the drive to the mounting frame, also 
remove the two screws holding the "CDRW BOARD" to the frame. (These 
four screws are located on the sides of the drive and require a VERY small 
phillips screwdriver) 

http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Number=677261&fpart=1
http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Board=16&Number=976890&Searchpage=7&Main=47033&Words=Hard+drive&topic=0&Search=true#Post976890
http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Board=16&Number=976890&Searchpage=7&Main=47033&Words=Hard+drive&topic=0&Search=true#Post976890
http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Board=16&Number=1029315&Searchpage=2&Main=97783&Words=Hard+Disk&topic=0&Search=true#Post1029315
http://www.vsplanet.com/ubbthreads/ubbthreads.php?ubb=showflat&Board=16&Number=1029315&Searchpage=2&Main=97783&Words=Hard+Disk&topic=0&Search=true#Post1029315
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5. Unplug the "CDRW BOARD" from the drive. 
6. Install new drive in opposite order. Takes appx 10 minutes. 
 
 
The VS2480 has 5 CPU's and DSP's on board. Since this is a real-time 
embedded system Roland proprietary design, the hardware architecture is 
very different to PC hardware. 
 
02129089 TMS320VC5402 IC (CPU DSP) IC62 on MAB 1 
01672867 M38881M2-069FP IC (CPU) IC107 on MAB 1 
01679156 HD6417014 RF28 IC (32BIT CPU) IC1 on PRB 1 
02454289 HD6417709AF133 IC (32BIT CPU) IC5 on MAB 1 
02453878 AK4528VF IC 
(AD/DA)IC28,IC3,IC33,IC13,IC23,IC18,IC36,IC8 on JKB 8 
01342978 TC160G22AF-1253 IC (CUSTOM) IC5 on PRB 1 
02455712 GM71VS16163CLT-6 IC (DRAM) IC84 on MAB 1 
02673812 HY57V641620HGT-P IC (DRAM) IC2,IC10 on MAB 2 
02458978 XCB56364FU100 IC (DSP) 
IC57,IC56,IC53,IC59,IC50,IC52,IC58,IC51 on MAB 8 
02454867 TC58FVB321FT-10 IC (FLASH MEMORY) IC3 on MAB 1 
02568323 MBM29F400BC-90PFTN IC (FLASH MEMORY) IC2 on PRB 1 
02344912 M7G1120-0104FP IC (GATE ARRAY) 
 
Link to PDF on how to run the Roland VS2480 TEST MODE…. 
https://skydrive.live.com/?cid=5D8E5CEAA7967BC4&id=5D8E5CEAA79
67BC4%21606 
 
 
 

https://skydrive.live.com/?cid=5D8E5CEAA7967BC4&id=5D8E5CEAA7967BC4%21606
https://skydrive.live.com/?cid=5D8E5CEAA7967BC4&id=5D8E5CEAA7967BC4%21606
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 How to use the Vocoder Effect  
The 19-band Vocoder found in all V-Studios provides quite a stunning "talk box" effect. 
It can make your synth or guitar track sound like it is talking. It does this by applying the 
envelope or articulation of a vocal track to the instrumental track. The vocal track that 
provides the envelope can be either a pre-recorded vocal, or you can even plug in a 
microphone and use the vocoder in real-time during a performance! 

When you use the vocoder -there are always two tracks or channels involved, one is the 
voice, and one is the instrument track. For the voice, you can either use a vocal already 
recorded, or a live mic input. For the instrument, use a rich, thick synth pad for the best 
results. You can also experiment with a strumming acoustic or electric guitar that has a 
lot of sustain. The key is use an instrument track that has continuous sound that doesn't 
drop out at all, and has a lot of notes playing a time - something with a big, thick chord - 
lots of harmonics. 

Now, to make the Vocoder sound right when you use it, you need to connect it the right 
way. And there really is only one right way to connect it. To explain, I'll refer to the two 
parts as the VOICE and the PAD. 

First pick the effect. From the Effects List of your V-Studio, choose "VOC2: 19-band" as 
the best choice. (Note, when you choose this for Effect 1, Effect 2 can not be used.) 

To connect the vocoder, it must be inserted on both the VOICE and the PAD tracks. I use 
the rhyme "Insert right on the mic" to remind me to insert the right channel of the 
vocoder on the VOICE track (i.e. "InsR"), and insert the left channel of the vocoder on 
the PAD track. If you have it inserted on both parts, but it doesn't sound right, chances 
are you got the Insert Left and Insert Right switched. Simply un-insert it all, and then try 
it again. 

Once you press play, you'll hear the PAD track but only if the VOICE track is "talking". 
If the voice track isn't talking or singing at that particular part of the song, you won't hear 
anything. When the VOICE track is making sound, you'll hear just the PAD, but as 
modulated or articulated by the VOICE. 

When you want to use the Vocoder with a live mic as the VOICE, just make sure you 
insert it on the Input Mixer, and not on the Track Mixer. 

 

Fun with the VS Vocoder (or eight easy steps to schizophrenia)  
 
Here's my routing:  
Input #1- keyboard 
Input #3- microphone  
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Your routing may be different. If so, you can either substitute your routing 
numbers for mine (e.g. if your keyboard is Input #2, just substitute Input #2 
wherever I mention Input #1) or you can temporarily route your stuff the 
way that is. Using headphones is a good idea while playing with the Vocoder.  
 
1.) Make sure that your Fader Edit button is showing yellow. This will allow 
you to manipulate the Input rather than the Track or Effects Retun. What we 
want to do here is to allow you to experiment with the Vocoder before you 
record. If you happen to get something that you like, then you can just start 
recording and the effect will be printed to the track that your Inputs are 
assigned to.  
 
2.) Looking at the Input Mixer, play your keyboard using a nice rich texture. 
String sounds usually work pretty well using four or five voice chords. Bring 
up Input #1 until you can hear the keyboard fairly well.  
 
3.) Now speak into your microphone and bring up Input #3 until you can 
hear your voice fairly well. I've found compressor on the voice will help a bit 
with Vocoder experiments.  
 
4.) Play sounds on your keyboard and speak into the microphone at the 
same time. Can you hear them both well? Good.  
 
5.) Hit the Effect button, and assign FX1 to B84, VOC2:M19Band.  
 
6.) Hit the Select/Channel Edit button for Input #1, and scroll until you find 
the IN1 FX1 Ins screen. It should be showing "Off" right now. Roll your 
Time/Value control clockwise until the display shows IN1 FX1 Ins=InsertL. 
playing your keyboard. You should not hear it.  
 
7.) Hit the Select/Channel Edit button for Input #3, and scroll until you find 
the IN1 FX1 Ins screen. It should be showing "Off" right now. Roll your 
Time/Value control clockwise until the display shows IN1 FX1 Ins=InsertR. 
into the microphone. You should not hear it.  
 
8.) lay a big four or five voice chord on your keyboard while speaking into 
your microphone. Your voice should "Vocoded". Go ahead, try that Cher song 
that you've heard over and over and over again. Now try some four-letter 
words…Now that you've tried some of the easy stuff, think of some even 
better things, like talking cymbals (if you're into cymbalism). Or think about 
Vocoding a bass guitar with a kick drum- there's a tight rhythm section!  
 
Talking traffic is cool, too. Gives you a taste of what schizophrenia is all 
about. 

 

From Brett’s site…   http://www.rolandvs2480.net/ 
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Backups, Format & New VS8F-3 Card Install                   
by Frank Griffith 

1) Do your backups first!  
2) Update the OS, the 2.504 update CD should have come 
with the VS8F-3 card. Insert it into the CD Tray and 
shutdown the VS. Now, Power up the VS with Update CD 
in the CD Drive and follow the prompts on the 3” x 5” 
screen, using the ENTER button to answer the prompts. 
Once the OS is updated it will load an INT0000Project. 
3) Now it’s ready to be formatted. (See “Formatting 
Process below) 
4) Recover your projects. (Also below) 
5) Turn off the VS and install the VS8F-3 card in slot "A", 
(under the panel on the back of the VS.) 
6) Power up the VS and install the VS8F-3 card program 
and plug-ins using the VS8F-3 card "Setup Disc" CD that's 
already in the CD bay, there are more detailed 
instructions that came with the VS8F-3 card. You can 
Click on CD-RW Mastering Menu and select “Plug-in 
Install” and follow the directions on screen. 
7) After that make a Backup of the "Setup Disc" which is 
explained later in this document, by clicking on CD-RW 
Mastering> then select “Plug-in Backup” and answer the 
prompts on your screen. Yes, it’s that easy. 
 
VS8F-3card Install Procedure 
1. Insert 3card SETUP disc 
2. Press CD-RW and the menu screen should open. 
3. Select page 2 "Plug-in Inst" and YES/ENTER 
4. Press "F5 Install" and the install menu should open. 
5. Press YES/ENTER and the installation should begin 
6. Here the "Authorize" popup should appear so press 
YES/ENTER to Authorize, if not... 
7. Press EXIT/NO to install the "Trial Version" 
8. If you pressed YES/ENTER then authorization will begin 
and be written to the setup disc and hard drive. 
9. Confirm by pressing YES/ENTER 
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10. When done the CD-RW menu will open and you can 
remove setup disc. 
 
NOTE: It has been found that once you “Authorize” a 
plug-in with a key VS8F-3card in slot “A” you can later re-
install the “Authorized” plug-ins with that key VS8F-3card 
in any slot. If you buy a new plug-in, you have to have 
the key VS8F-3card that “Authorized” the other plug-ins 
back in slot “A” to install a new plug-in. Even if you have 
all VS8F-3cards in all slots, all plug-ins have to be 
installed and “Authorized” with the single key VS8F-3card 
that install and “Authorized” the other plug-ins. It appears 
that you can not run 2 key VS8F-3cards in the same VS 
and have different plug-ins “Authorized” by different 
VS8F-3cards. 

 
 
Formatting Process (See “BkUPFmtRcvy.doc” for more detail on 
a Formatting HD.) 

1) Do backups first!  
2) If update is needed power up the VS with CD in the VS. This 

makes the VS boot from disc, answer the prompts on the 
small LCD using the ENTER button on the VS. It’ll update 
the OS in minutes. To check the OS version later, power up 
the VS holding down the Track Status & CH-Edit button 
above Track # 1. The VS will show you all four digits of the 
current OS on the LCD, again answer the prompts using the 
ENTER button on the VS to load a Project. 

3) Format the HD. 80GB=6 ½ hours, 120GB=13 Hours. 
4) Install VS8F-3 card program and all plug-ins. 
5) Recover your projects. 

 
 
 
 
 



 3 

INSTALL MORE PLUGINS 
Once the VS8F-3 card plug-ins have been installed, third party  
plug-ins are easier to install. 

1) Insert the New plug-in Installer disc into the VS2480’s CD-
RW 

2) Click on CD-RW Mastering> select PLUG-IN INSTALL> 
3) The Plug-in Install window opens, click “F5 INSTAL” 
4) It asks “INSTALL?” click “YES”, then it ask 

“AUTHORIZE?” click “YES” and “ARE YOU SURE?” 
click “YES” and wait… 

5) The disc will eject once the plug-in has been installed. 
 
LOADING & USING A PLUG-IN 
If you have your VS8F-3 card in slot “A” then we select the 
number one Effect to use the plug-in. Some plug-ins can use up 
Effects 1 & 2, the full effects processor in slot “A.” Now after you 
Insert Effect1 on a track, let’s use a plug-in on it. 

1) Click EFFECT> select EFFECT1> and the plug-in window 
opens. 

2) Click “F1 Plug-In” and the window changes to a list of plug-
in programs that are installed. 

3) Click on the one you want to highlight it and click “F5 
Select.” 

4) Now the window returns to the one before, after “Product 
Name:” should be the plug-in name. 

5) Click on “F3 PATCH” to patch in a preset effect you want to 
use. 

6) Highlight the Preset name in this list and click “F5 Select” to 
load that patch into the plug-in and wait… 

7) The window returns, now click “F4 EDIT” to load the visual 
of the plug-in on screen so that you can adjust its parameters 
or just exit out of it. 

8) Now press PLAY on the VS and listen to what this plug-in 
sounds like and make adjustments as needed if the edit 
window was left open.  
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9) When done click “F6 EXIT” and the plug-in leaves the 
screen but the effect is still INSERTED on that track for use 
as you left it. 

If you use the presets then they will load the plug-in as you left it 
the last time you shut down. If you make special changes to a plug-
in’s patch then click “F5 SAVE” and save it as a “User” Patch.  To 
select other patches just go to EFFECT> EFFECT1> then click on 
“F3 PATCH” and highlight another, click “F5 SELECT” and then 
“F4 EDIT” to bring the visual back up. Once a plug-in has been 
selected in an EFFECT,  it’s easy enough to go to that effect and 
PATCH in different patch selections and use the EDIT button to 
see what parameters are there to use. 
 
BACKUP PLUG-INS 
Once they are installed in the VS you should make a backup copy 
to a CD-R. It’s pretty easy to do, here’s how. 

1) Insert a blank CD-R into the VS’s CD-RW Drive 
2) Click on CD-RW Mastering> select PLUG-IN BACKUP> 

and the PLUG-IN BACKUP window opens 
3) Highlight the plug-in to backup by clicking on it.. 
4) Now click “F4 BACKUP” it will ask “Backup?” click “YES” 

and “Really Sure?” click “YES” and wait…. 
5) It will eject the disc when done so click “F6 EXIT” to close 

the window. 
 
USER Settings on Plug-ins 
Unlike the VS8F-2 card’s, you can not save USER settings you 
create using the VS8F-3 cards patches. You can do a Plug-in 
Backup and save your settings that way but you have no USER 
settings you can save on the VS8F-3 card. Also, SysEx does not 
work with VS8F-3 cards either. 
 
VS8F-3 Card Install AGAIN!     By Frank 
Griffith 
Follow the instructions that came with the card and this.  
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1) Do your backups first! See “VS BfUPFmtRcy.doc” for step by 
step info on this, Formatting & Recovering projects. 
 
2) Update the OS, the 2.504 update CD should have come with 
you VS8F-3 card. Insert it in the VS with it on, shutdown, 
power back up and watch the small LCD on the VS for prompts 
to answer using your ENTER/EXIT buttons. When it’s updated it 
loads a project, eject the Update CD and move on to the next 
step. 
 
3) Format the Hard Drive, seen manual for steps on formatting 
or my “VS BkUPFmtRcy.doc” for step by step info on this. Then 
install the VS8F-3 card with the VS off. 
 
4) Power up the VS and install the VS8F-3 card program and 
plug-ins using the VS8F-3 card "Setup Disc" CD that came with 
the VS8F-3 card, there are more detailed instructions that came 
with the VS8F-3 card, follow them. Also the VS8F-3 card "Setup 
Disc" will ask you if you want to "Authorize," answer YES. This 
will code the plug-ins to work only with that VS8F-3 card and 
allow you full use of the VS8F-3 card and plug-ins. The VS8F-3 
card's program and plug-ins are on the same "Setup Disc" CD 
and installed together. 
 
5) After that make a Backup of the "Setup Disc" by going to 
CD-RW Mastering and finding “Plug-in Backup” on the menu 
and select it. In the window that opens, highlight the VS8F-3 
card program name and click “OK” and insert a blank CD-R into 
the VS. 
 
 
NOTE: Have the VS8F-3 Owner's Manual handy when installing 
the card and programs. It'll only make since as you do the 
install, that's what worked for me. You can also call Roland's 
Free Tech line at 1-323-890-3741 M-F biz hours. Good luck. 
 
Install Third Party Plug-ins 
1) Insert the plug-in disc and select CD-RW Mastering> Plug-  
In Instal    
2) The VS scans drives and the plug-in window opens. Now 
click on “F5 INSTAL” a message ask “Install?” and you click 
“YES”.  
“Authorize?” and you click “YES”, “Really Sure?” and click 
“YES”  
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3) And the Plug-in Install progress bar begins. Wait a couple of 
minutes and the “In Preparation” progress bar starts then 
“Plug-in Authorize” begins and then “Eject Disc.” Done. 
4) Now go back to the CD-RW Mastering Menu, Insert a blank 
CD-R and select Plug-In Backup. The VS scans the drives and a 
“Plug-In Backup” window opens. 
5) In this window highlight the name of the plug-in to backup 
and       click “F5 BACKUP.” The VS scans the drive and ask 
“Backup?” and you click “YES”, “Really Sure?” and click “YES” 
and the VS scans the drive, “In Preparation” progress bar 
begins., then “Plug-In Backup” progress bar begins then “Eject 
Disc.” Click “F5 EXIT.” Done.  
 
ADDITIONAL INFO ON 3CARDS & PLUG-INS 
>>> I heard the term "  Vs8f 3  card getting "married" to the 
slot A used key card.?  Is this true?  
  
NO! What the deal is, in order to install the 3card and plug-ins, 
your 3card has to be in slot A in the VS. Then you can move 
that card to any other slot you choose after the setup disc has 
been installed, your 5 FREE plug-ins and 3rd party plug-ins. The 
“marry” part comes when you install a third party plug-in and 
choose “Authorize” on the install ie Auto-tune using that 3card, 
the Auto-tune is married/coded by that 3card and has to stay 
with that 3card. Once a 3card has installed all of your plug-ins 
in becomes the KEY 3card because it is the KEY that opens the 
locked plug-ins that it installed and “Authorized”.  
  
You can use the plug-ins as TRAIL versions and NOT have them 
married to a 3card but once you choose to "Authorize" a plug-
in during an install, it has to stay with that 3card it 
"Authorized" from then on. You can not sell that plug-in 
without its 3card or the plug-in will only work in TRAIL version 
mode and you will have a very unhappy buyer. 
  
The 3card install disc has the program on it that runs the 3card 
and any other 3card you install later. Once you have one 3card 
and install its setup disc, the rest of the 3cards you buy can be 
manually inserted in another slot and run off the first card's 
installed program. There are also five FREE plug-ins on that 
3card’s setup disc that you can install as well. You can run the 
3card without the FREE plug-ins and not install them and only 
install the third party plug-ins and run them or you can install 
both the 5 FREE and third party plug-ins for use.  
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The VS installs the 3card program on the last partition on your 
hard drive as well as any plug-ins you install. Therefore, any 
other 3card you manually insert into another slot in the VS will 
operate off what's already installed on the hard drive. They all 
share the one 3card’s setup disc program and all plug-ins it 
installed.  
 
Once you format your hard drive, every month or every 6 
months, you need to re-install every thing because the 
3card program and plug-ins get erased off the hard drive when 
you format. Before formatting, do backups of your entire plug-
ins and 3card program. Then you can use those to re-install 
every thing after the format. The original disc, some times fail 
after a couple of installs so backups are important to have and 
use, IMO. 
 
If you decide to buy all of the third party plug-ins available for 
the VS, you may want to buy a second 3card. The third party 
plug-ins has a lot of presets that use up the whole processor. 
You’ll have to bounce tracks with plug-in effects applied to free 
up a 3card to be used again. Many seem to like the MTKs on the 
3cards better than the ones on the 2cards. Probably has to do 
with the 3cards running plug-ins with a 56bit processing but 
also the full screen interfaces makes it easier to adjust 
settings. 
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V-Tracks-  
Next to every track's number is it's V-Track number, which would be a 
1. Just click on one of the Track's V-Track’s number 1 and a window 
opens up. The first V-Track is the one that, that track number has 
recorded your first take on. In the V-Track window, it will be a small 
black rectangle and a check mark beside it. “[Check 
mark, 1(rectangle):V.T  1- 1]” thru “[16_:V>T 1-16]” The other 15 V-
Tracks will be smaller black dashes. If you want to save a new TAKE 
of that track on a V-Track then Check Mark a different V-Track in the 
V-Track window, usually it's “[ 2_:V.T  1- 2]”. Then Click the Track's 
Number to EXIT the window and next to that Track's number will be 
number 2 for the V-Track you just selected. 
 
V-TRACK with EXTRA TAKES. 
If you want to keep a recording TAKE, let's say on Track 5, then click 
on the number 1 next to the 5 for track five, and in the V-Track 
window check mark “[2_:V.T  5- 2]” then click the 5 on track 5 to EXIT 
the V-Track window. Now you can record a second TAKE on Track 
5's V-Track # 2 and to the right of Track 5's number 5 will be a 2 for 
V-Track 2. There are 16 total V-Tracks per track. 
 
EASY ACCESS TO ALL V-TRACKS 
On the HOME screen in the track window there is an V-TRACK MAP. 
At the far right end of the ruler is a black left pointing arrow. Click on 
this arrow and it opens the “V.TRACK” map. Here the tracks that 
have data are colored, little yellow, blue and green squares. Just left 
click on any of the squares to switch to a different V-Track. A small 
widow opens confirming your selection and closes after a couple of 
seconds. *This is useful when auditioning different takes in you mix 
for deciding on what takes sound best. To close the V-Track map just 
click on the now right pointing black arrow. 
 
UNDO&OPTIMIZE.  
Recording take after take. If you just recorded a take and you don't 
want to keep it then immediately PRESS "UNDO" and in the UNDO 
window click on "ENTER" and that erases that bad TAKE. Another 
way to do this is, after you have recorded all of the tracks that you 
want to keep up to this point and you want to get rid of all of the re-
recording HISTORY then Click on PROJECT> and select OPTIMIZE. 
This will erase all of those bad takes but be sure you do not need to 
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go back and change anything before OPTIMIZING your project! Also, 
NEVER UNDO an OPTIMIZE, your project will disappear! The only 
way to retrieve the data is to REDO the UNDO by pressing and 
holding SHIFT + UNDO. To check the history map, PRESS UNDO 
and then PRESS EXIT/NO to shut it without undoing anything. 
  
AUTO PUNCH.  (Pg 192 in VS Manual) 
If you want to perform an AUTO-PUNCH, cue up the track's time line 
to the IN point and press and hold the "A.PUNCH" button down and 
press the IN button and release both, a RED down arrow will appear 
above the tracks in the RULER. Now cue the track's time line to the 
OUT point and press and hold down the "A.PUNCH" button and 
press the OUT button and release both, another RED down arrow will 
appear with a RED line connecting the two RED arrows. 
 
*NOTE: I like to PLAY the audio, keep the beat with my hand and 
count 1 and 2 and 3 and 4 and etc. Right after 4 on the “And” I press 
STOP and place my edit points or flags. This is usually a silent spot 
between beats. Practicing this will help you to get pretty precise at 
placing these flags. 
 
NOW let's say Track 5 is the one to punch IN & OUT of, press it's 
Track Status button till it's flashing RED. With your jog wheel back the 
time line up to before the IN point to give you time to get ready for the 
take to record and get in time with the beat. [You can place a 
LOCATOR button here as well if it’s lit just press 1 on the black area 
keypad, now you can cue up for several tries.] Now press Record and 
then when ready press Play. The music will play and when it reaches 
that IN point it will record on Track 5 until it reaches the OUT point 
where it will automatically exit record.  
 
Press STOP and turn the JOG wheel back to past the IN point and 
PLAY and listen to your take. You can leave the track flashing RED 
until you are sure you are keeping that take, if not then press UNDO 
and ENTER to erase it then press Record and Play and do it over or 
if you are keeping that take then press the Track Status button till it 
turns GREEN for PLAY.  
 
To get rid of the A.Punch markers hold down the "CLEAR" button 
with your left index finger and with the mouse in your right hand L-
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Click on the A.Punch's RED arrows while holding down “CLEAR” and 
the RED arrows with line will disappear. *If you do not do this, then 
when you try to record another track of audio, the VS will refuse to 
engage the record button. 
 
MANUAL PUNCH-IN/On the Fly. 
ARM the track to punch in on, back it up before the point you want to 
punch in at, play the song and when the VS gets to the point to punch 
in, press the RECORD button. When it gets to the point to punch out 
and stop recording press the RECORD button again. When done  
press STOP. 
  
AUTO or SOURCE.  
Also, during Auto-Punching some people like to hear the music play 
up to the edit point and after and some like to hear only the in point to 
out point section of music. To switch this parameter back and forth to 
do one or the other Select UTILITY> PLAY/REC PARAMETER> and 
in that window under "RECORD MONITOR" on page "F1 Param1" 
place a check mark by "SOURCE" or "AUTO", which ever is not 
selected, select it, then click EXIT. To hear your armed track’s INPUT 
signal with the RECORD engaged, select “AUTO”, when the 
RECORD is not engaged, to hear the armed track’s INPUT select 
“SOURCE” while practicing for the A-Punch.  
 
NOTE: In that same window on page "F2 Param2" is your PREVIEW 
Scub Lenghts and Preview TO & FROM times you can change by L-
Clicking with the mouse and moving it up and down. I have mine set 
at 1 Second, normally the default is too little time to understand what 
I’m hearing, now click EXIT to get out of this window and move on to 
the next item. 
 
 
 
REGION COPY. 
To copy a piece of one track to the same track but in a new position 
to cover up another piece of the same track, like copy a “chorus 3” 
vocal on track 6 to cover up a bad “chorus 2” vocal, do the following. 
Turn your jog wheel and place the time line at the beginning of  
“chorus 3” and press the IN button, then jog to the end on that chorus 
and place the time line there and press the OUT button.  
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Now jog to the beginning of “chorus 2” and press the TO button. 
Make sure your IN and TO points match the same beat and timing in 
each piece of that track 6.  
 
*NOTE: I also PLAY the audio, keep the beat with my hand and count 
1 and 2 and 3 and 4 and etc. Right after 4 on the “And” I press STOP 
and place my edit points or flags. This is usually a silent spot between 
beats. Practicing this will help you to get pretty precise at placing 
these flags. 
 
Now select TRACK, at top of screen, and select REGION COPY, 
when the REGION COPY window opens find the “F” button marked 
“SEL TRK” and click it, now the SELECT TRACK window opens, next 
to TRACK” 6-1”  place a check mark and you will see it change to 
“6-1   6-.1” so leave it there and click “F5  OK.”   
 
You will have to answer “Region Copy are you sure” by clicking 
“YES” and that’s it. If you want to redo it just press the UNDO button 
and click “ENTER” and try again. **Make sure there are not CHECK 
MARKS in other boxes from previous copies when selecting track. 
 
*Also, PRESS SHIFT+STORE often, to save your project during the 
process. Optimizing a project can cut down on project size as well. It 
cleans up the old editing data from erasing and editing. If you do 
Optimize, make sure that there is noting left that you need to UNDO.  
 
I always optimize when I am certain the song is done and that I have 
edited out all un-needed data. This cuts back on the amount of data 
to be backed up to DVD-R or RW or CD-R or RW disk later. Some 
projects at 250MB can wind up as small as 150MB after erasing extra 
data, and optimizing a project. This means you’ll need fewer disk to 
backup to in the end. 
 
MUTE & SOLO ETC. 
On your HOME screen you’ll notice that to the right of the area where 
you can have track names entered into, there are grayed out letters in 
boxes, “M”, “S”, “R” and “P.”  No, that does not stand for  
Manufacture’s Suggested Retail Price. The first two letters we will 
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discuss here. “Mute” & “Solo” because they can cause so much 
confusion in the future if one of them is on, especially Solo. 
 
Click on the “M” and you will Mute that track, meaning you will not 
hear it  play but will all the others. To Solo a track you can click on the 
“S” and it will light up BLUE. Soloing a track means that this track is 
the only one that will be heard out of the 24. If you accidentally have 
a track with nothing recorded on it Soloed then you will not hear any 
of the tracks that are recorded.  
 
Click on the “S” next to any track and watch at the bottom of the 
HOME screen to the left of the REMAIN graph. You will see a BLUE 
Solo flashing. Do the same for Mute and both will flash, Mute to Solo 
to Mute etc.  If you happen to have an INPUT Muted or Soloed you 
may not know it while looking at the tracks on the HOME screen.  
 
If you do not see any of the M’s or S’s lit but see Solo or Mute or both 
words flashing at the bottom of the screen then do this. At the very 
bottom of the list of M’s and S,s are tiny little black up arrows in 
grayed out boxes, click on those to turn off all of the Mutes & Solos. 
To the right of those are the “R” and “P.” The “R” is the Auto-mix 
Status button as on the VS and the “P” is for the Phrase Seq. Status 
button. The “PLY” acts like the TRACK STATUS buttons on the VS. 
Click on it to select from “PLY” for play to “OFF” to “REC” for arming a 
track to record.  
 
I know a lot of this is logical but I just wanted to make sure that users 
understood that these buttons can solo and mute tracks and that 
there has been some confusion in the past with users not hearing 
their tracks play. Even recording new tracks, seeing the gray record 
line of data as they record, then when they play the track, nothing! 
The final solution to the problem was to click on the ting little black 
arrows at the bottom of the M’s and S’s on the HOME screen. 
 
CH-LINK TRACKS & INPUTS 
Linking TRACKS for a stereo input is easy enough to do. Press TR1-
16 first. Now, you can either press the CH-Edit button for the odd 
numbered track and go to the CH-Edit page and find the CH-Link 
virtual button and click it or hold down the CH-Edit button of the odd 
numbered track and press the even numbered one’s CH-Edit button 
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until you see them link on the HOME screen in the track list. For 
linking INPUTS, press IN1-16 and do the same with their CH-Edit 
buttons or go to their CH-Edit page and click on the CH-Link virtual 
button.  
 
When bringing in stereo signals from an out side source, drum 
machines, keyboards etc, you will need to LINK both the INPUTS and 
the TRACKS to get a stereo signal recorded to the tracks. Either have 
them both LINKED or you can try UNLINKED but never have the 
INPUTS linked and not the TRACKS. This will confuse the VS and 
you will probably wind up with everything sounding centered. 
 
USING LOCATORS 
To the left of the JOG wheel are buttons numbered 0 thru 9, like a 
key pad with a dark gray background around them. Please, look at 
the VS and find them, OK? Above it says "Locator/Markers/Scenes"  
  
The easy way to use these multi function buttons is to use them as 
locators! It requires the least thought to use them as locators.  
  
IN TWO EASY STEPS DO THIS... 
1) Press the LOCATOR/Bank button to light it up. 
2) Turn the JOG wheel until the TIME LINE is where you want to 
place the LOCATOR ie the beginning of a song. 
3) Press any number on that pad you desire to remember that spot 
on the time line (maybe 0 or 1), the locator button will light up. Done. 
  
*Now, any time you want to go to that same spot on the time line 
quickly, press that same locator number. 
  
*If you ever want to CLEAR one of the LOCATORS, to the left of the 
number one LOCATOR is the CLEAR button on the VS, press and 
hold it down and then press the locator number you want to clear. 
You have 0 thru 9 LOCATORS you can use this way. There is a way 
to use up to 99, see the VS Manual for more. 
 
SCENES Storing a scene. 

1) Press and hold the SCENE/Bank button to light it up, then 
press a number on the keypad. 
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2) To bring up that SCENE from now on all you do is press the 
SCENE/Bank to light it up, then the number of the scene on the 
keypad. 

 
Clearing a scene... 

1) Clear a scene by pressing the SCENE/Bank button to light it up. 
2) While holding down the CLEAR button and press the scene’s 

number on the keypad. 
*To learn more about scenes see page 144 in the VS Manual. 
 
. 
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INCREMENTS of DATA              By Frank Griffith 
1) Check out the time in the upper left hand corner of the HOME 
screen. There is a yellow line under one of the double zero digits. 
There's 00h00m00s00f00 for hours, minutes, seconds, frames and 
something smaller, "Ticks" I guess. 
 
2) Press one of the Left or Right cursors to move the yellow line to 
seconds or frames and turn the JOG wheel. The TIME LINE moves in 
the smaller increments. This is good for use when editing tracks with 
them zoomed in on the wave files using WAVE DISP. You can easily 
line up the TIME LINE, (The RED LINE that crosses all tracks 
vertically) in very small increments for placing edit points. 
 
WAVE DISP Button (Wave Display) 
Any track that is selected will be displayed and fill the track screen 
when you press the WAVE DISP button. Also a wav disp blue icon is 
as the far right, bottom corner of the track screen’s scroll bars. You 
can just left click on it after selecting a track to view. 
 
So when you are doing a REGION COPY & MOVE you can use the 
WAVE DISP button to really zero in on the wave form and place your 
IN, OUT & TO points precisely. These buttons, IN, OUT, TO, FROM 
are on the second row of buttons below the LCD screen on the VS 
unit. 
 
Click Home and let’s REGION COPY something. Let’s say you want 
to repeat the last word on a verse once on track # 5. Move the TIME 
LINE to the front of the word just before you hear it play or play the 
track up to just before you hear it and press STOP. 
 
Now, on the HOME screen click on Track #5’s five(5) on the right of 
the HOME screen, to select it and highlight that track. 
 
Now press the WAVE DISP and see if you can see the word’s wave 
on the wave form, there will be a lot of tall vertical hash marks across 
the horizontal line. That’s the word. The flat line to the left of it is quiet 
space where you should place your IN point, but not just yet.  
 
Remember how far from the WORD WAVE your in point is. Using 
INCREMENTS as explained above, you can press the left or right 
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cursor buttons above the JOG wheel to change the amount to move. 
Watch the TIME DISPLAY and place the YELLOW/ORANGE colored 
line under “f” for frames by pressing the right cursor button>. Now 
place the TIME LINE on a flat, quiet place on the WAVE DISPLY by 
turning the JOG wheel. 
 
When the TIME LINE is in place, press IN. Now press HOME to come 
out of WAVE DISP and play the track and STOP it at the right end of 
the word, just after it.  
 
PRESS WAVE DISP and see where your TIME LINE is. Use the JOG 
wheel to place the TIME LINE on a flat place on the WAVE and now 
press the OUT button. Now you have placed and IN & OUT on this 
piece of wave for it to be selected, highlighted as the chunk of data to 
COPY later.  
 
SINCE we want the WORD to repeat it’s self, we just happen to be in 
the perfect spot to place the point where we are sending the selected 
word TO. We want it to come in and repeat where it went OUT. So… 
PRESS the TO button now so it’s in the same place the OUT point is. 
If you want it to be a beat later, then PLAY it and STOP it in the right 
place, and place the TO point in the new spot. 
 
Now go to TRACK menu and select REGION COPY, a window 
opens, click on “F1 Sel Trk” and on that window place a check mark 
in the empty box to the left of  
5-1   -“ and it’ll turn into “5-1  5-1” meaning you are copying a 
portion of track # 5 to track # 5. 
 
Now click OK and then click on EXIT to close the REGION COPY 
window. Play the tracks and see if the edit did what you wanted. If not 
you can press UNDO and then ENTER to try it again. 
 
*REGION COPY will copy a piece of audio and send it “TO” any track 
on the time line you want to send it “TO” leaving the original part in 
tact. REGION MOVE will MOVE that piece of audio to any track on 
the time line but not leave an original in tact. To send a copied piece 
of audio to a different track or V-Track, just select that track in the “F1 
Sel Trk” window mentioned above. It’s that simple.  
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VS2480 SHORT CUTS……….PS/2 KEYBOARD                 By Frank Griffith 
F1 – F6 = VS F1 – F6 …………………………………F7 = Dislay the EZRouting Screen 
SHIFT+ F7 = EZ Routing>EZ Patch Bay> …………...F10 = Track Menu 
SHIFT+ F8 = Mastering Room  ………………………F11 = Effect Menu 
F9 = Project Menu …………………………………….F12 = Utility Menu 
 
PRESS 
        Space Bar =…………………..Start, Stop and Continue Project 
     Arrow Keys =…………………. Moves the cursor on the display 
SHIFT+ Arrow Keys =………Zoom in and out vertically and horizontally  
        Ctrl+ S =…………………………Stores the current project 
Ctrl+ Alt+ Delete =……………………Shuts down the VS2480 
          Tab =………………………………….Page button 
         Enter =……………………….Enter/Yes or Left mouse button 
        Escape(Esc) =…………………………………Exit/No 
       Home = Home screen on VS 
 
VS2480 FUNCTION BUTTONS SHORT CUTS 
Quick Routing = Hold [Track Status]           / Snapshot = [Automix]+ [Snapshot]+ [TAP] 
 
Solo Ch. Clear = [Clear]+ [Solo (IN 1-16)]                /Automix = [SHIFT]+ [AUTOMIX] 
 
Mute Ch. Clear = [Clear]+ [Mute (IN 17-24)]                   / Marker = [Shift]+ [MARKER] 
 
Automix Status =  [Automix]+ [Automix Status]            / Tempo Map = [SHIFT]+ [TAP] 
 
Tr. Status REC =  [REC]+ [Track Status 1…24]     /REDO = [SHIFT]+ [REDO(UNDO)] 
 
Locator Clear =  [Locator (Bank)] [Clear]+ [0…9)] /Marker Erase = [CLEAR]+ [TAP] 
 
Scene Clear = [Scene (Bank)] [CLEAR]+ [0…9]    / Jump to IN point = [SHIFT]+ [IN] 
 
CD Track Number = [CD-RW (Mastering)]+ TAP /Jump to OUT point = [Shift]+ [OUT] 
 
Automix REC = [Automix]+ [REC]              / Jump to FROM point = [JUMP] + [FROM] 
 
All Markers Erase = [SHIFT]+ [CLEAR]+ [TAP]         / Jump TO point = [JUMP]+ [TO] 
 
Mastering Rom = [SHIFT]+ [Mastering (CD-RW)] / Loop From/To = [SHIFT]+ [LOOP] 
 
Sync Parameter = [SHIFT]+ [EXT SYNC]    / Reset Fader/Pan = [CLEAR]+ {CH-EDIT] 
 
Auto Punch IN/OUT = [SHIFT]+ [AUTO PUNCH] 
 
Tr. Status PLAY = [STOP]+ [Track Status 1…24]             
Found in VS Manual and Stickers 



 
 

What is the HoldID for? 
FAQ's - Tutorials - Tips 

There are a number of VGA and LCD commands that say ****ID next to them. What 
this does is give you two screens to work with at once.  
 
For example, you may push the IDHome button and the VGA screen remains the same 
but the LCD on the VS2480 changes to different views.  
 
If you like that view you can push the HoldID button and that screen will stay displayed 
even if the VGA screen changes pages.  You can have mixer view on the VS2480 LCD at 
all times or various others, a very handy feature.  

From Brett’s site on line.  
http://www.rolandvs2480.net/ 
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PC AUDIO & PERFORMANCE 
START> Control Panel>Classic View click System> Advanced> 
under Performance click Settings> then tick for Best Performance. 
  
Control panel> Classic View>Sounds and Audio Devices> Sounds 
tab> Sound Schemes, in the drop down menu select NO SOUNDS. 
  
Control panel>Classic View>Display> Settings> 1024 x 768 & Color 
@ Highest[32 Bit]. For Sonar Producer 4 select 24bit. 
  
Control Panel> Classic View> System> Advanced tab> under 
Performance click Settings> Advanced tab> there are 3 items: 
Processor Scheduling tick for BACKGROUND, Memory Usage tick 
PROGRAMS, Virtual Memory @ 1280, click Change to reset number 
if smaller than 1280. Why BACKGOUND? This lets your ASIO, 
DirectX and VSTs run better with less latency. 
 
Right-Click on bottom Task Bar> select Properties> uncheck “Show 
Clock”, this saves on CPU usage. 
 
START> Control Panel> System> Automatic Updates> Select “Turn 
Off Automatic Updates.” Check once a week when you want too. 
 
START> Control Panel> System> System Restore tab> Select “Turn 
Off System Restore” and click “OK.” This can happen at the most 
annoying times plus it uses up disk space. 
I recommend you set your own restore points weekly or monthly by 
going to START> All Programs> Accessories> System Tools> 
System Restore> and follow the directions given to create a restore 
point. You will have to turn it on first. Or, just move the space slider to 
halfway to have it use less disk space. 
 
Disable Remote Desktop and Assistance. START> Control Panel> 
System> Remote tab> Uncheck “Allow Remote Assistance…” and 
“Allow users to connect…” 
 
START> Control Panel> System> Hardware tab> Device Manager> 
[+] Disk Drives open> Highlight the Hard Drive and right click> Select 
“Properties”> Policies tab> Uncheck “Enable write caching on disk” 
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and click “OK.” You see the warning is has there about having it 
checked and data loss? 
 
START> Control Panel> Power Options> Power Schemes tab> 
Select “Home/Office in the first window and then select “NEVER” in 
the rest and click “Apply.” 
 
START>Control Panel> User Accounts> click on “Change the way 
users log on or off”> then uncheck “Use Fast User Switching” And 
click “Apply Options.” It uses too much CPU power. 
 
Right-Click on Desktop> Properties> Desktop tab> select 
Background None, and on Screen Saver tab> None.  
 
Also go to Internet Explorer> Tools> Internet Options> General Tab 
"Delete Cookies" and click “OK”, then “Delete Files” and click “OK”, 
now wait on the hour glass to go away & “Clear History” then click the 
“YES” and then Internet Options box’s “OK” to shut the window. 
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